## Table of Contents

### INTRODUCTION
- System Requirements ................................................................. 12
- Installation and Getting Started .................................................. 13
- Database Configuration .................................................................. 22
- Uninstalling ServiceDesk Plus ....................................................... 25
- Registering ServiceDesk Plus ......................................................... 26
- Contacting ZOHO Corporation ....................................................... 27

### HOME PAGE
- My Tasks ....................................................................................... 33
- Publishing Announcements .......................................................... 35
- Scheduler ........................................................................................ 37
  - My Schedule .................................................................................. 38
  - Technician Availability Chart ...................................................... 41
- Reminders ....................................................................................... 47
- License Expiry Alert ........................................................................ 49

### DASHBOARD

### REQUEST
- Request List View .......................................................................... 55
- Creating a New Incident ................................................................. 57
- Raising Service Requests .............................................................. 61
- Creating Custom Views ................................................................... 64
- Manage Custom Views ................................................................... 65
- Viewing a Request .......................................................................... 66
  - Request Tab .................................................................................. 66
  - Resolution Tab ............................................................................. 67
  - Tasks Tab ..................................................................................... 68
  - Approvals Tab ............................................................................. 68
  - History Tab .................................................................................. 69
- Editing a Request ........................................................................... 70
- Closing Requests ........................................................................... 71
- Picking up Requests ....................................................................... 72
- Assigning a Technician for the Request .......................................... 73
Unassigning a Technician from a Request ........................................... 75
Start / Stop Request Timer ............................................................... 76
Adding Notes .................................................................................. 77
Adding Work Logs ........................................................................... 78
Tasks ............................................................................................ 80
Merging Requests ............................................................................ 83
Duplicate Request ........................................................................... 84
Linking Requests ............................................................................. 85
Deleting Requests ........................................................................... 89
Add/Associate Problem to Requests ................................................... 90
Add/Associate Change to Requests .................................................... 92
Printing the Request ....................................................................... 94
Adding a Resolution ........................................................................ 95
Searching Solutions ......................................................................... 96
Submit For Approval ....................................................................... 97
Viewing Requester Details .............................................................. 99
E-mail the Requester ...................................................................... 100
Forward the Request ...................................................................... 102
E-mail the Technician ..................................................................... 103
SMS the Technician ........................................................................ 104
Request Conversations .................................................................... 105
Viewing Requests Based on Filters ....................................................106
Customizing Request List View .........................................................110
Searching Requests ........................................................................ 111
Multi site on Requests ..................................................................... 112

MOBILE CLIENT .................................................................... 114

PROBLEMS ........................................................................ 123
Creating a New Problem .................................................................124
Viewing Problem Details .................................................................126
Editing a Problem ..........................................................................127
Closing Problem .............................................................................128
Picking Up Problem .......................................................................129
Assigning Technician .....................................................................130
Problem Analysis ..........................................................................132
Problem Solutions .........................................................................133
Adding Notes .......................................................................................... 134
Adding Tasks .......................................................................................... 135
Adding Work Logs .................................................................................. 137
Deleting Problem ................................................................................... 138
Associating Incidents to a Problem .......................................................... 139
Associating Changes to Problem .............................................................. 140
Adding Reminders .................................................................................. 141
Viewing Reminders ............................................................................... 142
Publishing Announcements .................................................................... 144
Printing Problem .................................................................................... 146
Send Notifications ................................................................................ 147

**CHANGES** .......................................................................................... 148

Creating New Change ............................................................................. 149
Forward Schedule of Change ................................................................... 151
Viewing Change Details .......................................................................... 155
Editing a Change .................................................................................... 157
Printing Change ...................................................................................... 158
Adding Notes .......................................................................................... 159
Adding Reminders .................................................................................. 160
Adding Work Logs .................................................................................. 163
Assigning Technician to a Change ............................................................ 164
Picking Up Change ................................................................................ 165
Closing Change ....................................................................................... 166
Deleting Change ..................................................................................... 167
Associating Incidents to a Change ............................................................ 168
Associating Problems to a Change .......................................................... 169
Publishing Announcements .................................................................... 170
Send Notifications ................................................................................ 172
Change Planning .................................................................................... 173
 Recommending Change by CAB ............................................................... 174
 Approving Change by the Change Manager .............................................. 176

**ASSETS** ............................................................................................ 177

IT Assets ................................................................................................. 178
Adding IT Asset ...................................................................................... 179
Editing Assets ......................................................................................... 181
Adding Assets to Group ........................................................................ 182

ZOHO Corp.
Assigning Assets to Department/Site ........................................................ 183
Modifying State for IT Assets .................................................................... 184
Change log-in Credentials for bulk of IT Assets ....................................... 185
Bulk Scan of IT Assets ............................................................................. 186
Deleting Assets ...................................................................................... 187
Importing Asset details From CSV ......................................................... 188
Viewing IT Asset Details ......................................................................... 189
Copying Assets ...................................................................................... 191
Attaching Assets .................................................................................... 192
Attach Component ................................................................................ 193
Attach Documents ................................................................................ 194
Assigning IT Asset to User/Department/Asset ......................................... 195
Add New Workstation ........................................................................... 196
Bulk Scan of Newly Added Workstation ................................................ 197
Changing Workstation As Server .......................................................... 198
Viewing Workstation Details ................................................................ 199
Print Preview of Workstation Details ..................................................... 202
Modify Type .......................................................................................... 203
Reconcile Workstations ......................................................................... 204
Adding Software .................................................................................... 205
Deleting Workstations ........................................................................... 206
Remote Desktop Sharing ......................................................................... 207
Components .......................................................................................... 212
Adding Components ............................................................................... 213
Adding Components to Group ............................................................... 214
Deleting Components ........................................................................... 215
Viewing Components Details ................................................................ 216
Copying Resources ................................................................................ 217
Editing Components ............................................................................... 218
Attaching Documents ............................................................................. 219
Non IT-Assets ....................................................................................... 220
Assigning Non-IT Assets to Users and/or Department ......................... 221
Editing Non-IT Assets .......................................................................... 222
Adding Non-IT Assets to Group ............................................................. 223
Assigning Bulk Non-IT Assets to Department/Site ................................ 224
Modifying the State of Non-IT Assets ................................................... 225
Deleting Non-IT Asset ........................................................................... 226
Viewing Non-IT Assets Details ............................................................. 227
Assigning Non-IT Assets to Users and/or Department ......................... 228
Copying Resources ............................................................................... 229
Attaching Assets .................................................................................. 230
Attach Component ................................................................................ 231
Attach Documents ................................................................................ 232
Software Asset Management ............................................................ 233
Scanned Software ................................................................................. 234
Adding New Software .............................................................................. 235
Viewing Software Details ........................................................................ 236
Changing Software Type ........................................................................ 238
Changing Software Category .................................................................. 239
Deleting Software ................................................................................... 240
Associating Software Minor Versions ...................................................... 241
E-mailing Users ...................................................................................... 242
Software Summary ................................................................................ 243
License Agreement ................................................................................ 244
  Editing and Deleting License Agreement .............................................. 247
  Printing the License Agreement ............................................................. 248
Software License ................................................................................ 249
  Viewing Software Licenses ................................................................... 253
  Editing and Deleting Software License ................................................. 254
  Attach Document to Software Licenses ................................................. 255
Service Packs ................................................................................ 256
  Editing and Deleting Service Packs ...................................................... 257
Groups ............................................................................................. 258
  Creating New Group ........................................................................... 259
  Removing Assets from Group ............................................................... 260
  Editing & Deleting Groups .................................................................. 261
PURCHASE ................................................................................ 262
  Purchase Order Configurations ............................................................ 263
  Purchase Default Values ...................................................................... 264
  Purchase Order Additional Fields ......................................................... 265
  General Ledger Code (GL Code) ............................................................ 266
  Cost Center ......................................................................................... 267
  Contract Additional Fields .................................................................. 268
  Notification Rules ............................................................................... 269
  About Purchase Order .......................................................................... 270
  Creating a New Purchase Order ........................................................... 271
  PO Approval Process ........................................................................... 273
  Ordered Purchase Order ...................................................................... 275
  Receiving PO Items ............................................................................ 276
  Reconcile Workstations ..................................................................... 278
  Adding Invoice details and Notification ............................................... 279
  Adding Payment details & Notifications ............................................. 281
  E-mailing the PO Owner ....................................................................... 283
  E-mailing the Vendor ........................................................................... 284
  Editing Purchase Order ....................................................................... 285
Printing Purchase Order ................................................................. 286
Deleting Purchase Orders .............................................................. 287
Closing Purchase Order ................................................................. 288

CONTRACTS .......................................................... 289
  About Contracts ...................................................................... 290
  Creating a New Contract ....................................................... 291
  Viewing a Contract ............................................................... 293
  Editing and Deleting Contracts ............................................. 294
  Viewing Contract Owner Details .......................................... 295
  Renewing a Contract ............................................................. 296
  Print Preview of Contract ...................................................... 297
  E-mailing the Contract Owner ................................................. 298
  E-mailing the Vendor ............................................................. 299
  Searching Contracts ............................................................. 300

SOLUTIONS ......................................................... 301
  About Solutions ..................................................................... 302
  Adding a New Solution ......................................................... 303
  Viewing Solution Details ...................................................... 304
  Editing a Solution ................................................................. 306
  Submit for Approval ............................................................. 307
  Approve/Reject Solution ....................................................... 309
  Delete Solutions ................................................................. 310
  Search Solutions .................................................................. 311
  Browsing Solutions by Topic ................................................ 312
  Managing Topics .................................................................... 313
    Adding a New Topic .......................................................... 313
    Renaming a Topic ............................................................ 313
    Deleting a Topic ................................................................ 314

CONFIGURATIONS .................................................. 315
  Helpdesk Configurations ...................................................... 316
    Request Form Customizer .................................................. 317
      Configuring Category ....................................................... 318
      Editing & Deleting Category ........................................... 320
      Configuring Status ........................................................ 321
      Configuring Level .......................................................... 323
      Configuring Mode .......................................................... 324
    Request Closure Code ....................................................... 325
Change Closure Rules ................................................................. 425

Discovery - Scanning Workstations and Other Network Devices .............. 426

Scanning Windows Machine .................................................................. 427
Modes of Scan: Agent and Agentless ..................................................... 428
Agent Mode ........................................................................................ 429
Methods of Agent Deployment ............................................................. 432
Un-installing the Agent ........................................................................ 437
Agent-less Mode .................................................................................. 438
Scanning Linux, Solaris, MAC and AIX machines .................................... 439
Scanning Printers, Routers, Switches and Access Points ........................... 440
Windows Domain Scan ........................................................................ 441
Network Scan .................................................................................... 443
Workstation/Device Scan ...................................................................... 446
Standalone Workstation Audit ............................................................... 448
Ports used during Scan ......................................................................... 450
Scanning WAN environment ................................................................. 451
Schedule Scan .................................................................................... 452
Distributed Asset Scan ......................................................................... 454
General Settings ................................................................................ 457

Asset Management ............................................................................ 458
Configuring Product Types ................................................................. 459
Configuring Products ......................................................................... 461
Configuring Vendors .......................................................................... 463
Workstation Additional Fields ............................................................... 465
Asset Additional Fields ....................................................................... 466
Resource State .................................................................................. 467

Softwares .......................................................................................... 468
Configuring Software Type ................................................................. 469
Software Category ............................................................................. 470
License - Additional Fields ................................................................. 471
Software License Types ....................................................................... 472
License Agreement- Additional Fields .................................................... 474
Importing License From CSV ............................................................... 475

User Survey ..................................................................................... 477
Configuring Survey Settings ............................................................... 478
Defining a Survey ................................................................................ 480
Viewing Survey Results ....................................................................... 483

General Settings .............................................................................. 484
Configuring Self Service Portal Settings ................................................. 485
Backup Scheduling ............................................................................. 488
Data Archiving .................................................................................... 489
Desktop Central Integration ................................................................ 492
SERVICEDESK PLUS API ............................................................. 499
  Servlet API ........................................................................... 501
  Request Attributes and xml Response .................................. 503
  Site Attributes and xml Response ......................................... 511
  Technician Attributes and xml Response ............................ 516
  Requester Attributes and xml Response ............................... 520
  Asset Attributes and xml Response ...................................... 525
REST API ................................................................................. 531
  Request Operations ............................................................. 534
  Notes Related Operations .................................................. 539
  Worklog Related Operations .............................................. 544
REPORTS ................................................................................. 549
  About ServiceDesk Plus Reports ......................................... 550
  Custom Reports .................................................................. 555
  Creating New Query Reports ............................................. 559
  Flash Report ...................................................................... 560
  Scheduling Report Settings ............................................... 562
  Custom Settings ................................................................. 563
APPENDIX ............................................................................... 564
  System Log Viewer ............................................................. 565
  Feedback ............................................................................ 566
  Personalize ........................................................................ 567
  Back up and Restore .......................................................... 569
  Changing Web Server Port ................................................. 570
  ServiceDesk Plus Editions .................................................. 571
  Troubleshooting ................................................................. 572
Introduction

ManageEngine ServiceDesk Plus is a comprehensive help desk and asset management software that provides help desk agents and IT managers an integrated console to monitor and maintain the assets and IT requests generated from the users of the IT resources in an organization. The IT help desk plays an important part in the provision of IT Services. It is very often the first contact the users have in their use of IT Services when something does not work as expected. The IT help desk is a single point of contact for end-users who need help. Without this, an organization could certainly face losses due to inefficiencies.

The two main focuses of the ManageEngine ServiceDesk Plus are IT Request tracking and Asset Management. Using the following modules of ServiceDesk, technicians and system administrators can resolve issues of complex nature in no time and thus reduce the end-user frustration arising due to time consuming issue resolving process. They can also keep track of the needs of the organization with the help of asset management and proactively allocate resources to the right user/departments, thus increasing the productivity of the organization.

- Requests
- Problem
- Change
- Solutions
- Assets
- Purchase
- Contract

The request module functions as the Help Desk where requests are fetched and necessary solutions provided by assigning technicians to resolve issues reported.

When you log in to ManageEngine ServiceDesk Plus, the application displays the ServiceDesk Plus home page that contains information on pending requests, overdue requests, requests assigned to the user who has logged in, approved/unapproved changes by the logged in technician, open and unassigned problems assigned to the logged in technician, individual user’s task list, and depending on the user login, the other dashboard views such as Contract and Purchase Order summary may also be displayed.

Requests
Clicking on the Requests tab on the header pane takes you to the request module. This serves as the IT help desk module where the IT requests from individual users are fetched, tracked, technicians are assigned, and a solution is provided.

Problems
The objective of Problem Management is to minimize the adverse impact of Incidents and Problems on the business that are caused by errors within the IT infrastructure, and to prevent recurrence of Incidents related to these errors. In order to achieve this goal, Problem Management seeks to get to the root cause of Incidents and then initiate actions to improve or correct the situation.

Change
The goal of Change Management is to ensure that standardised methods and procedures are used for efficient and prompt handling of all Changes, in order to minimise the impact of change-related incidents upon service quality and consequently to improve the day-to-day operations of the organization.
Solutions
This module serves as a knowledge base for your IT help desk team as well as your users. Users can search this for solutions for issues and solve them themselves. Also when technicians resolve issues, they can directly convert these resolutions as knowledge base articles. To view the solutions, click the Solutions tab in the header pane.

Assets
Assets tab helps you to track & manage your assets efficiently. It tracks all your newly added assets, and have a record of all the assets in the organization. Assets can be categorized as IT, Non IT Assets & Asset Components in an organization. This includes Workstations, Printers, Routers, Software Licenses, Scanners, Projectors and even your air conditioning systems. Thus it offers a single view to track and manage all your assets in the organization.

Purchase
Here you can create new purchase orders and track them till the order has been delivered. The same details can also be maintained for future reference. Clicking the Purchase tab takes you to the Purchase module.

Contract
This module holds the details regarding the maintenance contracts between your organization and the vendor(s) from whom the assets of your organization have been purchased. Clicking the Contracts tab in the header pane takes you to the contract module.

In addition to these, ServiceDesk Plus has GUI-rich reports for requests and Assets modules. There are predefined sets of reports that help you evaluate the efficiency and productivity of your IT help desk team, the load of requests handled by the team, the assets distribution, and many more. Also, the ServiceDesk administrator can configure various help desk, asset, and enterprise-related settings, such as the working hours of the organization, service-level agreements, user roles, departments and many more.

Based on the permissions provided by the ServiceDesk Plus administrator to each of the users of the application, you will be able to access the above modules. If you do not have the access permission, contact your ServiceDesk Plus administrator.
System Requirements

Hardware
The following table list the hardware installation according to the number of Technician Logins.

<table>
<thead>
<tr>
<th>Technician Logins</th>
<th>No of Nodes</th>
<th>Processor Type</th>
<th>Processor Speed</th>
<th>RAM</th>
<th>Free Hard Disk</th>
</tr>
</thead>
<tbody>
<tr>
<td>5-20</td>
<td>50-200</td>
<td></td>
<td>1.7 GHz</td>
<td>1GB</td>
<td>20GB</td>
</tr>
<tr>
<td>20-50</td>
<td>200-500</td>
<td>Intel Core Duo</td>
<td>3.4 GHz</td>
<td>2GB</td>
<td>40GB</td>
</tr>
<tr>
<td>50-100</td>
<td>500-2000</td>
<td></td>
<td>2*3.4 GHz</td>
<td>4GB</td>
<td>40GB</td>
</tr>
<tr>
<td>100-200</td>
<td>1000-5000</td>
<td></td>
<td>4*3.4 GHz</td>
<td>4GB</td>
<td>80GB</td>
</tr>
</tbody>
</table>

Operating System
Windows
- Windows 2000 + SP4
- Windows 2000 / 2003 Server
- Windows XP Professional
- Windows 2008 Server
- Windows 7

Linux
- Red Hat Linux 7.2 and above
- Linux Debian 3.0

Supported Database
- MySQL 4.1.18
- MS SQL 2000, MS SQL 2005, MS SQL 2008
Installation and Getting Started

- In Windows
- In Linux

In Windows

Follow the steps given below to install and set up the ManageEngine ServiceDesk Plus application:

1. Download the **ManageEngine_ServiceDesk_Plus.exe** file.
2. Click the exe file to start the installation. The ServiceDesk Plus installation wizard appears as shown below,

![Installation Wizard Screenshot](image)

3. Click **Next** to proceed with the installation.
4. The second screen displays the License Agreement. You need to accept the license agreement to proceed with the installation. Click **Yes** to accept.
On accepting the license agreement, the installation wizard provides you with the option to choose between the **Standard**, **Professional** and the **Enterprise Edition**. **Standard Edition** - This edition offers Help Desk management, self-service portal, knowledge base, SLA management and Help Desk report to help you manage and track your requests. **Professional Edition** - This edition offers Software compliance & license tracking, Product Catalog, NMS integration, Asset Reports and few other asset related process along with the features of Standard Edition. **Enterprise Edition** - This is an ITIL ready Helpdesk. It includes all features of Professional Edition plus Incident management, Problem management, Change management & Configuration management database (CMDB).

A free and trial version is provided for Standard and Professional Edition. The **Free Version** never expires and is restricted to a single technician login with 25 nodes. The **Trial Version** is valid only for 30 days and allows 2 technician logins with 200 nodes. The Enterprise Edition is provided only with a trial version which is valid for 30 days with 5 technician logins with 200 nodes.
6. The next step is choosing the installation directory. By default, the application is installed in `C:\ManageEngine\ServiceDesk` directory.

If you want to change the installation directory, then, click the **Browse** button beside the directory path. From the file chooser window, choose the directory of your choice and click **Ok**.

7. Provide a name that needs to appear in the **Program Folders**. By default, it is **ManageEngine ServiceDesk Plus**. Click **Next**.
8. Enter the port number that has to be used to run the web server. The default port number provided is **8080**. If you already have any application running in that port, then enter the number of the port that is free and can be used by the web server to run the ServiceDesk Plus application server and click **Next**.

**Web Server Port**
Enter the Web Server Port Number

ManageEngine ServiceDesk Plus uses port 8080 to run the Web server. If you want to run it on a different port, specify the same here.

![Port Entry](image)

8080

7. Choose the Database between MY SQL and MS SQL. By default ServiceDesk Plus supports **MySQL database**, to switch over to **MS SQL database** you need to configure SQL server to establish connection and start the server. Enter the details as given below,

- **Host Name**: Enter the IP Address/host name in which the database is available. The default host name is 'localhost'.
- **Port**: Specify the port in the given text field. The default value is 1433.
- **Database**: By default the database name will be Servicedesk in non-editable format.
- **User Name**: Specify the user name to login to the server in the given text field.
- **Password**: Specify the password for the username in the given text field. Click **Next**.

**Note**: To switch over to SQL database, you need to enable SQL authentication as Window authentication will not work.
11. The **Registration for Technical Support** form is displayed. This is an optional form and it enables you to register for technical assistance. By registering, it helps the technical support team to be better informed about your organization and its specific needs and hence provide a more focused support. Enter the details such as Name, contact E-mail ID, Phone Number (helps in making calls for immediate support), Company Name, and Country. Click Next.

![Registration form](image)

13. The details that you have provided till now will be displayed as below for your confirmation:

- **Installation Directory**: C:\ManageEngine\ServiceDesk
- **Folder Name**: ManageEngine ServiceDesk Plus
- **WebServer Port**: 8080

**Start Copying Files**

Review settings before copying files.

The displayed information is correct, then click the **Next** button, or else click the **Back** button and make the necessary changes and proceed with the installation.
14. After you confirm the above details, the application is installed. On successful installation, the following screen is displayed.

If you choose to start the ServiceDesk as Service, then the ServiceDesk Server is started automatically and the client window opens. If you do not wish to view the readme file or start ServiceDesk as a windows service, de-select the options provided.

13. Click Finish to complete the installation.

If you had followed the instructions in the wizard and installed the application with the default settings suggested by the wizard, the ManageEngine ServiceDesk Plus program group is created in the Start menu. Also, the ServiceDesk server will be started and the client window opens with the login page. Enter the user name and password to log in to the application.

To manually start the ServiceDesk Plus application

1. Click Start -> Programs -> ManageEngine ServiceDesk Plus -> ServiceDesk Server to start the web server. This takes approximately 2 minutes in a Windows XP, 512 MB RAM, and 1.0 GHZ processor. Generally, the server is started and the web client is also launched in the default browser.

2. If the web client is not launched automatically, then click Start -> Programs -> ManageEngine ServiceDesk Plus -> ServiceDesk Web Client to start the web client. The application opens the login page in your default web browser.

3. Enter your user name "administrator" and password "administrator" to log in to ServiceDesk Plus. As soon as you log in the configuration wizard home page is displayed. Follow the instructions provided in the wizard and click the Next button.

To configure your application settings, refer to the Configurations section.
To shut down the ServiceDesk Plus application

1. Click **Start -> Programs -> ManageEngine ServiceDesk Plus -> Shutdown ServiceDesk**. A confirmation message is displayed.
2. Click **OK** to proceed with the shut down.

Alternatively, you can also right-click on the system tray icon and choose **Shut down Server**. A confirmation message is displayed. Click **OK** to shut down ServiceDesk Plus.

In Linux

Follow the steps given below to install and setup the ManageEngine ServiceDesk Plus application:

1. Download the **ManageEngine_ServiceDesk_Plus.bin** file.
2. Execute the .bin as given below, at your command prompt: `./ServiceDesk_Plus.bin`

   **Note:** You need to have execute permissions for executing the .bin type files.

The following screen of the installation wizard is opened and the you will be guided through the installation process.

Click **Next** and follow the steps given in the installation wizard.

The second screen displays the **License Agreement**. You need to accept the license agreement to proceed with the installation. Click **Yes** to accept.

On accepting the license agreement, the installation wizard provides you with the option to choose between the **Standard**, **Professional** and the **Enterprise Edition**.
Standard Edition - This edition offers Help Desk management, self-service portal, knowledge base, SLA management and Help Desk report to help you manage and track your requests.

Professional Edition - This edition offers Software compliance & license tracking, Product Catalog, NMS integration, Asset Reports and few other asset related process along with the features of Standard Edition.

Enterprise Edition - This is an ITIL ready Helpdesk. It includes all features of Professional Edition plus Incident management, Problem management, Change management & Configuration management database (CMDB).

A trial and free version is provided for Standard and Professional Edition. The Free Version never expires and is restricted to a single technician login with 25 nodes. The Trial Version is valid only for 30 days and allows 2 technician logins with 200 nodes. The Enterprise Edition is provided only with a trial version which is valid for 30 days with 5 technician logins with 200 nodes.

The next step is choosing the installation directory. By default, the application is installed in home/<user>/ManageEngine/ServiceDesk directory. If you want to change the installation directory, then, click the Browse button beside the directory path.

From the file chooser window, choose the directory of your choice and click Next.

Enter the port number that has to be used to run the web server. The default port number provided is 8080. If you already have any application running in that port, then enter the number of the port that is free and can be used by the web server to run the ServiceDesk Plus application server and click Next.

Note: If you wish to provide a port number lesser than 1024 as the web server port, then you need to be the super-user of the system to successfully install and run ServiceDesk Plus application.

The Registration for Technical Support form is displayed. This is an optional form and this enables you to register for technical assistance. By registering, it helps the technical support team to be better informed about your organization and its specific needs and hence provide a more focused support. Enter the details such as Name, contact E-mail ID, Phone Number (helps in making calls for immediate support), Company Name, and Country. Click Next.

The details that you have provided till now will be displayed as below for your confirmation:

Details of Installation

Installation Directory: home/<user>/ManageEngine/ServiceDesk
Product Size : 62.8 MB.

If the displayed information is correct, then click the Next button, or else click the Back button and make the necessary changes and proceed with the installation.

After you confirm the above details, the application is installed. On successful installation, the following screen is displayed.
If you do not wish to view the Readme file, de-select the check box.

Click Finish to complete the installation.

To manually start the ServiceDesk Plus application

1. Go to the <ServiceDesk Plus>/bin directory and execute the run.sh file as given below: $ sh run.sh

2. To start the web client, open a web browser and type the following in the address field: http://localhost:8080 Here, you need to replace the localhost with the corresponding server name where the ServiceDesk Plus web server is running and the port number 8080 should be replaced with the actual port where the server is running. The application opens the login page in your default web browser.

3. Enter your user name "administrator" and password "administrator" to log in to ServiceDesk Plus. As soon as you login the configuration wizard home page is displayed. Follow the instructions provided in the wizard and click the Next button.

To configure your application settings, refer to the Configurations section.

To shutdown the ServiceDesk Plus application

execute shutdown.sh file from the bin directory as below:

sh shutdown.sh -S
Database Configuration

By default ServiceDesk plus supports **MySQL database** to switch over to **SQL database** you need to configure SQL server to establish connection and start the server.

Configuring MS SQL Server

1. Execute the `changeDBServer.bat` [changeDBServer.sh for Linux] file presented under the ServiceDesk Home. This opens the **Database Setup Wizard** page. Fill in the details of the form to configure sql server.
   - **Server Type:** Select the server type from the combo box. Say MS SQL.
   - **Host Name:** Enter the IP address/host name in which the database is available. The default host name is 'localhost'.
   - **Port:** Specify the port in the given text field. The default value is 1433.
   - **Database:** By default the database name will be servicedesk in non-editable format.
   - **User Name:** Specify the user name to login to the server in the given text field.
   - **Password:** Specify the password for the username in the given text field.

2. To check the availability of connection press the **Test** button. A pop up window pops up showing 'Connection Established' message.

3. Click **OK** to proceed.

4. Click **Save** button to save the SQL server settings.
Configuring MYSQL Server

1. If you are using a remote MySql server and do not want to use the inbuilt server then,
2. Select Server Type as MySql server. This opens the database wizard page.
3. Specify the Host Name, Port, User Name & Password.
4. Click Test button and check the availability of the connection.
5. Once the Connection is Established, Save the details and start the server.

Non UI users

Run the changeDBServer.bat under command prompt by passing parameter like given below

>changeDBServer.bat --console

It will get the DB Server necessary information from the console.

Troubleshooting Tips

MY SQL Connection Resolution

Verify the following,

- Check if the MY SQL server is running.
- Check if the server name or the port number is misspelled or incorrect.
- If the MY SQL server is running in a remote machine then there may be a firewall blocking the port number you have entered.
- If none of the above mentioned issues matches then contact your system administrator.

MS SQL Connection Resolution

If a connection is refused and an exception is thrown by SQL Server as 'unable to connect the server' then there could be following reasons why this could happen such as,

- The server name is misspelled or the port number is incorrect
- The SQL server will not configured to use TCP/IP then in this case enable TCP/IP from SQL servers network utility application.
- If there is a firewall blocking the port 1433 on the server then you will not be able to connect to the server.
- To confirm the firewall block connect to TCP/IP use \"telnet<server_host>1433\" to confirm the block.
- SQL Server Instance is not currently supported by ServiceDesk and will be available in the feature release. You can also connect to SQL Server named instance once if you know the machine name and port of the named instance.
- Create new user with full privileges as shown below,
While configuring SQL server properties select the authentication type as SQL server as shown below. Windows authentication is not supported by serviceDesk Plus currently.
Uninstalling ServiceDesk Plus

- In Windows
- In Linux

**In Windows**
To uninstall ServiceDesk Plus from Windows

1. Click **Start -> Programs -> ManageEngine ServiceDesk Plus -> Uninstall ServiceDesk.**

**In Linux**
To uninstall ServiceDesk Plus from Linux

1. Go to `<ServiceDesk>_uninst directory.
2. Execute uninstaller.bin as below: $ ./uninstaller.bin

ZOHO Corp.
Registering ServiceDesk Plus

Once your trial evaluation period is over, you need to register the ServiceDesk Plus application. To purchase the application, please contact sales@manageengine.com. They will send you the registered license file. Using this license file, you can register the ServiceDesk Plus application.

To register ServiceDesk Plus,

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the License link available at the right top of the application. The License window is opened.
3. Click the Browse button to locate the license file sent to you when you purchased the application.
4. From the file chooser window, select the license file and click Open.
5. Click Upgrade.

The registration of the ServiceDesk Plus application is complete. You can continue using the application.
Contacting ZOHO Corporation

- ZOHO Corporation Headquarters
- Sales
- Technical Support

ZOHO Corporation Headquarters

<table>
<thead>
<tr>
<th>Web site</th>
<th><a href="http://www.manageengine.com">www.manageengine.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>ZOHO Corporation Headquarters</td>
<td>ZOHO Corporation (formerly AdventNet Inc.) 4900 Hopyard Rd., Suite 310 Pleasanton, CA 94588, USA Phone: +1-925-924-9500 Fax: +1-925-924-9600</td>
</tr>
<tr>
<td>ZOHO Corporation Development Center</td>
<td>ZOHO Corporation Development Centre (I) Private Limited 11 Sarathy Nagar, Vijayanagar, Velachery, Chennai 600 042 INDIA Phone: +91-44-22431115 (10 lines) Fax: +91-44-22435327</td>
</tr>
</tbody>
</table>

Sales

For purchasing ManageEngine ServiceDesk Plus from any part of the world, fill out the Sales Request Form. A sales person will contact you shortly. You can also send us e-mail at sales@manageengine.com

You can also call the ZOHO Corporation headquarters at the following numbers:
Phone: +1-925-924-9500
Fax: +1-925-924-9600 and request for Sales

Technical Support

One of the value propositions of ZOHO Corporation to its customers is excellent support. During the evaluation phase, the support program is extended to users free of charge.

For support, please mail to servicedeskplus-support@manageengine.com

Alternatively, you can submit your feedback from the ServiceDesk Plus product by clicking the Feedback link at the top right corner just above the header tabs after logging in to the application. Your feedback will be sent to the ServiceDesk Plus Support Team and they will get in touch with you. Do not forget to provide your e-mail ID or your contact information for the team to get in touch with you.
Home page

The home page of ServiceDesk Plus has various useful information displayed that enables an administrator, a technician, or a requester to take necessary action.

The user you are logged in as is the **Administrator** and the following are available in home page,

1. My View
2. Service Catalog
3. Scheduler
4. Quick Create - New Incident
5. Search
6. Recent Items
7. New Incident drop down
8. Service Catalog drop down
9. Quick Actions drop down
10. Feedback
11. Personalize

If you are on a Trail version, then the following links will appear along with the above,

1. License Expiry Alert
2. Get Quote
My View
The **My View** tab displays the following information,
- My Approvals
- My Summary
- My Tasks
- Announcements

My Approvals
This block lists all the approval actions to be taken by you for a service request, incident request or purchase order. To approve or reject, click on **Take Actions** button. The approval for service requests and purchase orders are listed only if you have the approval permission.

My Summary
This block displays the summary of requests, problem and changes assigned to the logged in technician.
- **Request Overdue** - Number of requests assigned to the logged in technician that are overdue.
- **Requests Due Today** - Number of requests assigned to the logged in technician that are due for that day.
- **Pending Requests** - Number of pending requests that are assigned to him/her.
- **Approved Changes** - Number of changes assigned to the logged in technician that are approved.
- **Unapproved Changes** - Number of changes assigned to the logged in technician that are unapproved.
- **Pending Problems** - Number of Open problems assigned to the logged in technician.
- **Unassigned Problems** - Number of problems that are unassigned to technicians.

Service Catalog
If you have customized the Service Catalog in the product, then the Service Catalog tab and Service Catalog drop down appears. The Service Catalog tab consists of the configured service items that are grouped and classified according to the service categories. From the service catalog tab, you can raise a service request instantly. Click here to know how to configure a Service Item.
Scheduler
Scheduler gives a calendar view of the number of open requests, problems, changes, task and reminder for a technician in a given month. Using the Technician Availability Chart, the availability of a technician on a given date can be viewed, based on which requests can be assigned to other technicians (backup technician).

- My Scheduler
- Technician Availability Chart

Quick Create - New Incident
Quick Create - New Incident is an instant mode to create new incident when you are on a call with a requester. You can either conduct a search for the existing requesters using the icon or enter the requesters name in the field provided. Next, all you need to do is enter Request Title and Description. If you require additional details such as category, priority or assign a technician, click Add More Details >> link. This takes you to the New Incident form. This section is available only when the ‘Quick Create Settings’ is enabled in the Self-Service Portal.

Search
You can search for Requests, Archived Requests, Problem, Change, Assets, Workstation, Software, Purchase, Contract, Solutions, System Log and Requester from the home page. You can further enhance the request search by drilling it down to sub modules. You can search for notes, worklog, resolution and request ID. Conducting a search using the request ID takes you to the request details page of the specified request ID.
Recent Item
While using ManageEngine ServiceDesk Plus, the application tracks your last viewed items and lists them in the Recent Items block. The items can comprise of requests, problems, changes, solution, purchase, contract and workstations that was last viewed. It lists the last 10 items with the latest viewed item appearing on the top of the list. Clicking on the item takes you directly to the item's details.

New Incident drop down
The incident templates made available to you are grouped based on the Service Category and listed in the New Incident drop down. Click on New Incident link to access the default incident template.

Service Catalog drop down
The service categories and the service items available to you are listed in the Service Catalog drop down. The list is organized to view the service items under each service category. All you need to do is browse for the available services in the catalog and submit a request.

Quick Actions drop down
Quick Actions functions as a instant navigator to the add new form, scheduler, tasks, reminders, asset groups, scanning inventories and archived requests.

Feedback
Send a feedback immediately to our support team from the application. Click here to know how to go about sending it.
Personalize
You can change the language and time zone displayed in the application, customize your signature, and change your password from the Personalize link. Click here to view more.

License Expiry Alert
The license expiry alert shows the number of days for the existing license to get expired. In addition, it also provides the date within which the license should be renewed and the contact information of the support team.

Get Quote
The Get Quote link is visible to users using the Demo or Trial version. Clicking on the Get Quote link navigates the page to the Get Quote form in the website. Entering the specifications in the form will help us to provide you with the exact details of your requirement. Click Submit on specifying the details and our sales team will contact you on receiving the e-mail.
My Tasks

My Tasks on the right hand side of the home page -> under my view tab-> next to the my requests summary block, shows all the Tasks assigned to you. These tasks could be added by you as a personal reminder of the due by tasks. Or it can be the tasks assigned to you by other technicians.

You can also assign tasks to other technicians through this option. On adding the tasks to other technicians, the added tasks will be listed in their home page under the My Tasks block and the technicians will be able to view the tasks immediately on logging in to ServiceDesk Plus application.

All your tasks including the requests assigned on your name can be added to this list as My Tasks, but you cannot maintain the log for the requests entered under my tasks list.

To add My Tasks,

From the ServiceDesk Plus login home page, you have My Tasks block on the right hand side of the home page. Click the Add New button at the down left corner of the My Tasks block. This opens the Tasks page. Alternatively, you can also add tasks by clicking )-> Add Task under the Task block.

1. Specify the Title of the task in the given text field. This is a mandatory field.
2. Specify relevant information about the tasks in the Description field.
3. Select the Scheduled Start Time from the calendar button. Also select the Scheduled End Time for the task from the calendar button.
4. The Actual Start Time and End Time of the task will be entered by the technician doing (owning) the task.
5. The actual start time and end time is the real time schedule of the task. The scheduled start time and end time specified by the task owner is a tentative time schedule.
6. Select the Owner (technician) of the task from the combo box.
7. Specify the Status of the task. By default the Status of the task is Open.
8. Specify any relevant comment about the task in the Comments field.
9. If you wish to be reminded of the task previously then select the Email me before option and select the number of days from the combo box. This option will be selected based on the scheduled start time.
10. Save the values. You can see the added tasks getting listed under My Tasks block in the home page as shown below. The tasks will be listed under the tasks tab in ascending order based on the scheduled start time.
To view the details of the tasks click the title of the task to be viewed. This opens the Tasks page and you can view the details.

When you have completed the task, you can just close the task by selecting the radio button beside the task. Alternatively,

1. Click the Show All link on the right hand side of the block. This opens the Show all Tasks page.
2. Select the tasks which has been completed by enabling the check box.
3. Click the Close button to close the task. You can see the tasks moved under closed status and in the home page you can see the tasks deleted from the My task block.

To view all the added Tasks,

To view all the tasks added to the list, click the >Show All button on the down right hand side of the My Tasks block. This opens the Show all Tasks page as shown below,

![Show all Tasks](image)

You can also add new task through this page by clicking on the New Task button available on the top right corner of the page.

To view the tasks based on the status-> click the Filter Showing combo box and select the task status from the list. You can see the tasks getting listed based on the selected status.

Alternatively, you can view All tasks and tasks assigned to you in Quick Actions under the Task block.

To Delete Tasks

1. Click the >Show All button on the down right hand side of the My Tasks block. This opens the Show all Tasks page as shown above.
2. Click the Delete button. A confirmation message pops up asking you confirm on the delete process.
3. Click Yes to proceed. You can see the task deleted from the Show all Tasks list as well as from the home page.
Publishing Announcements

ServiceDesk Plus allows you to publish announcements company wide or just to the technicians group. The announcement board is available in the login home page of the my view tab, below the My Summary block. Any technician can add, edit, and delete announcements.

The recent announcements will be displayed in the box. To view all the announcements (even completed ones), click the Show All button. This will display the list of all announcements added till date.

To view an announcement, click the Announcement Title to open the complete announcement details in a pop-up. If there are more than one announcements, then you will notice a Previous and Next button in the pop-up. Using this you can navigate through the announcements list and view all the announcements without closing the pop-up window.

Add a New Announcement

1. Login to ServiceDesk Plus using the administrator / technician user name and password.
2. In the login home page, if you have permissions to add an announcement, you will notice the Add New button in the announcements box as shown above. Click the button. The Add New Announcement dialog pops up.
3. Enter the Announcement Title. This can be a short statement that describes the announcement. This is mandatory field.
4. Type the Announcement Content in the text box provided for the same.
5. Select the From date and To date using the calendar icon beside the respective fields.
6. By default, the announcement is available to technicians. If you wish to publish the announcement in requester login, enable Show to Requester check box. If you have configured User Groups, then you can publish the announcement to requesters under the user group. Select the User Group from the available list, select >> button to move the list to the selected user group. The announcement is displayed in the home page with a lock beside it. Click here to know more on configuring User Groups.
7. If you wish to Send this announcement as mail then select the corresponding option by enabling the check box.
8. Click Save. At any point of time, you do not wish to add the announcement, click Cancel.

The announcement will be added and the pop-up will display the announcement details as entered by you. The announcement title will be displayed in the login home in bold text in the announcement box with a new icon beside it.

Edit an Announcement

1. In the login home page, click the title of the announcement that you wish to edit. The announcement details are displayed in a View Announcement pop-up. If you have permissions to edit / delete the announcements, you will see an Edit and Delete button.
2. Click Edit button.
3. You can change all the fields of the announcement in the Edit Announcement form.
4. Click Save. At any point of time, you do not wish to edit the announcement, click Cancel. All the changes made in the announcement will be saved.

Delete an Announcement
1. In the login home page, click the title of the announcement that you wish to delete. The announcement details are displayed in a View Announcement pop-up. If you have permissions to edit / delete the announcements, you will see an Edit and Delete button.
2. Click Delete button. A confirmation dialog pops up.
3. Click OK to delete, and Cancel to retain the announcement.

Alternatively,
1. In the login home page, click Show All button in the Announcements box.
2. In the announcements list view, select check boxes beside the announcement Title which you wish to delete.
3. Click Delete. A confirmation dialog pops up.
4. Click OK to delete, and Cancel to retain the announcements.

**Note:** If the announcements are open for everyone to view and not restricted to the technicians alone, then in the requester login, the requesters will be able to view the announcements by clicking the title of the announcements. Only announcements that have a completion time beyond the current date will be visible for the requesters.
Scheduler

ServiceDesk Plus gives the provision of a schedule calendar showing the number of open requests, problems, changes, task and reminder for a technician in a given month. The availability of a technician can be viewed from the technician availability chart, depending on which, the task, requests, problems and change can be re-assigned to other technicians.

The following are available under Scheduler,

- My Schedule
- Technician Availability Chart
- Mark Unavailability
My Schedule

My Schedule is a calendar view displaying the number of open requests, problems, changes, tasks and reminders assigned to a technician for a given month. The calendar also shows the availability of the technician for a specific day in a given month.

**Note:** The My Schedule calendar can be viewed by All Technicians.

- The *administrator* has the ability to view the number of open requests/ tasks/ problems / changes and availability of *All Technicians* in All Site.
- The *Site Admin* has the privilege to view the number of open requests/tasks/problems/changes and availability of technicians only in his site.
- The Technician can view only his open requests/ tasks/ problems/ changes and availability.

To view the My Schedule calendar,

1. Login to ServiceDesk Plus application using your username and password.
2. In the home page, click **Scheduler** tab beside My View tab (OR) Click **Quick Actions** -> **My Schedule** under the schedule block. This opens the **Schedule Calendar**. By default, the calendar shows the number of open requests, problems, changes, tasks and reminders assigned to you as shown below,

**Schedule Calendar**

- The Schedule Calendar shows the current month and year along with the navigation buttons on the left hand side of the page.
- The **Navigation buttons** helps to navigate to the previous and the forth coming months.
- The current date is marked in separate border.
• **For an administrator** all the sites should be listed along with its corresponding groups and technicians loaded in the drop down field. **For a Site Admin**, the site for which he is the administrator gets listed in the drop down box along with its corresponding groups and technicians. **Technician** can view only his open requests, problems, changes, tasks and reminders.

• The **number of Open Requests, problems, changes and task** assigned to the technicians for a specific date in a given month can be viewed.

• The unavailability of the technician is indicated in a different colour.

• The company holidays and weekends is marked in a separate.

Using My Schedule, you can perform actions such as,

- Mark Leave
- Edit/Cancel Leave
- Add Task
- Add Reminders
- Viewing requests/task/problems/change
- Re-assigning requests/task/problem/change

**Mark Leave**

It is essential to keep a track of technicians on leave so that work is not assigned to them for that particular day. To mark leave,

1. From My Schedule, hover over the day on which you want to mark leave. The list of icons gets displayed on the right hand side below the date. Click **Mark Leave** icon. This opens the **Mark Unavailability** pop-up window as shown below,

![Mark Unavailability](image)

2. The name of the **Technician** is displayed in non-editable text.
3. Select the **Leave Type** from the combo box. For ex. Casual Leave, Sick Leave etc.
4. Select the **From** and **To** date of leave from the calendar icon.
5. Specify any relevant **Comments** regarding the leave.
6. Click **Save**. The technicians holiday is indicated in a different colour.
Leave can be marked to other technicians using Technician Availability Chart. You can configure your leave by clicking **Quick Actions** -> **Mark Unavailability** under the scheduler block. This opens the Mark Unavailability pop up window. Follow the above steps to mark leave.

**Edit/Cancel Leave**
If you wish to edit or cancel a leave then,
1. From the schedule calendar, hover over on the day the technician is on leave. Click on the [Edit leave](#) icon on the right hand side below the date. This opens the **Mark Unavailability** pop-up window.
2. Click **Save** on making the changes.
3. If you wish to Cancel the leave then click **Cancel Leave**. The leave gets cancelled. **Note:** For continuous holidays, the entire series gets cancelled.

**Add Task**
You can also add, view and re-assign the tasks to other technicians. The tasks can be added to technicians for the current day and the forth coming days. To add task refer **Add Tasks.**

**Viewing Requests/Tasks/Problems/Changes**
The number open requests, tasks, problems and changes assigned to you gets listed in the calendar, by default. To view the details of the request/tasks/problem/change,
1. Click the link corresponding to the requests/task/problems/changes to be viewed for a specific day. The details of requests/tasks/problems/changes gets listed for the particular day as shown below,

![Requests Table]

**Re-assigning Requests/ Tasks/ Problems/ Changes**
The requests, tasks, problems or changes assigned to a particular technician can be re-assigned to other technicians. For ex. If requests are assigned to a technician for a specific day and if the technician is unavailable on that day, then the request can be re-assigned to other technicians. Similarly tasks, problems and changes can be re-assigned.

To re-assign requests/tasks/problems/changes,
1. Click the requests/tasks/problems/changes on the day, of the corresponding technician you want to re-assign from the Schedule Calendar. This lists out all the open request for that day.
2. Enable the check box adjacent to the request which you want to re-assign.
3. Select the technician from the combo box to whom the task is re-assigned. Click **Re-assign** button. The task is re-assigned to the technician.

**Reminders**
The reminder option is available only for the logged in technician, that is, if the logged in technician is an administrator then the reminders of other technicians cannot be viewed by him. To know more on reminders refer Reminders.
Technician Availability Chart

The Technician Availability Chart displays the list of technicians, along with the number of open requests assigned to them and their availability for a given month. The chart is a matrix view, indicating the availability of the technician for a specific day. It allows technicians to apply for leave, edit/cancel leave and even configure backup technicians when a technician is unavailable.

**Note:** The Technician Availability Chart is available only for technicians with Admin privileges such as an administrator and Site Admin.
- The **administrator** has the ability to view the availability of technicians and the number of open requests assigned to All Technicians in All Sites.
- The **Site Admin** has the privilege to view the availability of technicians and the number of open requests of technicians only in his site.

To view the Technician Availability Chart,
1. Click on Scheduler tab in the Home page. This opens the Schedule Calendar displaying the number of open requests, problems, changes, task and reminders assigned to the technician who has logged in.
2. Click on the Tech Availability Chart link on the right hand side of the page.
3. You can also choose Tech Availability Chart from the Quick Actions link under the header pane. This opens the Technician Availability Chart.

**Technician Availability Chart:**
- The Technician Availability Chart shows the current month and year.
- The Navigation buttons on the left top help to navigate to the previous and the forth coming months.
- The current date in the calendar is marked in blue border.
- By default, for an administrator, the list of all the technicians gets displayed, irrespective of the Site and Group. Using the "Site", "Group" and "Technician" combo boxes, the administrator can view the availability of a particular technician in a particular Site.
- For a Site Admin, the list of all technicians in his/her site is displayed irrespective of Groups. The number of Open Requests assigned to the technicians for a specific date is displayed in the Chart.
- Unavailability of a technician is indicated in pink colour.
- Company holidays and weekends are marked in other different colours.
Using the Technician Availability Chart, you can perform actions such as,
- Marking Leave
- Configuring Backup Technician
- Re-assigning Requests
- Editing/Cancelling Leave
- Viewing Request
- Backup Tech Chart

Mark Leave

The unavailability of a technician can be marked using the Technician Availability Chart. This is essential so that requests that are assigned to that particular technician on that day can be re-assigned to another technician.

To mark leave,
1. From the Technician Availability Chart, click on the day corresponding to the technician on leave. This opens the Mark Unavailability pop-up window as shown below,

   ![Mark Unavailability](image)

   - The name of the Technician is displayed in a non-editable text format.
   - Select the Leave Type (Casual Leave, Sick Leave and so on) from the combo box.
   - Select the From and To date of leave by invoking the calendar icon.
   - Specify any relevant Comments regarding the leave in the Comments text box.
   - Click Save. The technicians holiday will be indicated in a different colour.

Leave can also be marked by clicking Quick Actions -> Mark Unavailability under the Scheduler block. This opens the Mark Unavailability pop up window. Follow the above steps to mark leave.

Notifications rules can be configured to keep other technicians informed about the leave of absence of a technician. Once the technician applies leave, selected technicians or the group in which the technician is present will be notified about the leave when it is added, modified or cancelled.
Configure Backup Technician:

To configure a Backup Technician on the day of unavailability of a technician,

1. Click on the **name of the technician** who will be on leave in the Technician Availability Chart. This opens the **Technician Calendar** for that month with the technician's days of unavailability indicated in a different shade.

2. Click on **Backup Tech** link displayed in a different colour. This opens **Backup Technician Assignment** screen.

3. Choose one of the 3 options provided to handle the upcoming requests assigned to the unavailable technician.
   - **Move requests to unassigned state** - The requests assigned to the technician on leave are moved to an unassigned state, which means, it is assigned to no technician. This is done so that the unassigned requests can be re-assigned to another available technician by the administrator or help desk coordinator.
   - **Assign to following technician** - This option allows you to configure a Backup Technician throughout the absence of a particular technician. On choosing this option, one can select the **Backup Tech** from the list of technicians displayed in the drop down box. If Sites are configured, this drop down box displays only the names of the technician who are associated with the same site as that of the technician who is on leave.
   - **Don’t take any action on the requests** - This is the default option visible in the Backup Technician Assignment screen. In this case, no action is taken on the requests that is assigned to the technician. The request is assigned to the technician even if he is on leave.

4. Click on **Save** after configuring the Backup Tech.

5. Once the Backup Tech is configured, an icon appears in the calendar indicating that the backup technician has been configured. By hovering the mouse pointer over the icon, a description box appears (as shown below) indicating the status of the backup technician configuration.
If notification rules are configured, once the backup technician is configured, notification e-mails will be sent to selected technicians or the group in which the unavailable technician is present.

**Note:** Backup Technicians can be configured only up to one level. This means, if the backup technician is on leave, another backup technician cannot be configured.

All information relating to unavailability of a technician, including the period of leave and backup technicians (if configured) are displayed in the Backup Tech Chart.

**Re-Assigning Requests:**

Requests assigned to a technician can be re-assigned to another technician through the Technician Calendar.

To re-assign requests to another technician,

1. Click on the number of requests and this opens the Backup Technician Assignment screen along with the list of requests in the second half of the screen.
2. Select the requests that need to be re-assigned by clicking on the check boxes.
3. Select the Technician from the Technician drop down box.
4. Click on Re-Assign button to assign the requests to another technician.
5. Click on **Calendar View** to go back to the Technician Calendar.

6. You can also re-assign requests by clicking on the requests in the Technician Availability Chart and selecting **View Details** from the pop-up. Follow the above steps to re-assign the requests.

**Note:** Re-assigning requests is different from assigning requests through Backup Tech. Although Backup Tech can be configured only up to one level, in the absence of the backup technician, the pending requests can be assigned to another technician through this feature.

Click the name of the technician to have a detailed view about the number of requests, problems, changes and tasks assigned to the particular technician in My Schedule.

**Editing/Cancelling Leave**

To edit leave,

1. Click on the leave of the technician that needs to be edited from the Technician Availability Chart. This opens the **Mark Unavailability** pop-up window.

2. Make necessary changes (Leave Type or Leave Period).

3. Click **Save**.
To cancel leave,

1. Click on the leave of the technician that needs to be cancelled from the Technician Availability Chart. This opens the **Mark Unavailability** pop-up window.
2. Click on **Cancel Leave** button. The leave gets cancelled.

**Note:** If a continuous period of leave is applied, then the entire period will be cancelled.

**Viewing Requests**

To view the requests assigned to a technician for a particular day,

1. Click on requests on the day of absence of the corresponding technician from the Technician Availability Chart.
2. From the drop down box, select **View Details**. This opens the list of all open request due for that day.
3. Click on the request you wish to see and the request information is displayed in the same screen.

**Backup Tech Chart:**

Backup Technician Chart displays information such as absence of leave of a technician, name of the technician and the backup technician configured through the period. This chart helps to keep a check on the backup technicians whenever a technician applies for leave. To view the Backup Technician Chart, click on the **Backup Tech Chart** link next to the My Schedule link.

Using the **Navigation buttons** at the left top of the screen one can navigate to the previous and the forth coming months to get a broader idea about the technicians on leave, their period of absence and the backup technicians configured for that period.
Reminders

ManageEngine ServiceDesk Plus provides you with the option of tracking your tasks everyday. The tasks that you add to the My Reminders list act as substitute for your sticky notes or post-it notes which you would use to remember your tasks for the day.

Add Reminders

To add new reminders,

1. Log in to the ServiceDesk Plus application using your user name and password.

2. Click Quick Actions just below the header tabs -> Add New under the Reminders block. The Reminders form pops up. Alternatively, you can add a new reminder by clicking Quick Actions -> My Reminder(s). The My Reminder(s) form pops up as shown below,

![My Reminder(s) Form]

Click +Add New link at the bottom of the my reminders form. This opens Reminders page.

3. Enter the task summary in the text field provided.

4. Select the Date & Time for the reminder. The date field is set to the today's date and the time is set by default as 11:00 AM. Change the date and time settings. To change the date, click the calendar icon beside the date field and choose the date of your choice. From the time combo box, choose the time at which the task is scheduled. The values in the combo box are available in a gap of 5 min time interval.

5. Click Add. The new reminder is added and is listed along with the already existing reminders in the ascending order based on date and time.

Changing Status

When you have completed a reminder, you can just strike the reminder to indicate that it is completed by selecting the radio button beside the reminder.

1. From the My Reminders form, click the status radio button to change the task status from incomplete to Completed. The task is struck through to indicate that it is completed.

ZOHO Corp.
2. Alternatively, you can also change the task state by executing the following steps:

1. Click **Show all** at the bottom right of the **My Reminders** pop up window. The **All Reminders** window opens as shown below.

2. Select the check boxes beside the **Reminder Summary** for which you wish to change the state.

3. Select the state from the **Change Reminder State To** combo box, select the reminder state to **Completed**.

4. Click **Change** button to change the status of the task. To indicate the change the task would be striked of.

### Deleting Reminders

The reminders can be deleted by,

1. From the **My Reminders** form, click **Delete this reminder** radio button available beside the status radio button. The reminder gets deleted from the list.

2. Alternatively, from **All Reminders** window, enable the check box beside the Reminder summary to be deleted. Click **Delete**. A pop up window confirming the delete operation appears. Click **OK** to proceed. The reminder gets deleted from the list.

The advantage of moving the reminder to completed state instead of deleting it completely is that, you can revert the state of the reminder to **Open** again and edit its attributes. But once you delete the reminder, it is completely removed from the application and cannot be retrieved.

**Note:** The **Reminders** option is available under **Quick Actions** link for requesters accessing ServiceDesk Plus through Self-Service Portal, provided the option is enabled.
License Expiry Alert

The License Expiry Alert shows the number of days for the existing license (or the trial version) to expire. The message is displayed as shown in the image below,

If you wish to renew the license, then a renewal request must be sent to our support team, and they, in turn, will provide you with the license file. To send a renewal request, click the Renew button. The page navigates to a Renewal Form where the License ID and Customer ID are pre-populated. Enter the Email Address and your Company Name, also specify the Number of Technicians and Nodes license you wish to avail, and enable the add-ons if required. Enter relevant comments in the provided field and click Submit.

An email notification is sent to our support team, and they in turn will provide you with the license file. Once the license file is obtained, click the License link to install the license file. To know more on applying the license file, click Registering ServiceDesk Plus.
Dashboard

The Dashboard is a visual display of real-time information, consolidated and arranged in a single view so that it can be easily monitored. The Dashboard displays various statistical data related to number of requests, changes, problems, assets, software, POs and contracts based on various criteria.

**Note:** Information displayed on the Dashboard largely depends on the site and roles associated to the technician.

Data shown in the Dashboard is restricted to the site the technician is associated to. When a technician is associated to multiple sites, then a drop down option with sites he is associated to appears. By choosing the site, information and data associated with that site are displayed to the technician.

Similarly, data displayed on the dashboard is also restricted based on the roles associated to the technician.

Dashboards contains the following sub tabs:

1. Helpdesk
2. Problem & Change
3. Assets

**Helpdesk:**

Under the Helpdesk tab, 8 small widgets are available to provide request based information at one glance.

- The first widget displays a matrix chart. It shows the total number of requests in Open, On Hold and OverDue statuses. This information can be viewed based on the criteria provided in the drop down box. Number of requests can be viewed based on Technician, Category, Level, Priority and Mode. Clicking on the numbers in the chart opens the corresponding list of requests.
- The second widget displays a pie chart. It shows the number of open requests that can be viewed based on Level, Mode, Priority and Category. By clicking on the graph, you can view the requests corresponding to each shaded criteria.
- The third widget displays a bar graph. It shows the number of SLA violated requests and requests approaching SLA violation in 120 minutes. A drop down box provided allows you to view the number of SLA violated requests based on Priority, Group, Level, Technician and Category. By clicking on each bar, you can view the SLA violated requests corresponding to the selected criteria.
- The next 3 are angular charts that show the number of unassigned and open requests, number of SLA violated open requests, and number of requests nearing SLA violation in the
next 60, 120 and 180 minutes. Clicking on the number of requests present in the bottom of the widget opens the corresponding list of requests for viewing.

• The last 2 bar graphs show the number of requests that were created and closed in the last 20 days. Clicking on the bars on the graph, opens the corresponding requests for view.

Problem & Change:
Technicians who have permission to view the Problem and Change module can also view the Problem & Change widgets in the Dashboard.

• The first widget in the dashboard is a pie chart that shows all the scheduled upcoming changes that are to be rolled out. The changes that are scheduled to be rolled out in the following time period (This week, Next week, This month and so on) by selecting the time period from the first drop down box. The changes can also be viewed based on criteria such as Change Type, Priority, Urgency and Impact.

• The second widget shows a list of Approved changes that are scheduled to be rolled out. The list can be viewed based on the time period during which the changes are scheduled to be rolled out (This week, Next week, This month and so on). The list indicates the Title of the change along with the Change Type. Clicking on the title of the change opens a pop-up with the change details. By clicking on the title of the change in the pop-up, the complete change details page can be viewed.

• The third widget shows a list of unapproved changes along with the change type. Clicking on the title of the change opens a pop-up with the change details. By clicking on the title of the change in the pop-up, the complete change details page can be viewed.
• The last widget is a pie chart displaying the problems. The chart can be customized to be displayed based on Priority, Urgency and Impact.

Assets:
Technicians who have permission to view Asset module can also view the Asset Dashboard and monitor the statistical data displayed on it. The widgets in the Asset Dashboard give complete summary of all physical assets (IT and non-IT), software assets, workstations and POs & contracts.

• The first widget shows a summary of all physical assets in the organization including IT and non-IT assets. By default only number of Workstations, Printers, Routers, Servers and Others are displayed. By clicking on "View All", the Others category is expanded and other IT and non-IT assets such as Access points, Switches are displayed. The number of workstations failed to be scanned is also indicated in this widget along with the option to Troubleshoot the failure operation. By clicking on the number displayed next to the assets, one can view the list of those assets under the Asset module.

• The second widget displays a bar graph indicating the number of workstations depending on various criteria. These criteria can be selected by clicking on the red drop down arrow at the top of the widget. By clicking on "View All", a pop-up showing the extended graph is displayed. Set of graph that is not included in the original widget is displayed in this pop-up. Mouse hovering over each bar displays the number of workstations corresponding to the selected criteria. By clicking on the bar, the list of workstations is displayed under the Asset module.

• The third widget shows software related information in a combination of pie charts and bar graphs. By clicking on the red drop-down arrow below the widget title, one can select the criteria based on which the graph should be displayed. By clicking on "View All", a pop-up showing the extended graph is displayed. Set of graph that is not included in the original widget is displayed in this pop-up. Mouse hovering over each bar/pie region displays the number of software corresponding to the selected criteria. By clicking on the bar/pie region, the list of software is displayed under the Asset module.
The fourth widget shows a summary of Purchase Orders (POs) and Contracts. By selecting Purchase Order summary from the drop down, one can view the overdue POs, POs due in the next 7 days and the POs due in the next 30 days. By Selecting Contracts summary, one can view the contracts that have expired in the last 30 days, contracts expiring in the next 7 days and contracts expiring in the next 30 days.
Request

ManageEngine ServiceDesk Plus request module helps you to manage the services provided by your IT services team. The request module tracks all the outstanding and overdue requests that need immediate attention, thus improves the response time and resolution time of your IT services team. The requests in the request module are split into Incident Requests and Service Requests.

- **Incident Requests** are requests that denote the failure or degradation of an IT service. For example, Unable to print, unable to fetch mails and so on.
- **Service Requests** on the other hand are requests raised by the user for support, delivery, information, advice or documentation. Say, Installing software, move from one place to another, reset password and so on. A Service Request is not an Incident.

Apart from this, ServiceDesk Plus allows you to add relevant notes pertaining to the request that is being handled. The notes may contain any information such as, the exact scenario of the request or how the issue was resolved. Also, every action performed on the request in the ServiceDesk Plus application is stored in the Request History.

Clicking the Requests tab on the header pane takes you to the request module. Here the term request denotes any service (both incident requests and service requests) that is requested by a user from the internal IT services team. The requests is submitted to the system via mail or a web-based form. Sometimes, the requests can also be placed through a phone call during which, the help desk agent has to record the details of the phone call in the web-based form, and assign priority and technician based on the urgency of the request. The various actions that one can perform in the request module are explained in the respective sections.

To ease the process of tracking the requests posted by individual requesters, a Self Service Portal has been provided. The Self Service Portal is used by the individual requesters to track the status of their requests and to look up solutions from the online knowledge base. To access the self-service portal, the requesters need to log in to the ServiceDesk Plus application using their respective user name and password. For more details on self-service portal, refer to Self Service Portal topic.
Request List View

Request List View page organizes and maintains the list of all the issues raised into ServiceDesk Plus. You have the facility to,

- customize the page to display the requests
- options to view the requests (incident and service requests) based on filters
- view archived requests
- customize columns in the list view
- set the number of requests to be displayed per page and
- perform major operations on request from the list view

On clicking the Request tab in the header pane, the page redirects to the request list view page displaying all requests in the Open status by default. The term 'All Requests' denotes the Incident Requests and the Service Requests.

1. **Archived Requests**: Move all the closed/resolved requests from the active state to an archive state so that accumulation of millions of active requests can be avoided and the helpdesk performance increase. If required, export the requests as Html files, pdf files, xls file or csv file. To know more on configuring a schedule data archiving click here.

2. **Refresh this page**: Set time frame to auto refresh the request list view page from every 3 minutes to every 30 minutes.

3. **Custom and Manage View**:

   - create filters to customize and organize your request list view. The filters created can be made public or private.

   - View, edit and delete your customized view. Know more

4. **Request based on Filter**; Classify your request list view and view specific set of requests under three categories namely, My Group, Requests and My Views. Also, restrict the list view to display incident requests, service requests or both incident and service request. Know more

5. **Set the number of requests per page and navigation buttons**: View the entire set of requests available in ServiceDesk Plus application by settings the number of requests to be viewed per page. Navigate through the pages using the next and previous navigation buttons.

6. **New Incident**: Create new incidents on specifying the detail information of the incident such as, request type, priority, urgency, group, category, sub category and items.

7. **Search Requests**: Search for requests instantly on entering the Request ID in the Go to field. Also, you can conduct a search for a specific requester, subject, group and so on. Know More

8. **Bulk Operation**:

   - **Edit Requests**: Bulk edit the requests with similar information.

   - **Delete Requests**: Delete bulk requests.

   - **Pick up**: Pick up bulk requests.
• **Close Requests**: Close bulk requests on completion.
• **Merge Requests**: Merge two or more similar requests.
• **Link Requests**: Link related requests to one another and set some references between them.
• **Assign Requests**: Assign bulk requests to the selected technician.
Creating a New Incident

When system users detect a failure of an asset/resource or a degradation of service, then they can send an incident request to the system administration team using the New Request form.

There are various modes of placing a request to the system administration team. Some of the most common modes are,

- Requesters **call** up the help desk agent and report an issue or explain the nature of their request. The help desk agent will then manually feed in the details into the application.
- Requesters **log into** the **Self Service Portal** and submit their requests, or
- Requesters **email** the request to the help desk team. The email is automatically converted to a new request in the application.

Apart from the above three modes, there are various other modes by which an incident request is created. For more information on adding additional modes, refer to Configuring Mode section.

Creating incident requests from the application

A typical example for technicians to create an incident request from the application would be when a technician is on a call with the requester. The technician fills in the necessary details for future references.

There are three ways in which the new incident request form can be accessed in the application,

1. **New Incident drop down**
2. **Quick Create - New Incident**
3. **Request tab**

1. **New Incident drop down**

The Incident Templates configured in the application are grouped according to the service category and displayed in the New Incident drop down. The New Incident drop down is an instant means to access the request form.

All you need to do is browse through the available incident templates and select the one relevant to the issue, and raise a new incident. The Incident Templates are configured in the Admin tab.

Click **New Incident** link to access the default incident template. You can also select the Incident Templates in the new request form accessed from the Request tab.
2. Quick Create - New Incident

Quick Create - New Incident is an instant mode to create new incidents when you are on a call with a requester or when you are loaded with a lot of work. This section is available only when the 'Quick Create Settings' is enabled in the Self-Service Portal.

In the Quick Create - New Incident block, you can either conduct a search for the existing requesters using the icon or enter the requesters name in the field provided. Next, you need to enter Request Title and Description. Click Save. The incident is saved and the request details page is displayed.

If you require additional details such as category, priority or assign a technician, click Add More Details >> link. This takes you to the New Incident form.

3. Request Tab

To create a new request from the request tab,

1. Click Requests tab in the header pane.
2. From the Request list view page, click New Incident button. By default, the 'Default Incident Template' form is displayed. From this form, you can select an incident template from the Change Template drop down.
3. In the default request form, select the Request Type from the combo box. Request Type denotes the type of request sent by the requester to the help desk team. You can configure Request Type in the Admin tab.
4. Select the Status of the request, the Mode of request submission, Level and Priority of the request from the drop down box.
5. Also, select the Impact, Impact Details and Urgency of the request from the corresponding drop down box.
6. In the Requester Details block, specify the Requesters Name, Contact Number, Job Title and Department of the requester.
7. If the issue persists in the requester's asset, then select the Asset from the drop down. If the issue is caused by a network resource such as a router or an access point, then click the icon and select the asset.
8. You can select the requester from the list of users configured in the application. Click requester lookup icon beside the requester name field. The Requester List window pops up.
To select a requester from the list, click the hyper-linked requester Name. The requester name and details associated with the requester are populated in the requester details block.

- If the requester list is huge, then click on the Alphabets at the top of the page to view only a selected group of requesters.
- Conduct an instant search for the requester by entering the search string in Search Requester List field and click Go.
- If you are aware of any requesters details such as name, login name, department, email and so on, then conduct a column-wise search using the search icon.
- In addition, add new requester directly by clicking the Add Requester button from the requester list page.
- Also, you have an option to edit the requester details directly from this page. Click the edit icon beside the requester name to perform the edit operation.

9. By default, if the location of the requester is configured in the application, then the same is populated in the Site field. In certain scenarios, the requester may raise a request from one site to a problem in another site. In this case, the site in which the issue persists should be selected.

10. On selecting the site, the groups corresponding to the site gets populated under the Group field. The request is routed to the particular group by selecting the Group name from the drop down.

11. On selecting the Group, technicians associated with the Group alone are listed in the Technician drop down list. Select a Technician to handle the request from the drop down.

12. Select the Service Category which is effected by the incident from the drop down.

13. Select the relevant category under which the request is classified from Category drop down box.

14. Also, select the relevant Sub-Category and Item from the drop down box.

15. If you wish to add a CC to the email loop, then select the Email Id(s) to Notify by clicking the icon. From the Requester List pop up window, enable the check box beside the requester name. Click Add Requester. Note: Please note that the email address should be configured for the selected requesters.

16. Specify the subject line to be displayed while sending the request in the Subject text field. The subject line is displayed as the request title and is a mandatory field.

17. Provide a detailed description with any other associated details relevant to the request in the Description text box.

18. To add any attachments relevant to the request, click the Attach file button in the Attachments block. The Attach File pops up as shown below,
1. Click the **Browse** button and select the file to be attached from the file chooser window and click the **Open** button.

2. Click the **Attach file** button. The selected file is listed below the **Attachments** heading. If you have more files to choose, follow steps 2 and 3 repeatedly till you have attached all the relevant files. Please ensure that the maximum size of the attachment is 10 MB. The attached documents is indicated with an attachment icon beside the title of the request in the request list view page.

18. While entering the request details, if you have a solution for the request, then the same can be entered in the Resolution field. The purpose of resolution field in the new request form is, when you are reported of a problem for which you are aware of the solution, then in this case, specify the solution in the resolution field, set the status as closed to close the request.

   To add resolution, click the button beside Resolution title in the new request form. Specify the solution in the resolution text field. The entered resolution can be viewed by clicking the Resolution tab while viewing the request.

19. If there are any additional fields configured for the new incident form, then enter the values for the fields. To know more on adding user defined fields in the incident form, refer Incident - Additional Fields.

20. Click the **Add request** button. The request is added to the existing list of requests and can be viewed from the request list view.
Raising Service Requests

Service Requests are requests raised by the user for support, delivery, information, advice or documentation, which is not related to a failure in the IT structure. There are various modes of placing a request to the system administration team. Some of the most common modes are,

- Requesters call up the help desk agent and requests for service, the help desk agent will then manually feed in the details into the application.
- Requesters log into the Self Service Portal and raise the service requests, or
- Requesters email the service request to the help desk team. The email is automatically converted to a new request in the application.

Apart from the above three modes, there are various other modes by which an service request is created. For more information on adding additional modes, refer to Configuring Mode section.

Raising a Service Request from the application

There are two ways from which the service request can be raised in the application,

1. Service Catalog drop down
2. Home tab -> Service Catalog

1. Service Catalog drop down

Similarly to the New Incident drop down, the Service Catalog drop down lists the service items configured in the application. The service items are grouped under a service category for easy reference and identification. From the list of service items available to you, browse and raise a service request.

2. Home Tab -> Service Catalog

Alternatively, you can also select a service from Home tab -> Service Catalog. The list is organized to view the service items under each service category. From this page, you can conduct a search for the desired service item using Search Service Catalog field.
To raise a service request,

1. Select the service item from the catalog. This takes you to the **New Service Request** form. The New Service Request form for end-user specific is customized by the Service Manager.

2. Select the parameters such as Status, Level, Mode, Priority, Category, Sub category and so on, that is available in the template.

3. To select a **Requester** from the list of users configured in the application, click requester **lookup** icon  beside the requester name field. The **Requester List** window pops up. Click the hyper-linked requester **Name**. The requester name and details associated with the requester are populated in the requester details block.

   - If the requester list is huge, then click on the **Alphabets** at the top of the page to view only a selected group of requesters.
   - Conduct an instant search for the requester by entering the search string in **Search Requester List** field and click **Go**.
   - If you are aware of any requesters details such as name, login name, department, email and so on, then conduct a column-wise search using the search icon  .
   - In addition, add new requester directly by clicking the **Add Requester** button from the requester list page.
   - Also, you have an option to edit the requester details directly from this page. Click the **edit** icon  beside the requester name to perform the edit operation.
4. By default, if the location of the requester is configured in the application, then the same is populated in the Site field. In certain scenarios, the requester may raise a request from one site to a problem in another site. In this case, the site in which the issue persists should be selected.

5. On selecting the site, the groups corresponding to the site gets populated under the Group field. The request is routed to the particular group by selecting the Group name from the drop down.

6. On selecting the Group, technicians associated with the Group alone are listed in the Technician drop down list. Select a Technician to handle the request from the drop down.

7. For a service request template, the subject line is already specified. You can change or modify the subject. The subject line is displayed as the request title and is a mandatory field.

8. Provide a detailed description with any other associated details relevant to the request in the Description text box.

9. To add any attachments relevant to the service request, click the Attach file button in the Attachments block. The Attach File pops up as shown below,

   ![Attach File Pop-up](image)

   1. Click the Browse button and select the file to be attached from the file chooser window and click the Open button.

   2. Click the Attach file button. The selected file is listed below the Attachments heading. If you have more files to choose, follow steps 2 and 3 repeatedly till you have attached all the relevant files. Please ensure that the maximum size of the attachment is 10 MB. The attached documents is indicated with an attachment icon beside the title of the request in the request list view page.

10. While entering the request details, if you have a solution for the service request, then the same can be entered in the Resolution field.

11. Click Add New Request button. The request details page is displayed from where you can perform further actions on the service request.

**NOTE**

Please note that the following operations cannot be performed on a service request - Merging requests, Linking requests, Duplicating requests, Associating Problems to a request and Associating Changes to a request.
Creating Custom Views

You can create your own customized page to display the requests using Custom View option. You can specify the criteria to filter the selected requests that have accumulated in your requests list view page. This helps you to sort & view requests of your priority and requirement. To create your own custom view,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane. This opens Requests list view page.
3. Click Create Custom View icon. This opens Add Custom View page as shown below,

   ![Add Custom View](image)

4. Specify the View Name in the given text field. This is a mandatory field.
5. The administrators can make their views as private view or public view. By default the view will be public but to make this view as private custom view then select Make this view as private custom view check box.
   
   By default the technician without administrator log-in permissions can create only private views. Hence the above shown 'Make this view as a private custom view' option will not be available for the technician log-in.

4. Specify the filter criteria by selecting the column and its matching criteria from the combo box. And select the matching data for the column by clicking the Choose button. Also select the AND or OR conditions by enabling either of the two radio buttons.
5. Click Add to Filter button to save the filter criteria details. The filter criteria details will be listed in the Filter Set block.
6. If you wish to add more filter conditions to this view then, select the required column, criteria & conditions of the filter.
7. Save the filter criteria details. To add another custom view click Save and Add New button.

Custom views will be listed in the Filter showing combo box in the Requests home page at the top below the title. On clicking the combo box the views marked as private will be listed under My View list and the public views will be listed under Requests list.
Manage Custom Views

You can view all your customized view using this option. You can also edit, delete, add new custom views using this option.

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane. This opens Requests list view page.
3. Click Manage Custom View icon. This opens Manage Custom View page with the list of all the created custom views.

<table>
<thead>
<tr>
<th>Custom Views</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New Custom View</td>
<td>Delete</td>
<td>Created By</td>
</tr>
<tr>
<td>My Hardware View</td>
<td>Administrator</td>
<td></td>
</tr>
<tr>
<td>My Network View</td>
<td>Administrator</td>
<td></td>
</tr>
</tbody>
</table>

Editing Custom Views,
1. Click the custom view title or click the edit icon. This opens Edit Custom View page.
2. Edit the details and save the changes.

Deleting Custom Views,
1. Select the custom views to be deleted by enabling the check box. The public views can be deleted only by the administrators (ie: Only the administrators can make their view public other technicians without admin permissions can only create a private view).
2. Click the Delete button to delete the views. A pop up window pops up to get your confirmation on the delete operation.
3. Click Yes to proceed. You can see the view deleted from the list.
Viewing a Request

To view a request available in the ServiceDesk Plus Request module,

1. Click the Requests tab in the header pane. The next page lists all the requests available in the ServiceDesk Plus application in the Open status. The term 'All Requests' denotes the Incident Requests and the Service Requests. The Unassigned and assigned requests that have not yet been viewed by the corresponding technician even once is in bold text, while the viewed requests is in regular font.

2. Click on the Title of the request that you want to view. This opens the View Request page. By default the page displays Request, Resolution, and History tabs.

| Note | 1. The Conversations and Discussion Notes block are displayed when the same are added to the request. |
|      | 2. When the request is submitted for approval, the Approvals tab appears along with the Request, Resolution and History tabs. The Approval Status is shown on the top right corner of the page below the Status and Priority. To know more refer Submit For Approval. |
|      | 3. Similarly, the Tasks tab appears when some tasks are added to the request. |
|      | 4. In addition, you can also associate Problems and Changes to the incident requests. Refer Associating Problems to Incident and Associating Changes to Incidents to know more. |

Request Tab

In the request tab, the data is grouped in a logical manner. By default this page displays Subject of the request and Description of the request, Request Details, Requester Details and Time Elapsed blocks. The Request ID is displayed on the top left corner of the page below the tabs. The Status and priority of the request is displayed on the top right corner of the page.

Viewing Request Details

The Request Details block displays the Status, Group, Category, Sub Category, Item, Workstation, Created Date, Created By, Technician, Priority, Mode, Level and Due Date of the request. You have inline edit option to edit all the request details under this block. To edit the details click the link available for each of the request details against each field. Say for ex. If you wish to change the technician Jennifer Doe to John Abraham for Request ID 14 then click the name of the technician and select the technician name from the list.

Viewing Requester Details

In the Requester Details block, the details of the requester such as the Requester Name, Contact Number, Department, Email Address & Mobile Number of the requester are displayed. You have inline edit option to edit all the requester details under this block. To edit the details click the link available for each of the requester details against each field.

Viewing Conversations

Next is the Conversations block, which displays the mail transactions / threads that have been exchanged between the technician and the requester, related to the request.

Click the View Requester Conversations link to view the history of all the conversations. Conversations are listed in the ascending order of the time. The conversation block is visible only if there have been any mail transactions between the requester and the technician.

| Note | If any mail transactions/ threads has an attachment, then the same can be viewed under View Requester Conversation block. To know more refer Request Conversation. |
Viewing Discussion Notes
Once you add a note to the request the Discussion notes gets displayed in descending order of their date of creation just below the Requester Details block. If you select the option "Show this notes to requester" then the note will be displayed as Public. Else will be listed as private. You also have an option to edit or delete the discussion notes.

Asset belonging to the User, while adding users to ServiceDesk Plus in the Admin tab, you have an option to Associate Workstation to the user. If you have associated workstation to the user, you can view the list of all associated workstations under this block.

Cost of a Request
Finally, you can enter the worklog details for the request.

1. Click Add Work Log button. (OR) Alternatively, you can enter the time spend details for a request by clicking Add Work Log option under Actions combo box from the request details page. The Add Work Log dialog pops up with the subject and request id of the request mentioned.

2. Select the technician name from the Technician Resolving This Request list box. If you have already entered the per hour cost of the technician while creating the technician details, then that will be fetched and the total time spent on the request will be taken. If you wish to change these values, you can do so manually.

3. Specify the time taken to resolve the request.

4. The Technician Cost per hour will be fetched from the technician details, which is a non-editable field.

5. Using the above two data, the Technician Charge is calculated as Time Taken To Resolve X Technician's Cost per hour.

6. Specify the Executed Time by invoking the calendar icon.

7. If you wish you can enter a description for this time spent entry.

8. Click Save.

The Created Date field displays the time when the request was created. Based on the priority of the request and SLA that is associated with the requester/workstation/department, the Due By Date is calculated. If you have responded to the requester then you will see the Responded Date displayed just below the Priority field in the Request Details block. When you add any notes to the request, it gets appended below the Task Details block. The time spent on the request will also be calculated and displayed. The total time spent will exclude the time that the request was on hold and then calculate the total time from the time of creation till the request was closed.

If any notes are added to the request, they will be available below the description of the request. The notes are displayed in the descending order, with the latest added note displayed first and the rest below that. The notes can usually be added to convey any technical information related to the request or to convey the request status.

If there are any additional user-defined fields that have been added to the new request form, they are grouped under the Additional Request Details head and displayed just below the Request Details block.

Resolution Tab
To view or add the resolution for the request from the request details page,

1. Click the Resolution tab next to the request tab.

2. The current available resolution for the request is displayed in this page. You have an edit option on the right side of the resolution. If there are no resolutions available for the request, then the blank text is shown for you to add the resolution if needed. Also, you can add a
resolution using the Resolution Templates. Refer Resolution Template to know more on its configuration.

3. To search for resolutions from the solutions database, click **Search Solutions** button.

4. The resolution is a documented information of how the issue was resolved. This documented information can be very useful for future reference. This resolution can also be added to the knowledge base as an article which can be searched by requesters for resolving issues faced by them.

5. The status of the request can be modified while adding a resolution on selecting the status from **Change Status To** combo box.

6. You also have an option to **Add Time Entry** to the resolution. Select Add Time Entry option by enabling the check box and specify the details.

**Tasks Tab**

The **Tasks** tab is displayed beside the Request tab and appears when tasks are added to the request. From this tab you can **Add Tasks from the Template**, **Delete** existing tasks and also **Organize** tasks.

**Approvals Tab**

The **Approvals** tab is displayed next to the **History** tab when a request is submitted for approval. It displays all the mails sent for approval in ascending order with the Approver email address, Sent On, Status and acted on details of the request.

Once the request is approved by the manager the status of the request changes to **Approved**. If rejected by the manager the status of the request changes to **Denied** as shown below,
History Tab

To view the request history from the time of its creation, click the **History** tab in the view request page. The details that are displayed in the history are in the ascending order with the earliest performed action shown at the top of the page and the latest action at the bottom of the page.
Editing a Request

To edit a single request available in the ServiceDesk Plus Request module

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Requests tab in the header pane. This opens the Requests list.
3. Click the Title of the request which you want to edit from the view list page. This opens the View Request page. Click the Edit tab on the top of the page to modify the request details.
   [OR] From the request list view page, click the edit icon beside the request to be edit. This opens the Edit Request form where you can add resolution while editing, change the status of the request from open to close, and so on.
   Alternatively, you also have an inline edit option to modify the request details in the view request page. Click the edit button beside each block which opens the request form fields in editable format. This comes in handy when you need to edit the values of the entire block say Request Details one by one.

   **Note:** While editing the request details block, the SLA, department and the template is in non editable mode. The SLA of the corresponding site selected on editing the request gets applied. The department of the corresponding technician selected on editing the request gets displayed.

4. On modifying the values, click Update Request to save the changes. If you do not want to save the changes, click Cancel.

Editing more than one Requests

You have an option to edit more than one requests simultaneously. For instance, you want to assign a group say, Printer to ten requests relating to Printer Problem or you want to assign a Category to bulk requests. Instead of editing the requests individually you can perform a bulk edit to edit the requests instantly.

1. Select the check box beside the requests to be edited from the request list view page.
2. Click Edit Request button. The Edit Request page opens. The title displays the request Ids that are grouped together to edit.
3. Edit the fields, say Category into Desktop. This will replace the categories of all the requests grouped together.
4. Specify the Reason for Updating the request in the given text field.
5. Click Update button to save the changes.
Closing Requests

When a requester is completely satisfied that his/her request has been completely attended to and the reported problem has been solved, then the request can be closed.

To close a request,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Request** tab in the header pane. This opens the request list view page.
3. Click the **Subject** link of the request in the **Requests** list page.
4. Click the **Close** tab under the **Tasks** block. The **Close Request** dialog box appears. Enable the 'Yes' radio button if the resolution has been acknowledged. else enable 'No' radio button. Enter relevant **Comments** in the field provided. Also, select the **Request Closure Code** from the drop down. The Request Closure Code denotes the reason for closing the request. Click **Close** to close the request. If you do not wish to close the request then click **Cancel**. (OR) Alternatively, change the status field to **Closed** when the request is in editable mode.

You can reopen a request from the closed state. To do this, open the closed request that you wish to reopen in the editable mode and change the status field from **Closed** to **Open**. When a request is opened from the closed state, you can change the Due By time of the request when it is in the editable mode. Also, the closed date is removed once the request is reopened. When this request is finally closed, the **completed date** is updated and the **Time taken to close** is recalculated taking the reopened period into account.

To close more than one request at a time,

1. In the **Request** list view page, select the check boxes available beside the **Requester Name** field of the requests that you wish to close.
2. Now click the **Close** button. The **Close Request** dialog box appears. Enable the 'Yes' radio button if the resolution has been acknowledged. else enable 'No' radio button. Enter relevant **Comments** in the field provided. Also, select the **Request Closure Code** from the drop down. Click **Close** to close the request. If you do not wish to close the request then click **Cancel**.

To view the closed requests

1. From the Request list page, select **Closed Requests** from the Filter drop-down menu. This lists all the closed requests.
2. To view the closed requests which were assigned to you, select **My Closed Requests**.
Picking up Requests

ManageEngine ServiceDesk Plus provides the option of self-pick up of requests that are received in the requests module. If there are unassigned requests in the application, then the technicians can themselves pick up requests. This increases the efficiency in the turnaround time of the IT help desk team as the requests are assigned and answered sooner and waiting time of the request till it is assigned is reduced.

To pick up requests

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Requests tab in the header pane. The unassigned requests will be in bold font.
3. Select the requests you would like to pick up by enabling the check box. Click Pick up button. The selected request will be assigned to you. (Or)
4. You can also pick up requests after viewing the request details. Click the title of the request to open View Request page.
5. Click Assign tab. Select Pick Up option to pick up the request.
Assigning a Technician for the Request

Each request will be owned by a technician, who would be responsible for handling the request till it is closed.

To assign a technician,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane. This opens the Requests list.
3. Click the Title of the request for which you have to assign a technician. This opens the view request page.
4. The View Request page lists the Tasks that can be performed on the requests on top of the page. Here click the Assign link and select the assign option. This opens Assign Group and Technician page as shown below.

   Based on the issue you can assign this request to the appropriate Group and as well as to the Technician who belongs to that group. Or you can select either of the one. If you wish to select the technician alone then choose the technician from the list and click Assign button to assign the technician to handle the request. And when the technician logs into ServiceDesk Plus, he/she would see this request in the My Open Requests list.

5. Alternatively, you can also assign technician using inline edit option. Click the technician name shown in the request details block. This opens the drop down box as shown below. Select the technician from the list and click the ✓ icon to select the technician name else click cancel icon.
Bulk assign requests to technicians

You can also assign more than one request at a time to a technician.

1. In the Requests list page, select the requests to be assigned a technician by enabling the check box beside left side of each of the request title.

2. Select the Assign to check box. Select the technician from the drop down list.

3. Click Assign button to assign the technician.
Unassigning a Technician from a Request

Each request will be owned by a technician, who would be responsible for handling the request till it is closed. You can unassign a request from the request and move it back to unassigned status.

To unassign a technician

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane. This opens the Requests list.
3. Click the Title of the request for which you have to unassign a technician. This opens the view request page.
4. The View Request page lists the Tasks that can be performed on the requests on top of the page. Click the Assign link and select the Assign option from the list. Alternatively, you can also unassign technician using inline edit option. Click the technician name shown in the request details block. This opens the drop down box as shown below. Select the technician name from the list and click the icon to select the technician else click cancel icon.

5. Now select the NONE option and click Assign. The request will be unassigned. If you do not wish to unassign the technician then you can just close the pop-up by clicking Cancel.
Start / Stop Request Timer

If a technician is unable to close a request then, it could be for many reasons such as, lack of necessary information or and so on. If the technician is unable to continue the work then he/she can move the request to on hold status.

If this is not done, then the request will remain in open state idly which will lead to the violation of SLA that governs the request. Also, it will show that the time taken to close the request was high and will reflect on the efficiency of the technician (s) handling the request. To avoid all these, move the request to on hold state till the time you are ready to resume work on the same.

Alternatively, you can stop the timer when you are not working on the request.

Stop Timer
To stop the request timer,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Subject link of the request in the Requests list page.
4. Click the Stop Timer under Actions combo box. A pop-up window opens requesting you for the reason for stopping the timer.
5. Enter the relevant reason to stop timer in the text area provided for the same.
6. Click Add.

The status of the request will be changed to On hold and the reason gets appended to the request history.

Start Timer
To restart the request timer,

1. In the request details page, click Start Timer link under Actions combo box. A pop-up window opens requesting you for the reason for starting the timer.
2. Enter the relevant reason to stop timer in the text area provided for the same.
3. Click Add.

The status of the request will be changed to Open and the reason gets appended to the request history.

Note: You can stop and start timer for requests that are not overdue.


Adding Notes

When you would like to add some additional information including technical information to a particular request based on your observations, you can use Add Notes. You can also use notes to update the status of the request.

To add a note to a request,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request to which you would like to add a note.
4. Click the Actions menu -> Select Add Notes option. This opens Add Note page as shown below;

5. Enter your content in the text box below the Request ID.
6. There are two types of notes that can be added to the request such as, public & private.

   - **Public Notes**: Public notes can be viewed by the requesters & technicians.
   - **Private Notes**: Private notes can be viewed only by the technicians (all the technicians).

   These notes can be added to the request by both the technician and the requester. By default the requester can add only public notes.
   
   By default the technician can add only a private note but the technician also has an option to make his notes public.
   
   If you want the notes to be visible to the requesters (public), then select the **Show this notes to Requester also** check box. Else only the technicians will be able to view the notes (private).
   
5. If you want to notify the technician about the addition of the note, then select the check box, E-mail the technician for notes addition.
6. Click the Add Note button. The note is added at the bottom of the request along with a date and time stamp. The name of the person who added the note is also displayed.

You can add any number of notes to a request. The added notes will be displayed in the descending order with recently added note first. You can also edit or delete the notes that have been added.
Adding Work Logs

Using this option, the time spent by a technician on a request can be recorded. The total time spent excludes the time that the request was kept on hold. It takes the time of creation to till the request is closed.

To Add Work Logs,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Requests** tab in the header pane. From the request list view page, select the request for which the time spent details should be entered.
3. From the request details page, click Actions drop down -> Add Work Log option.
4. In the Add Work Log pop up, select the **Technician resolving this request** from the drop down.
5. Enter the **Time** (in Hours and Minutes) taken to resolve the request.
6. The **Technician Cost per hour** will be fetched automatically from the technician details, which is a non-editable field. If you have already entered the per hour cost of the technician while adding the technician details, then the details will be fetched automatically. If you wish to change these values, you can do so manually.
7. The **Incident Cost** will be automatically calculated taking the (total time spent to resolve the request * Technician's cost per hour).
8. Specify the **Executed Time** (date & time) taken to resolve the problem from the calendar button.
9. Specify any relevant information about the time spent in the description field.
10. **Save** the details.
The Work Log details are displayed in the request details page as shown below. You can also add a work log from this section.

<table>
<thead>
<tr>
<th>Time Elapsed</th>
<th>Add Work Log</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technician</td>
<td>Description</td>
</tr>
<tr>
<td>John Roberts</td>
<td></td>
</tr>
</tbody>
</table>

Total: 2 Hrs 00 Mins $20.00
Tasks

Sometimes, a request might involve multiple technician work. In that case, the request can be divided into several tasks and each task can be assigned to a technician/group.

For example, consider a scenario where a new employee joins the organization. There is a list of tasks that need to be performed such as seating location, providing a computer/laptop, installing necessary software, connecting telephone links, entering his/her name in the active entry and so on. These operations can be considered as separate tasks and be can assigned to different technicians.

Adding tasks:
To add tasks,
1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request to which you would like to add tasks.
4. Click the Actions menu -> select Add Tasks option. This opens the Tasks window.
5. Select the Task Template from Select Template drop down menu.
6. Specify the Title of the task in the given text field. This is a mandatory field.
7. Specify relevant information about the tasks in the Description field.
8. Select the Scheduled Start Time for the task based on the SLA from the calendar button. Also select the Scheduled End Time for the task from the calendar button.
9. The Actual Start Time and Actual End Time of the task can be selected later by the technician who works on the task.
10. Select the Group to which task has to be assigned. Select the Technician of the task from the combo box. Tasks can be assigned either:
   - to a Group alone,
   - to a Group and a specific Technician in the group,
   - to a Technician alone without selecting the group,
   - to no Group and no Technician.
11. In some cases, the implementation of one task depends on the completion of one or more other tasks. Dependencies on tasks can be captured by clicking on the relevant tasks in the Depends on Task List. In the snapshot below, Task "Setting up user computer" doesn't depend on any other task so the Depends on Task List is not checked. However, the task "Installing softwares" depends on the current task "Setting up user computer". It is therefore marked in the Dependents List.

For example, the same scenario where a new employee joins the organization. The list of tasks that need to be performed such as seating location, providing a computer/laptop, installing necessary software, connecting telephone links, entering his/her name in the active entry and so on. Some of these tasks are dependent on the other, like installing necessary software can happen only after providing computer/laptop.
12. Specify the **Status** of the task.

13. Specify any relevant comment about the task in the **Comments** field.

14. If you wish to be reminded of the task previously then select the time duration from the **Remind me before** combo box.

15. **Save** the values. You can see a Tasks tab getting created next to the Resolution tab. All the tasks created for the request will be listed under the tasks tab in descending order. The tasks assigned to other technicians can be viewed in their Task summary list in the home page.

16. When a task is completed, email notification will be sent to group/technician of the next dependent task to alert them about the completion of the previous task.

**Editing tasks:**

Task editing consists of capturing dependencies among tasks, and appending/removing/changing other task parameters.

To edit tasks,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the **Request** tab in the header pane.
3. Click the **Title** of the request under which the task to be edited is present.
4. Click on **Tasks** tab. This will show the list of tasks for the particular request.
5. Click on the task that you need to edit. The task configuration window opens.
6. Edit the necessary task parameters.
7. **Save** the parameters.

**Organizing tasks:**

In specific cases, certain tasks have to be completed in a hierarchical order either depending on priority or on dependency. This can be done by the administrator after the creation of the tasks.
To organize tasks,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request under which the task to be organized is present.
4. Click on Tasks tab. This will show the list of tasks for the particular request.
5. Click on Organize Tasks. This opens the Organize Tasks window with the list of tasks.
6. In the Organize Tasks window, click on the task that has to be moved. Re-organize the task by clicking on the Up or Down Arrow buttons and change the order of the tasks in the list.
7. Re-ordering tasks will remove all dependencies associated with that task.

Deleting tasks:

To delete tasks,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request under which the task to be deleted is present.
4. Click on Tasks tab. This will show the list of tasks for the particular request.
5. Click on the check boxes next to the tasks that need to be deleted.
6. Click on Delete.
7. Deleting a task will also delete all the dependencies associated with the task.
Merging Requests

When two or more requests are related to each other and are from the same requester, and can be handled by the same technician, they can be merged into one request and assigned to a technician.

To merge two or more requests from the Request List View page,

1. Click on the Requests tab to open the Request List View page.
2. From the request list view page, select the requests to be merged by enabling the check boxes.
3. Click Merge button to merge the requests.
4. All the merged requests appear as a single request.

(OR)

1. Click the Title of the request that you wish to merge in the request list view page.
2. Click Actions link -> Click Merge Request option. This opens Merge this Request form as shown below,

```
Choose a request to merge
```

5. You can search for specific request by providing a search string in the field provided above.
6. To confirm if the request that you want to merge is the correct one, you can view the request by clicking the title of the request.

7. Click the Merge Request icon to merge the two requests. A dialog box pops up asking for your confirmation to merge requests.

8. Click OK to merge request. All the merged requests will be displayed in the Conversations block of the view list page. And if you have attached notes, conversations and time-spent entry for the requests all the said information will be moved to the parent request.

9. Else if you wish to cancel merging click Cancel in both the dialogs to exit the Merge Request form.

You can split a thread of a request into a new request. For more information on this, kindly refer to the section Request Conversations.
Duplicate Request

When a single request has multiple issues in it that requires more than a single technician to handle them, then the request can be duplicated and each of the duplicated requests can have only one issue. This makes it easier for the technician to take ownership and complete the task independently.

To make multiple copies of a request,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Subject link of the request that you want to duplicate in the view list page. This opens the Request details page.
4. Click Duplicate Request option under Actions combo box. A Duplicate Request pop-up window opens, requesting you to give the number of copies.

![Duplicate Request Pop-up Window]

5. Enter the number of copies in the text field provided beside the Number of Copies label. The maximum value you can enter is 9. If you need more than 9 copies of the request, then you need to invoke Copy Request again.
6. Click Copy to make the copies of the request. The new copies of the request will be assigned new request ID that will uniquely identify them. The rest of the information such as the request details and description remains as it is.

Once you have created the copies of the request, you can edit the same to contain only the necessary information and assign appropriate technicians. You can modify the request copies by editing the copy of the request.

While copying the request, the Notes, Tasks, Reminders, Resolution and Approval status of the original request (if any) will not be present in the duplicated requests. Also, the Created Date and Due by Date will be different from that of the original request.
Linking Requests

Linking Requests is a feature that primarily provides an option to relate requests to one another and set some references between them. Secondly, certain common operations such as adding notes, creating resolutions, adding work logs and so on can also be linked between them.

When two or more requests are linked, one of the requests become the "Reference request" and the other requests are the "Linked requests".

Linking requests from the Request List View page

To link two or more requests from the Request List view page,

1. Click on the Requests tab and the Requests List View page is open.
2. From the Request List View page, select the requests that need to be linked by enabling the check boxes.
3. Click Link Requests button to link the requests.

Here, among the selected requests, the oldest created request becomes the "Reference request" and the other requests become the "Linked requests".

In the above example, the oldest request (Request ID 25) is the Reference request while the other requests later created (Request ID 26, 27 and 28) become its Linked requests.

Linking requests from the Request Details page

To link two or more requests from the Request details page,

1. Click on the Requests tab and open the Request List View page.
2. Click on the title of the request you wish to view. This opens the Request Details page.
3. In the request details page, click on Actions link and select the Link Requests option. This opens a pop-up window with a list of requests.
4. Select the requests that need to be linked by enabling the check boxes.
5. Click on the Link Requests button to link the requests.
In this case, the request through which the linking is done becomes the "Reference request" and other requests are its "Linked requests". This option is useful when you want to choose a specific request as the Reference request instead of the oldest created request. A relatively new request can be made as Reference request with older requests related to it as Linked requests.

In the above example, linking is done through the details page of Request ID 27 and so it is made as the Reference request. Other older and newer requests (18, 25 and 28) linked to it are its Linked requests.

**Note**: Linking requests is different from "Tasks" that are created within requests. Tasks are created in a request so that the request can be split into various activities and can be assigned to different technicians. All the tasks inside a request will be considered as a single request. However, Reference requests and the Linked requests are independent requests with only references set between them.

**Attributes of Reference Request and Linked Requests:**

1. Any Linked request can be associated with only one Reference request at any time.
2. Even though Linked requests are linked to a Reference request, they will still be considered as independent requests with their own SLA, Business Rules, and so on.
3. If a Reference request (A) is made as the Linked request of a new Reference request (B), then all the Linked requests earlier associated to Reference request A will be linked the new Reference request B.
4. Linked requests have their own independent work logs, resolutions and notes. Operations performed over the Linked requests have no impact over the Reference request. However, any work log, resolution or note added to the Reference request can be linked to all the Linked requests by enabling corresponding check boxes.
5. Notes added to a Reference request can be made available to the Linked requests by enabling the **Add notes to all linked requests** check box. The **Discussions Notes** section in the Linked request details page will show its own notes and the notes that have been linked.
from the Reference request. Editing notes in the Reference request has no impact on the notes that have been earlier linked to the Linked requests.

6. Similarly, work logs added to a Reference request can be made available to the Linked requests by enabling the **Add work log to all linked requests** check box. When work log from a Reference request is added to the Linked requests, the **Time Elapsed** section in the Linked request details page will show **sum** of time elapsed and **sum** of charges for the Linked request and the Reference request. However, any changes made to the work log in the Reference request will not change the work logs that were earlier linked to the Linked requests.

7. If a resolution written for a Reference request is linked to the Linked requests, then it overwrites any resolutions earlier added to the Linked requests. Editing resolutions for a Reference request will change the same in the Linked requests. All resolutions written for a particular Linked request can be viewed under the **History** tab of that Linked request. The **Click here** link opens a pop-up with all resolutions associated with that request. Also, **Change Status to** option applies only to the Reference request and does not have any impact on Linked requests upon linking.

8. While viewing a request's details page, indications are shown if there are any requests linked to the current request. By clicking on this indication, a description box opens and by clicking on the Request ID of the linked requests, one can navigate to the requests linked to the current request. Options to remove links between requests are also provided here.
9. Links between requests can be added, modified and also removed. Each of these operations will be recorded in the request History.

10. Links can be created between requests belonging to different request templates and even different sites. But, if the technician who has permissions in the site where the Base request is present does not have permission in the sites where the Linked requests are present, then the technician will not be able to perform operations on those Linked requests.

11. Closing and re-opening of requests is independent to both Reference and Linked requests.

12. Requests cannot be linked through API or E-Mail Command features.
Deleting Requests

You may receive lots of mails of which some may not qualify as requests at all and hence need to be removed from the ServiceDesk Plus application completely. In such cases, you can delete those individual requests in the view request page or select a group of requests in the list view page and delete them together.

To delete individual requests,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Subject link of the request that you want to delete. This opens the request details page.
4. Click Actions combo box -> Delete option. A confirmation dialog pops up.
5. Click OK to proceed deleting. The notes, work logs and conversations ( if any ) added to the request gets deleted. Click Cancel to abort deletion.

To delete more than one request at a time

1. In the requests list view page, select the check boxes beside the request that you wish to delete.
2. Click the Delete button. A confirmation dialog pops up.
3. Click OK to proceed deleting. Click Cancel to abort deletion.
Add/Associate Problem to Requests

You have an option to add, associate, view and detach problem to requests. Similar problem occurred to Incidents (requests) can be associated in order to track the problem occurred for the same request. You can also add new problem or detach the existing problem to a request. While adding/associating/detaching a problem the approval status of the request does not change.

- Associating Problem to request
- Add Problem to request
- Viewing Associated problem
- Detach Request from Problem

Associate Problem to Request

You can also associate the existing problem to the request. To associate problem,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Subject link of the request for which you want to add a problem. This opens the request details page.
4. Click the Actions combo box on the top right side of the page. Click Search Problems option. This opens Associate Incidents to problem page as shown below,

   ![Associate Incidents to problem](image)

   4. Select the type of problem to be displayed by selecting from the Filter Showing combo box on the top left hand side of the page. Ex: Open Problems or All Problems and so on. On selecting the problem type the corresponding problems gets listed.
5. Select any one problem to be associated with the request by enabling the radio button beside the title of the problem.
6. Click Associate button to associate respective problem to the request (particular selected request). You can associate the same problem to different requests. Once the problem is associated to the request, the View Problem and Detach from Problem option appears under Actions combo box.

Add Problem to requests

You can add new problem to requests. To add new problem,

1. From the request list view page, click the Subject link of the request for which you want to add a problem. This opens the request details page. Click New Problem button on the right hand side of description field. (OR) Alternatively, you add a new change from the Associate Problem to Incident pop up page. Click New Problem button below the filter showing combo box. This opens the New Problem form.
2. The details such as Status, Impact, Urgency, Priority, Category, Sub category, Item along with Subject and Description remains the same as of the request. If required, you can modify
the same on selecting from the combo box.

3. Select the **Reported By** requester from the list by clicking on the Requester icon. This opens the requester list page and click the requester title.

4. Select the **Technician** from the combo box.

5. Select the **Due by Date** and the **Closed Date** from the calendar button.

6. Select the affected **IT Services** from the list by clicking on the icon. This opens the **Services Affected** pop up box. Select the affected IT services and **Save** the changes.

7. Select the Assets Involved with the problem by clicking the icon. This opens the **Select Assets** page. Select the **Type of Assets** or the category of assets to be involved from the combo box. Ex: Workstations, Routers, Switches and so on. Select the **Available Assets** under the selected type from the list and move to **Assets involved** using >> button. And **Save** the changes.

8. If you have any file attachments for the problem click the **Attach File** button and attach files. **Note:** Maximum size of an attachment can be 10MB.

9. **Save** the changes. A new problem gets added in the problem list view page.

**View Associated Problems**

You have an option to view the newly added problems or the problems associated to the request.

To view the problem,

1. From the request list view page, click on the request for which you wish to view the problem. This opens the request details page.

2. Click **View Problem** button on the right hand side of the request description. (OR) Click **Actions** combo box -> **View Problem** option. This displays the Problems Details page of the problem added/associated to the request.

**Detach Request from Problem**

If you want to add another problem to the request then the existing problem has to be detached.

To detach a problem,

1. From the request list view page, click the request you wish to detach the problem. This open the request details page.

2. Click **Actions** combo box -> **Detach from Problem** option. The request is detached from the problem.
Add/Associate Change to Requests

You have an option to add, associate, view and detach change to requests. Similar change occurred to Incidents (requests) can be associated in order to track the change occurred for the same request. You can also add new change or detach the existing change to a request. While adding/associating/detaching a change the approval status of the request does not change.

- Associating Change to request
- Add Change to request
- Viewing Associated Change
- Detach Request from Change

Associate Change to Requests

You can also associate the existing change to the request. To associate change,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Request** tab in the header pane. This opens the request list view page.
3. Click the **Subject** link of the request for which you want to add a change. This opens the request details page.
4. Click the **Actions** combo box on the top right side of the page. Click **Search Changes** option. This opens **Associate Change to Incident** page as shown below.

   ![Associate Change to Incident](image)  

5. Select the type of change to be displayed by selecting from the **Filter Showing** combo box on the top left hand side of the page. Ex: Open Change or All Change and so on. On selecting the change type the corresponding changes gets listed.
6. Select any one change to be associated with the request by enabling the radio button beside the title of the change.
7. Click **Associate** button to associate respective change to the request (particular selected request). You can associate the same change to different requests. Once the problem is associated to the request, the **View Change** and **Detach from Change** option appears under **Actions** combo box.

Add Change to requests

You can add new change to requests. To add new change,

1. From the request list view page, click on the subject link of the request you wish to add change. This opens the request details page.
2. Click **New Change** button on the right hand side of the description field. This opens the **New Change** form. (OR) Alternatively, you add a new change from the **Associate Change to Incident** pop up page. Click **New Change** button below the filter showing combo box.

3. The details such as Status, Impact, Urgency, Priority, Category, Sub category, Item along with Subject and Description remains the same as of the request. If required, you can modify the same on selecting from the combo box.

4. Select the **Reported By** requester from the list by clicking on the Requester icon. This opens the requester list page and click the requester title.

5. Select the **Technician** from the combo box.

6. Select the **Schedule Start Time** and the **Schedule End Time** from the calendar button.

7. Select the affected **IT Services** from the list by clicking on the icon. This opens the **Services Affected** pop up box. Select the affected IT services and **Save** the changes.

8. Select the Assets Involved with the problem by clicking the icon. This opens the **Select Assets** page. Select the **Type of Assets** or the category of assets to be involved from the combo box. Ex: Workstations, Routers, Switches and so on. Select the **Available Assets** under the selected type from the list and move to **Assets involved** using >> button. And **Save** the changes.

9. If you have any file attachments for the problem click the **Attach File** button and attach files. **Note:** Maximum size of an attachment can be 10MB.

10. Click **Save**. A new change gets added in the change list view page.

**View Associated Change**

You have an option to view the newly added change or the change associated to the request.

To view the change,

1. From the request list view page, click on the request for which you wish to view the change. This opens the request details page.

2. Click **View Change** button on the right hand side of the request description. (OR) Click **Actions** combo box -> **View Change** option. This displays the Problems Details page of the change added/associated to the request.

**Detach Request from change**

If you want to add another change to the request then the existing change has to be detached.

To detach a change,

1. From the request list view page, click the request you wish to detach the change. This opens the request details page.

2. Click **Actions** combo box -> **Detach from Change** option. The request is detached from the change.
Printing the Request

You can customize the print preview of the request to satisfy your needs. To print a request,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane.
3. Select the Title of the request you wish to print.
4. Click Actions drop down list -> Print Preview option. The print preview of the request opens in a pop-up window.
5. By default, all the check box is enable under Select the required information block. To customize the print preview, disable the check box of the information that is not required. The disabled information disappears from the print preview.
6. Click the Print menu item from the browser File menu.
7. The default printer associated with your workstation is invoked. Set the required options and click OK. You can collect the printed copy of the request at the printer that is linked to your workstation.
Adding a Resolution

You can add resolutions for the issues reported in the requests.

To add a new resolution,

1. Log in to ServiceDesk Plus using your **user name** and **password**.

2. Click the **Requests** tab in the header pane. This opens the request list view page.

3. Click the request **Title** for which you want to add the resolution.

4. Check if a resolution already exists for the request by clicking the **Resolution** tab in the **Request details** page.

5. If no resolution is available for the request, then the plain html text page is displayed. Specify the resolution in the text field.

6. On specifying the resolution the status can be changed by selecting the status from the combo box.

7. You can also add **Time Spent Entry** details for the request in this page.

8. **Save** the resolution. You can see the resolution is displayed in this page.

9. If you wish to add the specified resolution to the solutions database, then click **Save and Add to Solutions**, or else click **Save**.

10. On selecting **Save and Add to Solutions**, you get a **New Solution** form. The title of the solution is automatically filled with the title of the request. The **Contents** is filled with the resolution. If you wish you can edit the contents.

11. From the **Topic** drop-down list which contains all the available topics, select the relevant parent topic for the solution.

12. Enter relevant keywords for the solution in the **Keywords** text box. Separate each keyword by a comma. This option is provided for the users to improve the search capability and get appropriate solution for the problem.

13. If needed you can also attach files to the solution.

14. Click **Add**. This also adds the resolution to the list of solutions.

These added resolutions can be used for various purposes. One of them is to add these resolutions as knowledge base articles which can be used for future reference to solve the same issue if reported. The resolution of the request also helps other technicians to know the kind of solution provided to the reported issue. This serves as a documented proof of the way a reported issues was resolved.
Searching Solutions

From the request, you can search for solutions that might help you solve the issue described in the request.

To search for solutions,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Requests tab in the header pane. This opens the request list view page.
3. Click the request Title for which you need to look up the solution.
4. In the View Request page, click the Resolution tab.
5. Click Search Solution link. Alternatively, you can also click the Search Solutions option under Actions combo box in the task block.
6. In the Search Solutions page, provide a search string in the Search field and click Search or press Enter. The solutions that match the search string are displayed.
Submit For Approval

You can submit the request for approval to the manager using this option. To submit for approval,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Request** tab in the header pane. This opens the request list view page.
3. Click the **Title** of a request which you want to submit for approval. This opens **View Request** page.
4. Click the **Actions** tab -> select **Submit For Approval** option. Submit For Approval page pops up.
5. Specify the **To** address. This is a mandatory field.
6. Edit the **Subject** and specify relevant subject in the given field. This is a mandatory field.
7. Specify the relevant **Description** in the given text field. **$ApprovalLink** is a variable. It should be available with the mail to replace the variable with the link where you have the request details.
8. And send the mail for approval.

The manager gets the Request for approval mail with the link. On clicking the link it opens a form with approve or reject option & request details as shown below,

The manager has to approve or reject the request based on the requirement. And save the details. On Saving the decision you get a thank you message.
A notification mail will be sent to you along with the request id, approval status for request and comments. This is fundamental as you need not revisit the request at periodic intervals to check the approval status.

In the Request Details page, the Approvals tab getting displayed next to History tab. It displays all the mails sent for approval in descending order with Sent On, Sent To & Status details of the requests.

Once the request is approved by the manager the status of the request changes to Approved. If rejected by the manager the status of the request changes to Denied as shown below,
Viewing Requester Details

When attending to a request, you may want to contact the requester to get additional information. To view the requester's contact details,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Request** tab in the header pane. This opens the request list view page.
3. Click the **Title** of a request. This opens the View Request page.
4. Click on the requester name link just below the request tab as shown below

![Request Details Pop-up](image)

**Requester Details** pops up where you can view details, such as name, designation, employee ID, department to which the requester belongs, e-mail ID, and phone and mobile numbers. Any additional fields configured will be able to view in the requester details page. Alternatively, you can also click the **View Requester Details** option available under **Actions** combo box in the task block.

![Requester Details](image)

5. Once you have finished viewing the details, click the **Close** link available at the top right corner of the pop-up.
E-mail the Requester

Sending a response to the requester is required when a new request is received. Also, when a technician is ready to close a request, the same can be notified to the requester so that if the requester has any concerns about the same, he/she can raise. The technician can then address the same and close the request after the requester is completely satisfied with the way his/her request has been attended to.

To respond to the requester,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane.
3. Select the Title of the request in the requests list page.
4. In the Request details page, click Reply button just below the description of the request. Alternatively, you can reply to the requester from Reply drop down -> Reply. The Mail to the Requester form pops up.

5. The To field is pre-populated with the email id of the requester. If you wish to send the same information to more than one person then enter the email IDs of those people in the CC field with comma as a separator.
6. Edit the Subject of the request, if required.
7. You can reply to a request using the Reply Template configured under the Admin section. Select the Reply Template from the drop down list.
8. Click Attach File button to add files as attachments to the mail.
9. Click Send to send the email to the requester. You can save the email and send it later to the requester by clicking Save. The email is saved as draft, in the request details page, above the title of the request along with Send for review and Delete button. To send the draft for review to the concern authority, click Send for review. A pop up as shown below appears,
Enter the email id in the To filed. Click Send. The draft is sent for review.

The responses that have been sent to the requester can be viewed as conversations in the request details view.

**Note:** While editing the subject of the e-mail, ensure that the request ID value remains intact with the # symbols beside it. Else, the threading of requests may not be proper.
Forward the Request

To forward a request,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane. This opens the request list view page.
3. Click the Title of the request in the requests list page.
4. In the View Request page, click Forward button just below the Request Description. Alternatively, you can click Forward the Request option under Reply combo box. This opens the Forward Request form.

5. Enter the e-mail ID of the person to whom you wish to forward the request in the To field. You can also mark a copy of the forward to others. To do this, enter their e-mail IDs in the CC field.
6. Edit the Subject and Description of the e-mail.
7. Click Attach a File button to add files as attachments to the mail
8. Click Send. The request is sent to all those whose e-mail ID is mentioned in the To and CC field. The forwarded requests will be shown in the conversation block.
E-mail the Technician

To e-mail a technician

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Request tab in the header pane.
3. Click the Title of the request from the requests list page.
4. In the View Request page, on the right-side Tasks block, under Notify, click E-mail the Technician. This opens the Mail to Technician form.

5. Enter the E-mail ID in the To field. This is a mandatory field.
6. Edit the Subject and Description of the e-mail.
7. Click Attach a File button to add files as attachments to the mail. All the newly attached files will be listed in the Newly attached files field.
8. Click Send. An e-mail is sent to the technician. To send the information to more people, enter their e-mail IDs in the To field or CC separated by comma.
9. You also have an option to Save the mail as draft copy for later use.
10. If you wish to send the drafted mail for review to the higher authority then click Send for review button.

A technician can be notified when a new request is assigned or an already existing request is reassigned to him/her.
**SMS the Technician**

ManageEngine ServiceDesk Plus enables you to notify a technician through SMS also. This option is available only to technician assigned requests.

To send an SMS to a technician

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the **Requests** tab in the header pane.
3. Click the request **Title** which is assigned to the technician whom you wish to notify through an SMS.
4. In the **View Request** page, on the right side under **Reply**, click **SMS the Technician**. The **Mail to Technician** window opens with the **To** address displayed as `<mobile number>@<service provider>.com`. You can configure the service provider details in the admin configurations.
5. You can add your message to this or edit the description to contain only those information that you wish to send.
6. Click **Send**. A message is displayed in the window, stating that the SMS is sent.
7. Click **Close**. This closes the notification window.

The SMS notification is also available under the **Notifications** tab of the request. You can view the contents of the notification by clicking the **View Details** link beside the notification information.
Request Conversations

ServiceDesk Plus displays the mail transactions happening between the technician handling a request and the requester, as conversations. At times, the technicians can converse with other technicians regarding the request which also gets listed in the conversation block. The conversations are listed one below the other in the ascending order of the time when the notification (response) was sent (received). You can choose to view either All conversation or Requester conversations.

To view all the conversation details, click the View All Conversation link at the top of this block. This shows all the conversation between the technician and the requester and between the technicians. If the conversation has any attachments, then the attachment icon can be viewed in this block. To view only the requester conversation, click View Requester Conversation link.

Split As New Request
You can choose to split the requesters conversations into a new request. To split the conversation as a new request,

1. Expand the conversations by clicking on the View All Conversation link or by clicking the button on the left of the row which you wish to expand.
2. Click Split as New request button at the right bottom of that conversation.

This splits the conversation into a new request.

Delete Conversation
You can delete a specific requesters conversation. To delete a conversation,

1. Expand the conversations by clicking on the Expand all link or by clicking the > button on the left of the row which you wish to expand.
2. Click Delete button at the right bottom of that conversation. A confirmation pop-up opens.
3. Click OK in the confirmation pop-up to delete the thread/conversation.
Viewing Requests Based on Filters

ManageEngine ServiceDesk Plus allows you to view the list of requests and also set a time period for auto refreshing the request list view page.

To auto refresh the list view page

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Requests tab in the header pane. In the Requests list page, just below the header links, top right corner, you will see an editable field, Refresh this page. By default, the value is set to Never.
3. Click the edit icon beside the value Never.
4. From the drop down list select the frequency of refreshing the page.
5. Click Set.

You can also apply various filters to this list and view only a specific group of requests that you would like to view. This filtering helps you focus on just the requests that you wish to look at.

To view the whole list of requests available in the ServiceDesk Plus application, click the Request tab in the header pane. This lists all the open requests available in the ServiceDesk Plus application. You can set the number of requests that you would like to view in a single page:

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Requests tab in the header pane.
3. In the Requests list page, click the drop-down box (shown in the figure below):
4. From the drop-down list, select the number of records that should be displayed in a single page.

You have three different filter categories to view the specific set of requests. The filter categories are, My Group, Requests & My Views. To view the requests listed under these specified filter categories,

1) Click the Requests tab in the header pane. This opens the Requests list page.
2) Select the Filter Showing combo box. You can see the list of all filters. Select the filter from the list based on your priority.

My Group

All your incoming requests can be grouped under different groups based on the classification set by the help desk team. The groups are created using the groups option in the admin tab. The requests which matches the group criteria will be listed under the particular group option as shown below,
Requests
All the incoming requests will be classified under different titles. These request titles are listed under the Requests option. On selecting the specific title of the request, corresponding set of requests gets listed.

My Open Or Unassigned Requests
All your open requests & the requests that are not assigned to any technicians will be listed under this option.

Unassigned Requests
All the requests that have not been assigned to any technician will be listed under this option.

My Open Requests
When you click the requests tab, this filter is selected by default and lists all the request that are assigned to you in the open status.

In addition to this if you have any requests placed in Groups, then you will also have option to filter the requests based on a specific Group alone. You can also perform a column sort of the requests.
**My Requests On Hold**  
All your assigned requests that are kept on hold will be listed under this option.

**My Overdue Requests**  
All your assigned requests that have crossed the scheduled time will be listed under this option.

**My Pending Requests**  
All your assigned unfinished requests are listed under this option.

**My Requests Due Today**  
All your assigned requests that are due for the current day will be listed under this option.

**My Completed Requests**  
All your assigned requests that are closed will be listed under this option.

**Requests Pending My Approval**  
All the requests pending for the logged in technicians approval are listed under this option.

**All My Requests**  
All the requests assigned to the logged in technician will be listed under this option.

**Open Requests**  
All the open requests irrelevant of the technician will be listed under this option.

**Requests On Hold**  
All the requests that are kept on hold irrelevant of the technician will be listed under this option.

**Overdue Requests**  
All the requests that have passed due by time irrelevant of the technician will be listed under this option.

**Requests Due Today**  
All the requests that are due for the day irrelevant of the technician will be listed under this option.

**Requests Pending Approval**  
All the requests that are pending for approval is listed under this option.

**Pending Requests**  
All the unfinished requests irrelevant of the technician will be listed under this option.
Completed Requests
All the closed requests irrelevant of the technician will be listed under this option.

All Requests
All requests on all status say (closed, pending, open) will be listed under this option.

My View
All your customized views gets listed under the my view list.

Sorting Requests by Column
To sort request by column, click the column header. Clicking it once will sort it in ascending order. Clicking twice will sort the column in descending order.
Customizing Request List View

ManageEngine ServiceDesk Plus allows you to customize the request list view to include columns of your choice.

To customize the list view

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Requests tab in the header pane.
3. Click the column edit icon available at the corner of the request list headers. This opens the available columns that can be displayed in the list view. All those that are visible currently, will have the check box beside them selected.

4. To remove a column, remove the selection from the respective check box beside the column name.
5. To add a column to the list view, select the unchecked select box beside the column name.
6. To change the column order, click the up and down arrow after selecting the column that you wish to move.
7. Click Save.

This will add only those columns which you have chosen in the list view.
Searching Requests

ManageEngine ServiceDesk Plus gives you an option to search for requests using a keyword search. All requests that match the keyword that you have provided in the search will be displayed.

To do a keyword search in requests

1. Log in to ServiceDesk Plus application using your **user name** and **password**.
2. On the left hand side web client, there is a Search block as shown in the figure below:

   ![Search block](image)

   In Search in drop-down box, select **Requests**. In the home page and the requests module, this is selected by default.
3. In the Enter Keyword text field, type the search string that you wish search for in the requests.
4. Click **Go** or press the **Enter** key on your keyboard. All the requests that match the search string are listed.

You can also do a column-wise search of the requests. To perform a column-wise search

1. Click the search icon at the end of the request list view headers. This opens the search field just below every column that is visible in the list view.
2. Enter the search key in field under the column of your choice.
3. Click **Go**. The search results matching the search string(s) are displayed.

**Note:** The search would return the results for any of the text fields of the request. You will not be able to search for a request based on any of the date fields of the request.
Multi site on Requests

An organization can have branches spread across different regions and sites of the globe to handle various specialized activities. In this globally distributed environment, a request can be raised from a site to a technician located in another branch of the organization. The request is resolved based on the admin configurations (operational hours, holidays, SLA and business rules) of the site from which the request was raised. Hence with site base configuration, the request module experiences an immense change.

If an organization has no branches and hence no sites configured, then while creating a new request then the default admin configurations gets applied to resolve the request.

Key entities in Request module

Creating Requests

- The admin configurations of the selected site in the new request form will get applied to the request.
- The Groups and Technicians corresponding to the selected site will be listed. Groups acts as a filter in choosing the technician to resolve the request.
- A request template with the group and technician pre filled with values needs to be re-selected on choosing the requester, if the group/technician is not associated to the requester's site.

Editing Requests

If a request needs to be routed to a technician in another site, then on selecting the site, the SLAs and business rules for the site will be applied and the due by time recalculated accordingly.

Viewing Requests

Technicians can view all the requests of a site if,

- the technician is associated to the site and have the viewing permission as 'All' in Configuring Roles.
- the technician is associated to the site with the viewing permission as 'All in associated sites'.
Assigning Technicians

ServiceDesk Plus provides you with an option to bulk assign requests to technicians. The request can be assigned to the technician if,

- The technician is associated to the site where the problem persist.
- The technician has the permission to view the requests in all sites. This can be done in Configuring Roles. If the technician is not associated to the site where the problem persist and if the technician has restricted view permissions then an error message occurs while assigning the request to the technician as shown below.

Scenario: Roles on Requests

A requester from London raises a demo related request persisting in Sydney through self service portal of the ServiceDesk Plus application. By default, the admin configurations for London will be applied to the request. The request is handled by John, a technician in London. John can view and re-assign the request,

- If John is only associated to London with the viewing permissions as 'All', then he will be able to view the requests in all the sites of the organization. He will be able to assign the request to technicians associated in other sites but if he assigned the request to himself, then the site field automatically changes to London.

- If John is only associated to London with the viewing permissions as 'All in associated sites', then he will be able to view all the requests raised in London. He will not have the privilege to re-assign the request to technicians in other sites.

- If John is associated to London and Sydney with the viewing permissions as 'All in associated sites', then he will be able to view all the requests raised in London and Sydney. He can re-assign the request to request to a technician in Sydney but not to technicians in other sites of the organization.

On assigning the request to Amy, the technician in Sydney, the SLAs and business rules configurated for Sydney will be applied to the request and the due by time re-calculated. If Amy is assigned to a Group say, Support, then she can view and re-assign the request,

- If Amy is associated to Sydney along with the viewing permissions as 'All in Group and assigned to him', then she will be able to view all the requests raised in the groups to which she is assigned.

- If Amy is associated to Sydney and London with the viewing permission 'All his requests', then she will be able to view only the requests assigned to her. She will be able to re-assign the requests to other technicians in London and Sydney but will not be able to view the request as it does not fall under their permitted scope.
Mobile Client

ManageEngine ServiceDesk Plus mobile client improves the efficiency and productivity of your helpdesk system by providing technicians with the ability to instantly access their tickets while they are away from their desk through their mobile devices. It is a complete browser based web application supporting various request features like viewing tickets, adding a new ticket, closing resolved tickets, assigning tickets, adding work Log, adding resolution and deleting a ticket.

ServiceDesk Mobile Client is compatible with mobile devices such as Blackberry and iPhone, and is accessed through the mobile browser on typing the url http://<machine-name>:<port-number>, which redirects to the 'mc' context.

Features

- A browser based web application to access tickets from any location.
- Supports request module features such as, creating new request, viewing request details, adding resolution to a request, adding worklog, assigning technician to a request, closing completed requests and deleting requests.
- Any actions performed on the requests are based on the Roles assigned to the technicians.

Limitations

- Currently, ServiceDesk Plus Mobile Client supports only request module.
- Editing/Modifying requests cannot be performed.
- Only Technicians can access ServiceDesk Plus mobile client through their hand-held devices.
- Compatible with mobile devices such as Blackberry and iPhone.

Getting Started

On connecting your mobile device to http://<machine-name>:<port-number>, the screen opens to displays the login page.

- **Username:** Username of the technician for the logged server.
- **Password:** Password of the technician for the logged server.
- **For Domain:** Choose the domain of the logged in technician. If the domain is not selected then it is considered as 'Not in any domain'.
- **Is AD Auth:** Select the check box for AD authentication.

Click **Login** button.

**Note:** ServiceDesk Plus Mobile Client does not support Single Sign-On (SSO).
On logging into the application from your mobile device, the home page displays the Dashboard, Requests and Logout options.

- **Dashboard** displays the number of Overdue Requests, Requests Due Today and Pending Requests of the logged in technician.
• Requests displays the request list view with options to select, My Pending requests, All Pending requests and All Requests.

• Log out: to log out from the mobile client.

Dashboard
The dashboard of the logged in technician comprises of the number of all overdue requests, requests due to be completed today and the pending requests. Click on a section to display the list of request under it.

Note: If there are no requests under any section say, there are no pending requests for the logged in technician, then the link to view the pending requests is not available.

To revert back to the Home page click on Home > link or the home icon on the top right corner of the page.

Requests
Selecting Requests from the dashboard takes you to 'My Pending' requests by default. The requests view options comprises of My Pending Requests, All Pending Requests and All Requests.

Note: The request list view and the actions performed on the requests is based on the roles assigned to the logged in technician.
Request List View

Request List View displays the title of the request, requester, status of the request, created date and time, technician assign icon, priority color code, first response time overdue flag, request overdue flag, and first response and resolution overdue flag.

- **Search** - Search for requests on entering the **Request ID** in the Search text field.
- **New** - Create new requests instantly and with ease.
- **Pick** - Pick requests which are unassigned or assigned to other technicians on enabling the check box and selecting Pick.
- **Assign** - Assign requests to other technicians.
- **Close** - Close requests on completion by enabling the check box and selecting Close.
- 🔄 - indicates that first response time of the request is overdue. The first response time is configured in Service Level Agreement.
- 🔄 - indicates that the request is overdue.
- 🔄 - indicates the first response time and the resolution are overdue.

**Technician Assign Icons**

- 👨 - unassigned requests i.e., request is not assigned to any technician.
- 👨 - request is assigned to a technician.
- 👨 - request assigned to the logged in technician.
The request list view displays a total of five requests in a page. You can navigate to other pages using the navigation options below the page. To revert back to the Home page, click the Home > link or the home icon on the top right corner of the page.

Creating a New Request

Requests raised through phone calls can now be instantly created from your hand-held device on entering details such as, requester name, request title and description.

Click New in the request list view page.

- **Requester Name** - name of the requester raising the request. To select and search for available requesters, click Select.
- **Request Title** - a brief summary of the request raised.
- **Description** - a detail description of the request.

Click Add to save and add the request in the request list view.

**Note:**

- Requests cannot be created through Request Template though templates are configured in the server.
- Request details such as request type, priority, urgency, group, category, sub category and item cannot be added while creating a new request.
Viewing Request Details

Click on the request you wish to view from the request list view page. The request details page displays the Request ID, Requester, Status of the request along with the overdue flag, Technician assigned to the request, Due by Time of the request along with the priority color code, Subject and Description.

Click **More details...** link to get the entire detail of the request such as, request type, impact, status, due by time, response due by time and so on.

If the description exceeds 250 characters then *(More...)* link appears. Click the link to view the entire description.

Click **More..** button to add resolution and work Log.

If the request is resolved, click **Close**. Click **Delete** to discard the request completely from the application.
Assigning requests to technicians
If you are assigning requests to technicians using your mobile device, then the list of all the available technicians are displayed. Requests can be assigned to technicians provided the technician is associated to the site where the issue exists.

1. Select the check box beside the request.
2. Click **Assign**. Select the radio button beside the technician.
3. Click **Assign**.

**Note:** An error message does not occur if a request is assigned to a technician with restricted access permission and if the technician is not associated to the site. Instead the request is not assigned to the technician.
Adding Resolution to a request
1. From the request details page, click **More..**
2. Click **Add** beside Resolutions. Enter the resolution in the text field.
3. You can also change the status of the resolution from **Change State to** drop down list.
4. Click **Save**.

Note:
- Resolutions can be added only as plain text.
- Resolutions cannot be created through resolution templates though the templates are configured in the server.
- Resolutions cannot be searched from Solutions module.

Viewing/Editing Resolutions for a request
1. Click **More..** from the request details page.
2. If the resolution is added to the request then the **Edit** and **View** link appears.
3. Click **View** to view the resolution. The resolution along with the technician submitted the resolution is displayed.
4. From the view resolution page, click **Edit** to modify the resolution. You can edit the request from **More..** -> **Edit** link.
5. Edit the content and if necessary change the status.
6. Click **Save**.
Adding Work Log for a request

You can add the time spent details for a request from your mobile device.
Click More.. from the request details page.

- **Technician** - the name of the logged in technician is displayed in a non editable text by default.
- **Time Taken** - the time taken to resolve the request in hours and minutes.
- **Incident Cost** - the Incident Cost is taken from the Time Taken x Technician's cost per hour. The Technician Cost per hour is mentioned while adding a technician under Admin -> Technician.
- **Execution Time** - by default, the execution time displays the current date. Select the date and month from the drop down box.
- **Description** - a description about the time spent entry.

Click Save. The name of the technician along with the time taken to resolve the request and the cost is displayed. To know more on Adding Work Log refer Cost of Request.

**Note:**
- Work Log cannot be added for other technicians.
- The logged in Technician's Cost per hour should be configured in the server.
Problems

Problem Management

This module is available only in the ServiceDesk Plus Enterprise edition.

A problem is an unknown underlying cause of one or more Incidents. The objective of Problem Management is to minimize the adverse impact of Incidents and Problems on the business that are caused by errors within the IT infrastructure, and to prevent recurrence of Incidents related to these errors. In order to achieve this goal, Problem Management seeks to get to the root cause of Incidents and then initiate actions to improve or correct the situation.

The Problem Management process has both reactive and proactive aspects. The reactive aspect is concerned with solving Problems in response to one or more Incidents. Proactive Problem Management is concerned with identifying and solving problems and known errors before incidents occur in first place.
Creating a New Problem

The goal of problem management is to minimize the adverse impact of incidents and problems on the business that are caused by errors within the IT infrastructure and to prevent recurrence of incidents related to these errors.

Add New Problem

The new change form can be accessed by two ways in SupportCenter Plus application,

a. Quick Actions drop down
b. Problems tab

Quick Actions drop down

The quick actions drop down is a quick navigator to instantly access the New Problem form. Click Quick Actions -> Problem under Create New block.

Problems Tab

1. Click the Problems tab in the header pane.
2. Click the New Problem button to open the New Problem form.
3. Specify the user who has requested the problem in the Requested By field. You can also select the user by conducting a search in the requesters list using the icon.
4. Select the Technician from the drop down. If you have configured Sites in the application, then Sites drop down appears. Select the Site in which the problem has occurred. The Technicians associated to the sites gets listed in the technicians drop down.
5. Select the Category, Sub Category and Item from the drop down.
6. Select the **Status** of the problem, say **Open** from the drop down.

7. Select the **Impact, Urgency and Priority** of the problem from the drop down.

8. Select the **Due by Date** and the **Closed Date** from the calendar button.

9. Select the affected **IT Services** from the list by clicking on the icon. This opens the **Services Affected** pop up box as shown below. Select the affected IT services and **Save** the changes.

11. Select the **Assets Involved** with the problem by clicking the icon. The **Select Assets** page pops up. Select the asset category from **Type of Assets** drop down. Say, Workstations, Printers, Routers, Switches, all assets, all site assets and so on. **All Assets** lists the assets within your permission scope. Say, John, a technician, is associated to Site1 and Site2. John has the privilege to view the assets associated to Site 1 and Site 2. So, if John is creating a problem arising in Site 1, the **Type of Assets - All Site Assets** lists the assets available only in the selected Site 1 and **All Assets** lists the assets available in Site 1 and Site 2. Select the **Available Assets** under the selected type from the list and move to **Assets involved** using >> button. Click **Save**.

12. Specify the **Title** of the problem. The title is a mandatory field.

13. Specify the details of the problem in the **Description** field.

14. If you have any file attachments for the problem click **Attach File** button and attach files. Maximum size of an attachment can be 100 MB.

15. **Save** the details.
Viewing Problem Details

1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.
2. Click the Problems tab. This opens the problems list view page.
3. Click the Title of the problem to view the problem details. This opens the problem details page. By default the problem details page opens in the Problem tab. From the problem details page, you can navigate to the previous or the next problem using the navigation buttons on the top right hand side corner. Using this, you need not return back to the list view page to view the next problem.

**Problem Tab**
The problem tab shows general details of the problem such as, Category, Technician, Status, Priority, Urgency, Impact, Requester, Reported Date, Due By Date, Closed Date, affected IT Services and Assets Involved.

Click the **Edit** button to edit all the details of the change. You also have inline edit option for all the details. To modify the details of the problem click the details and choose the option from the combo box.

**Analysis Tab**
In the Analysis tab the technicians analyze the root cause and impact of the problem and attach the same in SDP as part of the problem. Also they specify the symptoms of the problem to identify the same problem in the future.

**Solution Tab**
In the solutions tab resolution for the problem is given as Work Arounds and Solutions. Work Arounds are temporary solutions that can be used by the technician till the actual solution is ready. Solutions are the permanent fixes to the problems raised.

**Incidents Tab**
The incidents tab shows the list of all associated incidents with the problem. You have **Attach** option to attach the incident with the problem. And the **Detach Incidents** option to detach associated incidents with the problem.

**History Tab**
The History tab shows the problem history from the time of its creation. It shows all the actions performed in the problem. The history tab also shows the incidents and the changes associated to the problem on clicking the **Property View** link available on the right hand side. The details that are displayed in the history are in the ascending order with the earliest performed action shown at the top of the page and the latest action at the bottom of the page.
Editing a Problem

To edit a problem available in the ServiceDesk Plus Problem module

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Problems tab in the header pane. This opens the problems list view page.
3. Click the Title of the problem which you want to edit. This opens the Problem details page which list the Tasks that can be performed on the problem.
4. Click the Edit link on the top of the page to modify the problem details. This opens the Edit Problem page. From this page you can add status of the problem from open to close, and also change the entire template to a new one apart from the regular editing of the problem details.

Alternatively, you also have an inline edit option to modify the problem details in the view problem page. Click the edit icon on the right side of each block which opens the problem form fields in editable format. After modifying the values, save the changes. This comes in handy when you need to edit the values of the entire block say Problem Details one by one.

Modifying the Problem Details
In the editable problem form you can change the problem details, such as Status of the problem as Closed or Open, Impact details, Urgency and Priority details. You can also modify affected IT Services and Assets Involved in the problem.

Modifying Owner Details
You can modify the owner details and technician details of the problem. If you have configured Sites in the application, then Sites drop down appears. You can modify the site in which the problem has occurred. The corresponding technicians associated to the site is listed. You can also edit the Reported Date and Due by Date of the problem. If the problem has been closed, then the Closed date will be displayed beside this due by date.

Modifying the Problem Category
You can change the Category, Sub Category and Item of the problem. If the same was not appropriately chosen at the time of submitting then the problem can be selected now from the drop down list.

Modifying the Problem Description
You can modify the title and description of the problem to completely capture the actual nature of the task at hand.

Appending Attachments
If you wish to attach more files to the problem, click the Attach a File button and attach as many files as you wish and click Done. You can also delete the attachments that were already available in the problem by clicking the delete icon available beside the attachment.
Closing Problem

If a requester is completely satisfied that his/her problem has been attended and completely solved, then the problem can be closed.

To close a problem

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the Title of the problem in the Problems list page. This opens the problem details page.
4. Click the Close Problem link under the Tasks block. This closes the problem.

**Note:** If the mandatory fields are not entered then an error message is shown asking you to enter the value in the fields.

You can reopen a problem from the closed state to open state. To do this, open the closed problem that you wish to reopen by clicking the edit button. Then change the status field from Closed to Open and save the changes. When a problem is opened from the closed state, you can change the Due By time of the problem. Also, the closed date is removed once the request is reopened. When this request is finally closed, the completed date is updated and the time taken to close is recalculated taking the reopened period into account.

To close more than one problem at a time

1. In the Problem list page, select the problem from the list by enabling the check boxes available beside the Problem Name.
2. Now click the Close button.

To view the closed requests

1. From the Problem list page, select Closed Problems from the Filter drop-down menu. This lists all the closed problems.
2. To view the closed problems which were assigned to you, select My Closed Problems.
Picking Up Problem

ManageEngine ServiceDesk Plus provides an option to the technicians to self-pick up problem. If there are unassigned problems, the technicians can pick up any of the unassigned problems from the list. As the problems are picked up and answered quickly the waiting time to assign the problem to each technician and then closing the problem will be reduced. This in turn will increases the turnaround time and the efficiency of the IT help desk team.

To pick up problems,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Problems tab in the header pane. The unassigned problems will be in bold font.
3. Select the problems you would like to pick up by enabling the check box. Click Pick up button. The selected problem will be assigned to you. (Or)
4. You can also pick up problems after viewing the problem details. Click the title of the problem to open View Problem page.
5. Click Assign tab. Select Pick Up option to pick up the problem.
Assigning Technician

Each problem will be handled by a technician, who would be responsible for closing the problem.

To assign a technician to the problem,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Problem tab in the header pane. This opens the Problems list page.
3. Click the Title of the problem for which you have to assign a technician. This opens the problem details page.
4. Click the Actions combo box on the right hand side of the page -> Click Assign Technician link from the list. This opens Assign Technician to this Problem pop up page as shown below. Select the technician from the list and Assign the problem to the technician.

5. Alternatively, you can also assign technician using inline edit option. Click the technician name shown in the problem details block. This opens the drop down box as shown below. Select the technician from the list and click the icon to select the technician name else click cancel icon.

You can also assign more than one problem at a time to a technician.
To bulk assign problems to technicians

1. In the **Problems** list page, select the problems to be assigned a technician by enabling the check box beside left side each of the problem title.

   ![My Open Problems](image)

   - **Select Technician**
   - **Assigned To**: John Roberts
   - **Category**: Routers
   - **Priority**: High

2. Click the **Select Technician** check box. Select the technician from the drop down list.

3. **Assign** the technician.
Problem Analysis

The goal of Problem Management is to find the root cause of the incidents and reduce the impact on the business by providing solutions and workarounds. In the problem analysis the technicians analyze the root cause and impact of the problem and attach the same in SDP as part of the problem. Also they can specify the symptoms of the problem to identify the same problem in the future. The following are the steps to understanding the cause of the problem,

- Symptoms - Evidences helping in identifying the problem.
- Root Cause - Detecting the underlying cause of the incident.
- Impact - Adverse effect of the problem on the business.

To specify the Problem Analysis,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Problems tab -> click the title of the problem for which you need to specify the analysis. This opens the problem details page.
3. Click the Analysis tab.

Adding Impact details,

1. Click the Add button. You can see the text area getting displayed for the impact details.
2. Specify the impact details in the text field and Save the changes. You can see the details getting displayed below the title. (OR)
3. If you like to attach a file on the impact details instead of entering the details in the text field then click Attach File button to attach a file for the impact details. The maximum size of the attachment should be 10MB.

Adding Root Cause,

1. Click the Add button. You can see the text area getting displayed for the root cause.
2. Specify the root cause in the given text field and Save the changes. You can see the details getting displayed below the title. (OR)
3. If you like to attach a file on the root cause instead of entering it in the text field then click Attach File button to attach a file for the root cause. The maximum size of the attachment should be 10MB.

Adding Symptoms,

1. Click the Add button. You can see the text area getting displayed for the symptoms.
2. Specify the symptoms in the given text field and Save the changes. You can see the details getting displayed below the title. (OR)
3. If you like to attach a file on the symptoms instead of entering it in the text field then click Attach File button to attach a file for the symptoms. The maximum size of the attachment should be 10MB.
Problem Solutions

Resolution for the problem can be given as Work Arounos and Solutions in ServiceDesk Plus. Workarounds are temporary solutions that can be used by the technician till the actual solution is ready. Solutions are the permanent fixes to the problems raised. The problem is considered as a known error when a solution or work around is added to a problem.

To add resolution,
1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.
2. Click the Problems tab. This opens the problems list page.
3. Click the Title of the problem for which you like to view the reminder. This opens the problem details page.
4. Click the Solution tab.

To Add Work Around,
1. Click the Add button. You can see the text area getting displayed for the WorkAround details. Specify the temporary solutions for the problem.
2. Save the details. You can see the details getting displayed.
3. Click Attach File button to attach a file for the impact details. The maximum size of the attachment should be 10MB.

To Add Solution
1. Click the Add button. You can see the text area getting displayed for the Solution details. Specify the permanent fixes to the problems.
2. Save the details. You can see the details getting displayed.
3. Click Attach File button to attach a file for the impact details. The maximum size of the attachment should be 10MB.
Adding Notes

If you like to add additional information including technical information based on your observations to a particular problem, then you can Add Notes to that problem. You can also use notes to update the status of the problem.

To add a note to the problem,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the Title of the problem to which you would like to add a note. This opens the problem details page.
4. Click the Add New combo box -> Select Note option. This opens Add Notes page as shown below,

5. Enter your content in the text box. These notes are public.
6. Save the details. The note is added at the bottom of the problem along with a date and time stamp. The name of the person who added the note is also displayed.

You can add any number of notes to a problem. The added notes will be displayed in the ascending order. You can also edit or delete the notes that have been added.
Adding Tasks

Using this option you can assign different tasks to different technicians. Task is a sub-unit of an activity. If a problem involves multiple technicians work, then the technician whoever receives the problem (owner of the problem) can assign different tasks to different technicians.

To add tasks,
1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the **Problems** tab in the header pane.
3. Click the **Title** of the problem to which you would like to add tasks.
4. Click the **Add New** menu -> select **Task** option. This opens the **Tasks** window.
5. You can either select the task template from **Select Template** drop down list or you can add a new task.
6. Specify the **Title** of the task in the given text field. This is a mandatory field.
7. Specify relevant information about the tasks in the **Description** field.
8. Select the **Scheduled Start Time** from the calendar button. Also select the **Scheduled End Time** for the task from the calendar button.
9. The **Actual Start Time** and **End Time** of the task will be entered by the technician doing (owning) the task.
   The actual start time and end time is the real time schedule of the task. The scheduled start time and end time specified by the problem owner is a tentative time schedule.
10. Select the **Group** to which the task needs to be assigned. Select the **Technician** of the task from the combo box. Tasks can be assigned either:
   - to a Group alone,
   - to a Group and corresponding technician from the group,
   - to a Technician alone,
   - to no Group and Technician.
11. Specify the **Status** of the task.
12. Specify any relevant comment about the task in the **Comments** field.
13. If you wish to be reminded of the task previously then select the **Email me before** option and select the number of days from the combo box. This option will be selected based on the scheduled start time.
14. **Save** the values. You can see a Tasks tab getting created next to the solution tab. All the tasks created for the problem will be listed under the tasks tab in descending order. The tasks assigned to other technicians can be viewed in their **Task summary list** in the home page.

Adding Bulk Task to a problem

Certain problem may require more than one task involving different technicians. In this case, rather than adding tasks one by one, you can add bulk tasks to the problem from the task template.

1. From the problem details page, click the **Task** tab. The task details page opens.
2. Click **Add Task from Template** button. The Task Template window pops up listing all the active templates.
3. Select the check box beside the templates and click **Add Template** button. The tasks selected are added under Task Details.
Deleting Tasks

1. From the tasks details page, select the check box beside the task you wish to delete.
2. Click the **Delete** button. A confirmation message appears.
3. Click **Ok** to continue. The task is deleted from the list.
Adding Work Logs

You can enter the technicians time spent details for the problem using this option. The total time spent will exclude the time that the problem was kept on hold. It takes the time of creation to till the problem was closed.

To Add Work Logs,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Select the Technician Name from the combo box.
3. Specify the Executed Time (date & time) taken to resolve the problem from the calendar button.
4. The Technician Cost per hour will be fetched automatically from the technician details, which is a non-editable field. If you have already entered the per hour cost of the technician while adding the technician details, then the details will be fetched automatically. If you wish to change these values, you can do so manually.
5. The Incident Cost will be automatically calculated taking the (total time spent to resolve the problem * Technician's cost per hour).
6. If there are any extra charges specify in the Other Charges field.
7. Using the above two data the Total Charges (Technician Charges + Other Charges) will be displayed automatically.
8. Specify any relevant information about the time spent in the description field.
9. Save the details.

---

**Add Work Log**

* Technician Name: administrator

Executed Time: 3 Aug 2007 15:17:59

Time Taken To Resolve: 5 Hours 20 Minutes

Technician's Cost per hour ($) : 55.0

Incident Cost ($) : 293.33

Other Charges ($) : 25

Total Charges ($) : 318.33

Description

---

ZOHO Corp.
Deleting Problem

You have an option to delete individual problems or group of problems together.

To delete individual problems
1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the Title of the problem to be deleted in the problems list view page. This opens the Problem Details page.
4. Click the Actions combo box on the top right hand side of the page.
5. Click the Delete link from the list. A dialog pops up asking you to confirm on the delete process.
6. Click OK to proceed. You can see the problem deleted from the list.

To delete more than one problem at a time
1. In the Problem list view page, select the problems to be deleted by enabling the check boxes.
2. Click the Delete button. A dialog pops up asking you to confirm on the delete process.
3. Click OK to proceed deleting Or click Cancel to abort deletion.
Associating Incidents to a Problem

You have an option to associate Incidents to the problem. Similar Incidents to problem can be associated in order to track the number of incidents occurred for the same problem and also to track the priority and severity of the problem based on the number of incidents.

To Associate Incidents,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Problems tab. This opens the Problem List View page. Click the problem title to be associated with the Incidents. This opens the problem details page.
3. Click the Actions combo box on the top right side of the page. Click Associate Incidents option. This opens Associate Incidents to problem page as shown below,

   4. Select the type of requests to be displayed by selecting from the Show combo box on the top left hand side of the page. Ex: Open Requests or All Requests and so on. On selecting the request type the corresponding requests gets listed.
5. Select the Incidents from the list by enabling the check box beside each incident.
6. Click Associate Incidents to associate respective requests to the problem (particular selected problem). The associated incidents gets listed in the Incidents tab in the problem details page as shown below,

   ZOHO Corp.
Associating Changes to Problem

You have an option to associate Changes to the problem. Similar Changes to problem can be associated in order to track the number of changes occurred for the same problem.

To Associate Changes,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Problems tab. This opens the Problem List View page.
3. Click the problem Title to be associated with the Incidents. This opens the problem details page.
4. Click the Actions combo box on the top right side of the page. Click Search Changes option. This opens Associate Problem to Changes page as shown below,

<table>
<thead>
<tr>
<th>Title</th>
<th>Technician</th>
<th>Category</th>
<th>Priority</th>
<th>Change Type</th>
<th>Change Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample Problem</td>
<td>radhika</td>
<td>-</td>
<td>Medium</td>
<td>Major</td>
<td>Requested</td>
</tr>
<tr>
<td>Mouse</td>
<td>radhika</td>
<td>Desktop Hardware</td>
<td>Medium</td>
<td>Significant</td>
<td>Requested</td>
</tr>
<tr>
<td>Router Change</td>
<td>Shawn Adams</td>
<td>-</td>
<td>High</td>
<td>Standard</td>
<td>Requested</td>
</tr>
<tr>
<td>Network Change</td>
<td>John Roberts</td>
<td>Network</td>
<td>High</td>
<td>Minor</td>
<td>Approval</td>
</tr>
<tr>
<td>New change for</td>
<td>scan</td>
<td>-</td>
<td>Normal</td>
<td>Major</td>
<td>Approved</td>
</tr>
<tr>
<td>Need to go for</td>
<td>Howard Stern</td>
<td>-</td>
<td>Medium</td>
<td>Standard</td>
<td>Requested</td>
</tr>
</tbody>
</table>

Select the type of change to be displayed by selecting from the Filter Showing combo box on the top left hand side of the page. Ex: Open Change or All Change and so on. On selecting the change type the corresponding changes gets listed.

Select the Changes from the list by enabling the check box beside each change.

Click Associate button to associate respective changes to the problem (particular selected problem).
Adding Reminders

You can add reminders to the problems using this option. All the pending tasks specific to the problem can be added as reminders. The technician can add these task list as a personal reminder to himself/herself. On adding these reminders they get displayed in My Reminder(s) under Quick Actions.

To add reminders,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Problems tab in the header pane. This opens the problems list page.
3. Click the Title of the problems from the list. This opens the problems details page.
4. Click on the Add New combo box on the top right side of the page. Click the Reminder link. This opens the Reminders page. Specify the content in the given text field.
5. Select the reminder Date and Time by invoking the calendar icon.
6. To be reminded of the task in advance, select the time from the Email me before combo box.
7. The problem id is shown in non editable mode.
8. Click Add button to add the reminder. You can see the reminder getting listed in the My Reminder(s) pop up window in ascending order.
Viewing Reminders

You can view the reminders specific to each problem in this module.

To view reminders,
1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.
2. Click the Problems tab. This opens the problems list page.
3. Click the Title of the problem for which you like to view the reminder. This opens the problem details page.
4. Click the Actions combo box -> Click the View Reminders option. This opens the Showing All Reminders Page as shown below. This lists all the reminders in ascending order based on the date.

5. Once the task is completed you can change the state of the reminder from open to completed. To do this, select the reminder from the list to be closed by enabling the check box beside each of the reminder.
6. Select the Change Reminder State To Completed then -> click Change button to change the state. You can see the reminder struck off to indicate the change. Alternatively, you can also view the reminders by, clicking Quick Actions link -> My Reminder(s) option under the Reminders block. This opens the My Reminders pop up window as shown below. This shows all your reminders irrespective any specific module.

You can also add new reminders by clicking +Add New link at the bottom of the my reminders form.
The new task is added and is listed along with the already existing tasks in the ascending order based on date and time.

When you have completed the task, you can just strike out the task to indicate that it is completed by selecting the radio button beside the task summary.

You can also delete the task by clicking the delete icon beside the task.
Publishing Announcements

ServiceDesk Plus gives you an option to publish announcements while fixing the problem without breaking the work flow. Say if you want to inform the company that, the mail server will be down for next five hours and your are fixing the problem then in this case you need not go to the home page to make an announcement you can publish the announcement from the problem module.

To Publish Announcements,

1. In the Problem details page click the Actions combo box and select the Make an announcement option. This opens the Add New page.
2. The announcement Title and Description of the problem gets displayed automatically. This is a mandatory field. You can also modify the title and description of the problem.
3. Specify any relevant information about the announcement in the Description field. Also specify the result under the Resolution title.
4. Specify the date and time to Show this announcement, between these dates from the calendar button. If this field is not entered the announcement will be displayed in the dashboard for ever.
5. To Show this announcement only to technicians select the check box.
6. To Send this announcement as mail select the check box.
7. Save the changes. You can see the announcement page as shown below. To view the next and previous announcement in the dash board click the Next and Previous buttons on the right side of the page.

You can also edit and delete the announcement in the same page.

To edit the announcement,

1. Click Edit button. This opens the Edit Announcement form.
2. Change the details of the announcement in form.
3. Save the changes. All the changes made in the announcement will be saved.
To delete an announcement,

1. To delete the announcement click **Delete** button. A dialog pops up asking you confirm on the delete operation.
2. Click **OK** to delete. Or click **Cancel** to retain the announcement.

Alternatively you can also publish announcements company wide or just to the technicians group from the **Home page**. The announcements are displayed just below the my view requests tab in the home page as shown below,

All recent announcements will be displayed first based on the date. To view all the announcements (even completed ones), click the **Show All** button on the right side of the page.

<table>
<thead>
<tr>
<th>Announcement</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Upgrade</td>
<td>Mail Server will be down for next 5 hours</td>
<td></td>
</tr>
<tr>
<td>Routers Change</td>
<td>Upgradation of 800 series routers to 1200 series routers</td>
<td></td>
</tr>
<tr>
<td>Printer will not be available</td>
<td>Resolution :null</td>
<td></td>
</tr>
</tbody>
</table>

To add a new announcement

1. Login to ServiceDesk Plus using the administrator / technician user name and password.
2. In the login home page, if you have permissions to add an announcement, you will notice the **Add New** button in the announcements box as shown above. Click the button. The **Add New Announcement** dialog pops up.
3. Enter the Announcement Title. This can be a short statement that describes the announcement.
4. Type the **Announcement Content** in the text box provided for the same.
5. Select the **From** date and **To** date using the calendar icon beside the respective fields.
6. If you wish to publish the announcement only to the technicians and do not wish to expose it to your requesters, then select the check box **Show this announcement only to technicians**. The announcement will be displayed in the home page with a lock beside it.
7. If you wish to **Send this announcement as mail** then select the corresponding option by enabling the check box.
8. Click **Save**. At any point of time, you do not wish to add the announcement, click **Cancel**.

The announcement will be added and the pop-up will display the announcement details as entered by you. The announcement title will be displayed in the login home in bold text in the announcement box with a new icon beside it.
Printing Problem

To print a problem,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Problems tab in the header pane.
3. Click the Title of the problem you would like to print.
4. Click the Print Preview link on the right side Tasks block. The print preview page of the problem opens in a pop-up window.
   In the print preview page you can view the Impact Analysis, Root Cause, Symptoms, WorkAround, Solution, Problem Details Notes and their attachments.
5. Click the Print menu item from the browser File menu.
6. The default printer associated with your workstation is invoked. Set the required options and click OK. You can collect the printed copy of the problem at the printer that is linked to your workstation.
Send Notifications

To send notifications specific to the problem to the CAB members, technicians or to any concerned person then,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Problems tab in the header pane. This opens the problem list view page.
3. Click the title of the problem to which the notification has to be sent. This opens the problem details page.
4. Click the Actions combo box and select the Send Notification link. This opens the Send Notification page.
5. Specify the To and CC address in the given text field.
6. Specify the Subject of the notification in the given text field.
7. Specify relevant information about the notification in the Description field.
8. Send the notification.
Changes

Change Management

Changes arise as a result of problems. But, a lot of changes can come from pro-actively seeking business benefits such as reducing costs or improving services. The goal of Change Management is to ensure that standardised methods and procedures are used for efficient, and prompt handling of all changes, in order to minimise the impact of change-related incidents upon service quality and consequently to improve the day-to-day operations of the organization.

The change is initiated by creating a change request, entering values in the defined additional fields, selecting the time duration and assigning the change to a technician. The status of the change is updated at every stage by the technician handling the change. The Approval Status is set to 'Pending Approval', when the change is sent for recommendation to the CAB members. The Approval Status is an automated and sets the status to "Approved" or "Rejected".

Since the change request is initiated from one or more Problems, the related Incidents and Problems are associated with the change. A Change Plan is formulated to get started with the change process. After which, tasks are assigned to various technicians to go ahead with the change. A Work Log is entered by the technicians specifying the time taken to resolve the change, the cost of the incident and the total charges.

Changes are site specific, meaning, a change is intended to occur in a particular site which should be handled by technicians associated to that site. Technicians an view the changes made at a site to track any likely cause of future problem.

A change request entails a considered approach to assessment of risk and business continuity, change impact, resource requirements and change approval. This approach is important to maintain the balance between the need for change against the impact of change.
Creating New Change

Changes arise as a result of problem and hence there are different types of changes that can occur in an organization. The change can be Major, Minor, Standard, Significant or a configured change type. To initiate a change, a request for change has to be sent to the change management team upon which specific actions and tasks are carried out.

Add New Change

The new change form can be accessed by two ways in SupportCenter Plus application,

a. Quick Actions drop down
b. Changes tab

Quick Actions drop down

The quick actions drop down is a quick navigator to instantly access the New Change form. Click Quick Actions -> Change under Create New block.

Changes tab

1. Click on Changes tab in the header pane to open the change list view page.
2. Click New Change button to access the new change form.
3. Specify the user who has requested the change in the Requested By field. You can also select the user by conducting a search in the requesters list using the icon 📐.
4. Select the Technician assigned to the change from the drop down. If you have configured Sites in the application, then Sites drop down appears. Select the Site for which the change is intended to occur. The Technicians associated to the selected site is listed in the technicians drop down.
5. Select the Category, Sub Category and Item from the drop down.
6. Select the Status of the change from the drop down. The status is updated at every stage by the technician handling the change.

ZOHO Corp.
7. Select the **Impact, Urgency and Priority** of the change from the drop down.

8. Select the **Change Type** from the combo box. Say Major.

9. Select the **Scheduled Start Time** and **Scheduled End Time** from the calendar button.

10. Select the affected **IT Services** by the change from the list by clicking on the icon. This opens the **Services Affected** pop up box as shown below. Select the affected IT services and **Save** the changes.

![Services Affected](image)

11. Select the Assets Involved with the change by clicking the icon. The **Select Assets** page pops up. Select the asset category from **Type of Assets** drop down. Say, Workstations, Printers, Routers, Switches, all assets, all site assets and so on. **All Assets** lists the assets within your permission scope. Say, John, a technician, is associated to Site1 and Site2. John has the privilege to view the assets associated to Site1 and Site2. So, if John is creating a change arising in Site1, the Type of Assets - All Site Assets lists the assets available only in the selected Site1 and All Assets lists the assets available in Site1 and Site2. Select the **Available Assets** under the selected type from the list and move to **Assets involved** using >> button. And **Save** the changes.

12. Specify the **Title** of the change. The title is a mandatory field.

13. Specify the details about the change in the **Description** field.

14. If you have any file attachments for the change click the **Attach File** button and attach files. The maximum size of an attached file can be 10MB.

15. **Save** the details. You can see the new change created in the change list view page.
Forward Schedule of Change

The change home page shows two types of views, **List View** and **Calendar View**. The list view shows the list of all changes to be made. And the Calendar View shows the changes with start & end schedule time marked in different colors based on the type.

To view the schedule,

1. Log into ServiceDesk Plus using your **user name** and **password**.
2. Click the **Changes** tab in the header pane. This opens the change list view page by default as shown below.

**List View**

<table>
<thead>
<tr>
<th>Title</th>
<th>Technician</th>
<th>Category</th>
<th>Priority</th>
<th>Change Type</th>
<th>Change Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routers Change</td>
<td>Shawn Adams</td>
<td>-</td>
<td>High</td>
<td>Standard</td>
<td>Requested</td>
</tr>
<tr>
<td>Network Change</td>
<td>John Roberts</td>
<td>Network</td>
<td>High</td>
<td>Minor</td>
<td>Approval</td>
</tr>
<tr>
<td>Fix Share for servers</td>
<td>John</td>
<td>-</td>
<td>Normal</td>
<td>Major</td>
<td>Approved</td>
</tr>
<tr>
<td>Need to go for newer PC</td>
<td>Howard Stern</td>
<td>-</td>
<td>Medium</td>
<td>Standard</td>
<td>Requested</td>
</tr>
<tr>
<td>Change mouse</td>
<td>Heather Graham</td>
<td>-</td>
<td>Medium</td>
<td>Major</td>
<td>Requested</td>
</tr>
<tr>
<td>Change keyboard</td>
<td>Shawn Adams</td>
<td>-</td>
<td>Medium</td>
<td>Significant</td>
<td>Requested</td>
</tr>
</tbody>
</table>

**Forward Schedule of Change (Calendar View)**

1. Click the **Calendar View** tab next to the list view tab in the home page. This opens the calendar view of change as shown below.

To display the changes in the **Calendar View**, the changes should have the scheduled start time and end time.
The Calendar View displays all the scheduled changes for the entire month. Click the forward arrow to go to the next month. Click the backward arrow to go to the previous month.

You can choose the type of change from the Filter Showing combo box. You can view the Open Changes, Approved Open Changes, All Changes and Completed Changes.

If Sites is configured in the application, then the Site drop down appears. List of sites associated to the logged in technician appears. Here, the logged in technician can view the sites to which he is associated and the changes raised for a specific site.

A thick strip will be running across the scheduled start date and end date of the change. The outward curve (Change regarding) at the beginning of the strip indicates the start date. And the inward curve (Change regarding) at the end of the strip indicates the end date.

The color of the strip depends on the type of the change. Say standard, major, minor and so on.

At the bottom of the page you have all the four change types with one N/A type displayed along with the check boxes. For ex: If you wish to view only the standard changes for the month in the calendar view, then select the Standard check box and de-select the other change types. If you wish to view all the change types then select all the change type by enabling the check box.

The backward arrow in the strip indicates the previous week continuation of the change.

And the forward arrow in the strip indicates that the change will be continued for the next week.

On clicking at any part of the strip you will be able to view the change details page as shown below.

In the change details page,

- If there are any tasks associated with the change then the task status bar will also be displayed.
- If all the tasks are completed then the status bar would be in green color.
Out of two tasks, if one task is complete and the other task is incomplete then the status bar would show half green color.

You will be able to view the number of tasks completed / the total number of tasks. Say 1 tasks completed out of 2 tasks.

You will also be able to see the Status of the task and owner at the bottom of the page. If the status is completed then the bullet point would be in green color. If the status of the task is incomplete then the bullet point would be in red color.

- The calendar can show only three changes in a particular date. If there are more than three changes in a date, then the calendar will show the extra more changes in the text form as +n more as shown below.

```
22
works.
Change regarding
+1 more
```

- Clicking the + n more text link, will list all the displayed changes in the calendar, plus the extra more changes in the left hand side of the page as shown below. They can also be viewed by clicking the dates of the marked changes in the calendar. Say by clicking the date 22 you will be able to view the list.

- A calendar on the top left hand side of the page, shows the current date marked in a box. All the changes in the current month will be underlined and bold. On clicking any of the underlined date will list all the scheduled change for the particular date below the calendar.

```
A calendar on the top left hand side of the page, shows the current date marked in a box. All the changes in the current month will be underlined and bold. On clicking any of the underlined date will list all the scheduled change for the particular date below the calendar.
```

- Click the Week link at the Top of the page to view the weekly change schedule as shown below. Click the forward arrow to view next week change schedules. Click the backward arrow to view the previous week change schedules.
<table>
<thead>
<tr>
<th>Change</th>
<th>Sunday</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
<th>Friday</th>
<th>Saturday</th>
</tr>
</thead>
<tbody>
<tr>
<td>change keyboard</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Routers Change</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>change mouse</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Need to go for newer firewall for the corporate website</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New change for corporate website</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network change</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>close all the tasks</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

UnAssigned     Minor     Major     Standard     Significant
Viewing Change Details

1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.
2. Click the Changes tab. This opens the changes list page.
3. Click the title of the change to view the change details. This opens the change details page. By default the change details page opens in the General tab.

General Tab
The general tab shows general details of the change such as, Category, Technician, Status, Priority, Urgency, Type, Impact, Requester, Start Time, End Time, affected IT Services. The Status field holds the state of the change such as Requested, Approved, Implemented, Reviewed and Closed. The approval status denotes whether the change is approved or rejected. The change will be considered as approved and listed in the change calendar only if the Approval Status is 'Approved'. The approval status is given in non-editable mode.

Click the Edit button to edit all the details of the change. You also have inline edit option for all the details. To modify the details of the change click the details and choose the option from the combo box.

Problems Tab
The problems tab shows the list of all the associated problems with the change. You have Attach option to attach the problem with the change. And the Detach Problem option to detach associated problem with the change.

Incidents Tab
The incidents tab shows the list of all associated incidents with the change. You have Attach option to attach the incident with the change. And the Detach Incidents option to detach associated incidents with the change.

Planning Tab
The planning tab shows the planning phase of the change on how to go about the change. It shows the Impact details, Roll Out, Back Out plan and finally the Check List for the plan.

Approvals Tab
From the Approvals tab, the administrator can Add CAB Members and Send the change for Recommendation to the CAB members. Thus it helps to show the approval status of the change.

Implementation Tab
Implementation page shows the task details of the change and the work log details of the change. You can also add, edit and delete new Task and new Work Log details.

Review Tab
From the review tab you can add post change assessment details or the evaluation results on how the change is made details are specified. It is basically a recap of the change.
To add review details Click the Add button. This opens the review text box.
Specify the details in the text box and **Save** the details. You can see review details getting displayed under the title. And the name of the person who entered the details with date and time will be displayed on the right hand side of the page.

To edit the review details click the **Edit** button next to the title. Edit the details and save the changes.

If you would like to attach a file on the review details of the change, click **Attach a File** option and attach files.

**History Tab**

The **History** tab shows the change history from the time of its creation. It shows all the actions performed in the change. The history tab also shows the incidents and the changes associated to the problem on clicking the **Property View** link available on the right hand side. The details that are displayed in the history are in the ascending order with the earliest performed action shown at the top of the page and the latest action at the bottom of the page.
Editing a Change

To edit the change available in the ServiceDesk Plus,

1. Click the Changes tab in the header pane. This opens the changes list view page.
2. Click the Title of the change to be edited. This opens the change details page which list the Tasks that can be performed on the change.
3. Click the Edit link on the top of the page to modify the change details. This opens the Edit change page. From this page you can add status of the change from open to close, and also change the entire template to a new one apart from the regular editing of the change details.

Alternatively, you also have an inline edit option to modify the change details in the view change page. Click the edit icon on the right side of each block which opens the change form fields in editable format. After modifying the values, save the changes. This comes in handy when you need to edit the values of the entire block say change Details one by one.

Modifying the Change Details

In the editable change form you can change the change details, such as Status of the change as Closed or Open, Impact details, Urgency, Priority and Change Type details. You can also modify affected IT Services and Assets Involved in the change.

Modifying Owner Details

You can modify the Requested by details and Technician details of the change. If you have configured Sites in the application, then Sites drop down appears. You can modify the site for which the change is intended to occur. The corresponding technicians associated to the site gets listed. You can also edit the Scheduled Start Time and Scheduled End Time of the change.

Modifying the Change Category

You can change the Category, Sub Category and Item of the change. If the same was not appropriately chosen at the time of submitting then the change can be selected now from the drop down list.

Modifying the Change Description

You can modify the title and description of the change to completely capture the actual nature of the task at hand.

Appending Attachments

If you wish to attach more files to the change, click the Attach a File button and attach as many files as you wish and click Done. You can also delete the attachments that were already available in the change by clicking the delete icon available beside the attachment.
Printing Change

To print a change,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Changes tab in the header pane.
3. Click the **Title** of the change you would like to print.
4. Click the **Print Preview** link on the right side **Tasks** block.
   
   In the print preview page you can view the Impact Analysis, Roll Out Plan, Back Out Plan, Checklist and Review. Then the Change details, Approval status and Notes and their attachments.
5. The print preview page of the change opens in a pop-up window. Click the **Print** menu item from the browser **File** menu.
6. The default printer associated with your workstation is invoked. Set the required options and click **OK**. You can collect the printed copy of the change at the printer that is linked to your workstation.
Adding Notes

If you would like to add additional information including technical information based on your observations to a particular change, then you can Add Notes to that change. You can also use it to update the status of the change. These notes cannot be added by the requesters. The requesters can only view the notes.

To add a note to the change,

1. Log in to the ServiceDesk Plus application.
2. Click the Change tab in the header pane.
3. Click the Title of the change to which you would like to add a note. This opens the change details page.
4. Click the Add New combo box -> Select Note option. This opens Add Notes page as shown below,

![Add Notes](image)

5. Enter your content in the text box. These notes will be added to the change only by the technicians. The requesters will not be able to add the notes. These notes are public.
6. Save the details. The note is added at the bottom of the change along with a date and time stamp. The name of the person who added the note will also be displayed.

You can also add any number of notes to a change. The added notes will be displayed in the descending order with recently added note first. You can also edit or delete the notes that have been added.
Adding Reminders

You can add reminders to the changes using this option. All the pending tasks specific to the change can be added as reminders. The technician can add these task list as a personal reminder to himself/her. On adding these reminders they get displayed in My Reminder(s) under Quick Actions.

To add reminders,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Changes tab in the header pane. This opens the changes list page.
3. Click the Title of the change from the list. This opens the change details page.
4. Click on the Add New combo box on the top right side of the page. Click the Reminder link. This opens the Reminders page. Specify the content in the given text field.
5. Select the reminder Date and Time by invoking the calendar icon.
6. To be reminded of the task in advance, select the time from the Email me before combo box.
7. The change id is shown in non editable mode.
8. Click Add button to add the reminder. You can see the reminder getting listed in the My Reminder(s) pop up window in ascending order.
Viewing Reminders

You can view the reminders specific to each change.

To view reminders,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**. This opens the ManageEngine ServiceDesk plus home page.

2. Click the **Changes** tab. This opens the changes list page.

3. Click the title of the change for which you like to view the reminder. This opens the change details page.

4. Click the Actions tab -> Click the **View Reminders** option. This opens the **Showing All Reminders** page as shown below. This lists all the reminders in ascending order based on the date.

5. Once the task is completed you can change the state of the reminder from open to completed. To do this, select the **reminder** to be closed from the list by enabling the check box on the left side of each reminder.

6. Select the **Change Reminder State To Completed** then -> click **Change** button to change the state. You can see the reminder striked off to indicate the change.

Alternatively, you can also view the reminders by, clicking **Quick Actions** link

- > **My Reminder(s)** option under the Reminders block. This opens the **My Reminders** pop up window as shown below. This shows all your reminders irrespective any specific module.
You can also add new reminders by clicking +Add New link at the bottom of the my reminders form. The new task is added and is listed along with the already existing tasks in the ascending order based on date and time.

When you have completed the task, you can just strike out the task to indicate that it is completed by selecting the radio button beside the task summary.

You can also delete the task by clicking the delete icon beside the task.
Adding Work Logs

Work Log is the time spent on a change by a technician. The technician assigned to the change can add work log once the change request is completed. If the change involves multiple technicians, then the time spent details should be entered by each technician.

To add a work log,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Changes tab. This opens the changes list page.
3. Click the title of the change for which you like to enter the work log. This opens the change details page.
4. Click the Add New combo box -> Select Work Log option from the list. This opens the Add Work Log page.
5. Select the Technician Name from the combo box.
6. Specify the Executed Time (date & time) taken to resolve the change from the calendar button.
7. The Technician Cost per hour will be fetched automatically from the technician details, which is a non-editable field. If you have already entered the per hour cost of the technician while adding the technician details, then the details will be fetched automatically. If you wish to change these values, you can do so manually.
8. The Incident Cost will be automatically calculated taking the (total time spent to resolve the problem * Technician's cost per hour).
9. If there are any extra charges specify in the Other Charges field.
10. Using the above two data the Total Charges (Technician Charges + Other Charges) will be displayed automatically.
11. Specify any relevant information about the time spent in the description field.
12. Save the details.

![Add Work Log](image-url)
Assigning Technician to a Change

Each change will be handled by a technician, who would be responsible for closing the change. If a change is created for a particular site, then the technician associated to the site is assigned to the change.

To assign a technician,

1. Click the Change tab in the header pane. This opens the Changes list page.
2. Click the Title of the change for which you have to assign a technician. This opens the change details page.
3. Click the Actions combo box on the right hand side of the page -> Click Assign Technician option from the list. This opens Assign Technician to this Change pop up page as shown below. Select the technician from the list and Assign the change to the technician.

5. Alternatively, you can also assign technician using inline edit option. Click the technician name shown in the change details block. This opens the drop down box as shown below. Select the technician from the list and click the icon to select the technician name else click cancel icon.

You can also assign more than one change at a time to a technician.

To bulk assign changes to technicians

1. In the Changes list page, select the changes to be assigned a technician by enabling the check box beside left side each of the change title.
2. Click the **Select Technician** check box. Select the technician from the drop down list.

3. **Assign** the technician.

**Picking Up Change**

ManageEngine ServiceDesk Plus provides an option to the technicians to self-pick up change. If there are unassigned changes, the technicians can pick up any of the unassigned changes from the list. This in turn will increase the turnaround time and the efficiency of the IT help desk team.

To pick up changes,

1. From the change list view page, select the changes you would like to pick up by enabling the check box. The unassigned changes will be in bold font.

2. Click **Pick up** button. The selected change will be assigned to you. **(Or)**

3. You can also pick up changes after viewing the change details. Click the title of the change to open **View Change** page.

4. Click **Assign** tab. Select **Pick Up** option to pick up the change.
Closing Change

To close a change,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Changes tab in the header pane.
3. Click the Title of the change in the Changes list page. This opens the change details page.
4. Click the Close Change link under the Tasks block. This closes the change.

Note: If the mandatory fields are not entered then an error message is shown asking you to enter the value in the fields.

To reopen the change

You can reopen a changes from the closed state to open state. To do this,

1. Click the title of the change. This opens the change details page.
2. Click the Edit button. This opens the form in the editable format.
3. Change the status field from Completed to Requested and save the changes made.
   
   When a changes is opened from the closed state, you should change the Created Time, Scheduled Start time and End time of the change. When the request is finally closed, the completed Time will be automatically updated.

(OR)

4. Click the Status of the change in the form you have inline edit option for each of the change details. This opens the combo box as shown below,

   ![Combo Box](image)

   6. Select the status from the list and immediately the status of the change get's updated.

To view the closed changes

1. From the change list page, select Closed Changes from the Filter drop-down menu. This lists all the closed changes.
2. To view the closed changes which were assigned to you, select My Closed Changes.
Deleting Change

You have an option to delete individual change or group of changes together.

To delete individual changes

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Changes tab in the header pane.
3. Click the Title of the change to be deleted in the changes list view page. This opens the Change Details page.
4. Click the Actions combo box on the top right hand side of the page.
5. Click the Delete link from the list. A dialog pops up asking you to confirm on the delete process.
6. Click OK to proceed. You can see the change deleted from the list.

To delete more than one change at a time

1. In the Change list view page, select the changes to be deleted by enabling the check boxes.
2. Click the Delete button. A dialog pops up asking you to confirm on the delete process.
3. Click OK to proceed. Or click Cancel to abort deletion.
Associating Incidents to a Change

You have an option to associate Incidents with the change. Similar Incidents as in Change can be associated in order to complete the requests quickly rather than doing it one by one.

1. Click the **Changes** tab. This opens the **Change List View** page. Click the change title to be associated with the Incidents. This opens the change details page.

2. Click the **Actions** combo box on the top right side of the page. Click **Associate Incidents** option. This opens **Associate Incidents to Change** page as shown below,

```
<table>
<thead>
<tr>
<th>Show</th>
<th>Open Requests</th>
<th>Show: 1 - 2 of 2</th>
<th>Show: 25 per page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Associate Incidents</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

```
<table>
<thead>
<tr>
<th>Subject</th>
<th>Requester Name</th>
<th>Assigned To</th>
<th>Due By</th>
<th>Status</th>
<th>Created Date</th>
</tr>
</thead>
</table>
```

4. Select the type of requests to be displayed by selecting from the **Show** combo box on the top left hand side of the page. Ex: Open Requests or All Requests and so on. On selecting the request type the corresponding requests gets listed.

5. Select the change from the list by enabling the check box beside each change.

6. Click **Associate Incidents** to associate respective requests to the change (particular selected change). The associated incidents gets listed in the Incidents tab in the change details page as shown below,

```
<table>
<thead>
<tr>
<th>Routers Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue in 900 series routers</td>
</tr>
</tbody>
</table>
```

ZOHO Corp. 168
Associating Problems to a Change

You have an option to associate problems with the change. Similar problems as change can be associated in order to complete the requests quickly rather than doing it one by one.

To associate problem,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Changes tab. This opens the Change List View page. Click the change title to be associated with the problems. This opens the change details page.
3. Click the Actions combo box on the top right side of the page. Click Associate Problems option. This opens Associate Problems to Change page as shown below,
4. Select the type of problems to be displayed by selecting from the Show combo box on the top left hand side of the page. Ex: Open Problems or All Problems and so on. On selecting the problem type the corresponding problems gets listed.
5. Select the change from the list by enabling the check box beside each change.
6. Click Associate Problems to associate respective problems to the change (particular selected change). The associated problems gets listed in the Problems tab in the change details page.
Publishing Announcements

ServiceDesk Plus gives you an option to publish announcements while doing the change without breaking the work flow. Say if you have to make an announcement to the company that the mail server will be down for next five hours and your are doing the change then in this case you need not go to the home page and make an announcement. You can directly publish the announcement from the change module.

To Publish Announcements,

1. In the Problem Details page click the Actions combo box and select the Make an announcement option. This opens the Add New page.
2. Specify the Announcement Title in the given text field. This is a mandatory field.
3. Specify any relevant information about the announcement in the Description field. Also specify the result under the Resolution title.
4. Specify the date and time to Show this announcement, between these dates from the calendar button. If this field is not entered the announcement will be displayed in the dashboard for ever.
5. Select the check box to Show this announcement only to technicians.
6. Select the check box to Send this announcement as mail.
7. Save the changes. You can see the announcement page as shown below. To view the next and previous announcement in the dash board click the Next and Previous buttons on the right side of the page.

You can also edit and delete the announcement in the same page.

To edit the announcement,

1. Click Edit button. This opens the Edit Announcement form.
2. Change the details of the announcement in form.
3. Save the changes. All the changes made in the announcement will be saved.
To delete an announcement,

1. To delete the announcement click **Delete** button. A dialog pops up asking you confirm on the delete operation.
2. Click **OK** to delete. Or click **Cancel** to retain the announcement.

Alternatively you can also publish announcements company wide or just to the technicians group from the **Home page**. The announcements are displayed just below the my view requests tab in the home page as shown below,

All recent announcements will be displayed first based on the date. To view all the announcements (even completed ones), click the **Show All** button on the right side of the page.

---

**Announcements**

- **Server Upgrade**
  - Description: Mail Server will be down for next 5 hours
  - Resolution:

- **Routers Change**
  - Description: Upgradation of 800 series routers to 1200 series routers.
  - Resolution:

- **Printer will not be available**
  - Description: Resolution: null

---

To add a new announcement

1. Login to ServiceDesk Plus using the administrator / technician user name and password.
2. In the login home page, if you have permissions to add an announcement, you will notice the **Add New** button in the announcements box as shown above. Click the button. The **Add New Announcement** dialog pops up.
3. Enter the Announcement Title. This can be a short statement that describes the announcement.
4. Type the **Announcement Content** in the text box provided for the same.
5. Select the **From** date and **To** date using the calendar icon beside the respective fields.
6. If you wish to publish the announcement only to the technicians and do not wish to expose it to your requesters, then select the check box **Show this announcement only to technicians**. The announcement will be displayed in the home page with a lock beside it.
7. If you wish to **Send this announcement as mail** then select the corresponding option by enabling the check box.
8. Click **Save**. At any point of time, you do not wish to add the announcement, click **Cancel**.

The announcement will be added and the pop-up will display the announcement details as entered by you. The announcement title will be displayed in the login home in bold text in the announcement box with a new icon beside it.
Send Notifications

To send notifications specific to the change to the CAB members, to change managers, technicians or to any concerned person then,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Changes tab in the header pane. This opens the change list view page.
3. Click the title of the change to which the notification has to be sent. This opens the change details page.
4. Click the Actions combo box and select the Send Notification link. This opens the Send Notification page.
5. Specify the To and CC address in the given text field.
6. Specify the Subject of the notification in the given text field.
7. Specify relevant information about the notification in the Description field.
8. Send the notification.
Change Planning

The change plan is formulated to get started with the change process. It needs to have complete
details about the reasons for considering the change that how this change can impact the business.
The change planning stage needs to have following information so that change managers and CAB
has all the details to make informed decisions.

- Impact Analysis - Risk involved in implementing the change.
- Rollout Plan - How the plan will be implemented.
- Back Out Plan - Plan to restore things back to original state if plan fails.
- Checklist - List of mandatory items required for the plan to succeed.

To specify the change plan,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Changes tab. This opens the Change List view page. Click the title of the change
for which you need to plan to make decisions. This opens the change details page.
3. Click the Planning tab. You can view the change planning stages one below the other.

To add the Impact details,

1. Click the Add button. You can see the text area getting displayed for the impact details.
2. Specify the risk involved in implementing the change in the given text area.
3. Save the details. You can see the details getting displayed.
4. Click Attach File button to attach a file for the impact details. The maximum size of the
attachment should be 10MB.

To specify the Roll Out Plan

1. Click the Add button. You can see the text area getting displayed for the roll out plan.
2. Specify how the plan will be implemented in the given text area.
3. Save the details. You can see the details getting displayed below the title.
4. Click Attach File button to attach a file for the impact details. The maximum size of the
attachment should be 10MB.

To specify the Back Out Plan

1. Click the Add button. You can see the text area getting displayed for the back out plan.
2. Specify the plan to restore things back to original state if plan fails in the given text field.
3. Save the details. You can see the details getting displayed below the title.
4. Click Attach File button to attach a file for the impact details. The maximum size of the
attachment should be 10MB.

To enter the Checklist

1. Click the Add button. You can see the text area getting displayed for the check list.
2. Specify the list of mandatory items required for the plan to succeed in the given text field.
3. Save the details. You can see the details getting displayed below the title.
4. Click Attach File button to attach a file for the impact details. The maximum size of the
attachment should be 10MB.
Recommending Change by CAB

The Change Advisory Board (CAB) is a body that exists to recommend changes and to assist Change Management in the assessment and prioritise of changes. As and when a CAB is convened, its members should be chosen who are capable of ensuring that all changes are adequately assessed from both the business and technical viewpoint. A technician or a requester can be a CAB member based on the organization structure.

General Work Flow for approving a change

- The CAB should be convened for a change. The CAB members can differ for each change. The CAB member can be a requester or a technician whoever is capable to assess from both the business and technical viewpoint.
- Once the CAB is convened the change should be sent to the CAB members for recommendation.
- The technician whoever receiving the change or assigned a change will be the owner of the change and he will send the change for recommendation to the CAB.
- If the change is recommended by the CAB members, the CHANGE MANAGER should approve the change. The change manager can approve or reject the change irrespective of the recommendation of the CAB.
- Only the approved change will be taken further by the technician to take necessary steps.

To add CAB members and send for recommendation,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Changes tab. This opens the Change List view page.
3. Click the Title of the change which you need to send for recommendations. This opens the change details page.
4. Click the Approvals tab. You have to add CAB members, and send the change for recommendation. The CAB members has the authorization to recommend the change.

To Add CAB Members

5. Click the Add CAB Member button.
6. Select the CAB from the combo box.
7. Select the members list for the committee. The selected members will be responsible for approving the changes.
8. Save the changes. You will get a confirmation message saying members added to the CAB successfully.

Send the change for Recommendation

9. Click Send for Recommendation button to send the change for approval to the CAB members. Only the members of the CAB can recommend a change. This opens the submit change for approval page.
10. If the e-mail id is already configured for the CAB members then the Id would get automatically get listed in the To text field. This is a mandatory field. If the mail id is not configured refer Configuring Technicians.
11. Specify the Subject in the given text field. This is a mandatory field.
12. Specify the Description about the change in the given text field.
13. Send the mail to the CAB members for approval. Once the mail is sent the CAB members would get a mail with the link to the form to approve the changes as shown below.

Administrator has requested your recommendations for this Change - Change Cards in the Server. Click here to view Change details
http://shawnadams/approval/Approve.jsp?ITEMID=2&MODULE=Change&KEY=21187331524593&USERID=4
14. Click the link in the mail to open the form as shown below,

![Form Image]

15. Select **Approve Recommend** or **Reject** radio button based on the change details listed below the form.

16. Specify the **Comments** in the given text field.

17. **Save** the changes.

**Recommending the change directly from the Approval page**

If you are a member of the CAB after logging into ServiceDesk Plus, you can recommend the change from the Approval page directly by clicking the Take Action icon under the Recommendation title as shown below.

![Approval Page Image]

This opens the Approve page. **Recommend or Reject** the change.

Specify the **Description** and **Save** the changes. The status of the change becomes recommended.
Approving Change by the Change Manager

Only the Change Manager has the authority to approve the change. Any technician with the SD change manager role permissions can approve the change. A change manager can or could not be a member of the CAB. If needed the change manager can reject the change though the change is recommended by the CAB members. It is to the change manager's discretion whether to approve or reject the change.

Once the change is recommended by the CAB members the Change Manager should Approve or Reject the change. Except for the Standard Change type all other change type should be approved the change manager. The standard change type is a pre-approved change type hence it does not require any approval from the change manager. Only the approved changes will be taken further to solve the issue.

To Approve the Change by the Change Manager,

1. Log in into ServiceDesk Plus using your user name and password.
2. Click the Changes tab -> click the title of the change to be approved. This opens the change details page.
3. Click the Approvals tab, you get a link on the top right hand side of the page to approve or reject the change as shown below,

   ![Approve or Reject Link]

4. Click the Approve link to approve the change. This opens a dialog box.
5. Specify the comments in the box and Save the details.
6. Text in the link changes as Approved with the change manager name, date and time will also be displayed as shown below. At any time to reject the change, you can click the reject link next to the approve link.

   ![Approved Status]

In the change details page Approval status of the change would show as Approved in a non-editable format. Also on the top right hand side of the page the Approval status of the change would change as Approved.
Assets

ManageEngine ServiceDesk Plus helps to manage all your IT and Non-IT assets. ServiceDesk Plus offers a single view to track and manage all your assets with ServiceDesk Plus, you can track and manage ownership of

- IT, Non-IT and Asset Components.
- Software Asset Management

IT & Non-IT Asset Management

ServiceDesk Plus helps you to manage,

- IT assets such as, workstations, switches, routers, printers, and access points
- Non-IT assets such as basic fixtures, furniture, chairs, tables, projectors, and desk phones
- Asset Components such as keyboards, Mouse and even your printer inks.

Software Asset Management

Software License Management

ServiceDesk Plus helps you to manage software licenses installed across the enterprise. You can consolidate and manage all your software licenses from a single screen. ServiceDesk Plus will scan and automatically pickup license keys for Microsoft Windows and Microsoft Word. You can key-in all the licenses purchased earlier and track future purchase of software licenses through the Purchase module.

Software Metering

ServiceDesk Plus helps you to track the usability of the installed software across organization. It gives the count of rarely used, frequently used and occasionally used software.

Software Compliance

ServiceDesk Plus tracks purchased versus installed licenses helping you to ensure software license compliance. The scheduled scan alerts you when an unauthorized software installation is detected, ensuring software compliance on an on-going basis.
IT Assets

All IP based assets are discovered under IT assets. The list of possible IT assets are given below,

- Workstations
- Printers
- Switches
- Servers
- Routers
- Access Points
- Adding New IT Assets
- Editing Assets
- Adding Assets to Groups
- Assigning Assets to Department
- Modifying the State of the Assets
- Change log-in Credentials of IT Assets
- Bulk Scan of IT Assets
- Deleting Assets
- Importing Asset Details from CSV
- Viewing Asset Details
- Copying Resources
- Attaching Assets
- Attaching Components
- Attaching Documents
- Assigning Assets to Users/Departments/Assets
- Adding New Workstation
- Bulk Scan of Newly Added Workstations
- Changing Workstation as Server
- Viewing Workstation Details
- Print Preview of Workstations
- Modify Type
- Adding Software
- Deleting Workstations
Adding IT Asset

IT Assets other than workstations are configured under IT Assets. To add a new asset,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**. This opens the ManageEngine ServiceDesk Plus home page.
2. Click on **Assets** tab in the header pane. This opens the Asset home page.
3. Click **Quick Actions** link on the top left hand side of the page -> Click **Asset** option from the drop down menu. (OR) Click **IT Assets** under Resources block on the left side of the page -> Select any one of the listed IT assets link. e.g. Access points, printers etc. This opens the particular IT asset page.
4. Click **New** button. This opens Add Asset page.
5. Select the **Product Name** of the asset from the combo box. If required, you can add a new product name by clicking **Add New** link beside the product name field. This is a mandatory field.
6. Select the **Vendor Name** from the combo box. If required, you can add a new vendor by clicking the **Add New** link beside the vendor name text field.
7. Specify the **Asset Name** in the given text field. This is a mandatory field.
8. Specify the **Asset Tag, Asset Serial No, Bar Code** and **Asset Cost** in the corresponding text fields.
9. Specify the **Acquisition Date & Expiry Date** from the calendar button.
10. Select the **Site** from the combo box.
11. Specify the **Location** in the given text field.
12. Specify the **Asset State** by selecting the current status of the asset from the combo box.
   If the asset is in **Use** state you need to associate or assign asset to department or user or asset.
   1. Allocate the asset to an **Asset** or to an **User** or to the **Department** by selecting any of the two radio button. Say Associate to Asset or Assign User/ or Department.
2. If you choose to associate asset to an asset then select the asset name from the Choose Asset combo box. Or if you have chosen to assign to user or the department then select User or Department from the combo box.

3. If the asset is leased select the check box Asset is Leased. If the asset is leased then specify the From and To date from the calendar button.

13. Click Save button to save the changes. To save and add another asset click Save and add new button.
Editing Assets

To edit the resource details,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab -> select the IT Assets link on the left hand side of the page. This opens the list view page of the IT assets.
3. Click the title of the IT asset to be edited. This opens the Asset details page.
4. Click Edit button on the top right hand side of the page (Or) click the Actions combo box next to the edit resource button -> select the Edit option. This opens the Edit Asset page.
5. Edit the Asset Details block such as Product Name, Asset Name, Tag, Serial No, Bar Code, Vendor Name, Cost, Acquisition Date, Expiry Date, and Location.
6. Modify the Asset State details such as, Current usage status of the assets like In Use, In Repair and so on. Then the Associate the asset to User or Department details or Assign to User or Department details.
7. Update the changes. You can see the assets details getting updated.
Adding Assets to Group

You have two types of groups in ServiceDesk Plus say, Static group and Dynamic. Add to group option in asset list view page is to group bulk of assets. These assets will be grouped under the Static group by default.

To Add IT Assets to group,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click any of the IT Assets link under the Resources block on the left hand side of the page. Select any one of the listed IT assets link. e.g. Access points, printers etc. This opens the particular IT asset page.
3. Select the assets to be added to the group by enabling the check box. Click Actions button - > Add to Group option. This opens the Add Resource(s) to page.
4. By default you can group assets only to the static group. Either to the Existing static group or New static group can be added.
5. If you would like to group the assets under existing static group then click the corresponding radio button. Select the group name from the combo box.
6. Else, if you would like to add a new static group and group the assets, click New Group radio button. Specify the Group Name and relevant information about the group in the Description field.
7. Click Save button to save the changes.
Assigning Assets to Department/Site

Assigning IT Asset to Department
1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the IT Assets title under the Resources block. Select the corresponding IT Asset link say, servers, workstations and so on. This opens the selected Assets list view page.
4. Click on the Asset Name to be assigned to a Department/Site by enabling the check box.
5. Click the Actions menu -> select Assign to Department option from the list. This opens Add Resource(s) to pop-up window.
6. Select the Department Name from the combo box and Save the details.

Assigning IT Asset to Site
1. From the Asset list view page, click the Actions menu -> select Assign to Site option from the list. This opens Assign Resource(s) to Site pop-up window.
2. Select the Site name from the combo box.
3. Save the details. Else click Cancel button.
Modifying State for IT Assets

To modify the state of IT Assets,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the IT Assets title under the Resources block. Select the specific IT Asset link. This opens the Assets list view page.
4. Select the assets to be modified of their status by enabling the check box. Click the Actions menu and select the Modify State option. This opens the Modify State pop up window.
5. Select the State from the combo box. For ex, In Store, In Use and so on.
6. Save the changes.
Change log-in Credentials for bulk of IT Assets

You can change the log-in credentials for bulk of assets. You have **Global** credentials and **Local** credentials. Global credentials are common login permissions for all the assets. Local credentials are private login permissions for an asset (generally used to restrict the access permissions to everyone).

To change the login credentials,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Assets** tab in the header pane. This opens the assets home page.
3. Click **IT Assets** under **Resources** block on the left hand side of the page. Select the respective IT assets link. e.g. Access points, Printers and so on. This opens the corresponding IT asset page.
4. Select the IT Assets to change the log-in credentials by enabling the check box. This opens the assets list view page. Click the **Actions** combo box --> and select the **Change Credentials** option. This opens the corresponding page.
5. Select either **Global Credentials** or **Local Credentials** by selecting the radio button.

**Global Credentials**

1. On selecting the global credentials, select the **Network** from the combo box.
2. Select the communication **Protocol** either SSH or Telnet option for linux workstations by enabling the corresponding radio button.
3. If you would like to **Scan Software in Linux Workstations** then enable the corresponding check box.
4. Specify the **User Name** and **Password** for the network.
5. **Save** the details. If you would like to **Save and Scan now** click the corresponding option.

**Local Credentials**

1. On selecting the local credentials, specify the **User Name** and **Password**.
2. Select the communication **Protocol** either SSH or Telnet option for linux workstations by enabling the corresponding radio button.
3. If you would like to **Scan Software in Linux Workstations** then enable the corresponding check box.
4. **Save** the details. If you would like to **Save and Scan Now** click the corresponding option.
Bulk Scan of IT Assets

Scan now option is to scan group or bulk of assets for assets data. Each time when a new asset is added, instead of scanning all the assets, you can scan the newly added assets for resource details.

If you have changed the credentials for the assets or if you want to specify the log-in credentials for an asset then select the Change Credentials option under the actions menu and specify the details. Then click Save and Scan now button for scanning the assets.

To scan bulk of IT Assets,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the IT Assets title under the Resources block. Select the specific IT Asset link. This opens the Assets list view page.
4. Select the assets to be scanned by enabling the check box. Click the Actions tab -> select Scan Now option. This opens the Scan wizard page with total number of scanned and failed assets. And you can view the asset details in the Resource details page.
Deleting Assets

1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.

2. Click on Assets tab -> Click IT Asset link under the resource block on the left hand side of the page. This opens the IT Assets list view page.

3. From the assets list view page, select assets to be deleted by enabling the check box.

4. Click Delete button to delete the selected assets. You can see the selected assets deleted from the list.
Importing Asset details From CSV

ServiceDesk Plus helps you to import your asset details saved in CSV (Comma Separated values) format. If you have asset details in .XLS files, open it with Microsoft Excel and save it as .CSV files and then import it.

1. From the Assets view list page, click the Import from CSV link. This opens the Resource Import Wizard page.

2. Select the Resource Category from the combo box, IT or NON IT. This is a mandatory field.

3. Select the Resource Type from the combo box.
   If you have selected Non-IT as resource category then the resource type would display components and assets. (OR) If you have selected IT as resource category then the resource type would display, components and IT Assets. Under IT Assets you have workstations and other IT-Assets. This is a mandatory field.

4. Locate the .CSV file using the Browse button.

5. Click on Step2 button to go to the next page. Click Previous button if you need to go the previous page.

6. If you have selected the resource type as workstations then select the Workstation details from the combo box. Also specify the Asset Details by selecting from the combo box. The columns in .CSV file are populated in the select boxes beside each field label. Advent Net Manage Engine ServiceDesk Plus asset field’s needs mapping with the field names from the .CSV file.

7. Map the Workstation Name for workstation details. For asset details map the Product Type, Product Name, Asset Name from the combo box. These are mandatory fields.

8. Map the Model, Tag, Manufacturer, Operating System and Domain details for the workstation details.

9. Map the Asset Tag, Asset Serial No, Bar Code, Vendor Name, Asset Cost, Warranty Expiry Date, Expiry Date, Location, Assigned to User, Assigned to Department from the combo box.

10. Map the Acquisition Date field with the relevant field in the .CSV file. Also map the order of the acquisition date i.e. date/month/year available in the .CSV file.

11. Click Step3 to go the next page. Click Previous button if you need to go the previous page.

12. Click Import Now button to import the existing data from the .CSV file. Once the data is imported, you can see the Import Wizard page with result break-up.
Viewing IT Asset Details

1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.
2. Click on Assets tab -> Click IT Asset link on the left hand side of the page. This opens the IT Assets list view page.
3. Click on the IT Asset name to view the IT Assets details. By default Resource Info tab details are displayed.

Viewing Resource Info Details

Resource Info tab displays the Resource Details such as, Resource Name, Tag, Bar Code, Serial No Region, Cost, Acquisition Date and many other details are displayed.

Viewing Relationships

This relationship tab shows the assets association to other Assets, Business Services, Users and Components.

On clicking the tab -> click the Add Relationship button on the top right hand side of the page.

Connection Relationship

1. Click the Connection Relationship option from the list. This opens the Connection Relationship page.
2. To connect the assets to other assets select the Assets radio button.
   1. Select the assets to be connected from the Asset List.
   2. Move the selected asset to the Connected Assets list using the >> button.
   3. Save the details. You can see the connected assets under the Connected to Assets block.
3. To connect the assets to the Business Services select the corresponding radio button.
   1. Select the business services from the list to be connected to the assets such as, Email, Internet Access and so on.
   2. Move the selected assets from the Business Service list to the Connected Services list using the >> button.
   3. Save the changes. You can see the connected business services under the Business Services block.

Usage Relationship

1. Click the Usage Relationship option from the list. This opens the Usage Relationship page.
2. Select the Assign the asset to User/Department radio button to associate the asset to the user/department.
   1. Select the User from the combo box.
   2. Select the Department to be associated from the combo box.
   3. If the Asset is Leased then select the corresponding check box.
   4. Save the changes. (Or)
3. Select the Associate to Asset radio button to assign the asset to the asset.
   1. Choose Asset to be associated from the combo box.
   2. Save the details.
Container Relationship

1. Click the Container Relationship option from the list. This opens the Container Relationship page.
2. Select the Components radio button to associate the components to the user. Select the type of components to be displayed in the list by selecting it from the choose product combo box.
3. Select the components from the Components List and move it to the Attached components list using >> button.
4. Save the details.

Viewing History of IT Asset

Click on the History tab to view the IT Asset history. This gives the complete IT - Assets Resource Ownership History on date and State of the components.

Request Details

On clicking the Request Details page you will be able to view all the requests raised for the asset.

On Clicking the request title you can view the details of the request, requester details, Assets belonging to the user, Time elapsed to solve the request, resolution for the request and history of the request

Also you can send reply for the request or forward the request to the technician. You can Search associated problem and change or add new problem or change to the request.

Viewing Contracts of the IT Asset

Click on Contracts tab to view the contracts attached to the IT Asset. This gives the complete details about the contract such as, vendor name, support details, contract rules, expiry date, cost and other rules.

Viewing Costs

1. Click on the Costs tab to view the costs associated to the IT Asset.
2. Click on Add Cost button at the right side of the page to add cost to the IT Asset.
3. Select the Cost Factor from the combo box. For ex. Service Cost. This is a mandatory field.
4. Specify the description about the cost in the Description field. Say if the cost factor is service cost you can specify important information about the service cost.
5. Specify the Amount in $ in the Amount field. This is a mandatory field.
6. Select the Date from the calendar button. This is mandatory field.
7. Click on Add Cost button to add the cost. You can see the cost added to the IT Asset shown in the Other Costs list view page.
Copying Assets

Using Copy Resource option you can make multiple copies of the resource and its details. On making multiple copies of the resource, it becomes easier for the technician to add bulk of similar assets. The technician need not manually enter all the resource details for each resource. The new copies of the resource will be assigned with new asset name and rest of the details is retailed as is.

**Example:**
If you have ten printers of the same configurations in your organization, then in this case, enter the configurations for one printer and save it. Then copy the same printer for ten times and add its configurations to other printers.

To make multiple copies of the Resources,

1. Click the **Assets** tab in the header pane. This opens the assets home page.
2. Click **IT Assets** under **Resources** block on the left hand side of the page. Select the respective IT assets link. e.g. Access points, Printers and so on. This opens the corresponding IT asset page.
3. Click the **Title** of the assets to be duplicated. This opens the Asset details page.
4. Click the **Actions** menu on the right hand side of the page. Select **Copy Resource** option. This opens the Copy Resource pop up window as shown below,

![Duplicate Request](https://example.com/duplicate_request.png)

5. Specify the **Number of Copies** to be made for the resource in the given text field.
6. **Copy** the resource. You can see the list of resource copies listed in the list view.
Attaching Assets

To attach assets to the IT Assets,

1. Log in to ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Assets** tab in the header pane. This opens the assets home page.
3. Select the **IT Assets link** under the Resource block on the left hand side of the page. Select the corresponding IT Asset link say, Printers, Access Points and so on. This opens the Asset list view page.
4. Click the title of the asset to be attached with an asset. This opens the asset details page.
5. Click the **Actions** combo box -> select the **Attach Asset** option from the list. This opens the **Attach Asset** pop up window.
6. If you would like to display the list of all assets or filter specific asset then select the assets to be displayed from the **List** combo box. Ex: Printer, Access Points and so on. Also select the type of asset such as asset in store, in use and so on from the **of type** combo box.
7. You have two columns, such as **Asset list** and **Attached Assets** list. You have to select the assets to be attached from the assets list and move it to the attached assets list using the **>>** button. To remove the assets from the attached assets list use the **<<** button. **Example:** If you would like to attach a printer to a workstation then select the list of assets to be attached from the assets list and move it to the attached assets list.
8. **Save** the changes. If you would like to detach all the attached assets then select the **Detach All** option.
Attach Component

To attach components to an asset,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane, this opens the assets home page.
3. Select the IT Assets link under the Resource block on the left hand side of the page. Select the corresponding IT Asset link say, Printers, Access Points and so on. This opens the IT asset list view page.
4. Click the Title of the asset to be attached with an component. This opens the asset details page.
5. Click the Actions combo box -> select the Attach Component option from the list. This opens the Attach Component pop up window.
6. If you would like to display the list of all components or filter specific components then select the components to be displayed from the List combo box. Ex: keyboard, mouse and so on. Also select the type of component such as component in store, in use and so on from the of type combo box.
7. You have two columns, such as Component list and Attached Components list. You have to select the components to be attached from the components list and move it to the attached components list using the >> button. To remove the component from the attached component list use the << button.

Example:
If you would like to attach a keyboard and a mouse to a workstation then select the list of components to be attached from the component list and move it to the attached component list.

7. Save the changes. If you would like to detach all the attached components then select the Detach All option.
Attach Documents

To attach documents,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab in the header pane. This opens the Asset home page.
3. Select IT Assets link under the resource block on the left hand side of the page. Select the corresponding IT Assets say, Printers, Routers and so on. This opens the IT asset list view page.
4. Click the Asset Name of the asset to which the document needs to be attached. This opens the Asset details page.
5. Click the Actions combo box on the top right hand side of the page -> select the Attach Documents option. This opens the Attach File pop up window.
6. Choose the file to be attached by clicking the Browse button. The maximum size of the attached file can be 10 MB.
7. Click Attach File. The attached document will be listed in Asset details page under Attached Documents. The attached file can be deleted by clicking the delete icon beside file name.
Assigning IT Asset to User/Department/Asset

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the IT Assets title under the Resources block. Select the specific IT Asset link. This opens the selected Assets list view page.
4. Click on the Asset Name to be assigned a user/department/asset. This opens the Asset details page.
5. Click the Actions menu on the right hand side of the page -> click Assign option from the list. This opens the Assign/Associate page.
6. If you would like to assign the asset to user or department then, select Assign User and or Department radio button. Or if you would like to associate with an asset then select Associate to Asset radio button.

Assign User and or Department

1. On selecting this radio button, select the User name and Department name from the combo box.
2. If the asset is leased then enable the Asset is Leased check box and specify the From and To date of the lease.

Associate to Asset

1. On selecting this radio button, Choose the Asset to be associated from the combo box.
7. Save the details.
Add New Workstation

1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.

2. Click on Assets tab in the header pane. This opens the asset home page.

3. Click IT Asset link under the resource block on the left hand side of the page. Select the corresponding assets say, Printers, Routers and so on. This opens the Asset list view page.

   Click New button. (OR) Click on Quick Create tab on the top left hand side of the page -> click Workstation option. This opens the Workstation Configuration page.

Computer Details

4. Specify the Name of the computer in the name text field and select the Model of the workstation from the combo box. This is a mandatory field. Ex: Latitude D620.

5. Specify the Service Tag & Manufacturer of the workstation in the given text field.

6. Specify the Processor Count, Processor Info, Clock Speed and Manufacturer of the processor in the given text fields.

7. Specify the RAM and Virtual Memory in (MB) the given text fields.

8. Also specify the Name and Service Pack of the operating system in the corresponding fields.

Resource Info Details

9. Specify the resource info details such as, Resource Tag, Resource Serial No, Bar Code & Location in the given text fields.

10. Select the Site and Vendor Name of the workstation from the combo box.

11. Select the Acquisition Date, Expiry Date & Warranty Expiry Date from the calendar button.

Asset State Details

12. Select the status of the asset from the Asset State combo box. Ex: In Store, In Use and so on

Network Adapter Details

13. Specify the network adapter details such as, Network IP Address, MAC Address, NIC, Network, DNS Server name & Default Gateway in the given text field.

14. Select the Domain name from the combo box.

15. If you would like to enable DHCP then select the check box.

Input/Output Devices Details

16. Also specify the input/output devices details of the workstation. Specify the Monitor Type, Mouse Type, Keyboard Type & their corresponding manufacturers in the respective fields.

17. Save the details. If you would like to Save and Add New workstation then click the corresponding button.
Bulk Scan of Newly Added Workstation

Using this option you can scan a new workstation added to the domain for its hardware and software details. This is very useful when you have to scan a single or a set of newly added workstations. In such case you don’t have to scan the entire domain for adding the workstations to the network.

To Scan New Workstation,

1. Click on the Assets tab in the header pane -> click the Workstations link under the Resources tab on the left side of the page. This opens Workstations list view page.
2. Select the Workstations to be scanned by enabling the check box -> Click the New Scan button next to the Actions menu. This opens the Scan Configuration page.
3. Specify the Name/IP of the workstation. This is a mandatory field.
4. Select the log-in credentials for the workstation by selecting either of the two radio buttons. Say Global or Local credentials. By default Global Credentials option will be selected.

Global Credentials

1. Select the Scan type from the combo box. Say Domain mode or Network mode.
2. Select the Domain/Network name from the combo box. This is a mandatory field.
3. Specify the Login Name and Password for the selected domain.

Local Credentials

1. Specify the local Login Name and Password.
2. Select the Protocol to connect it to the workstation by enabling either of the two radio buttons. Say SSH or Telnet.
3. If you would like to scan software in Linux workstation then select the corresponding check box.
4. Click Scan to scan the workstation. Else click Cancel.
Changing Workstation As Server

You can change workstation as server,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Assets** tab in the header pane. This opens the assets home page.
3. Click **IT Assets** under **Resources** block on the left hand side of the page. Click the **Workstations** link. This opens the workstations list view page.
4. Select the workstations name to be changed as server by enabling the check box.
5. Click the **Actions** menu and select the **Change as Server** option. This opens the **Modify Device Type** page as shown below,

![Modify Device Type](image)

6. Select the **Type** of the server from the combo box.
7. **Save** the details.
Viewing Workstation Details

1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.
2. Click on Assets tab -> Click Workstation link under IT Assets title on the left hand side of the page. This opens the workstations list view page.
3. Click on the workstation name to view the workstations details. By default Resource Info tab details are displayed.

Viewing Resource Info Details

Resource Info tab displays the Resource Details & Workstation Details. Resource details such as Resource Name, Tag, Bar Code, Serial No etc. Workstation details such as Computer Name, OS version, Service pack, Processor details, memory information and many other details are displayed.

Viewing Hardware Details

Click Hardware tab to view the complete Hardware details of the workstation. The hardware tab is broadly divided in to four major blocks such as Workstation Details block, Network Details, Discs and Drive Details, Printer Details and Other Details.

Under the workstation block you can view computer system, operating system, processor, memory and installed memory details. Under network block you can view the network adapters details. Under disks and drives block you can view the hard disks, logical drives and physical drives details. The printer details can be viewed under the printer details block. Under other details block you can view the keyboard, mouse, monitor, multimedia, ports, USB controllers details.

Viewing Software Details

Click Software tab to view the software details of the workstation. This opens the software details page with the list of all installed software’s in the workstation. By default the list of All Software will be displayed.

Select the corresponding filter option from the Filter Viewing combo box. There are different status levels of the software, such as Excluded, Managed, Prohibited, Freeware, Shareware and Unidentified. You can select any of these status levels and filter the software’s listed.

Click on the software title to view the software details such as, number of licensed installations, number of unlicensed installations and number of Purchased licenses.

If there are any license violations a warning message is displayed saying: License Violation. Software installations are more than purchased licenses.

Viewing Relationships

This relationship tab shows the assets association to other Assets, Business Services, Users and Components.

On clicking the tab -> click the Add Relationship button on the top right hand side of the page.

Connection Relationship

1. Click the Connection Relationship option from the list. This opens the Connection Relationship page.
2. To connect the assets to other assets select the Assets radio button.
   1. Select the assets to be connected from the Asset List.
2. Move the selected asset to the **Connected Assets list** using the >> button.

3. Save the details. You can see the connected assets under the **Connected to Assets** block.

3. To connect the assets to the **Business Services** select the corresponding radio button.
   1. Select the business services from the list to be connected to the assets such as, Email, Internet Access and so on.
   2. Move the selected assets from the **Business Service list** to the **Connected Services list** using the >> button.
   3. **Save** the changes. You can see the connected business services under the **Business Services block**.

**Usage Relationship**

1. Click the Usage Relationship option from the list. This opens the Usage Relationship page.

2. Select the **Assign the asset to User/Department** radio button to associate the asset to the user/department.
   1. Select the **User** from the combo box.
   2. Select the **Department** to be associated from the combo box.
   3. If the **Asset is Leased** then select the corresponding check box.
   4. **Save** the changes. (Or)

3. Select the **Associate to Asset** radio button to assign the asset to the asset.
   1. Choose **Asset** to be associated from the combo box.
   2. **Save** the details.

**Container Relationship**

1. Click the Container Relationship option from the list. This opens the Container Relationship page.

2. Select the **Components** radio button to associate the components to the user. Select the type of components to be displayed in the list by selecting it from the choose product combo box.

3. Select the components from the **Components List** and move it to the **Attached components list** using >> button.

4. **Save** the details.

**Viewing History of workstation**

Click on the **History tab** to view the workstation history. This gives the complete Workstation Scan History and Resource Ownership History on date.

**Request Details**

On clicking the Request Details page you will be able to view all the requests raised for the asset.

On Clicking the request title you can view the details of the request, requester details, Assets belonging to the user, Time elapsed to solve the request, resolution for the request and history of the request.

Also you can send reply for the request or forward the request to the technician. You can Search associated problem and change or add new problem or change to the request.
Viewing Contracts of the workstation
Click on Contracts tab to view the contracts attached to the workstation. This gives the complete details about the contract such as, vendor name, support details, contract rules, expiry date, cost and other rules.

Viewing Costs
1. Click on the Costs tab to view the costs associated to the workstation.
2. Click on Add Cost button to add cost to the workstation.
3. Select the Cost Factor from the combo box. For ex. Service Cost. This is a mandatory field.
4. Specify the description about the cost in the description field. Say if the cost factor is service cost you can specify important information about the service cost.
5. Specify the Amount in $ in the Amount field. This is a mandatory field.
6. Select the Date from the calendar button.
7. Click on Add Cost button to add the cost. You can see the cost added to the workstation shown in the Other Costs list view page.
Print Preview of Workstation Details

You can view the preview of the workstation details in printable format.

To view the Preview of Workstation Details,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Assets** tab in the header pane. This opens the assets home page.
3. Click **IT Assets** under **Resources** block on the left hand side of the page. Select the **Workstations** link. This opens the workstation details page.
4. Click the **Workstation Name** to view the preview of the workstation details. This opens the Workstation details page.
5. Click the **Actions** menu on the right hand side of the page. Select **Print Preview** option. This opens the **Resource Details** pop up window. You can view the complete resource details, workstation details, network details, disks & drives details, printer details, other details, software details, installed service packs details, resources attached details, workstations scan history details, resource ownership history details, contracts details & costs details.
Modify Type

To Modify Device type,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Assets** tab in the header pane. This opens the assets home page.
3. Click **IT Assets** under **Resources** block on the left hand side of the page. Select the Workstations link. This opens the workstation list view page.
4. Click the **Workstation Name** to be modified of the device type. This opens the Workstation details page.
5. Click the **Actions** menu on the right hand side of the page. Select **Modify Type** option. This opens the modify device type pop up window.
6. Select the device type from the **Modify Type** combo box.
7. **Save** the details.
Reconcile Workstations

The Reconcile Workstations option is to merge two resources and delete one of the resource. This is essential when the workstations received from a Purchase Order are associated to Departments or Groups, and on performing a domain scan or a network scan, these workstations are duplicated.

Say, "LD400 - PO # 2[10]" is the workstation purchased and has been renamed as "SDP-dept". On performing a scan, both the workstations (LD400 - PO # 2[10] and SDP-dept) appear in the List View. To avoid duplication, you can reconcile the workstations, where LD400 - PO # 2[10] is deleted and SDP-dept is retained. The reconcile option can be performed from either the PO details page or from the asset list view page.

To reconcile workstations from the asset list view page,

1. Click the **Assets** tab in the header pane.
2. Click **IT Assets** under the Resource block.
3. From the workstation list view, enable the check box beside the workstations to reconcile.
4. Click **Actions** drop down -> **Reconcile** option. Click **Ok** to proceed with the reconcile operation.

**Note:** Please note that if both the workstations are received via Purchase Order, then the workstations cannot be reconciled.
Adding Software

Using this option you can add multiple software to the workstation.

To add Software to the workstation,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Assets** tab in the header pane. This opens the assets home page.
3. Click **IT Assets** under **Resources** block on the left hand side of the page. Select the **Workstations** link. This opens the workstation list view page.
4. Click the **Workstation Name**. This opens the Workstation details page.
5. Click the **Actions** menu on the right hand side of the page. Select **Add Software** option. This opens the **Add Software** pop up window.
6. Select the software from the list to be added to the workstation. You can select multiple software to be added to the workstation using ctrl or shift keys.
7. **Save** the details. Else **Close** the pop-up window.
Deleting Workstations

1. Log in to the ServiceDesk Plus application using your **user name** and **password**. This opens the ManageEngine ServiceDesk plus home page.

2. Click on **Assets** tab -> Click **IT Asset** link on the left hand side of the page. This opens the IT Assets list view page.

3. From the Workstations view list page, select workstations to be deleted by enabling the check box.

4. Click **Delete** button to delete the selected workstations. You can see the selected workstation deleted from the list.
Remote Desktop Sharing

With multi-site support, ManageEngine ServiceDesk Plus has emerged as a globally supported IT helpdesk software, effectively resolving issues raised from various locations. Sometimes, there may be issues that require technicians to access machines in remote locations, say, a SAP-related issue in New York requires immediate attention and your support team is located in California. Likewise, when a request is raised via phone call, it would be great if the technician can access the requesters machine from his desk to resolve the issue instantly.

That is where Remote Desktop Sharing comes into play! Instead of launching a whole bunch of different softwares to access remote machines, ServiceDesk Plus Remote Desktop Sharing helps you to access all your scanned workstations and resolve issue in no time!

Browsers compatible for accessing remote desktop

- InternetExplorer (version 5.5 and above)
- Firefox

Accessing Remote Control

1. Click the Asset tab in the header pane.
2. From the Resources block, select Workstations under IT assets. The list of all the workstations is displayed.
3. Select the workstation you wish to gain remote access.
4. From the workstation details page, click on Remote Control tab. Note: Please note that the credentials should be configured before selecting the remote control tab. If the credentials are not configured then the log-in credentials window pops up.
5. Click Save and Remote Control.

The following activities occur on clicking the Remote Control tab from the workstation details page.
File Transfer

The Agent.exe file is installed in the C drive of the remote machine and an ActiveX control is run as a viewer. The following should be configured in the remote machine for the file transfer.

- Enable "File and Printer share" on executing the command (given below) in the command prompt of the remote machine

  `netsh firewall set service FILEANDPRINT`  

- User should have permission to write in C drive of remote machine.

The above two steps are required only on performing remote control to a workstation for the first time. The ports for pushing the agents are TCP 135, 138, 139 and 445.

Instead of opening these ports and giving permission to all the scanned workstations for transferring files, you can push the agent.exe from Active Directory to all the machines.

To push the agent to remote machine from Active Directory,

1. Download the contents in the batch file and copy it to the ActiveDirectory machine. The contents in the batch file are,
   
   ```
   copy file://network/ share\agent.exe c:\ /y
   copy file://network/ share\install.iss c:\ /y
   copy file://network/ share\uninstall.iss c:\ /y
   ```

2. Copy the files from `<SDP-Home>\server\default\conf\agent\*.*` to the Active directory machine.

3. In the script, the path from where the files are to be copied is specified as "network share". Replace this path to where you have copied the files to.

4. From your Domain controller, click **Start -> Administrative Tools -> Active Directory Users and Computers**.

5. In the console tree, right click on your domain, and select **Properties**.

7. Right click on the name of domain or the Organizational unit for which you would like to configure the script. Click **Create and Link a GPO Here...** option.

8. Type a name for the new GPO (for example; REMOTECONTROL), and click **Ok**. The GPO is added to the existing list.

9. Right click on the newly created GPO and click on **Edit** option.
10. From the Group Policy Object Editor window, select **User Configuration** -&gt; **Windows settings** -&gt; **scripts** -&gt; double click logon.

11. In the new Logon Properties window click on **Add**. The **Add a Script window** opens. Browse and select the Script name "CopyAgent.bat" and the script should be accessible by the remote machines.
12. Click **Ok** on Logon Properties window.

**Installing the Agent and starting the Service**

Using Windows Management Instrumentation (WMI), the agent is installed and the remote workstation can be accessed. The ports to install and start the agent as service in WMI are TCP 135, 445 and one random port greater than 1024. The service starts with the name ManageEngine AssetExplorer-RemoteControl.

**Note:** You can verify the installation of the agent by check the files under the directory `C:\ProgramFiles\AdventNet\ME\AssetExplorer\RemoteControl` of the remote machine.

**Installing ActiveX Viewer in the browser**

On starting the service in the remote machine, the ActiveX viewer is installed in the client machine, which connects the remote machines as add on to the browser. In Firefox 2 browser, the viewer is installed each time the remote control button is selected.

**Acknowledge**

An acknowledge message appears in the client window from which you try to connect the remote machine. Click **Ok** to allow technician to access your workstation.

**Meeting**

The Meeting is established between the remote machine and the client machine (this may or may not be server machine). The port TCP/ 10443 should be opened in the firewall between the remote machine and the client machine for this communication.

**Disconnect Remote Control**

When you close the pop up window of Remote Control, the service running in the target computer will be stopped using WMI.
Components

A part of the asset (ie. associated with the asset) which does not stand alone are grouped under Components. The list of all possible components are given below,

- Keyboard
- Mouse
- Adding Components
- Adding Components to Groups
- Deleting Components
- Viewing Components Details
- Edit Components
- Associate Assets
- Copy Resources
- Attach Documents
Adding Components

1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk Plus home page.

2. Click Quick Actions link on the top left hand side of the page -> Click Asset option from the drop down menu. This opens Add Asset page. (OR) Click Asset Components under Resources on the left side of the page -> Select any one of the listed IT assets components link. e.g. Keyboards etc. This opens the particular Asset Component page.

3. Click New button. This opens Add Asset page.

4. Select the Product Name from the combo box. If required, you can add a new product name by clicking Add New link beside the product name field. This is a mandatory field.

5. Select the Vendor Name from the combo box. If required, you can add a new vendor by clicking the Add New link beside the vendor name text field.

6. Specify the Asset Name in the given text field. This is a mandatory field.

7. Specify the Asset Tag, Asset Serial No, Bar Code, Asset Cost in $ in the corresponding text fields.

8. Specify the Acquisition Date & Expiry Date from the calendar button.

9. Select the Site from the combo box.

10. Specify the Location in the given text field.

11. Specify the Asset State by selecting the current status of the asset from the combo box. If the asset is in Use state you need to associate or assign asset to department or user or asset.

   1. Allocate the asset to an Asset or to an User or to the Department by selecting any of the two radio button. Say Associate to Asset or Assign User/ or Department.

   2. If you choose to associate asset to an asset then select the asset name from the Choose Asset combo box. Or if you have chosen to assign to user or the department then select User or Department from the combo box.

   3. If the asset is leased select the check box Asset is Leased. If the asset is leased then specify the From and To date from the calendar button.

12. Click Save button to save the changes. To save and add another asset click Save and add new button.
Adding Components to Group

You have two types of groups in ServiceDesk Plus say, Static group and Dynamic. Add to group option in component list view page is to group bulk of components. These components will be grouped under the Static group by default.

To Add Components to group,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click any of the Components link under the Resources block on the left hand side of the page. This opens the components list view page.
3. Select the components to be added to the group by enabling the check box. This opens the Add Resource(s) to page.
4. By default you can group components only to the static group. Either to the Existing static group or New static group can be added.
5. If you would like to group the components under existing static group then click the corresponding radio button. Select the group name from the combo box.
6. Else, if you would like to add a new static group and group the components, click New Group radio button. Specify the Group Name and relevant information about the group in the Description field.
7. Click Save button to save the changes.
Deleting Components

1. Log in to the ServiceDesk Plus application using your **user name** and **password**. This opens the ManageEngine ServiceDesk plus home page.

2. Click on **Assets** tab -> Click **Asset Components** link under resource block on the left hand side of the page. This opens the components list view page.

3. From the components list view page, select assets to be deleted by enabling the check box.

4. Click **Delete** button to delete the selected assets. You can see the selected assets deleted from the list.
Viewing Components Details

1. Log in to the ServiceDesk Plus application using your **user name** and **password**. This opens the ManageEngine ServiceDesk plus home page.

2. Click on **Assets** tab -> Click **Components** link under on the left hand side of the page. This opens the components list view page.

3. Click on the components name to view the components details. By default **Resource Info** tab details are displayed.

**Viewing Resource Info Details**

Resource Info tab displays the Resource Details such as, Resource Name, Tag, Bar Code, Serial No Region, Cost, Acquisition Date and many other details are displayed.

**Viewing History of Components**

Click on the History tab to view the components history. This gives the complete components **Resource Ownership History on date and State of the components**.

**Request Details**

On clicking the Request Details page you will be able to view all the requests raised for the Component.

On Clicking the request title you can view the details of the request, requester details, Assets belonging to the user, Time elapsed to solve the request, resolution for the request and history of the request

Also you can send reply for the request or forward the request to the technician. You can Search associated problem and change or add new problem or change to the request.

**Contracts Details**

Click on Contracts tab to view the contracts attached to the components. This gives the complete details about the contract such as, vendor name, support details, contract rules, expiry date, cost and other rules.

**Costs Details**

1. Click on the Costs tab to view the costs associated to the components.

2. Click on **Add Cost** button to add cost to the components.

3. Select the **Cost Factor** from the combo box. For ex. Service Cost. This is a mandatory field.

4. Specify the description about the cost in the **Description** field. Say if the cost factor is service cost you can specify important information about the service cost.

5. Specify the **Amount** in $ in the Amount field. This is a mandatory field.

6. Select the **Date** from the calendar button. This is mandatory field.

7. Click on **Add Cost** button to add the cost. You can see the cost added to the components shown in the Other Costs list view page.
Copying Resources

Using Copy Resource option you can make multiple copies of the component and its details. On making multiple copies of the resource, it becomes easier for the technician to add bulk of similar components. The technician need not manually enter all the components details for each component. The new copies of the component will be assigned with new component name and rest of the details is retailed as is.

Example:
If you have twenty keyboards of the same configurations in your organization, then in this case, enter the configurations of one keyboard and save it. Then copy the same keyboard for twenty times and add its configurations to other keyboards.

To make multiple copies of the Resources,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab, this opens the asset home page -> select the Asset Components link on the left hand side of the page.
3. From the list view page of the Asset Components -> click the title of the asset component to be duplicated. This opens the asset components details page.
4. Click the Actions combo box -> select the Copy Resource option. This opens the Copy Resource page as shown below;

   ![Duplicate Request](image)

   Enter the number of copies to make of the selected request

   Number of Copies

   Copy Cancel

5. Specify the Number of Copies to be made for the resource in the given text field.
6. Copy the resource. You can see the list of resource copies listed in the list view.
Editing Components

To edit the resource details,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab -> select the Asset Components link under the resource block on the left hand side of the page. This opens the list view page of the asset components.
3. Click the title of the Asset Components to be edited. This opens the Asset details page.
4. Click Edit button on the top right hand side of the page (Or) Click the Actions combo box next to the edit resource button -> select the Edit option. This opens the Edit Components page.
5. Edit the Asset Details block such as Asset Name, Tag, Serial No, Bar Code, Vendor Name, Cost, Acquisition Date, Expiry Date, and Location. The Product Name cannot be edited as it is linked to the product list created by the technician.
6. Modify the Asset State details such as, Current usage status of the assets like In Use, In Repair and so on. Then the Associate the asset to User or Department details or Assign to User or Department details.
7. Update the changes. You can see the components details getting updated.
Attaching Documents

To attach documents to an Non-IT Asset,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab -> select the Assets Components link under the resource block on the left hand side of the page. This opens the IT asset list view page.
3. Click the title of the component to be attached to other assets. This opens the Asset details page.
4. Click the Actions combo box on the top right hand side of the page -> select the Attach Documents option. This opens the Attach File pop up window.
5. Choose the file to be attached by clicking the Browse button. The maximum size of the attached file can be 10 MB.
6. Click Attach File. The attached document will be listed in Asset details page under Attached Documents. The attached file can be deleted by clicking the delete icon beside file name.
Non IT-Assets

All non IP based assets are grouped under Non-IT assets. The list of all possible non-IT assets are given below,

- Projectors
- Scanners
- Tables
- Chairs
- Telephones
- Adding Non-IT Asset
- Editing Non-It Asset
- Adding Non-It Asset to Group
- Assigning bulk Non-It Asset to Department/Site
- Modify the State of Non-It Assets
- Delete Non-It Asset
- Viewing Non-It Asset Details
- Assigning Non-It Asset to Users and/or Department
- Copy Resources
- Attach Asset
- Attach Component
- Attach Documents
Assigning Non-IT Assets to Users and/or Department

To assign assets to asset/users/departments,
1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab -> select the Non-IT Assets link on the left hand side of the page. This opens the list view page of the Non-IT assets.
3. Click the title of the Non-IT asset to be assigned to users or departments. This opens the Asset details page.
4. Click Assign button (Or) the Actions combo box on the top right hand side of the page -> select the Assign option. This opens the Assign/Associate page.
5. Select the Assign the asset to User/Department radio button to associate it to the user/department.
   1. Select the User from the combo box.
   2. Select the Department to be associated from the combo box.
   3. If the Asset is Leased then select the corresponding check box.
   4. Save the changes.
6. Else select the Associate to Asset radio button to associate to the asset.
   1. Choose Asset to be associated from the combo box.
   2. Save the details.

Once you save the details the page is refreshed with a message saying 'Owner assigned successfully for this resource'.
Editing Non-IT Assets

To edit the non-it assets details,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab -> select the Non-IT Assets link on the left hand side of the page. This opens the list view page of the IT assets.
3. Click the title of the Non-IT asset to be edited. This opens the Asset details page.
4. Click Edit button on the top right hand side of the page (Or) click the Actions combo box next to the edit resource button -> select the Edit option. This opens the Edit Asset page.
5. Edit the Asset Details block such as Product Name, Asset Name, Tag, Serial No, Barcode, Vendor Name, Cost, Acquisition Date, Expiry Date, and Location.
6. Modify the Asset State details such as, Current usage status of the assets like In Use, In Repair and so on. Then the Associate the asset to User or Department details or Assign to User or Department details.
7. Update the changes. You can see the assets details getting updated.
Adding Non-IT Assets to Group

You have two types of groups in ServiceDesk Plus say, Static group and Dynamic. Add to group option in Non-IT asset list view page is to group bulk of Non-IT assets. These assets will be grouped under the Static group by default.

To Add Non-IT Assets to group,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click any of the Non-IT Assets link under the Resources block on the left hand side of the page. This opens the Non-IT assets list view page.
3. Select the Non-IT assets to be added to the group by enabling the check box. This opens the Add Resource(s) to page.
4. By default you can group Non-IT assets only to the static group. Either to the Existing static group or New static group can be added.
5. If you would like to group the Non-IT assets under existing static group then click the corresponding radio button. Select the group name from the combo box.
6. Else, if you would like to add a new static group and group the Non-IT assets, click New Group radio button. Specify the Group Name and relevant information about the group in the Description field.
7. Click Save button to save the changes.
Assigning Bulk Non-IT Assets to Department/Site

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Select the Non-IT Assets title under the Resources block. Select the specific Non-IT Asset link. This opens the Assets list view page.

Assign Bulk of Assets to Department

1. Click on the Non-IT assets to be assigned to a Department by enabling the check boxes. Click Actions menu -> select Assign to Department option. This opens Assign Resources to pop-up window.
2. Select the Department Name from the combo box.
3. Save the details.

Assign Bulk of Assets to Site

1. Click on the Non-IT assets to be assigned to a Site by enabling the check boxes. Click Actions menu -> select Assign to Site option. This opens Assign Resources to pop-up window.
2. Select the Site Name from the combo box.
3. Save the details.
Modifying the State of Non-IT Assets

To modify the state of Non-IT Assets,

1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.
2. Click on Assets tab -> Click Non-IT Asset link on the left hand side of the page. This opens the IT Assets list view page.
3. From the Assets list view page, select the asset to be modified by enabling the check box beside the asset title.
4. Click the Actions combo box -> select the Modify State option. (OR) From the Asset details page, click the Change link beside the Resource State on the right hand side of the page. This opens the Modify State page.
5. Select the Modify State from the combo box. Ex: In Use, In Store and so on.
6. Save the changes.
Deleting Non-IT Asset

1. Log in to the ServiceDesk Plus application using your **user name** and **password**. This opens the ManageEngine ServiceDesk plus home page.

2. Click on **Assets** tab on the header pane. This opens the Asset home page.

3. Click **Non-IT Assets** link under Resource block on the left hand side of the page. This opens the Non-IT Assets list view page.

4. Enable the check box beside the assets to be deleted. Click **Delete** button.

5. A confirmation dialog appears. Click **Ok** to continue. You can see the selected assets deleted from the list.
Viewing Non-IT Assets Details

1. Log in to the ServiceDesk Plus application using your user name and password. This opens the ManageEngine ServiceDesk plus home page.

2. Click on Assets tab -> Click Non-IT Assets link under on the left hand side of the page. This opens the Non-IT Assets list view page.

3. Click on the Non-IT Asset name to view the Non-IT Assets details. By default Resource Info tab details are displayed.

Viewing Resource Info Details
Resource Info tab displays the Resource Details such as, Resource Name, Tag, Bar Code, Serial No Region, Cost, Acquisition Date and many other details are displayed.

Viewing History of Non-IT Assets
Click on the History tab to view the Non-IT Assets history. This gives the complete Non-IT Assets Resource Ownership History on date and State of the Non-IT Assets.

Request Details
On clicking the Request Details page you will be able to view all the requests raised for the Non-IT Asset.

On Clicking the request title you can view the details of the request, requester details, Assets belonging to the user, Time elapsed to solve the request, resolution for the request and history of the request

Also you can send reply for the request or forward the request to the technician. You can Search associated problem and change or add new problem or change to the request.

Contracts Details
Click on Contracts tab to view the contracts attached to the Non-IT Assets. This gives the complete details about the contract such as, vendor name, support details, contract rules, expiry date, cost and other rules.

Costs Details
1. Click on the Costs tab to view the costs associated to the Non-IT Assets.

2. Click on Add Cost button to add cost to the Non-IT Assets.

3. Select the Cost Factor from the combo box. For ex. Service Cost, Purchase Cost etc. This is a mandatory field.

4. Specify the description about the cost in the Description field. Say if the cost factor is service cost you can specify important information about the service cost.

5. Specify the Amount in $ in the Amount field. This is a mandatory field.

6. Select the Date from the calendar button. This is mandatory field.

7. Click on Add Cost button to add the cost. You can see the cost added to the Non-IT Assets shown in the Other Costs list view page.
Assigning Non-IT Assets to Users and/or Department

To assign assets to users/departments:

1. Log in to ServiceDesk Plus using your user name and password.

2. Click the **Assets** tab -> select the **Non-IT Assets link** on the left hand side of the page. This opens the list view page of the Non-IT assets.

3. Click the **title of the Non-IT asset** to be assigned to users or departments. This opens the **Asset details** page.

4. Click **Assign** button (Or) the **Actions** combo box on the top right hand side of the page -> select the **Assign** option. This opens the **Assign/Associate** page.

5. Select the **Assign the asset to User/Department** radio button to associate it to the user/department.
   - 1. Select the **User** from the combo box.
   - 2. Select the **Department** to be associated from the combo box.
   - 3. If the **Asset is Leased** then select the corresponding check box.
   - 4. **Save** the changes.

6. Else select the **Associate to Asset** radio button to associate to the asset.
   - 1. Choose **Asset** to be associated from the combo box.
   - 2. **Save** the details.

Once you save the details the page is refreshed with a message saying 'Owner assigned successfully for this resource'.
Copy Resources

Using Copy Resource option you can make multiple copies of the resource and its details. On making multiple copies of the resource, it becomes easier for the technician to add bulk of similar assets. The technician need not manually enter all the resource details for each resource. The new copies of the resource will be assigned with new asset name and rest of the details is retailed as is.

To make multiple copies of the Resources,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click Non-IT Assets under Resources block on the left hand side of the page. Select the respective Non-IT assets link. e.g. Projectors, Scanners and so on. This opens the corresponding Non-IT asset page.
4. Click the Title of the assets to be duplicated. This opens the Asset details page.
5. Click the Actions menu on the right hand side of the page. Select Copy Resource option. This opens the Copy Resource pop up window.

5. Specify the Number of Copies to be made for the resource in the given numeric field.
6. Click Copy to make the copies of the Non-IT asset. The new copies of the Non-IT asset will be assigned with new asset name that will uniquely identify them. The rest of the information is retained as is. If required, you can also edit the resource details.
Attaching Assets

To attach assets to the IT Assets,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab -> select the Non - IT Assets link on the left hand side of the page. This opens the list view page of the Non-IT assets.
3. Click the title of the Non-IT asset to be attached to other assets. This opens the Asset details page.
4. Click the Actions combo box on the top right hand side of the page -> select the Attach Asset option. This opens the Attach Asset page.
5. You have two columns, such as Asset list and Attached assets list. You have to select the assets to be attached from the assets list and move it to the attached list using the >> button. To remove the asset from the attached asset list use the << button.
   
   **Example:**
   If you would like to attach a scanner to a list of workstations then select the list of workstations from the asset list and move it to the attached asset list.
6. Save the changes. If you would like to detach all the attached assets then select the Detach All option.
   
   If you would like to display the list of all assets or a specific asset in the organization such as Linux workstations, Laptops D620 etc, then in this case select the assets to be displayed from the List combo box. Also select the type of asset such as assets in store, in use and so on from the of type combo box.
Attach Component

To attach component to an Non-IT asset,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane, this opens the assets home page -> select Non-IT Assets under Resources block on the left hand side of the page. Click the specific Non-IT asset link. This opens the Non-IT assets list view page.
3. Click the title of the Non-IT asset to be attached with an component. This opens the Non-IT asset details page.
4. Click the Actions combo box and --> select the Attach Component option from the list. This opens the Attach Component pop up window.
5. If you would like to display the list of all components or filter specific components then select the components to be displayed from the List combo box. Ex: keyboard, mouse and so on. Also select the type of component such as component in store, in use and so on from the of type combo box.
6. You have two columns, such as Component list and Attached Components list. Select the components to be attached from the components list and move it to the attached components list using the >> button. To remove the component from the attached component list use the << button.
   **Example:**
   If you would like to attach a keyboard and a mouse to a workstation then select the list of components to be attached from the component list and move it to the attached component list.
7. **Save** the changes. If you would like to detach all the attached components then select the Detach All option.
Attach Documents

To attach documents to an Non-IT Asset,

1. Log in to ServiceDesk Plus using your user name and password.
2. Click the Assets tab -> select the Non-IT Assets link under the resource block on the left hand side of the page. This opens the IT asset list view page.
3. Click the title of the Non-IT asset to be attached to other assets. This opens the Asset details page.
4. Click the Actions combo box on the top right hand side of the page -> select the Attach Documents option. This opens the Attach File pop up window.
5. Choose the file to be attached by clicking the Browse button. The maximum size of the attached file can be 10 MB.
6. Click Attach File. The attached document will be listed in Asset details page under Attached Documents. The attached file can be deleted by clicking the delete icon beside file name.
Software Asset Management

ManageEngine ServiceDesk Plus discovers all installed software in the network. Asset managers have tough time managing personal, official and recreational software that is common in the workplace.

1. ServiceDesk Plus groups scanned software based on Managed, Open Source types etc.
2. Helps in License Management
3. Helps in Group based on application
4. Software Metering - which tracks the usage of the software in each workstation.
Scanned Software

While scanning workstations, the softwares installed in the workstations are also scanned and listed under Scanned Softwares in the Software tab. From the Scanned Software list view page, you can acquire details such as, Manufacturer, Software Type, number of Installations of the software and so on.

The page also includes various useful functionality such as,

- Option to view the scanned softwares based on the Sites, Manufacturer and Software Type.
- Customize columns to be displayed in the List View
- Set the number of softwares to be displayed per page.
- Perform bulk operations such as delete, change category and software type of softwares.

Representation of icons in the List View:-

- Software which are Compliant.
- Software the Compliant Type as Under License. The number of license installation is less than the amount purchased.
- Software with Compliant Type as Over License. The number of license installation is more than the amount purchased.
- Softwares for which the Compliant is not applicable.
- Select the columns to be displayed in the list view.
- Search for softwares on entering the manufacturer, category, type and so on.

From the List View page you can,

1. **View Softwares based on Filter:** You can filter softwares based on the Sites, the Software Manufacturer and the Software Type. Say, If you require to view of all the managed softwares from Adobe Systems, select the Manufacturer as Adobe Systems and the Software Type as Managed.

2. **Set the number of softwares per page and navigation buttons:** You can set the number of softwares to be displayed per page in the List View page.

3. **Adding New Software:** Add New Software apart from the existing scanned softwares.

4. **Bulk Operations:**
   - **Move:** Option to move the bulk softwares from one software type to another.
   - **Change Category:** Option to change the category of bulk softwares.
   - **Delete:** Option to bulk delete softwares.
Adding New Software

To Add new Software,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane. This opens the assets home page.
3. Click Software title under Resources block on the left hand side of the page. Click the Scanned Software link. This opens the software list view page. By default the list of All softwares will be listed.
4. Click the New button on the right hand side of the page. This opens Add Software form.
5. Specify the Software Name in the given text field. e.g. Adobe Photoshop. This is a mandatory field.
6. Specify the Version of the software. Say 7.1, 7.2 etc.
7. Select the Software Type from the combo box. Say Managed.
8. Select the Software Category from the combo box. Say Graphics. This is a mandatory field.
9. Specify relevant information about software in the Description field.
10. Click Add button to add the software. You can see the newly added software getting listed in software list view page.
Viewing Software Details

The details of the software added by you is displayed under the Software Details page. Apart from viewing the software details, you can also perform various actions on the software such as,

- changing the software type
- adding and associating a software license to the software
- adding a new license agreement, and
- associating minor versions to the software

To view the software details page,
1. Select Software -> Scanned Software under Resources block.
2. From the software view list page, select the Software Type as Managed from the Filter drop down. All the licensed software are listed.
3. Click on the software name to view the software details. The page opens to display Software Details tab and License Agreements along with the Actions drop down.

Software Details

The details added by you in Add New Software is displayed under this block. In addition, the software license associated to this product is also displayed as Purchased License. You can also change the software category and type by clicking change link beside the fields.

From the Actions drop down, you can perform various actions such as Changing the Software Type, Add Software License, adding a new license agreement and associating minor versions.

In addition, you can also view the list of workstations with the licensed installed, workstations with unlicensed installations and number of software licenses purchased.

Licensed Installations

Under Licensed Installations, all workstations with the licensed software installed is listed. You can view details like, the license version, the software usage, license key and the license allocated. You also have an option to De-allocate the license from the workstation.

Un Licensed Installations

Under Unlicensed installations, all workstations with unlicensed installation of the software is listed. You can allocate license to a single machine or to all the machines in the list.
Allocate Licenses to a single machine

1. Click the Attach License to Software icon.
2. From the available license listed in Select Software License pop up, enable the radio button beside the license name to allocate to the software installed in the workstation.
3. Save the changes. The software installed in the workstation is licensed and is listed under the Licensed Installations column.

Allocate Licenses to multiple machines

1. Select the workstations to allocate licenses by enabling the check box.
2. Click Allocate License button to allocate licenses to bulk of workstations. It takes all the unallocated licenses and assign it to the workstations automatically.

Purchased Licenses

Under Purchased licenses, you can view the number of purchased licenses, license type, Installation details, license key details etc.

Deleting the Purchased License

1. Enable the check box beside the purchased licenses from the list you wish to delete.
2. Click Delete button. A confirmation window pops up.
3. Click Ok to proceed. The softwares licenses is deleted from the list.

Move Licenses

You can move all the unallocated purchased license to sites.

1. Select the site from the Move Licenses To check box.
2. Enable the check box beside the licenses to be moved to the selected site.
3. Click Move button. You can change site by selecting the site from the site option at the top left of the page.

License Agreements

Software license agreement is a contract between the software vendor and the purchaser. It is often called as the end user license agreement. The license agreement consists of terms and conditions on how to use the software in the organization.

You can Filter to view the license agreement based on the active and expired agreements. In addition, you can also add a new license agreement and delete the existing license agreement for this software. [ Refer Add License Agreement to know more.]
Changing Software Type

Using this option, you can change the existing type of the software, say, from Shareware to Managed. You can change the software type either from the software list view page or from the software details page.

Changing Software Type from Software List View

From the software list view page, you can change the software type for bulk softwares instantly and with ease.

1. Select Software -> Scanned Software link from the Resources block. All the scanned softwares are listed.
2. Enable the check box beside the software to change the software type.
3. Choose the Software Type from the drop down and click Move button. The software type for the selected software is changed.

Changing Software Type from the Software Details page

Change the software type for individual softwares using this option,

1. From the Software details page, select the software name. The software details page opens.
2. Click the Actions tab -> Change software type option. The change software type window pops up.
3. Select any one of the listed software type. Say Managed.
4. Click Change button to change the software type. The software type changes to managed in the software details page.
Changing Software Category

Using this option, you can change the existing category of the software. Say, from Graphics software to Multimedia software so on.

1. Click the Software -> Scanned Software under Resources block. All the scanned softwares are listed.
2. Enable the check box beside the software to change the software category.
3. Click Change Category button. The Change Software Category to window pops up.
4. Select the software category from the list, say Accounting, Development.
5. Save the changes. The category for the selected software is changed.
Deleting Software

1. From the Software list view page, select the software to be deleted by enabling the check box. You can select multiple software to be deleted.

2. Click the Delete button. A pop up window pops up asking your confirmation on the delete process.

3. Click OK to proceed. You can see the software deleted from the list.
Associating Software Minor Versions

ManageEngine ServiceDesk Plus allows you to group minor versions of the software under major version.

For e.g. A company buys AdobePhotoshop 7.0 with 4 licenses. The license is applicable for both 7.1 and 7.2 versions and vice versa. In this case 7.0 is the major version and 7.1 and 7.2 are the minor versions. The licenses purchased are the same for all the three versions.

If Adobephotoshop 7.0 is installed in two different machines and 7.1 & 7.2 is installed in other two different machines. On scanning for Adobe Photoshop software before grouping, the ServiceDesk Plus shows the list as different single entries. The purchased licenses for the software would be as ’4’ for the version 7.0 and ’0’ purchases for other versions (7.1 & 7.2).

Using associate minor versions option you can group 7.1 & 7.2 minor versions under 7.0 major version. This shows the software list to be a single entry with the number of purchased licenses and installations. Thus helps you in avoiding individual entry for each version of the software. And also helps in easier management of the installed software for the assetmanager.

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane to open assets home page.
3. Click Software title under Resources block. Click Scanned Software link.
4. From the software list view page, click the software name to open the software details page.
5. Click on the Actions tab -> select Associate Minor Versions option. The Associate minor versions page opens.
6. Select the managed software (licensed) to be grouped of minor versions from the list. Click >> button to move the selected managed software to the Version Group list. By moving the selected managed software under Version Group, all the minor versions will be associated with the major version.
7. Click Save button. You can see all the added minor versions getting displayed in the software details page under the title Software - All Versions.
E-mailing Users

Technicians can communicate to the users who have installed the software instantly by send email from the software details page. With this option, technicians can communicate with the users for any event occurred or to get information from users.

1. Click **Software -> Scanned Software** link under **Resources** block. All the scanned softwares are listed.
2. Click on the software name to open the software details page.
3. Click on the **Actions** tab -> **Email users** option. The Email Users page pops up.

4. Specify the **To** email address in the given field.
5. By default you have subject and description provided for the email. If required, you can edit and specify the **Subject** and **Description** about the email in the fields.
6. Click **Send E-mail** button. The email is sent to the mail ID provided in the To field.
Software Summary

ServiceDesk Plus scans your network and automatically discovers all softwares available in the workstations. From the Software Dashboard, Asset Managers can

- group the softwares according to the Manufacturers and the Site in which they are associated.
- easily ensure compliance by keeping a check on the list of compliant, under licensed and over licensed software.
- facilitate easy access to view the total number of softwares that are unused, rarely used, managed, prohibited and unidentified for the selected Manufacturer and Site.
- view the number of expired license agreement, agreement to be expired in the next 7 days and agreement to expire in the next 30 days.
- Software Metering - tracks the usage of software in each workstation.
License Agreement

Software License Agreement is a contract between the software vendor and the purchaser. Software companies often make special contracts, such as contract for support and warranty with large businesses. Also, the license agreement consists of the acquisition date, expiry date, terms and conditions on how to implement the software in the organization. These documents are called as the End User License Agreement (EULA).

ManageEngine ServiceDesk Plus provides an option to maintain the license agreements in the database by adding the license agreement in the application. Also you can associate the license agreement with the software licenses.

Adding New License Agreements

1. Click **Assets -> License Agreement** under **Resources** block. The available license agreement is listed.
2. Click **Add New** button.
3. Select the **Manufacturer** of the software for which the license agreement is created from the drop down. If the manufacturer is unavailable in the list, select the add new icon. Enter the **Manufacturer** and **Description** in the pop up.
4. Specify the **Agreement Number** and **Authorization Number**. The Agreement Number is a mandatory.
5. Select the **Acquisition Date** and **Expiry Date** of the software using the calendar icon.
6. Select the **Vendor** from whom the software was purchased from the drop down. If the vendor detail is unavailable in the list, select the add new icon and enter the **Vendor Name**, **Description** and name of the **Contact Person**.
7. Specify the **Description** and **Terms** for the license agreement.

8. If required, you can also attach relevant documents to the agreement. Click **Attach File** button. **Browse** through the file and click Attach file.

9. You can add additional license agreement fields directly from this form by clicking **Add More Fields**.

ou can choose the type from Single-line, multi-line, picklist, numeric and date/time fields. Enter the Label and Default Value (for single-line and multi-line) to be displayed in the form.

10. Specify the Purchase and Invoice Details such as, **Purchase Order Number**, **Purchase Order Name**, the date of purchase of the software in the respective fields.

11. Also, enter the **Invoice Number**, **Invoice Date** from the calendar icon and the **Total Cost** of the software.

12. You can either **associate the license with an existing software license** (provided there are unassociated license available for the selected manufacturer) or **add a new software license and associate the agreement**.

**Associating existing license to agreement**

1. Click **Associate to Existing License** button.

2. From the Associate Existing License pop up window, choose the **Site** and **Software** from the filter drop down.

3. Enable the check box beside the license to be associated with the license agreement.

4. Click **Associate to agreement** button. The selected licenses is associated and listed below the Purchase Software License block.

**Add New License and Associate**

You can instantly add a software license and associate it to the license agreement.

1. Click **Add New License and associate** button.

2. From the pop up window, select the **Software**, **License Type**, **License Options**, **Installations Allowed**, **License Key** and the **Cost ($)** from the drop down. The License Type, License Options and Installations Allowed are mandatory fields.

3. You can add licenses for other softwares by clicking the **Add** icon and repeat the steps as above.
4. Click **Associate to agreement** button. The license is associated and listed below the Purchase Software License block.

13. You can notify users before the license agreement expires by selecting the users to be notified from the **Users List**. Click >> button to move the selected user to **Notified User List** block.

14. Select the **Days** before which the selected users should be notified of the license agreement expiry. If you have selected the users to be notified of the license expiry then this field is mandatory.

15. Click **Save**.
Editing and Deleting License Agreement

You can modify and delete the existing license agreement from the application.

Edit License Agreement

1. Select Assets tab -> License Agreement under Resources block. The list of available license agreement is displayed.
2. Select the Agreement Number to be edited.
3. From the License Agreement details page, click Actions -> Edit Agreement option. The Edit License Agreement form appears with details populated while creating the license agreement. The Manufacturer field is non-editable.
4. Modify the details and Save the changes.

Delete License Agreement

1. Select Software -> License Agreement under Resources block. The list of available license agreement is displayed.
2. Enable the check box beside the Agreement Number to be deleted.
3. Click the Delete button. The agreement is deleted from the list.
Printing the License Agreement
You can preview and print the entire license agreement details using Print Preview option.

To print the license agreement,

1. Click Assets tab -> License Agreement under Resources block. The list of available license agreement is displayed.
2. Select the Agreement Number to be printed.
3. From the License Agreement details page, click Actions -> Print Preview option. The license agreement details appears in a printable form in a pop up window.
4. Click Ctrl + p keys to print the contract details.
5. Set the required options and click Ok.
Software License

ServiceDesk Plus helps you to manage software licenses installed across the enterprise. You can consolidate and manage all your software licenses from a single screen. ServiceDesk Plus will scan and automatically pickup license keys for Microsoft Windows and Microsoft Word. You can key-in all the licenses purchased earlier and track future purchase of software licenses through the Purchase module.
Adding Software Licenses

Using this option, you can create a software license for the existing software. The software license form can be accessed by two ways in ServiceDesk Plus application.

a. Quick Actions drop down
   b. Assets Tabs

a. Quick Actions drop down

The Quick Actions drop down is a quick navigator to instantly access the Software License form from the home page. To add a new Software License, go to Step 2 in Software Tab.

b. Assets Tab

1. Click on Assets tab in the header pane.
2. Select Software -> Software License under Resources block. The list of available software license is displayed.
3. Click Add New button.
4. Select the Manufacturer of the software.
5. The list of managed softwares available for the selected manufacture is listed in Managed Software drop down. Select the software for which the license is created.
6. Select the Vendor Name from the drop down. If the vendor is not available in the list, you can add a new vendor on selecting the Add New link. In the pop up, specify the Vendor Name, Description and Contact Person, and save the changes.
7. Select the date of purchase of the software from the calendar button in Acquisition Date field.
8. Select the Expiry Date of the software from the calendar icon.
9. Specify the cost of the software per license in Purchase Cost field.
10. Select the department for which the software was purchased in Purchased for drop down list.
11. If you have configured Sites, select the site name where the licensed software is installed, from Allocated to Site drop down.
12. Select the License Type from the drop down. Each manufacturer has their unique license type apart from the several common license types. Some of which are,

   - **Individual**: License type for single installation
   - **OEM (Original Equipment Manufacturers)**: License type for softwares that are already installed in the hardware.
   - **Named User License**: License Type for a specific user.
   - **Volume**: License Type supporting multiple users.
   - **Client Access License (CAL)**: License type that gives a user the rights to access the services of the server.
   - **Trial License**: License Type for trial versions of a software.
   - **Enterprise (Perpetual)**: License Type that does not require renewal and is for life long.
   - **Concurrent License**: License Type for a software that can be accessed by a specific number of users at a time.
   - **Free License**: License Type for freeware softwares.
   - **Enterprise Subscription**: License Type that requires renewal for every specific period.
   - **Node Locked**: License Type for workstations with specific configurations.
Individual License/OEM
1. Select the **License Option** as either Full Package Product (FPP) or Others from the drop down.
2. Specify the **Number of licenses** required for the selected product.
3. Enter the **License Key (s)** for the software in the given text box. The license keys values should be in comma separated values format. Say XBVJD,YCCYR,7DF28,JH2PX,MYT7M.
4. Save the details The license is listed in the software license list view page.

Volume License/Trial License
1. Mention the **Number of licenses** required for the selected product.
2. Specify the number of **Installations allowed** per license.
3. Specify the **License Keys** in the given text field. Say XBVJD,YCCYR,7DF28,JH2PX,MYT7M.
4. Save the details. The license is listed in the software license list view page.

Client Access License (CAL)
The Client Access License consists of the following License Options,
- **Per Seat-Device/ Per Seat-User**: License given to each unique user/device to avail the server software product. The number of CALs is equal to the number of devices/users accessing the server software.
- **Per Server**: License given to each server. The number of devices accessing the server simultaneously is limited and is primarily recommended for servers that require limited access.
- **Pre Processor**: Connect unlimited users/workstations to the server product.
- **Pre Mailbox**: License for each mailbox using Exchange Server.

Select the **License Option** from the combo box.

**Pre Seat-Device**
1. Enter the required **Number of CALs**.
2. Specify the **License Keys** in the given text field. Say XBVJD,YCCYR,7DF28,JH2PX,MYT7M.
3. If there are any additional information required, then the same can be specified under **Additional Information** block.
4. You can select the workstations that can access the software from **Choose CAL Installation** block. Select the workstation by either choosing the client software from **Filter by** or from **Departments** drop down. You can also search for the workstation on entering the name in **Search** field and selecting Go button. The list of server/workstations is displayed. Select the workstations. Click >> button to move to CAL Installation box. **Note**: The number of workstations selected should be lesser than or equal to the specified number of CALs.
5. Save the details. The license is listed in the software license list view page.

**Pre Seat-User/ Pre-Mailbox**
1. Specify the details similar as above.
2. Instead of selecting the workstations from Choose CAL Installation block, choose the **Users** to access the software from the list displayed.
3. Save the details. The license gets listed in the software license list view page.
Pre-Server

1. Specify the details similar as in Pre-Device.
2. Associate the specified number of CALs to the server selected from **Associate to Server** drop down list.
3. **Save** the details. The license gets listed in the software license list view page.

Pre-Processor

1. Specify the **Number of Processor(s)** that supports the ability to connect unlimited users/workstations in the given field. Since unlimited users/workstations can connect to the server software product the CAL Installation block is not available.
2. Specify the details as configured above.
3. **Save** the details. The license is listed in software license list view page.
Viewing Software Licenses

The details of the software license added by you is displayed under Software License details page. Apart from viewing the software details, you can also view the workstations allocated with the software license, any relevant document attached and the contracts associated to the software license.

To view the software license details,

1. Select Assets tab -> Software License under Resources block. The list of available software license is displayed.
2. Click on the software license name to view the software details. The page opens to display License Info and the Contracts tab.

License Info

The details added in the New Software License form is displayed under this block. Apart from the details added, you can also view the license agreement number associated with the Software.

From this page, you can Edit and Attach relevant documents the software license using the options from the Actions drop down.

Contracts Tab

Contracts associated to software is listed under the Contracts tab. You can add a new contract under the Contracts tab.
Editing and Deleting Software License

ManageEngine ServiceDesk Plus provides you with the option to modify and delete the existing software license.

Edit Software Licenses

1. Select Assets tab -> Software -> Software License under Resources block. The list of available software license is displayed.
2. Click the software license name to be edited.
3. From the software details page, click Edit tab. [OR] Click Actions tab -> Edit option. The Edit Software License page opens.
4. Modify the required fields and Save the changes.

Delete Software Licenses

1. Select Assets tab -> Software -> Software License under Resources block. The list of available software license is displayed.
2. Enable the check box beside the software licenses to be deleted.
3. Click Delete button. A confirmation dialog box appears.
4. Click Ok to proceed. The software license deleted from the list.
Attach Document to Software Licenses

To attach document to Software Licenses,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane, this opens the assets home page.
3. Click the Software title under the Resources block on the left hand side of the page. Click Software licenses link, this opens the software licenses details page.
4. Click the software license name to be attached with an document. This opens the software license details page.
5. Click the Actions combo box -> select Attach Documents option from the list. This opens the Add/Remove Attachment pop up window.
6. Click the Browse button to select a file. The maximum size of the attached file can be 10 MB.
7. On selecting the file, click Attach File button to attach the document.
Service Packs

ServiceDesk Plus keeps track of all the service packs such as hotfix, security update, installer, on scanning the workstations.

To view the Service Packs details,

1. Click Software title -> Service Packs link under Resources block. The service pack list view page opens.
2. Click the service pack name to view the service pack details.

The details page displays the complete detail about the service pack with number of installations, and installation without service packs. It also provides information on the number of software the service pack applies to.

Say, If the service pack Security Update for Windows XP is applicable for Microsoft Windows XP Professional and Microsoft Windows 2000 Professional then this software list would be displayed before the service pack installations list.

Service Pack

<table>
<thead>
<tr>
<th>Service Pack</th>
<th>KB896358</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Security Update for Windows XP (KB896358)</td>
</tr>
<tr>
<td>Installations</td>
<td>1</td>
</tr>
<tr>
<td>Applies To Software</td>
<td>Microsoft Windows XP Professional</td>
</tr>
</tbody>
</table>

Service Pack Installations

Under this block you get the list of all service pack installations with the Workstation name, User name, Installed On and Installed By details.

Software Installations without Service Packs

Under this block you get the list of all software installations without the service packs along with the Workstation name, User name, Software and Usage details.
Editing and Deleting Service Packs

ServiceDesk Plus gives you an option to modify and delete the existing Service Packs.

Edit Service Packs

1. Click **Software** title -> **Service Packs** link under **Resources** block. The service pack list view page opens.

2. Select the Service Pack name to be edited from the list.

3. From the Service Pack details page, click the **Edit** button. This opens the Edit Service Pack page.

4. Modify the **Service Pack Name**, **Type** and **Description** of the service pack. Also, you can add software or service packs to the existing service pack list. To add to the list, select from the available list of software and move to the selected software using **>>** buttons.

5. **Save** the changes.

Delete Service Packs

1. Click **Software** title -> **Service Packs** link under **Resources** block. The service pack list view page opens.

2. Enable the check box beside the Service Packs to be deleted from the list.

3. Click **Delete** button. A confirmation message appears.

4. Click **Ok** to continue. The Service Pack is deleted from the list.
Groups

Manage Groups

ManageEngine ServiceDesk Plus helps you to group assets based on asset properties. You can group assets of users belonging to the same team and location. Organizing assets based on groups gives you more fine-grained control and helps you manage assets efficiently. E.g. you can group assets based on OS, Service packs, Memory size and so on. When you are getting ready for migration you will be able to pinpoint assets with 256 MB RAM that need upgrade before rolling out Windows Vista.

- Creating New Group
- Removing Assets from a Group
- Editing and Deleting Group
Creating New Group

For easier channelization, users can be categorized under Static and Dynamic groups.

Under **Static group** you define the group by listing its members.

Under **Dynamic group** resources are grouped automatically based on certain criteria set by the administrator.

1. Log in to ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Assets** tab in the header pane. This opens the assets home page.
3. Click **Quick Actions** menu on the top left side of the page. Select **New Group** under **Asset - Groups** from the list. **OR** Click **Groups** under **Resources** block on the left hand side of the page. Click **New Group** link. This opens the **Create Group** form.
4. Specify the **Group Name** in the given text field. This is a mandatory field.
5. Specify relevant information about the newly created group in the **Description** field. Say the group name is Test DL600 you can specify Test DL600 stands for Dell Lateral 600.
6. Select any of the **Group Type** by enabling the radio button. Say **Static** or **Dynamic** group. **Static Group:** You define the group by listing its members. **Dynamic Group:** Resources are grouped automatically based on certain criteria.
7. Click **Save** button to save the group. You can see the newly created group getting listed in the **Create Group** page.
8. Once the group is created you have to add resources to the group.

**To add resources to the Static group,**

1. Select the filter criteria from the **Showing** combo box. Say for ex. You can select **All Assets in Use**.
2. Specify the **Search** criteria in the given text field.
3. Click **Go** button to list all resources based on the filter criteria. All the resources gets listed under **Pick resources to add** block.
4. Select the resources to be added to the group by enabling the check box.
5. Then click **Add** button to add resources to the group. You can see the selected resource added to the group, shown under Resources In group column.

**To add resources to the Dynamic Group,**

1. You define the filter criteria by selecting the **Criteria** and **Conditions** from the combo box. Select the **Criteria** from the combo box say for e.g. **Resource Criteria** or **Workstation Criteria**.
2. Select **Conditions** from the combo box, which will be listed based on the selected criteria.
3. Click **Choose** button to choose the resource or workstation criteria listed based on the criteria you have selected. **For example:** If you have selected resource criteria as **Product Type** and conditions as **is** then on clicking choose button you will get the list of all product types say scanners, keyboard, printers etc.
4. Select any one of the **Match Criteria** by selecting either of the radio buttons. Say (And) or (OR) criteria.
5. Select any of the listed Product Type and click **Ok** buttons to add to the group. You can see the group criteria getting listed.
6. Click **Save and View group** button to view the list of all resources based on the filter criteria.
Removing Assets from Group

To remove the existing resources from the group,

1. From the Group list view page, select the resource name from the list by enabling the check box under the Resources in-group column.

2. Click **Remove from Group** button to remove the resources. You can see the selected resource deleted from the list.
Editing & Deleting Groups

To Edit Groups,
1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Assets tab in the header pane. This opens the Assets home page.
3. Click Groups under Resources block on the left hand side of the page. Click Manage Groups link.
4. From the Manage Group list view page, click Edit link. This opens Edit Group page.
5. In the Edit Group form, the Group Type is in non editable text. Do the required changes and click Save.

To Delete Groups,
1. From the Manage Group list view page, click the corresponding Delete link to be deleted on the right hand side of the page.
2. A pop up window pops up to get your confirmation on the delete operation. Click OK to proceed. You can see the group deleted from the list.
Purchase

The Purchase module streamlines the procurement of required components and allows you to add them as unassigned assets. The Purchase module is tightly integrated with the Inventory. You can configure the vendor-related information and the products supplied by those vendors and their price quotes in ServiceDesk Plus. This information helps in making the choice of vendors while generating the Purchase Order (PO) by comparing the pricing of each vendor. The purchase process starts with a purchase request and is completed when the requested component or item has been purchased and reaches the requester of the purchase request. Below is the workflow that details the various steps involved in a purchase process.

To reach the purchase module, log in to the ServiceDesk Plus application using your user name and password and click the Purchase tab in the header pane.
Purchase Order Configurations

You need to configure the purchase/contract configurations before creating a Purchase Order and Contract.

The Purchase/Contract Configurations are,

- **Purchase Default Values** Set default values to be populated in the New Purchase Order form.

- **Purchase - Additional Fields** Require Additional Fields while creating a Purchase Order. This configuration provides option to add text, numeric, date/time and cost fields.

- **Cost Center** The Business Units are budgeted and tracked for the cost, income and allocation.

- **GL Code** Add General Ledger Codes that can be associated with the Purchase Order.

- **Contract Additional Fields** Require Additional Fields while creating a contract. This configuration provides option to add text, numeric and date/time.

- **Notification Rules** Notify Technicians of an Overdue Purchase Order or when the lease period of the asset is about to expire.
Purchase Default Values

With this option, you can set the default values to be populated in the New Purchase Order form. You can set default values for fields such as tax rate, the billing and shipping address, the purchase order terms and conditions and so on. Thereby, making it feasible to add create a Purchase Order instantly.

Also, from this option, you can set the mandatory fields to be filled in before closing a PO. These fields are the additional fields configured under Purchase Additional Fields.

To access the purchase default value configuration page,

1. Click the Admin tab in the header pane.
2. In the Purchase/Contracts block, click Purchase - Default Values icon. This opens the Purchase Default Values page.

Configuring Purchase Default Values

- **Default Currency**: The default currency to be displayed in all the purchase orders (PO) generated and in places where money is being used. Say, USD, $.

- **Default Tax Rate (%)**: Tax rate used for calculating the sales tax in all the POs generated. You can provide different tax rate to a specific PO by entering the new rate while creating the PO.

- **Signing Authority**: Signing Authority’s name.

- **Tax Shipping**: Enable the check box for additional tax in shipping of the items.

- **Shipping Address**: Select the default Site to which the PO items needs to be shipped.

- **Billing Address**: Select the default Site for invoice and billing the PO items.

- **Cost Center**: Default cost center department to be displayed.

- **Approver(s)**: Approvers for the purchase order. The approvers can be the users or technicians in your organization.

- **PO Owner as Approver**: Enable the check box if you wish to add the PO owner as the approver.

- **Multi Approval**: If there are more than one approvers, on enabling multi approval check box, the PO is approved only if all the approvers approve the PO. The PO is rejected even if one of the approvers rejects the PO.

- **Terms and Remarks**: Terms and remarks while making the purchase.

- **PO# Start From**: Customize the PO number.

**Mandatory fields for closing PO**

The fields listed in this block are the PO additional fields configured in the application. Enable the check box beside the field that should be filled in before closing the PO. Click Save to save the settings.
Purchase Order Additional Fields

You can configure purchase additional fields that need to appear in the new purchase order form.

1. Log in to ServiceDesk Plus application using your **user name** and **password**.
2. Click the **Admin** tab in the header pane.
3. In the Purchase/Contracts management block, click the **Purchase - Additional Fields** icon . This opens the Purchase - Additional Fields page. You can add four types of fields in the form: text, numeric, date/time and cost.
4. To add the text fields, enter the label name in the form fields below the **Label** heading. If required, enter the description for the field.
5. You can choose the type of text field that you wish to add by selecting the radio buttons.
   - **Single-line text field**: Allows you to add just a text field in the new purchase order form.
   - **Multi-line text field**: Allows you to add a text box where a lengthy description can be added in the new purchase order form.
   - **Pick List**: Allows you to add a combo box in the new purchase order form. Contents of the combo box can be added by specifying it in the text field and adding it to the list. This gives you an option to select from the list. In all the three cases, you can add default values for the text field in the space provided for the field.
     To add items for the pick list, enter the value in the text filed and click **Add Item**. To select the default selected value of the list, click on the value in the list.
6. To add numeric fields, click the **Numeric** tab and then enter the label name in the form fields provided for the same.
7. To add date/time fields, click the **Date/Time** tab and enter the required details.
8. To add the cost field, click the **Cost** tab. You have two cost type fields, **Add cost** (for cost addition) and **Subtract cost** (for cost subtraction). Click the corresponding radio button to select the cost fields.
9. Click **Save**. A message for successful creation of the fields is displayed.

These fields (except for cost) appear under the General Information in the **New Purchase Order** form. To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label names that you wish to remove from the fields of the form and click **Save**. The respective fields that you deleted will be removed from the New Purchase form.
General Ledger Code (GL Code)

You can add all the general ledger codes using this option. A general ledger account will have a specific code for all transactions in the organization. On specifying the GL code you will be able to track the necessary information for a specific transaction.

Say, if you like to know all your company's IT purchases for the November month 2007, then you can specify the GL code for IT purchases in November 2007 and get the details.

To access the GL Code configuration,

1. Click on the Admin tab in the header pane.

2. In the Purchase/Contracts management block, click GL Code icon. The GL Code list view page opens where you can add, edit and delete a GL Code.

Add GL Code

1. Click the New GL Code link. The GL Code form has two fields namely, GL Code and Description.
2. Enter the GL Code. This field is mandatory.
3. Specify any relevant information about the GL Code in the Description field.
4. Click the Add GL Code button. The GL Code is added to the List View.

Edit GL Code

1. Click the Edit icon beside the GL code to modify. The details while adding the GL Code is populated in the edit form.
2. Modify the required details in the fields.
3. Click Update GL Code button.

Delete GL Code

1. Click the Delete icon beside the GL code to delete. A confirmation dialog appears.
2. Click Ok to proceed. The cost center is deleted from the list.
Cost Center

Individual department or a group of department makes a Cost center. These cost centers are budgeted and tracked for the cost, income and allocation. These cost centers will be associated with the purchase order while making a new purchase in your organization.

To access the Cost Center configuration,

1. Click the Admin tab in the header pane.

2. Click Cost Center icon under the Purchase/ Contract Management block. The Cost Center List view page opens where you can add, edit and delete a cost center.

Add Cost Center

1. Click the New Cost Center link. The Cost Center form has four mandatory fields namely, Cost Center Code, Name and Owner.

2. Specify the code for the cost center in Cost Center Code field.

3. Specify the Name of the cost center.

4. The departments configurated in AssetExplorer application is listed under Departments. Select the Department from the available list.

5. Specify the Owner of the cost center. The owner is generally the department head and employee of the organization.

6. If required, enter relevant information about the cost center in the Description field.

7. Click Add Cost Center button. The cost center is added to the List View.

Edit Cost Center

1. Click the Edit icon beside the cost center you wish to modify. The details while adding the cost center is populated in the edit form.

2. Modify the required details in the fields.

3. Click Update Cost Center button.

Delete Cost Center

1. Click the Delete icon beside the cost center to be deleted. A confirmation dialog appears.

2. Click Ok to proceed. The cost center is deleted from the list.
Contract Additional Fields

You can configure contract additional fields that need to appear in the new contract form.

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Admin tab in the header pane.
3. In the Purchase/Contracts management block, click the Contract - Additional Fields icon. This opens the Contract - Additional Fields page. You can add three types of fields in the form: text, numeric and date/time.
4. To add the text fields, enter the label name in the form fields below the Label heading. If required, enter the description for the field.
5. You can choose the type of text field that you wish to add by selecting the radio buttons.
   - Single-line text field: Allows you to add just a text field in the new contract form.
   - Multi-line text field: Allows you to add a text box where a lengthy description can be added in the new contract form.
   - Pick List: Allows you to add a combo box in the new contract form. Contents of the combo box can be added by specifying it in the text field and adding it to the list. This gives you an option to select from the list. In all the three cases, you can add default values for the text field in the space provided for the field.
     To add items for the pick list, enter the value in the text filed and click Add Item. To select the default selected value of the list, click on the value in the list.
6. To add numeric fields, click the Numeric tab and then enter the label name in the form fields provided for the same.
7. To add date/time fields, click the Date/Time tab and enter the required details.
8. Click Save. A message for successful creation of the fields is displayed.

These fields appear under the Additional Contract details in the New Contract form. To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label names that you wish to remove from the fields of the form and click Save. The respective fields that you deleted will be removed from the New Contract form.
Notification Rules

Notification Rules are helpful when an event has to be notified to the technicians. Say, when Purchase order is overdue or Audit changes during discovery or Software under Compliance during discovery or when prohibited software is identified during discovery.

When the above-mentioned situations are managed suitably, it not only helps technicians in efficient management of the assets but also brings in cost savings to the organization.

Enabling Notification Rules

1. Click the Admin tab in the header pane. The configuration wizard page opens.


3. To set the notification rules select the relevant notification rules by enabling the check box. These notification rules are self-explanatory.

4. Except for Purchase order Overdue, You can assign technicians to notify of the fault for all the other notification rules.

5. To assign technician select Choose button, this brings up the Choose Technician Name page.

6. Select as many as technicians from the list using ctrl or shift keys.

7. Click OK button to save. You can see the selected technicians displayed in the choose technicians grayed out field.

8. Click Save button to save the set notification rules. The notification to the administrator or to the technicians will be generally sent through email.

Customize Message Template

You have default message template for Contract notification. To customize email templates as per your requirement,

1. Under Customize Message Template, click Edit Template link.

2. You can change the Subject and the Message content by typing the text of your choice and also adding other variables that you wish to display as a part of the subject or message content.

3. To add more variables, just click the corresponding variable from the list box beside the respective field.

4. Click Save.
About Purchase Order

1. Log in to ServiceDesk Plus application using your **user name** and **password**.
2. Click on **Purchase** tab in the header pane. This brings up the Purchase Orders list view page. By default the status of the Purchase Order will be 'All POs'.
3. Select the corresponding filter option from the **Filter Showing** combo box. You can view purchase orders with different status levels using filters. They are,
   - **All POs** All Purchase Orders irrespective of the status will be listed. This is the default status on opening the purchase order list view.
   - **Open POs** The newly added Purchase Order will fall under this category. These POs are not submitted for approval.
   - **POs Pending Approval** The Purchase Orders which are submitted and waiting for approval from the purchase order approvers will be listed under this category.
   - **Approved POs** All the Purchase Orders which are approved but the purchase items are not yet received will be listed under this category.
   - **Rejected POs** All the Purchase Orders rejected by the purchase order approver gets listed under this category.
   - **Ordered POs** Lists all the POs for which the items have been ordered by the vendor.
   - **Partially Received POs** Purchase Orders, which are partly received from the vendor, will be listed under this category.
   - **Received POs** Lists the POs for which the items has been completely received.
   - **Invoice Received POs** Lists all the POs for which the invoice is received from the vendor.
   - **Payment Done POs** Lists all the POs for which the payment is done.
   - **Closed POs** The Purchase Order gets listed under this category when the purchased items are fully received from the vendor.
   - **Overdue POs** Purchase orders not delivered and have exceeded the delivery date will be listed under this category.
   - **POs due in next 7 days** Outstanding Purchase Orders, expiring in next 7 days will be listed under this category.
   - **POs due in next 30 days** Outstanding Purchase Orders, expiring in next 30 days will be listed under this category.
   - **Searched POs** While searching for the Purchase Order under Search, the list of Searched POs will fall under this category.
Creating a New Purchase Order

To create a new purchase order,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Purchase tab in the header pane. This opens the purchase order list view page.
3. Click the New Purchase Order button available in the Purchase Order block. (OR) Click Quick Actions button in the home page --> click Purchase Order option under Create New option as shown below,

   ![Add Purchase Order form](image)

   This opens the Add Purchase Order form. By default, the status of the Purchase Order while adding will be New PO, after which the status changes to Open.

4. Specify the Order No in the given field. For ex: 140. This is mandatory field.
5. Enter the PO Name say, Purchase of monitors, and the Required By Date by invoking the calendar icon. The PO name in mandatory field.
6. Select the Vendor Name from the combo box. This is mandatory field. If the specified vendor name is not available in the list, click Add New link adjacent to the Vendor field and specify the vendor details like Name, Contact Information and Contact Person of the vendor. Click Save button to save the details.
7. Select the Shipping and Billing Address from the combo box. You can also add the shipping and billing address by clicking the Add New link. Enter relevant details in the pop up window.
8. On selecting the Vendor, the corresponding Product Type and Products gets populated in the combo box. Select the Product type and the Products, the items gets listed one below the other along with the price details. You can also add new product to the specified vendor by invoking the icon beside the product combo box. This opens the Products Details pop up window. Specify the Product Name and the Product Type of the item which are mandatory fields. Specify the Part No and the Price of the item in the given fields. Click Save, the item gets added to the list.
9. By default, the check box beside the item will be enabled. Specify the price of the item if it is not mentioned and the quantity of items to be ordered in the text box. The cost calculations of the item changes accordingly to the number of items purchased.
10. Under the general information block, select the **Cost Center** and the **GL Code** from the combo box. By default, the **Requested By** will be the name of the technician creating the PO. The **Created Date** and the **Owner** is in non editable text.

11. Enter the description for the PO or any other information that you wish to add in the **Remarks** field.

12. If there are any specific terms associated with the PO, enter the same in the **Terms** field.

13. If you would like to attach a file then click **Attach file** button.

14. Select the Approvers of the purchase order from the **PO Approver(s) list** pop window by clicking the icon.

15. Specify the **Signing Authority** of the company in the respective field.

16. Click **Save the Purchase Order** button to save the details.
PO Approval Process

Once the Purchase Order is created, the PO should be Submitted for Approval by the concern technician. The approval process is initiated by sending a request for approval to the concerned authority and depending on their decision the PO is approved or rejected.

- The technician approving the purchase order should be assigned with the **Purchase Order Approver** role.
- While creating a purchase order the approver should be selected from the approver's list to send for approval.
- If the approver is not selected or if there are no approver in the list, a warning message appears while submitting the PO for approval.
- Once the request is submitted for approval the status of the PO changes to PO Pending Approval.

Submit PO for Approval

1. Click the Purchase tab in the header pane to open the PO List View page.
2. Select the Open POs to be submitted for approval using the **Filter** drop down. Click the **PO name** link.
3. From the PO details page, click **Actions tab** -> **Submit for Approval** option. The Submit for Approval dialog pops up.
4. Enable Send Mail Notification check box, if you wish to send a mail to the approver regarding the PO Approval.
5. The **To** field is pre populated with the email address of the approvers. If required, you can modify the subject content manually.
6. Type in the message text for mail notification in the **Description** field.
7. Click **Send**. The mail notification is sent to the user addressed in the **To** field of the notification.
Approve / Reject PO

Once the PO is submitted for approval, a mail is sent to the user addressed in the To field. The email contains the link to the PO requiring approval. Clicking the link displays the PO awaiting approval. The user can also approve/reject the PO directly from the application.

Approve/Reject PO from the application

If you have the permission to approve/reject a Purchase Order,

1. Login to the ServiceDesk Plus application with your login credentials.
2. Click the Purchase tab in the header pane.
3. Select the POs Pending for Approval using the Filter drop down. Click the PO name link.
4. From the PO details page, click Actions tab -> Approve/Reject option. You can send an email notification to the PO owner regarding your decision.

The approved Purchase Order is grouped under the status Approved POs while all the rejected Purchase Orders is grouped under Rejected POs status. The Rejected POs can be deleted completely from the system or can be edited and sent for approval again.
Ordered Purchase Order

Once the Purchase Order is approved by the concern personnel, you need to order the items from the vendor.

1. Click the **Purchase** tab in the header pane to open the PO List View page.
2. Select Approved POs from the **Filter** drop down. Click the **PO name** link.
3. From the PO details page, click **Actions** tab -> **Order this PO** option. The Order this PO dialog pops up.

4. Enable **Send Mail Notification** check box, if you wish to send a mail to the vendor regarding ordering of items.
5. Enter the Email address of the Vendor in the **To** field. You also have an option to **CC** this mail.
6. If required, you can modify the **Subject** content manually and type in the message text for mail notification in the **Description** field.
7. Click **Attach file** button to attach relevant files to the Order.
8. Click **Send**.
Receiving PO Items

The Approved PO is sent to the vendor to acquire the ordered items. The vendor can dispatch the items either completely or partially, providing a receipt in both cases.

ServiceDesk Plus has the ability to change the status of the PO accordingly, i.e., when the items are received partially, the PO Status is automatically changed to Partially Received and on receiving all the items, the PO Status changes to Items Received.

Receiving Items

To mark partially or completely receive items,

1. Click the Purchase tab in the header pane to open the PO List View page.
2. Select Ordered POs from the Filter drop down. Click the PO name link.
3. Click Actions tab -> Receive Items option. The Receive Items dialog pops up.

4. Enable the check box beside each of the received items. If only a part of the ordered items are delivered, enter the Quantity that have been received.
5. Click Receive items button. The PO form is updated with the Received Quantity value and the status is moved to Partially Received POs.

All the received items is added as assets automatically, except for the items with Product Type as Consumable. [Refer Product Type]
Associated Assets

To associate assets,

1. From the Purchase Order details page, click on **Actions** tab -> **Associated Assets** option. All the received assets for the PO is displayed.

2. Enable the check box beside the asset to associate the asset to a group. Click **Actions** drop down -> **Add to Group**. The **Add Resource (s) to** dialog pops up.

3. Select the group from the existing list of groups or enable the radio button beside **New Group**, to add a new group. The asset gets associated to the corresponding group.
Reconcile Workstations

Once the workstations are received from Purchase Order, the assets are associated to Department or Groups. On performing a domain scan or network scan, the associated workstations are duplicated.

Say, "LD400 - PO # 2[10]" is the workstation purchased and has been renamed as "AE-dept". On performing a scan, both the workstations appear in the List View. To avoid this you can reconcile the assets from either the PO details page or from the asset list view page.

**Note**

1. Items with the Product Type as Consumables are not added to the assets and hence cannot be reconciled.
2. The scanned workstations can be reconciled only once.
3. You cannot reconcile workstations from the same purchase order.

To reconcile assets from the purchase order details page,

1. Click the **Purchase** tab in the header pane to open the Purchase Order list view page.
2. Click on the **PO# name** link of the purchase order for which the items needs to be reconciled. You can also use the Filter drop down to sort and select the PO.
3. From the purchase order details page, click **Actions** -> **Reconcile** option. The Reconcile Workstation(s)/Server(s) pops up.

4. Enable the check box beside the resource name and enter the **Service Tag** of the scanned workstation.
5. Click **Reconcile** button. The data in the purchased workstation is copied to the scanned workstation copied. On reconciling, the purchased workstation is deleted.
Adding Invoice details and Notification

Once the PO is approved by the concern personnel, the Invoice and Payment options gets populated in the Actions tab. On receiving the Invoice from the Vendor, you can add the Invoice details and also sent a notification to the concern technicians.

**Add Invoice**

1. Click the **Purchase** tab in the header pane to open the purchase list view page.
2. Click the **PO Name** link of the Purchase Order to add an Invoice.
3. From the PO details page, click **Actions** drop down -> **Add Invoice** option. The Add Invoice dialog pops up.

4. Enter the **Invoice ID**. This field is mandatory.
5. Select the **Receive Date** and the **Payment Due Date** from the calendar icon.
6. If required, enter the relevant comments from regarding the Invoice in the **Comments** field.
7. You can also enable payment notification to the technicians by enabling the check box.
8. Select the technicians from the list for payment notification. Click >> button.
9. Enter the **Days** before which the notification should be sent to the selected technicians.
10. Click **Save**.

ZOHO Corp.
Receive Invoice

Once the Invoice is received from the Vendor, you can notify the same to the PO approvers.

1. Click **Actions** drop down -> **Receive Invoice** option. The Receive Invoice dialog pops up.
2. Enable **Send Mail Notification** check box.
3. Enter the email address in the **To** field.
4. If required, you can modify the **Subject** content manually and type in the message text for mail notification in the **Description** field.
5. Click **Send**. The status of the PO changes to **Invoice Received**.

The Invoice details such as the Invoice ID, Received Date, Payment Due Date and Created by can be viewed in the PO details page under **Invoice and Payment** tab.
Adding Payment details & Notifications

Once you receive the Invoice from the Vendor, you can proceed with the payment process and notify the approvers done the payment is done.

Adding Payment Details

1. Click the Purchase tab in the header pane to open the purchase list view page.
2. Click the PO Name link of the Purchase Order to add an Invoice.
3. From the PO details page, click Actions drop down -> Add Payment option. The Add Payment details dialog pops up.

4. Enter the Pay Amount ($). This field is mandatory.
5. Select the Date of Payment from the calendar icon.
6. If required, enter relevant comments in the Comments field.
7. You can also enable notification if there are any dues in the payment by enabling the check box.
8. Select the Payment Due Date from the calendar icon.
9. Select the technicians from the list for payment notification. Click >> button.
10. Enter the Days before which the notification should be sent to the selected technicians.
11. Click Save.
Payment Done
Once the payment is done, you can notify the same to the PO approvers.

1. Click **Actions** drop down -> **Payment Done** option. The Payment Done dialog pops up.
2. Enable **Send Mail Notification** check box.
3. Enter the email address in the **To** field.
4. If required, you can modify the **Subject** content manually and type in the message text for mail notification in the **Description** field.
5. Click **Send**. The status of the PO changes to **Payment Done**.

The Payment details such as the Payment Date, Amount Paid, Payment Due Date (if any) and Created by can be viewed in the PO details page under **Invoice and Payment** tab.
E-mailing the PO Owner

By default, the logged in technician creating the Purchase Order is the PO owner. You can send email notifications to the owner regarding the progress of the Purchase Order using this option.

To send an Email to the owner,
1. Click on the **Purchase** tab in the header pane to open the Purchase Order List View page.
2. Click the **PO # name** link. You can use the **Filter** drop down to sort and select the Purchase orders.
3. From the Purchase Order details page, click **Actions** tab -> **E-mail the Owner** option. A **Send E-mail** notification window opens with the owner's **email ID** in the **To** field. The subject reads as "Notification for Purchase Order" with the notification number. Say, Notification for Purchase Order # 1.
4. To notify the contents of the email to any other person other than the owner, specify the **Email ID** in the **Cc** field.
5. To attach any file to the mail, select **Attach file** link.
   1. Click **Browse** button to choose a file.
   2. Select the file and click **Attach file** button to attach the files. You can see the file attached with the file size. **Note:** Files up to the file size of 10 MB can be attached.
6. Enter the email content in the **Description** area.
7. Click **Send** button to send the mail. This displays a message showing that the Notification has been sent successfully.
8. Close the window.
E-mailing the Vendor

Once the purchase items are ordered from the vendor, you can send e-mail notifications to the vendor regarding the progress of the items received i.e., if the organization has received the items partially or completely.

To e-mail the vendor,

1. Click the Purchase tab in the header pane to open the purchase order list view page.
2. Click the PO # Name link. You can use the Filter drop down to sort and select the PO.
3. From the purchase order details page, click the Actions tab -> select E-mail the Vendor option. The Send E-mail notification window opens.
4. Enter the vendor address in the To field. You can also notify the contents of the e-mail to more than one person by entering their email address in the CC field.
5. By default, the Subject reads as "Notification for Purchase Order" with the notification number. Say, Notification for Purchase Order # 1.
6. Enter the e-mail content in the Description area.
7. To attach any attachment to the mail select Attach file link.
   1. Click Browse button to choose a file.
   2. Select the file and click Attach file button. You can see the file attached with the file size. **Note:** Files up to the file size of 10 MB can be attached.
8. Click Send button to send the mail. This displays a message showing that the Notification has been sent successfully.
9. Close the window.
Editing Purchase Order

ManageEngine ServiceDesk Plus provides an option to modify the created Purchase Order.

1. From the PO List View page, select the **PO# Name** link to view the PO details page.
2. Click **Actions** tab -> **Edit Purchase Order** option. The PO form opens in an editable form with the values populated while creating the Purchase Order.
3. Modify the details and **Save** the changes.

**Note:** While editing an approved PO the status on saving changes to Pending Approval.
Printing Purchase Order

You can preview and print the entire Purchase Order details using Print Preview option.

To print a Purchase Order,

1. Click the Purchases tab in the header pane to open the purchase list view page.
2. Click the PO # Name link of the purchase order you wish to print. You can use the Filter drop down to sort and select the PO.
3. From the Purchase Order details page, click Actions tab -> Print Preview option. The Purchase Order details is displayed in a printable format.
4. Click Print option or Ctrl +p to print the Purchase Order details.
5. Set the required options and click Ok.
Deleting Purchase Orders

You can delete a Purchase Order either from the List View or from the PO details page.

Deleting PO from List View

Delete bulk Purchase Orders using this option.

1. Enable the check box beside the Purchase Order to delete. You may use the Filter drop down to sort and select the PO to delete.
2. Click Delete button. A confirmation message appears.
3. Click Ok to proceed. The PO is deleted from the list.

Deleting PO from details page

Individual Purchase Order can be deleted using this option,

1. Select the PO Name link of the Purchase Order to delete. You may also use the Filter drop down to sort and select the PO to delete.
2. From the PO details page, click Actions tab -> Delete Purchase Order option.
3. A confirmation message appears. Click Ok to proceed. The PO is deleted from the list.
Closing Purchase Order

ManageEngine ServiceDesk Plus provides an option to Close PO manually on receiving all the items and the invoice, or after making the payment.

To close a Purchase Order,

1. Click the Purchase tab in the header pane to open the purchase list view page.
2. Click the PO Name link of the Purchase Order to close. You can use the Filter drop down to sort and select the PO.
3. From the PO details page, click Actions drop down -> Close PO option. The Close PO dialog pops up.
4. Enable Send Mail Notification check box.
5. By default, the email address of the technician is displayed in the To field.
6. If required, you can modify the Subject content manually and type in the message text for mail notification in the Description field.
7. Click Send button. The status of the purchase order is changed to Closed.
Contracts

Every organization would maintain an annual maintenance contract with third-party vendors to maintain its infrastructure and function without any major downtime due to bad maintenance of the assets owned by it. ManageEngine ServiceDesk Plus gives you a provision to track such contract details, its date of commencement, and date of expiry, alert you with a reminder in advance about the expiry of the contract, the cost incurred for the purchase and renewal of the contract, the kind of maintenance support provided by the third party vendor, and the third party vendor name with whom the contract has been signed. Any other related documents to the contract can also be maintained along with these details as attachments to the contract. To open the contracts module, log in to the ServiceDesk Plus application using your user name and password and click the Contracts tab in the header pane.

- About Contracts
- Creating a New Contract
- Viewing Contract
- Editing and Deleting Contract
- Viewing Contract Owner Details
- Renewing Contract
- Print Preview of Contract
- E-mailing the Contract Owner
- E-mailing the Vendor
- Search Contracts
About Contracts

1. Click on **Contracts** Tab. This brings up the Contracts view list page. By default, the list of **Open Contracts** will be displayed.

2. Select the corresponding filter option from the Filter Showing combo box. You can view the contracts with different status levels using filters. They are,
   - **Open Contracts** Contracts which are active and yet to get expired comes under this category.
   - **All Expired Contracts** All the expired contracts will be listed under this category.
   - **Contracts expired in last 30 days** Contracts which expired in the last 30 days gets listed under this category.
   - **Contracts expiring in next 7 days** Contracts, which will be expiring in next 7 days, will be listed under this category.
   - **Contracts expiring in next 30 days** Contracts, which will be expiring in next 30 days, will be listed under this category.
Creating a New Contract

To create a new contract for asset,

1. Log in to the ServiceDesk Plus application using your **user name** and **password**.

2. Click the **Contract** tab in the header pane. This opens the contracts list view page.

3. Click the **New Contract** button in the contract index page. (OR) Click **Quick Actions** link in the home page -> Click **Contracts** option under Create New. This opens the Add Contract form. This form has three major sections: **Contract Details**, **Contract Rules**, and **Notification Rules**.

4. Specify a name for the contract in the **Contract Name** field. This is mandatory field.

5. Enter relevant **Description** for the contract in the respective text field.

6. Select the **Maintenance Vendor** from the combo box listing all the vendor names available. This is mandatory field. If the vendor is not listed, then click **Add New Vendor** button beside the combo box. The **Add New Vendor** window pops up as shown below,

   ![Vendor Details Form]

   - 1. Specify the name of the vendor in the given field. This is mandatory field.
   - 2. Enter a brief description about the vendor in the respective field.
   - 3. Specify the **Contact Person** in the given field.
   - 4. Click **Save**. The added vendor is selected and is displayed in the combo box. If you do not wish to add a new vendor then click **Close**.

7. In the **Support** field below it, enter the details regarding the kind of support that will be provided by the vendor to you.

8. You can add files that are related to the contract and are necessary to be maintained and referred to along with the contract information. Click **Attach File** button. The Attach File window pops up as shown below,
1. Click the **Browse** button to open the file selector window.

2. Select the file that you wish to add and click the **Attach File** button. The selected file is added and is displayed in the same window just below the file selection field. The total size of the attachments should not exceed 10 MB.

3. The attached file gets listed along with the File name and the size. The file can be deleted on clicking the **Delete** icon beside the file name.

9. In the **Contract Rules** section, you need to choose the assets that are to be maintained under this contract and mention the maintenance period and maintenance cost. Select the **Assets** that are covered under the contracts from the **Maintained Assets** list.

10. To add more resources to the list, click **Select Resources for this contract** link. This opens Select Resources page.

   1. Specify the **Resource Name** or **Product Type** or **Product** in the search field.
   2. Click **Search** button to get the result. Select the required resources by enabling the check box.
   3. Click **Add Items** button to add the selected items.
   4. Click **View Resources>>** button to view the selected resources.
   5. Click **Add Resources** to Contract button to add resources to the Maintained Assets list.
   6. Click **Remove Selected Resources** icon to remove selected resources from the list.

11. The **Active period** of the contract is a mandatory field where you need to enter the **From** and **To** date of the contract period. Choose the dates from the calendar that can be invoked by clicking the icon.

12. Enter the maintenance cost in terms of $ in the **Maintenance Cost** field.

13. Select the check box beside **Enable Notification**. This displays the notification rules information. Here you need to select the technician who needs to be notified about the expiry of the contract and how many days before the expiry, the notification needs to be sent.

14. Click **Save**.
Viewing a Contract

To view a contract and its details,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is displayed.
3. Select the status of the contract you wish to view using the Filter Showing combo box.
4. Click the Contract Name link that you wish to view. This opens the View contract page.

The Contract ID is a unique ID given to the contract during the time of its creation. This is system generated and is used to identify and track the contract uniquely. The contract details are grouped under three major heads: Contract Details, Contract Rules, and Notification Rules. Based on the entries made in the contract during the time of its creation, the details will be displayed in the respective section.

In the Contract Rules block, the assets that are maintained under the current contract are displayed. These assets are hyperlink to display their respective details. Click any of the asset names to open the Edit Asset form. Here you can edit the required information and update the same. To know more on editing assets, refer to the Editing Asset Details section.
Editing and Deleting Contracts

Editing Contract
To edit a contract,

1. Log in to the ServiceDesk Plus application using your user name and password or using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is displayed.
3. Select the status of the contract you wish to edit using the Filter Showing combo box.
4. Click the Contract Name link that you wish to edit. This opens the View Contract page.
5. Click the Edit button on the right hand side of the page. (OR) Click Actions combo box -> Edit Contract option. This opens the Edit Contract form.
6. The existing details of the contract is displayed. As the contract ID is a system generated ID, it is not available in the edit contract form. You can edit all the other details.
7. Once you are done with editing, click Save. If you entered wrong information and want to know what the initial values were, then instead of Save, click Reset.

Deleting Contract
To delete contract,

1. Log in to the ServiceDesk Plus application using your user name and password or using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is displayed.
3. Select the status of the contract you wish to delete using the Filter Showing combo box.
4. Click Delete on enabling the check box beside the contract.
5. A pop up window confirming the delete operation appears. Click Ok to proceed. The contract will be deleted from the list.
Viewing Contract Owner Details

By default, the owner of a contract is the person who enters the contract details into the application.

To view the owner details,

1. Log in to the ServiceDesk Plus application using your **user name** and **password** or using admin login.
2. Click the **Contracts** tab in the header pane. By default, the list of **Open Contracts** is displayed.
3. Click the **Contract Name** link to view the contract owner details. This opens the View Contract details page.
4. Click **Actions** combo box - > **View Owner Details** option. A pop up window containing the owner details such as, name, employee id, designation, contact information appears.
5. Click **Close** to close the pop-up.
Renewing a Contract

To renew a contract,

1. Log in to the ServiceDesk Plus application using your user name and password or using admin login.

2. Click the Contracts tab in the header pane. By default, the list of Open contracts is displayed. Select the status of the contract which you wish to renew using the Filter Showing combo box.

3. Click the Contract Name link that you wish to renew. This opens the View Contract page.

4. Click Actions combo box -> Renew Contract option. The Renew Contract form is displayed with the contract rules of the original contract. As the contract ID is a system generated ID, it is not available in the renew contract form. The contract name is appended with the word renewed. You can edit the name but ensure that the contract name is unique and does not have the old name.

5. Enter the Description for the contract.

6. Choose the maintenance vendor from the combo box. If the vendor is not listed, then click Add new link beside the combo box. The Vendor Details page pops up. Specify the name of the vendor, description, and the contact person name in the pop-up window. Save the changes.

7. If you have any information on the type of support, enter the same in the Support text area.

8. If there are any documents that you wish to attach to the contract, click the Attach File button. The Attach File window pops up.

   1. Click the Browse button to open the file selector window.
   2. Select the file that you wish to add and click the Attach File button. The selected file is added and gets listed along with the File Name and size. If you wish to delete any of the file then click the delete icon beside the file. The total size of the attachments should not exceed 10 MB.

9. Select the Assets that are covered under the contracts from the Maintained Assets list. To add more resources to the list,

   1. Click Select Resources link. This opens Select Resources page.
   2. Specify the Resource Name or Product Type or Product in the Search field.
   3. Click Search button to get the result.
   4. Select the required resources by enabling the check box.
   5. Click Add Items button to add the selected items.
   6. Click View Resources>> button to view the selected resources.
   7. Click Add Resources to Contract button to add resources to the Maintained Assets list.

10. The Active period of the contract is a mandatory field where you need to enter the From and To date of the contract period. Choose the dates from the calendar that can be invoked by clicking the icon.

11. Enter the maintenance cost in terms of $ in the Maintenance Cost field.

12. Select Enable Notification option by enabling the check box. On enabling you get the User list & Notified User list. To notify users regarding contract expiry select the user from the User list and click forward >> button to move the user to the Notified User List. Specify the days before which the information has to be notified in the Notify before field.

13. Select the check box, Disable all notifications for the old contract, to disable notifications of the old contract.

14. Click Save.
Print Preview of Contract

To print a contract,

1. Log in to the ServiceDesk Plus application using your user name and password or using admin login.
2. Click the Contracts tab in the header pane. By default, the list of Open Contracts is displayed.
3. Select the corresponding filter option from the Filter Showing combo box.
4. Click the Contract Name that you wish to print. This opens the view contract page.
5. Click Actions combo box -> click Print Preview option. The contract details are displayed in a printable format in a pop-up window.
6. Click the Print option to print the contract details.
7. Set the required options and click OK.
E-mailing the Contract Owner

By default, the owner of a contract is the person who enters the contract details into the application.

To send an e-mail to the owner,

1. Log in to the ServiceDesk Plus application using your **user name** and **password** or using admin login.
2. Click the **Contracts** tab in the header pane. By default, the list of **Open Contracts** is displayed in the contract list view page.
3. Click the **Contract Name** link of the contract you wish to e-mail the owner. This opens the view contract page.
4. Click **Actions** combo box -> **E-mail the Owner** option. A **Send Notification** window opens with the owner's e-mail ID in the **To** field. The subject reads as **Notification for Contract ID <number>**.
5. If you wish to notify about the contents of the e-mail to anyone else also, then enter their e-mail ID in the **CC** field.
6. Enter the e-mail content in the **Description** area.
7. Click **Send**. A message is displayed saying that the e-mail has been sent successfully.
8. Click **Close**.
E-mailing the Vendor

To notify the vendor,

1. Log in to the ServiceDesk Plus application using your **user name** and **password** or using admin login.
2. Click the **Contracts** tab in the header pane. By default, the list of **Open** contracts are displayed in the contract list view page.
3. Click the **Contract Name** link of the contract you wish to notify the vendor. This opens the **View Contract** page.
4. Click Actions combo box - > click **E-mail the Vendor** option. A **Send Notification** window opens with the vendor’s e-mail ID in the **To** field. The subject reads as **Notification for Contract ID <number>**.
5. If you want to send the same notification to anyone else, then add their e-mail ID in the **CC** field.
6. Enter the e-mail content in the **Description** area.
7. Click **Send**. A message is displayed saying that the e-mail has been sent successfully.
8. Click **Close**.
Searching Contracts

You can search for contracts with the Search in contracts option of the ServiceDesk Plus application.

To search for contracts,

1. Log in to the ServiceDesk Plus application using your user name and password or using admin login.
2. In the search block on the left hand side of the page, choose Contract from the Search in combo box. If you are in contracts section, then by default, contract is selected.
3. In the Enter Keyword field, type in your search string.
4. Click Go or press the Enter key in your keyboard. The search result displays all contracts that match the search string.

You can search for contracts based on the contract name, asset names added in the contract, and owner of the contract.
Solutions

The ManageEngine ServiceDesk Plus application provides a facility to record the solutions for the received requests. The recorded solutions function as a knowledge base of solutions. Thus, when you receive a request, refer to the recorded solutions and solve it. This reduces the turnaround time in attending to the requests generated by the requesters and closing the same.

All requesters and technicians who have permissions to view the solutions module can access this section of the application. The ServiceDesk Plus administrator can assign access privileges to the various technicians for the solutions section. This access privilege can vary from just view only privilege to full control privilege. For setting the access privileges to technicians, refer to the Configuring Technicians and Configuring Roles sections. Moreover, new technicians joining the organization can browse through these recorded solutions to have an idea of the frequently resolved problems.

You can access the approved solutions even without logging in to the application, but will be able to view only those solutions that are published in the Self Service Portal. To access the knowledge base directly without having to login to the application, type the URL provided below in the address bar of the browser:

http://<server name>:<port number>/sd/SolutionsHome.sd

where, the <server name> is the name of the server where ServiceDesk Plus is installed and <port number> is the port where the application is running.
About Solutions

1. Click on the **Solutions** tab. This brings up the Solutions list view page. By default, the list of **All Solutions** is displayed.

2. Select the corresponding filter option from the **Filter Showing** combo box. You can view the solutions with different status levels using filters. They are,
   - **All Solutions** All the solutions irrespective of the status can be viewed under this category.
   - **Approved Solutions** All the approved solutions are listed under this category.
   - **Approval Pending Solutions** The solutions which are sent for approval are listed under this category.
   - **Unapproved Solutions** The solutions which are not approved and has to be sent for approval are listed under this category.
   - **Rejected Solutions** All the rejected solutions are listed under this category.
Adding a New Solution

The solutions module is a knowledge base with resolutions for the problems encountered by your help desk team. The solutions can be grouped under topics to access the solutions with ease. In addition, the solutions can be restricted to specific user groups. The requesters under the user group can view the solutions on logging into the application.

To add new solutions to the existing knowledge base,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Solutions tab in the header pane. This opens the solutions list view page. By default, the list of all solutions gets displayed. Click New Solution button. (OR) Click Quick Actions -> Solutions under the Create New block. This opens the New Solutions page. The title, contents and the topics fields are mandatory fields.
3. Enter a title for the solution you wish to add in the given text field. This can be a summary of the complete solution in one line that will exactly tell what the solution is all about.
4. Enter the complete solution in the Contents text field.
5. If this solution requires any additional files to support the article, then you can attach the same by clicking Attach File button. The Attach File window pops up as shown below,

- i. Click Browse and select a file from the file chooser window. Click Open.
- ii. Click Attach File button. The attached file gets listed along with its size.
- iii. Repeat steps 1 and 2 to attach another file.
6. The topic field is a combo box that lists all the available topics and sub-topics. Select the topic in which you wish to add the current solution.
7. The keywords are optional, but the presence of a keyword for the solution will help in improving the search capability and will provide accurate search results. While entering multiple keywords, separate them with comma.
8. To make this solution available in the self service portal for the logged in and non logged in users, select Publish this solution in Self-Service Portal also check box. If you have configured User Groups, then you can restrict the solutions to a specific user group by selecting the user group from the available list, use >> button to move it to the selected user group block. The solution will be available to the user group on logging into the application.
9. Click Add. If you do not wish to add the solution then click Cancel.
Viewing Solution Details

You can view the solution along with the solution details such as created by, created on, status and so on in the solution module.

To view the solution details,

1. Login to ServiceDesk Plus application using your username and password.
2. Click Solution tab in the header pane. The list of All solutions is displayed by default.
3. Click the solution which you wish to view from the solution list view page. The View Solutions Details page opens as shown below,
4. The Solution Id and the Status gets displayed on the right hand side of the page.
5. The Subject, Type and Category can be viewed along with the complete solution.
6. The Keywords gets listed below the solution. If there are multiple keywords then they are separated by commas.
7. The Solution Details such as Created By, Created On, Type, Views, Status and so on can be viewed under this block. The requester details can be viewed by clicking the created by link.
8. The comments given to the solution on approving/rejecting can be viewed in Comments History. The status of the solution can also be viewed.
Editing a Solution

To edit a specific solution,

1. From the solutions list view page, click on the solution which you want to edit using the filter showing combo box. (OR) you can select the solution which you wish to edit by clicking the topic from browse by topics. All the solutions, irrespective of the status, available under that topic gets listed.

2. Click the **Edit** button available on the right hand side of the view solutions details page.

3. In the **Edit Solutions** page, make the necessary modifications. The title, contents, and the topic under which you wish to place the solution are mandatory fields. You can also add more attachments or delete existing ones.

4. Click **Save**. If you want to drop the modifications made, click **Reset**. If you do not want to save the changes and get back to the solutions listing, click **Cancel**.

5. On Saving the solution, the status of the solution shows **Unapproved**. The solution has to be submitted for approval to the concerned technician. To know more on refer Submit for Approval.

Alternatively, to open the solution that you wish to edit, type the solution title in the keyword field of the search block and click **Go** or press the **Enter** key. The solutions matching the search string will be listed, from which you can choose the solution and edit the same.
Submit for Approval

The newly added solutions has to be approved by the concerned technician, in order to be viewed by the requesters in the self service portal. To provide access permission to approve solutions refer Configuring Roles.

To submit for approval,

1. From the solutions list view page, select Unapproved Solutions from the filter showing combo box. The list of all Unapproved solutions gets displayed.
2. Click the subject of the solution which you want to submit for approval. This opens the View Solutions page. The Status is shown as Unapproved below the Solution Id.
3. Select Submit for Approval under the Approve Actions combo box on the right hand side of the page. This opens Submit for Approval page.
4. Select the To address by invoking the icon. This opens the Add users for Approval pop up window as shown below,

   - Enable the check box adjacent to the user whom you want to submit the solution for approval.
   - The To text field gets filled with the mail id of the corresponding administrator.
5. The Subject and Description is entered as given in Notification Rules email template. If needed you can modify the subject and description content manually, else you can change the same from the Notification Rules email template under Helpdesk.
6. If there is any relevant files to be attached then, click Attach File button.
7. Click Send to submit the solution for approval.
The mail notification is sent to the person who was addressed in the To field of the notification. The mail contains the link to the specific solution which needs approval. On clicking the link, it leads you to the login screen, where on providing the proper credentials, the solution awaiting approval opens. To approve/reject solutions refer Approve/Reject Solutions.
Approve/Reject Solution

On submitting the solutions for approval, a mail notification is sent to the concerned technician requesting the approval of the solution along with the solution link. The solution can be either approved or rejected. The approval access permission is given in Configuring Roles.

To approve/reject solution,

1. Click the link to open the solution.
2. Login to the ServiceDesk Plus application using your username and password. This opens the view solution details page of the solution pending for approval. The status of the solution shows Approval Pending on the right hand side of the page.
3. Click Approve Actions combo box -> Approve Solution. This opens the Approve Comments pop up window. Specify any related Comments in the field provided. Click Approve.
4. If you wish to reject the solution then, select Reject Solution under Approve Actions. This opens Reject Comments pop up window. Specify comments, such as reason to reject the solution in the Comments field. Click Reject.

To approve/reject bulk solutions,

1. From the solution list view page, select Unapproved Solutions from the filter showing combo box.Enable the check box adjacent to the solutions which you want to approve/reject.
2. Click Approve Actions combo box -> Approve Solution. This opens the Approve Comments pop up window. Specify any related Comments in the field provided. Click Approve.
3. If you wish to reject the solution then, select Reject Solution under Approve Actions. This opens Reject Comments pop up window. Specify comments, such as reason to reject the solution in the Comments field. Click Reject.

The approved solutions can be viewed by the requesters in the self service portal. The rejected solutions can be edited and sent for approval to the concerned technician. Thus the solution is not completely deleted from the list.
Delete Solutions

To delete a specific solution

1. From the solutions list view page, click on the solution which you wish to delete using the filter showing combo box.

2. Alternatively, click the topic in which the solution you wish to delete is available. All the solutions available under that topic are listed. Alternatively, you can also search for the solution using the Search in Solutions feature.

3. Click the **Delete** button available on the right hand side of the page. A confirmation dialog opens.

4. To continue deleting, click **OK**; or else, click **Cancel**.

To delete multiple solutions,

1. **Enable** the check box adjacent to the solution in the solutions list view page.

2. Click **Delete** button. A confirmation dialog opens.

3. Click **Ok** to continue. The solution gets deleted from the list.
Search Solutions

ManageEngine ServiceDesk Plus allows you to search for solutions using its Search Solutions and Search in Solutions options.

To search for solutions,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. In the search block, choose Solutions from the Search in combo box.
3. In the Enter Keyword field, type in your search string.
4. Click Go or press the Enter key in your keyboard. The search results display all the solutions that match the search string.

Alternatively, from the solutions list view page, enter the search string in the Search Solutions text field. Click Search Solutions button. The list of solutions corresponding to the search string gets displayed.

Another option to search solutions will be using the column-wise search option. To perform a column-wise search

1. Click the search icon at the end of the solution list view headers. This opens the search field just below every column in the list view as shown below,

2. Enter the search key in field under the column of your choice. You can enter keywords in more than one column to perform a combined column search.
3. Click Go. The search results matching the search string(s) are displayed.
Browsing Solutions by Topic

To browse for solutions using topics,

1. Log in to ServiceDesk Plus application using your user name and password.
2. Click the Solutions tab in the header pane. This opens the Solutions list view page.
3. Hover over combo box next to manage topics link. This opens the Categories window listing all the topics and their sub topics as shown below,

```
Categories

General

Hardware
  Desktop Hardware, Printers, Routers, Switches

Network
  Internet

Softwares
  ServiceDesk Plus
```

4. To view all the sub topics, click >>Show All link on the right hand side of the page. This lists out the topics and sub topics in a logical manner.

5. On clicking the topic, the solutions of the topic and its corresponding sub topics gets listed. Click the sub topic to view the solutions only in that sub topic.
Managing Topics

You can add new topics, rename an existing topic, and move topics and subtopics to a different parent topic. This provides you the ability to organize your solutions in a logical manner that would meet your organization's needs.

To manage topics

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the Solutions tab in the header pane.
3. In the Actions block, click Manage Topics link (OR) Click the Manage Topics link available in the Solutions list view page adjacent to the Browse by Topics combo box. The manage topics page is displayed with the available topics and their subtopics listed in the hierarchy. From here you can add, rename, move, and delete topics.

Adding a New Topic

To add a new topic

1. In the Manage Topics page, click the Add New Topic button. The add new topic form is displayed just above the available topics list with the Topic Name and the list of parent topics as the two fields. If there are no topics available then the Choose a parent topic field will have the /Topic Root alone.
2. Enter the name of the topic in the Topic Name field and choose the parent topic under which you want to place the new topic. For example - if you want to add the new topic as a main level topic, choose /Topic Root as the parent topic. Or else, choose any other topic as the parent topic.
3. Click Add. The topic is added as subtopic to the parent that you chose and is displayed in the available topics list. A message is displayed stating that the new topic is added successfully.

Renaming a Topic

To rename a topic

1. In the Manage Topics page, click the Rename link of the topic that you wish to rename. The Rename topic form is opened.
2. Type the new name for the topic in the topic name field.
3. Click Save.

The changes made to the topic name are displayed in the available topics list and a message is displayed above the list.

Moving a Topic

To move a topic to a different parent

1. In the Manage Topics page, click the Change Parent link in the row of the topic that you wish to move. The Change Parent Topic form is displayed. In the Choose the parent topic text box, by default, the current parent topic of the topic that is to be moved is selected.
2. Select the new parent topic.
3. Click Save. If you do not want to move the topic to a different parent topic, then click Cancel.

Note: You cannot move a topic as a subtopic to its current child topic itself.
Deleting a Topic

To delete a topic

1. In the Manage Topics page, click the Delete link in the row of the topic that you wish to delete. A confirmation page opens.

2. Click Confirm to delete the topic or click Cancel to retain the topic. If you click Confirm, then the topic is deleted and a message is displayed stating that the topic is deleted.

When a topic is deleted, by default, the solutions present under the topic are also deleted and if there are any subtopics, then these are moved to the /Topics Root. You can later choose to move the topics as child topics to other parent topics. But if you want to override the default actions performed during the delete operation, move the subtopics of the topic which you plan to delete, under a different parent topic of your choice. Also, if you do not wish to delete the solutions that are available under the topic to be deleted, then you can move the solutions to other topics. For this, when you click the Delete link and are led to the confirmation page,

1. Select the check box below the first point. This opens the topic list box, and enables you to move the reference of the solutions of the topic to a different parent topic of your choice.

2. Select the parent topic of your choice from the list box.

3. To move the subtopics to a different parent topic, select the check box below the second point in the confirmation page.

4. In the topic list box, select the parent topic of your choice under which the subtopics of the current parent topic that is being deleted can be moved.

5. Click Confirm.

This deletes the topic after moving the solutions and subtopics from the deleted topic to the parent topic you selected.

Note: You cannot move a subtopic of the topic that is going to be deleted, as a subtopic to another child topic of the same parent topic which is going to be deleted.
Configurations

All configurations for the application are grouped under Admin tab. You can access the various configuration options by logging into the application with the username and password of an admin user.

On logging into the application with the login credentials of an administrator, the Configuration Wizard page opens. To proceed with the configurations, follow the instructions provided in the configuration wizard.

The various configurations are grouped under the following major heads:

- Helpdesk Configuration
- User Management
- Problem/Change Management
- Discovery
- Asset Management
- Software Management
- Purchase/Contract Management
- User Survey
- General Settings

Each of these configurations is explained in details in the following sections.
Helpdesk Configurations

If you have logged into the application as the administrator then you need to configure the helpdesk settings before the request module can be opened for real time functioning of fetching the customer support mails and tracking the same.

The following configurations must be set up for an effective request workflow,

- Helpdesk Customizer
- Organization details
- Mail Server settings
- Region
- Sites
- Operational hours (Working Hours of the organization)
- Holidays
- Departments
- Configuring Business Rules
- Service Level Agreements
- Notification Rules
- Preventive Maintenance
- Incident Template
- Service Catalog
Request Form Customizer

The new request form can be configured to suit the needs of your organization. It is highly customizable. You can add your own values to be set for the category of the request, priority of the request, level of request, and mode of the request. These will already have some default values in them. If you do not wish to have these then you can delete them and add new values or edit them to suit your needs. You can also add your own custom fields which will be available in the form. These custom fields can be of three types: text field, numeric field, and date field. You can use these to collect organization specific information for getting a better and clearer idea about the reported issue. Finally you can set the default values for the request form fields so that creating and submitting a new request if made easier.

The subsequent sections of the document explain in detail the various customizations and configurations that can be done in the request form.

- Configuring Request Category
- Configuring Request Status
- Configuring Request Level
- Configuring Request Mode
- Configuring Impact
- Configuring Urgency
- Configuring Request Priority
- Configuring Priority Matrix
- Configuring Request Type
- Configuring Incident - Additional Fields
- Configuring Request Closure Code
- Configuring Request Closing Rules
- Configuring Incident Template
- Configuring Resolution Template
- Configuring Reply Template
- Configuring Task Template
Configuring Category

The requests can be grouped under proper Categories, Sub-categories and Items.

For example: A request to install Adobe Photoshop can be put under the request Category as Software, Sub-Category as Adobe Photoshop and Item to be Versions 5.0, 6.0 and so on. Similarly, if there is a problem in the functioning of the mouse, then it can categorized under the Category as Hardware, Sub-Category to be mouse and Item to be scroll button not working.

Depending on the need, you can create various such categories, sub-categories and items using this option. These categories, sub-categories and items will be listed in the drop-down menu in the New Request form.

To configure Category,

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the HelpDesk Customizer icon . This opens the HelpDesk - Category page where you can categorize the request in to category, sub-category and item. You have the list of request form attributes that can be customized such as status, level, mode and so on listed on the left side of the page.

Create New Category,

4. Click New Category button. This displays the category form.
5. Specify the Category Name in the given text field. For ex. Software. This is the only mandatory field.
6. Specify relevant information about the newly created category in the Description field.
7. Select the technician to be assigned for the newly created category from the Assign To Technician combo box. All the issues related to this category will be assigned to the selected technician.
8. Click Save button to save the details. You can see the category getting listed in the category list view below the form.
9. Click Save And Sub Category button to save the details and add a sub-category to the category.

Create New Sub-Category,

10. Click New Sub Category button in the category list page to add a sub-category to the category. Or click add sub-category icon beside the category title in the list view . This displays the sub-category form.
11. Specify the Sub Category name in the given text field. For ex. AdobePhotoshop. This is a mandatory field.
12. Specify relevant information about the newly created sub category in the Description field.
13. Select the Category from the combo box. For ex. Software. This is a mandatory field.
14. Click Save button to save the values. You can see the sub-category getting listed under the selected category.
Create New Item,

15. Click **New Item** button in the category list page to add an item to the sub-category. Or click add new item icon beside the sub-category title in the list view. This opens the New Item form in which the you have category, sub-category and other details on top of the page.

16. Specify the **Item name** in the given text field. For ex. versions. This is a mandatory field.

17. Specify relevant information about the newly created item in the **Description** field.

18. Select the **Sub Category** for the item from the combo box. For ex. software. This is a mandatory field.

19. Click **Save** button to save the details.
Editing & Deleting Category

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the HelpDesk Customizer icon. This opens the Configuration Wizard page.
4. Click the HelpDesk Customizer block at the left side of the page under the HelpDesk block. This opens the HelpDesk- Category page.

Editing Category

1. Click the edit icon beside the category name in the Category List page. This opens the edit category form.
2. Edit the details and save the changes.

Editing Sub-Category

1. Click the title of the category in the category list page. This opens the sub-category details page.
2. Click the edit icon. This opens the edit sub-category form.
3. Edit the details and save the changes.

Editing Item

1. Click the title of the sub-category to open the item details page.
2. Click the edit icon. This opens the edit item form.
3. Edit the details and save the changes.

Delete Category

1. From the Category List page, select the categories to be deleted by enabling the check box.
2. Click delete icon beside the category name in the category list page. A pop window pops up to get your confirmation on the delete operation.
3. Click OK to proceed. The Category will be deleted from the list.

Delete Sub-Category

1. Click the corresponding sub-category from the list. You can view the list of sub-categories for the category.
2. Select the sub-category from the list by enabling the check box.
3. Click Delete button to delete the selected sub-category. A pop window pops up to get your confirmation on the delete operation.
4. Click OK to proceed. The Sub-category will be deleted from the list.

Delete Item

1. Click the corresponding item from the list. You can view the list of items for the category.
2. Select the item from the list by enabling the check box.
3. Click Delete button to delete the selected item. A pop window pops up to get your confirmation on the delete operation.
4. Click OK to proceed. The item will be deleted from the list.
Configuring Status

Requests fetched in ServiceDesk Plus application will be in various stages of completion by the technician. To determine the status of a request and for easy management, you can create various request status under which the requests can be grouped. These status can either be **In Progress** or **Closed**.

While creating a status, you can also choose to stop the request timer for the status that is being created. Depending on the need of your organization, you can create various such status, which will be listed in the status drop-down menu in the *New Request* form.

To open the status configuration page,

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the **Admin** tab in the header pane.
3. In the **Helpdesk** block, click the **Request Form Customizer** icon. The next page displays the list of request form attributes that can be customized on the left menu and the category list page.
4. Click **Status** from the left menu, or click the **Next** button on the top of the category list page. The **Status List** page is displayed. You can add, edit, or delete the request status.

**Add Status**

To add a request status,

1. Click the **Add New Status** link.
2. Enter a unique status name to identify the status in the **Name** field.
3. Select the **Type** to which the status belongs. The status type allows you to identify whether the status that you are adding is still in progress and hence should be a part of the open requests or should be moved to the closed requests.
4. If the added status requires the timer of the request to be stopped, then you need to set the check box **Stop timer**.
5. If you wish, you can enter the status **Description**.
6. Click **Save**.

If you want to add more than one status, click **Save and add new** button. This adds the new status and reopens the add status form.

At any point, if you decide not to add the new status, then click **Cancel** to get back to the status list. Clicking the **View List** link on the top right corner of the add status form will also take you to the status list view.

**Edit Status**

To edit an existing status,

1. Click the **edit** icon beside the status name that you wish to edit.
2. In the **Edit Status** form, you can modify the name of the status.
3. If the status belongs to the In Progress type, then you can choose to stop or start timer. If the request status belongs to the completed type then you cannot edit the type of the request status.
4. If you wish you can edit the **Description** of the status.
5. Click **Save** to save the changes. At any point, if you wish to cancel the operation that you are performing, click **Cancel**.
Even while editing a status, you can add a status by clicking **Save and add new** button.

<table>
<thead>
<tr>
<th>Note: Option to edit the default status (Name and Description) from the list view. So, while adding a new status, the default status name (<strong>Open / Closed / Resolved / OnHold</strong>) should not be specified as the new status name.</th>
</tr>
</thead>
</table>

**Delete Status**

1. Click the **delete** icon beside the status name you wish to delete. A confirmation dialog appears.
2. Click **OK** to proceed with the deletion. If you do not want to delete the status, then click **Cancel**.
Configuring Level

Request level is a measure to indicate the complexity of a request. For example, if the received request just has some information and does not require any action to be taken, then it can be classified as Level 1. If there is a minor level action, such as providing the requester some tips to resolve the issue, then it can be classified as Level 2, and so on. To open the request level configuration page:

1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Request Form Customizer icon. The next page displays the list of request form attributes that can be customized on the left menu and the category list page.
4. Click Level from the left menu. The Level List page is displayed. You can add, edit, or delete the request levels.

Add Level

To add a request level:

1. In the Level List page, click Add New Level link at the top right corner.
2. In the Add Level form, enter the level Name. If you want, you can enter the level Description also. Please note that you cannot add two levels with the same name. Each level needs to be unique.
3. Click Save. The new level gets added to the already existing list.

If you want to add more than one level, then instead of clicking Save, click Save and add new button. This adds the new level and reopens the add level form.

At any point, if you decide not to add the new level, then click Cancel to get back to the level list. Clicking the View List link on the top right corner of the add level form will also take you to the level list view.

Edit Level

To edit an existing level:

1. In the Level List page, click the edit icon beside the level name that you wish to edit.
2. In the Edit Level form, you can modify the name and description of the level.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are performing, click Cancel.

Even while editing a level, if you wish to add new level, then click Save and add new button instead of clicking Save button after making the changes.

Delete Level

1. In the Level List page, click the delete icon beside the level name that you wish to delete. A confirmation dialog appears.
2. Click OK to proceed with the deletion. If you do not want to delete the level, then click Cancel.
Configuring Mode

There are different modes of submitting a request to the IT help desk team. ServiceDesk Plus provides you the option of submitting the request through an online form. Instead, a requester can call up the IT help desk agent and inform him/her regarding an issue faced, where the help desk agent will ensure to log the details discussed over the phone call through the web-based form. The other mode by which you can submit a request is by sending a mail to the IT help desk team. The IT help desk will then log the details of the mail through the web-based form in the ServiceDesk Plus application. If there are other methods of reporting a request to the IT help desk team in your organization, you can add the corresponding mode. To open the mode configuration page

1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Request Form Customizer icon . The next page displays the list of request form attributes that can be customized on the left menu and the category list page.
4. Click Mode from the left menu. The Mode List page is displayed. You can add, edit, or delete the request mode.

Add Mode

To add a request mode

1. In the Mode List page, click Add New Mode link at the top right corner.
2. In the Add Mode form, enter the Mode Name. If you want, you can enter the mode Description also. Please note that each Mode Name needs to be unique.
3. Click Save. The new mode gets added to the already existing list.

If you want to add more than one mode, then instead of clicking Save, click Save and add new button. This adds the new mode and reopens the add mode form.

At any point, if you decide not to add the new mode, then click Cancel to get back to the mode list. Clicking the View List link on the top right corner of the add mode form will also take you to the mode list view.

Edit Mode

To edit an existing mode

1. In the Mode List page, click the edit icon beside the mode name that you wish to edit.
2. In the Edit Mode form, you can modify the name and description of the mode.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are performing, click Cancel.

Even while editing a mode, if you wish to add new mode, then click Save and add new button instead of clicking Save button after making the changes.

Delete Mode

1. In the Mode List page, click the delete icon beside the mode name that you wish to delete. A confirmation dialog appears.
2. Click OK to proceed with the deletion. If you do not want to delete the mode, then click Cancel.
Request Closure Code

Request Closure Code denotes the reason behind closing a request, whether the request was closed successfully, unsuccessfully, cancelled and so on. Using the request closure code, the administrator is able to comprehend the purpose of closing the request by the technician. In addition, comments can be provided to give a detailed explanation for closing the requests. The configured request closure code list appears while closing the request, and the data entered is viewed in the request details page.

To access the Request Closure Code list page,
1. Click Admin tab in the header pane to open the Configuration Wizard page.
2. In the Helpdesk block, click Helpdesk Customizer icon. The next page displays the list of request form attributes that can be customized on the left menu and the category list page.
3. Select Request Closure Code from the left menu. The available request closure code is displayed. From this page you can add, edit and delete a closure code.

Adding New Closure Code
1. Click Add New Closure Code link.
2. Specify a unique Name for the request closure code. The name is a mandatory field.
3. Provide a brief Description about the request closure code.
4. Click Save to save the request closure code and return to the list view.

To add more than one request closure code, click Save and Add New button. This adds the new closure code and reopens the Add Request Closure Code form.

Click Cancel to exit the add request closure code form and return to the list view. Clicking the View List link on the top right corner of the add request closure code form also take you to the Closure Code list view.

Editing a Request Closure Code
1. From the Request Closure Code list view page, click the edit icon beside the closure code name to edit. The Update form is displayed.
2. Modify the Name and Description.
3. Click Save, to save the request closure code and return to the list view.

Even while editing a closure code, if you wish to add a new request closure code, click Save and Add New button. This updates the request closure code and reopens the Add Request Closure Code form.

Click Cancel to exit the add request closure code form and return to the list view. Clicking the View List link on the top right corner of the add request closure code form also take you to the Closure Code list view.

Deleting a Request Closure Code
1. From the Request Closure Code list view, enable the check box beside the closure code to delete.
2. Click Delete button. A confirmation dialog appears.
3. Click Ok to continue. The request closure code is deleted from the list.

If the request closure code is used in a request, the closure code is not deleted, instead it is grayed (made inactive) and will not be available for further usage.
To bring the request closure code back to the active state,

1. Click the edit icon beside the inactive request closure code. The update form is displayed.

2. De-select the **Request Closure Code not for further usage** check box.

3. Click **Save**. The request closure code is saved and will be available for further usage.

Click **Save and Add New**, to save and add another request closure code. Click **Cancel** to exit the add request closure code form and return to the list view.
Configuring Impact

Impact is a measure of the business criticality of an Incident or a Problem. Impact is often measured by the number of people or systems affected. By default you have four Impact details listed in the list view.

To open the impact configuration page,

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the HelpDesk Customizer icon. This opens the Configuration Wizard page.
4. Click the Impact link at the left side of the page under the HelpDesk block. This opens the Impact page from where you can add, edit and delete the impact.

Adding New Impact

1. Click New Impact link on the top right hand side of the page. This opens the Add impact details page.
2. Specify the Name of the impact in the given text field.
3. Specify the details about the impact in the given Description field.
4. Save the changes.
5. Click the Save and add new button to save the Impact and add another Impact.

Editing Impact details

To edit an existing impact,

1. In the Impact List page, click the edit icon beside the impact name that you wish to edit.
2. In the Edit Impact form, edit the fields you want to change.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are performing, click Cancel.

Even while editing a impact, if you wish to add a new impact, then click Save and add new button instead of clicking Save button after making the changes.

Delete Impact

1. From the Impact List page, enable the check box beside the impact name that you wish to delete.
2. Click Delete button. A confirmation dialog appears.
3. Click OK to proceed with the deletion. The impact gets deleted from the available list. If you do not wish to delete the impact, then click Cancel.
Configuring Priority

Priority of a request defines the intensity or importance of the request. To open the request priority configuration page

1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Helpdesk Customizer icon. The next page displays the list of request form attributes that can be customized on the left menu and the category list page.
4. Click Priority from the left menu. The next page displays the available list of priorities. You can add, edit, or delete the request priorities.

Add Priority
To add a request priority,

1. In the Priority List page, click the Add New Priority link at the top right corner. This opens the Add Priority form.
2. Enter the priority name in the Name text field. The provided name has to be unique and cannot be duplicated. This is a mandatory field.
3. If required, select the Color code to identify the priority by invoking the icon. The selected color has to be unique for every priority specified.
4. You can enter a short description about the priority in the Description field. This can help in understanding the kind of priority associated with the name mentioned in the Name field.
5. Click Save. The new priority is added to the already existing list. At any point you wish to cancel the operation that you are performing, click Cancel.

Priority order is a number that is associated with the priority name. This defines the order in which the request received by the IT help desk team is to be handled. The requests that have a higher priority order are taken first before the other requests with lower priority are attended to.
If you want to add more than one priority then, click Save and add new button. This adds the new priority and reopens the add priority form.

Note: The priority name along with its color code can be view in the request list view page provided the priority check box is enabled in the column chooser.

Edit Priority
To edit an existing priority

1. In the Priority List page, click the edit icon beside the priority name that you wish to edit.
2. In the Edit Priority form, edit the fields you want to change.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are performing, click Cancel.

Even while editing a priority, if you wish to add a new priority, then click Save and add new button instead of clicking Save button after making the changes.
Delete Priority

1. From the **Priority List** page, enable the check box beside the priority name that you wish to delete.
2. Click **Delete** button. A confirmation dialog appears.
3. Click **OK** to proceed with the deletion. The priority gets deleted from the available list. If you do not wish to delete the priority, then click **Cancel**.
Priority Matrix

The priority matrix helps you to determine the Priority automatically based on Impact and Urgency of a request. Impact is listed in the y-axis, and Urgency list in the x-axis of the matrix. Priority Matrix requires a one-time configuration by the Administrator.

Once you set the Priority for specific Impact and Urgency in the priority matrix, when a requester selects a similar impact and urgency combination in the new request form, then the priority of the request will be determined based on the matrix.

To set up Priority Matrix,
1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Helpdesk Customizer icon. The next page displays the list of request form attributes that can be customized on the left menu and the category list page.
4. Click Priority Matrix from the left menu. The next page displays priority matrix with impact list in the y-axis and the urgency list in the x-axis.
5. From the Priority Matrix page, click the priority link against specific urgency and impact, this opens the drop down box.

To set up Priority Matrix,
1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Helpdesk Customizer icon. The next page displays the list of request form attributes that can be customized on the left menu and the category list page.
4. Click Priority Matrix from the left menu. The next page displays priority matrix with impact list in the y-axis and the urgency list in the x-axis.
5. From the Priority Matrix page, click the priority link against specific urgency and impact, this opens the drop down box.

6. Select the corresponding priority from the list. The priority will be set for the particular Impact and Urgency combination.

<table>
<thead>
<tr>
<th>Impact</th>
<th>High</th>
<th>Low</th>
<th>Normal</th>
<th>Urgent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Affects Business</td>
<td>High</td>
<td>--Select Priority--</td>
<td>--Select Priority--</td>
<td>--Select Priority--</td>
</tr>
<tr>
<td>Affects Department</td>
<td>Select Priority</td>
<td>High</td>
<td>Select Priority</td>
<td>Select Priority</td>
</tr>
<tr>
<td>Affects Group</td>
<td>Select Priority</td>
<td>Medium Normal</td>
<td>Select Priority</td>
<td>Select Priority</td>
</tr>
</tbody>
</table>

Example: In priority matrix: If Impact is Affects Business and Urgency is High then Priority should be High.

Result in request form: If requester/technician selects Affects Business for impact and high for urgency in the request then, the priority field gets filled automatically and displays as high.
Configuring Request Type

Request Type is the type of request sent by the requester such as service request or request for any information. ServiceDesk Plus gives you the provision of configuring your request type other than the default options. This is essential while creating a new request under the request module.

1. Login to ServiceDesk Plus application using the username and password of the admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the HelpDesk Customizer icon. This displays the list of request form attributes that can be customized on the left menu.

Add Request Type

To add a new request type,
1. Click the Add Request Type link on the right hand side corner of the Request Type list page. This opens the Add Request Type form.
2. Specify the name of the request type such as, Incident, Request for Information in the Name text field. This is mandatory field.
3. Enter a brief description about the type of requests which fall under the category in the Description text field.
4. Click Save, to save and return to the list view page. Click Save and Add New to save and create another request type.

Edit Request Type

1. From the Request Type list page, click the edit icon beside the request type which you want to edit. This opens the Update- Incident page.
2. Modify the changes in Name and Description text field.
3. Click Save to save the changes. You can also Save and add a new request type by clicking Save and Add New.

Delete Request Type

1. From the Request Type list page enable the check box adjacent to the request type which you want to delete.
2. Click Delete button. A confirmation message for the delete operation pops up. Click Ok to proceed. The request type gets deleted from the list.
Configuring Incident - Additional Fields

Sometimes you may want to capture some additional details about an organization, for which, you need additional fields apart from the default fields in the New Incident form. You can add your own fields using the Additional Fields configuration.

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Request Form Customizer icon. The next page displays the list of request form attributes that can be customized on the left menu and the category list page.
4. Click Incident - Additional Fields from the left menu. The next page is a form that allows you to add the field labels and description of the field. You can add three types of fields in the form: text, numeric, and date/time. These three fields are available in three tabs as shown below:

<table>
<thead>
<tr>
<th>Text</th>
<th>Numeric</th>
<th>Date/time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Type:</td>
<td>Multi-line</td>
</tr>
<tr>
<td>Description</td>
<td>Default Value</td>
<td>Note: Default value will appear pre-filled in the form</td>
</tr>
<tr>
<td>Label</td>
<td>Type:</td>
<td>Multi-line</td>
</tr>
<tr>
<td>Description</td>
<td>Default Value</td>
<td>Note: Default value will appear pre-filled in the form</td>
</tr>
<tr>
<td>Label</td>
<td>Type:</td>
<td>Multi-line</td>
</tr>
<tr>
<td>Description</td>
<td>Add items to your pick list</td>
<td>Note: Selected item is the default value</td>
</tr>
</tbody>
</table>

The default tab selected is Text.
5. To add the text fields, enter the label name in the form fields below the Label heading. If required, enter the description for the field.
6. You can choose the type of text field that you wish to add by selecting the radio buttons. A Single-line text field allows you to add just a text field. The Multi-line text field allows you to add a text box where a lengthy description can be added. A Pick List allows you to add a list menu from which you can select. In all the three cases, you can add default values for the text field in the space provided for the same.

7. To add items for the pick list, enter the value in the text field and click Add Item. The value will get added to the list below. To select the default selected value of the list, click on the value in the list.

8. To add numeric fields, click the Numeric tab and then enter the label name in the form fields provided.

9. To add Date/Time fields, click the Date/Time tab and enter the required details.

10. Click Save. A message is displayed saying that the additional field is successfully created.

The new custom fields that you have added will appear in the New Incident form. To delete the user-defined fields, follow the above steps till the 4th step. Then, delete the label names you wish to remove and the default entries made for them, and click Save. The respective fields that you deleted will be removed from the New Incident form.

On adding the field, the newly added fields has to be configured in the Incident Template by Drag and Drop method. You can also preview your new incident form by clicking the Incident Template link in the left menu.
Request Closing Rules

Request closing rules can be used to select the mandatory fields to be filled in by the technicians while closing the requests. You can also use it to confirm user acknowledgement to the technician and close requests either manually or automatically.

To preset the request closing rules,

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the HelpDesk Customizer icon. This opens the Configuration Wizard page.
4. Click the Request Closing Rules link at the left side of the page under the HelpDesk block. This opens Request Closing Rules page.
5. Select the mandatory fields for closing the request from the list by enabling the check box.

Confirm User Acknowledgement

On closing the request, the resolution is acknowledged by the requester through mail (if the option is enabled in Notification Rules). If you want to prompt a confirmation message to the technician asking if user has acknowledged the resolution then enable Yes, prompt a message radio button, else enable No, don't prompt a message radio button.

Request Closing Process

**Manual Closing**

1. If you would like to close the request manually select the Manual radio button.
2. Save the changes. On resolving the request each time you have to close the request manually.

**Automatic Close**

1. Select the Automated Close radio button to close the request automatically.
   
   In the automatic mode,
   
   1. An email is sent to the requester when the Request is put in Resolved state
   2. The Requester can Close the Request with the close link given or Re-open the Request by replying to the mail.
   3. If the Requester takes no action the Request will be closed after the number of days specified in the combo box.

2. Select the close resolved request after n number of days from the combo box. After the selected number of days the resolved requests will be closed automatically if the requester does not take any action.

3. Save the details.

**Example:** If you have selected Resolution as a mandatory field, then the technician fixing the problem, should enter the reason and solution for the problem in the resolution text field before closing the request, else an error message pops up asking you to enter the details in the resolution field. If Yes, prompt a message radio button is enabled then, a confirmation message is prompted to the concerned technician if user has acknowledged the resolution.
Resolution Template

Resolution templates can be created to handle repeated requests with the same solution. The solutions of frequently raised requests, such as printer configuration can be made into a Resolution Template. Thus the technicians need not type the same resolution repeatedly for the request raised.

To open the configuration page for resolution template,
1. Login to ServiceDesk Plus application with the **username** and **password** of an admin user.
2. Click the **Admin** tab in the header pane.
3. In the **Helpdesk** block, click **Resolution Template** to open the Resolution Template list page.

**Add New Template**
1. Click **New Template** button to open the Add-Resolution Template form.
2. Specify a unique name for the template in the **Name** text field.
3. Enter the resolution in the **Description** text field. Both the Name and Description are mandatory fields.
4. You can mark this template as inactive by enabling the check box beside **Mark as InActive**. The inactive template is marked in grey and does not get listed in the resolution template drop-down while resolving a request.
5. Click **Save**. To save and add another resolution template, click **Save and Add New**.

**Editing a Resolution Template**
1. In the Resolution Template list page, click on the **Edit** icon beside the template you wish to edit.
2. In the **Edit Resolution Template** form, modify the required changes mentioned while adding the resolution.
3. Click **Update**. Even while editing, if you wish to add a new resolution template, then click **Update and add new** button. At any point you wish to cancel the operation that you are performing, click **Cancel**.

**Deleting a Resolution Template**
1. In the Resolution Template list page, select the check box beside the template you wish to delete.
2. Click the **Delete** button. A confirmation message appears. Click **Ok** to continue. The resolution template gets deleted from the list.
Reply Template

While replying to requests, technicians tend to type the same response repeatedly to many requests. With Reply Template, technicians can create templates for the repetitive response to requests, thus saving time and easing their work.

To open the configuration page for reply template,
1. Login to ServiceDesk Plus application with the **username** and **password** of an admin user.
2. Click the **Admin** tab in the header pane.
3. In the **Helpdesk** block, click **Reply Template** to open the Reply Template list page.

Add New Template
1. Click **New Template** button to open the Add Reply Template form.
2. Specify a unique name for the template in the **Template Name** text field.
3. Enter the content of the template in the **Description** text field. Both the Name and Description are mandatory fields
4. You can mark this template as inactive by enabling the check box beside **Mark this template INACTIVE**. The inactive template is marked in grey and does not get listed in the reply template drop-down while replying to requests.
5. Click **Save**. To save and add another resolution template, click **Save and Add New**.

Editing a Template
1. In the Reply Template list page, click on the **Edit** icon beside the template you wish to edit.
2. In the **Edit Reply Template** form, modify the required changes mentioned while adding the Reply.
3. Click **Update**. Even while editing, if you wish to add a new Reply template, then click **Update and add new** button. At any point you wish to cancel the operation that you are performing, click **Cancel**.

Deleting a Template
1. In the Reply Template list page, select the check box beside the template you wish to delete.
2. Click the **Delete** button. A confirmation message appears. Click **Ok** to continue. The reply template gets deleted from the list.
Task Template

Certain tasks need to be repeated by the technicians for different users and scenarios. With Task Template, repeated tasks can be pre-defined thus saving time on creating and assigning tasks to the technicians. Task Template can be applied while adding a task to a request, problem and change.

To open the configuration page for task template,
1. Login to ServiceDesk Plus application using your username and password.
2. Click the Admin tab in the header pane.
3. In the helpdesk block, click Helpdesk Customize icon . The configuration wizard page opens.
4. Click Task Template on the left hand side of the page in the helpdesk block. The list of available task templates is displayed.

Add Task Template
1. Click New Template button to open the Add-Task Template form.
2. Specify a unique name for the task in Template Name text field.
3. Specify the Title of the task in the field. The Template Name and Title are mandatory fields.
4. Enter a brief Description about the task template in the field provided.
5. Select the group to assign the task from Groups drop down list.
6. The list of technicians associated to the selected Group is listed in Owner combo box. Select the Owner of the task.
7. Select the Status of the task, say Open or Closed, from the drop down list.
8. Specify relevant comments for handling the tasks in the Comments text field.
9. You can mark the template as inactive on selecting the check box beside Mark Template as Inactive. The inactive template is marked in grey and do not get listed in the Add task form while adding tasks to requests, problem or change.
10. Click Save. To save and add another task, click Save and Add New.

Editing a Template
1. In the task template list view page, click on the Edit icon beside the template you wish to edit.
2. In the Edit-Task Template form, modify the changes mentioned while adding the task template.
3. Click Update. While editing, if you wish to add a new Task Template click Update and Add New button. At any point, if you wish to cancel the operation you are performing, click Cancel.

Deleting a Template
1. In the task template list view page, select the check box beside the template you wish to delete.
2. Click the Delete button. A confirmation message appears. Click Ok to continue. The task template is deleted from the list.
Configuring Organization Details

You can configure your organization's details in the ServiceDesk Plus application. This information will be used in various cases. To configure your organization's details:

1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Organization icon. The Organization Details form is displayed.
4. Enter the Name of your organization. You cannot leave the name field empty. The other fields can be empty. But if you have the required information, then enter them as explained in the following steps.
5. The description field can contain information about what your organization specializes.
6. The next block collects the address of your organization. Enter the address details in the relevant fields, such as address, city, postal code, state, and country.
7. If you have a common contact e-mail ID, then enter the same in the E-mail ID field.
8. Enter the phone and fax number, and the URL of your company's web site.
9. You can import the company logo and use that in places where the organization details are being used.
   1. Click Import Image button beside the Company Logo field.
   2. Click the Browse button and choose the image file from the file chooser window and click Open.
   3. Click Import.
10. By default, the Use this image check box is enabled. If you do not wish to use this image, then disable the check box.
11. Click Save.

At a later time, if you wish to edit the information that you entered now, you can do so by following the same procedure explained above.
Mail Server Settings

Configuring Mail Server Settings
ServiceDesk Plus allows you to configure the incoming e-mail settings and the outgoing e-mail settings such that it fetches the mails that are sent to the IT help desk team and sends notifications/feedback to the technicians, requesters, and vendors.

Incoming Mail Settings
To configure the incoming e-mail settings,

1. Log-in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Mail Server Settings icon. The Mail Server Settings page displayed will be as shown in the figure, with the incoming e-mail settings tab selected by default.

<table>
<thead>
<tr>
<th>Server Name / IP Address</th>
<th>* Mandatory Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>* Mandatory Field</td>
</tr>
<tr>
<td>Password</td>
<td></td>
</tr>
<tr>
<td>Email Address</td>
<td></td>
</tr>
<tr>
<td>Email Type: IMAPS</td>
<td></td>
</tr>
<tr>
<td>TLS Enabled: Yes</td>
<td></td>
</tr>
<tr>
<td>Port</td>
<td>993</td>
</tr>
<tr>
<td>Fetch mails every Minutes</td>
<td></td>
</tr>
</tbody>
</table>

4. All the fields marked * are mandatory fields. Enter the server name, user name, password, e-mail address, email type, port, and the time interval in which the mail needs to be fetched periodically. The time period is in minutes. The e-mail type is a combo box from which you need to select the value. If you have selected IMAPS then you have an option to enable Transport Layer Security (TLS).
5. Click Save. On successful connection to the server, the success message is displayed.

To start fetching the mails, click the Start Fetching button. Once the mail fetching is started, the Save button in the incoming mail server settings is disabled. If you wish to change any of the settings, then you need to stop mail fetching, make the changes, save them and then restart the mail fetching.
Outgoing Mail Settings
To configure the outgoing mail settings,

1. In the Email Settings page, click the Outgoing tab. The outgoing mail settings form is displayed as above.
2. Enter the outgoing mail server name / IP address, reply-to e-mail address, and port. These three are the mandatory fields.
3. If there is an alternate server, then enter its name in the Alternate Server Name / IP Address field.
4. Enter the name of the sender in the Sender's Name field.
5. Choose the e-mail type, which is usually SMTP and SMTPS. By default, the port associated to SMTP is 25 and the port associated to SMTPS is 465.
6. If required, you can enable Transport Layer Security (TLS) from the drop down.
7. If your SMTP server for outgoing mails require authentication, then select the check box Requires Authentication.
8. Enter the User Name and Password in the respective fields.
9. Click Save.

Spam Filter
You can mark all you junk mails into spam by defining filter criteria for the mails. Once you set a criteria say, "Subject contains Out of Office or Spam", then mails matching this criteria will be dropped and no new request will be created out of them. To configure Spam Filter,

1. Click Spam Filter tab.
2. Define a rule on selecting a Criteria from the drop down list and also mention the Condition.
3. Specify the filter content in the given text field by clicking choose button.
4. Say, if criteria is Sender and condition is is then the content can be "mailer-deamon".
5. Click Add to Rules button to add the criteria to the rules and match it with the incoming mails. Specify Match all of the following (And) or Match any of the following (OR) option to match with the rule by selecting any of the radio buttons.
6. Click Save.
E-Mail Command

Currently, when e-mails are received, various fields are set according to business rules. E-mail Command allows the technician to delimit fields in the e-mail, according to which the e-mail can be parsed and corresponding fields can be set.

Consider a scenario where business rules needs to be created for the following criteria:

- To assign Category based on subject:
  1. When Subject contains “Printer”, set Category as “Printers”
  2. When Subject contains “Network”, set Category as “Network”
  3. When Subject contains “Routers”, set Category as “Hardware”
  4. When Subject contains “Switches”, set Category as “Hardware”

- To assign Priority based on subject:
  1. When Subject contains “High Priority”, set Priority as “High”
  2. When Subject contains “Low Priority”, set Priority as “Low”

- To assign Urgency based on subject:
  1. When Subject contains “Urgent”, set urgency as “Urgent”
  2. When Subject contains “High Urgency”, set urgency as “High”

For example, when the subject contains “Printer” and “High Priority” or when the subject contains “Printer” and “Low Priority”, separate business rules have to be written for each criteria. This becomes complicated further when more fields need to be set based on the incoming e-mail. We need to have hundreds of business rules to achieve combinations of several fields and that will complicate the entire business rule section.

Also, consider another scenario where business rules for incoming e-mails are set as follows:

- When Category is “Printer”, Subject contains “Crash” and Priority is “Low”, place in Group “Hardware problems”

Suppose an incoming e-mail has a subject line “Printer Crash” with high priority, then the request field will be set as ‘Category = Printer’ with ‘Priority = Low’ based on the existing business rule.

E-mail command overcomes this complication. Request fields can be defined through an e-mail itself. An incoming e-mail is parsed, and various request fields are set from the e-mail content based on the parsing delimiters.

To configure E-mail Command,

1. In the E-mail Settings page, click on E-mail Command tab. The E-mail Command configuration screen is displayed.

2. Click on the check box Enable E-mail Command to activate the e-mail parsing feature. If this option is not selected, then the incoming e-mail will be handled as a normal mail based on established business rules even if the incoming e-mails contain the parsing string in the subject.

3. In the E-mail Subject contains text box, enter valid subject that determines the e-mails which have to be parsed. E-mails containing this text will be parsed for various fields. Assume the E-mail Subject identifier is given as @@SDP@@, then all e-mails with subject as @@SDP@@ alone will be considered for parsing.

4. Provide any special character (@@, ##, $$, %%, &&, so on) as the Command Delimiter. The field values assigned between these special characters are assigned to the corresponding fields while the requests are created. Assume if the Command Delimiter is @@ and category field needs to be set to Printer, then the email description should contain @@Category=Printer@@.
Notes:

- A request can be created/edited/closed/picked up by a technician through e-mails. Operational string "Operation = AddRequest", "Operation = EditRequest", "Operation = CloseRequest" and "Operation = PickupRequest" is used for this purpose.

- To edit, pick up or close a request through e-mail, the corresponding operational string (EditRequest/PickupRequest/CloseRequest) and the RequestId must be present. If not, the e-mail will be processed normally and treated as a new request.

- When a request is edited through an e-mail, the conversation will not be added in the request. Hence attachments and inline images in the e-mail will not be updated in the request. However, the update information will be added in the history.

- If the field name given in the e-mail is not available in ServiceDesk Plus, then parsing will be excluded for that field.

- If there is more than one value present for a particular field in an e-mail, then the last value alone will be taken and others will be discarded.

- Request threads with subject containing the “RequestId” and no operational string (UpdateRequest) will be updated as a normal conversation and a new request will not be created.

- The e-mail sender should have a log in for ServiceDesk Plus for the E-mail Command to happen. This is because, various operations that can be handled by a user to parse an e-mail are defined by the user’s Role. Request authorization (close a request, pick up a request, update a request, accept closure of a request and so on) are set using Roles in ServiceDesk Plus.

- The e-mail sender will be considered as the requester if the requester name is not specified in the e-mail.

- Permissions and Parameters supported:
  - If the e-mail sender is a requester with requester permissions, then the fields that be parsed are limited. A requester can parse only those fields that he can view in the request form while creating a request.
If the e-mail sender is a technician with technician permissions, then the fields that can be parsed are same as those fields that he can view in the request form while creating a request.

Fields that can be parsed are LEVEL, MODE, PRIORITY, URGENCY, IMPACT, CATEGORY, SUBCATEGORY, ITEM, GROUP, TECHNICIAN, TECHNICAL-MAIL, REQUESTER, REQUESTER-MAIL, REQUESTID, REQUESTTEMPLATE, REQUESTTYPE, STATUS, SITE, ASSET and additional field label (the field label given in the e-mail must match the field label set in the product)

To change the fields that a requester or a technician can parse, go to Admin --> Request Templates (under Helpdesk domain), select Default Template and add or remove the fields.

The RequestId present in the description of the e-mail it will be given higher precedence over the RequestId present in the subject of the e-mail.

Consider an example:

1. **To create** an e-mail that has to be parsed, the subject of the e-mail should be same as defined in the configurations (E-mail Subject contains), for example, "@@SDP@@" and the content is as follows:

   ```plaintext
   @@CATEGORY = Printers@@
   @@PRIORITY = High@@
   @@URGENCY = Normal@@
   @@LEVEL = Tier 4@@
   @@MODE = E-mail@@
   @@IMPACT = Affects User@@
   @@GROUP = Network@@
   ```

   When the request is created, say with a Request ID 6735352, the fields for the request are set based on the above content from the parsed e-mail.

2. **To edit** this request, say to assign a Technician or a Sub-Category, operational string "OPERATION = EditRequest" along with the RequestId (or WorkOrderId) and the delimiting fields have to be specified in the e-mail as follows:

   ```plaintext
   @@OPERATION = EditRequest@@
   @@REQUESTID = 6735352@@
   @@TECHNICIAN = Administrator@@
   ```

   This updates the request 6735352 and assigns ‘Administrator’ to the ‘Technician’ field.

3. **To pick up** the request through an e-mail, the technician who has ‘AssigningTechnician’ permission should specify the operational string “PickupRequest” along with the RequestId should be mentioned in the e-mail. The technician can pick up the request only if the request falls under his site.

   ```plaintext
   @@OPERATION = PickupRequest@@
   @@REQUESTID = 6735352@@
   ```

3. **To close** the above request (6735352) through an e-mail, the operational string (CloseRequest) and the Request ID has to be present in the content of the e-mail.

   ```plaintext
   @@OPERATION = CloseRequest@@
   @@REQUESTID = 6735352@@
   ```
Configuring Regions

Organizations can have various branches to handle various specialized activities. Such branches can be located at different regions and data from each of these branches need to be maintained in the same place. You can configure the various locations of your branches in the ServiceDesk Plus application. To open the organization regions configuration page,

1. Login to the ServiceDesk Plus application using user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Organizational Details block, click the Regions icon. The next page displays the available list of regions. You can add, edit, or delete regions.

Add Region

To add a new region,

1. Click Add New Region link available at the top right corner of the Region list page.
2. In the Add Region form, enter the Region Name. It is mandatory field.
3. Specify brief description about the core activities taking place in the branch in the Description text field.
4. Click Save to save and return to the list view. Click Save and Add New a to save and add a new region. At any point, if you do not wish to add the region and would like to get back to the location list, click Cancel.

Edit Region

To edit an already existing region,

1. In the Region List page, click the edit icon beside the Region Name that you wish to edit.
2. In the Edit Region form, modify the Region name and its Description.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are performing, click Cancel. Even while editing a region, if you wish to add another new region, then click Save and add new button.

Delete Region

1. In the Region List page, click the delete icon beside the Region Name that you wish to delete. A confirmation dialog appears.
2. Click OK to proceed with the deletion. If you do not want to delete the region, then click Cancel.

On deleting the region, the sites corresponding to the region along with the attributes such as groups, SLA, business rules, holidays and so on gets deleted.
Configuring Sites

Organizations, big or small, may have several branches across the globe to handle various specialized activities. These branches can be located in the same or different region, and the data from each of these branches need to be maintained in the same place. You can configure various sites (branches) to a region in the ServiceDesk Plus application.

To access the Sites configuration page,

1. Login to ServiceDesk Plus application using the username and password of the admin user.
2. Click Admin tab in the header pane.
3. On the Helpdesk block, click Sites icon.

Note: The administrator has the privilege to Add/Edit/Delete a site. The Site Admin can only View/Edit/Delete the sites to which he is associated from the Site List page.

Add Site

1. In the Site List view page, click Add New Site link on the right hand side corner. The Add New Site form opens.
2. Enter the Site Name in the text field provided. It is mandatory field.
3. Enter brief information in the Description field about what your organization does in the above mentioned site.
4. Select the Region and the Time Zone of the site from the combo box. The specified time zone is essential to calculate the operational hours for the site. Hence, any request raised in the site can be resolved within its operational hours.
5. Specify the Address of the organization along with City, Postal Code, State and Country.
6. Enter the Contact Information such as E-mail Id, Phone no, Fax no and the Web URL of your organization.
7. Enable any of the following related settings,

   • Refer Default Settings: On enabling refer default settings, the default settings are not copied to site and hence there is not separate site based configurations (except for departments). Instead the configurations made under the default settings are referred to the site. Any modifications made under the default settings such as, adding a new holiday or group to the existing list will get applied to the sites with refer default settings enabled. Say, for an organization with various sites having similar site specific configurations, enable refer default settings instead of copying the default configurations to every site. Any additional holiday or group added under default settings will automatically get applied to all the sites with this option enabled.

   • Copy Default Settings: Copy default settings help you to maintain separate site specific configurations for every site, and if there is any slight modifications made under default settings then, the same gets pushed to the sites provided the previous states of default setting and site configuration is the same. Any minor changes made in the site based configurations of a site is exclusively for the particular site. Say, the escalation rules set in a SLA for one site is different from another site. In this case, enable copy default settings radio button and modify the changes in the escalation rules.

   • Custom Settings: Custom default settings help you to organize, configure and maintain separate site specific configurations of a site. The default settings do not have any influence over the default settings. Consider an organization with branches across the globe having different operational hours and holidays, and thus with different SLAs. In this case, site specific configurations needs to be configured separately for every site by enabling the radio button corresponding to the options in Custom Settings for the site.
8. Click Save button to save the site details and return to the list view. Click Save and add new button to save and add another site. If you wish to cancel the operation then click Cancel.

**Edit Site**

1. From the site list page, click the edit icon beside the site which you wish to edit. The Edit Site page opens with the existing details.
2. You can modify all the fields in this page.
3. Click Save to save the modified changes and return to the list view.

Even while editing a site, if you wish to add a new site, click Save and Add New button. This updates the site and reopens the Add Site form.

**Delete Site**

If the site is being used by a module, the site cannot be deleted. In turn, the site is grayed (marked inactive) to avoid the further usage of the site. If the site is associated to a Requester, Asset, Request Template or Preventive Maintenance task, then you have an option to associate a different site to these parameters.

To delete a site,

1. Select the site you wish to delete by enabling the check box.
2. Click Actions drop down -> Delete Site(s) option. A confirmation dialog appears.
3. Click Ok to proceed.
4. If the Site is associated to a requester, asset, request template or a preventive maintenance task, Change Site association pop up appears listing the parameters to which the site is associated.
5. To associate these parameters to a different site, select the site from the drop down. By default, not associate to any site is populated.
6. Click Associate. The parameters are associated to the newly selected site. The site to be deleted is marked inactive and will not be populated wherever site is specified.

To bring the site back to active state,

1. Click the edit icon beside the site name.
2. From the edit site page, disable Site not for further usage check box.
3. Click Save to save the site details and return to the list view.

If the site is not used by any module, the site is removed from the site list view.

---

**Auto change of site from inactive to active state:**

- Succeeding an Active Directory import, the grayed out site is automatically changed to the active state.
- On performing a CSV Import of Users and assets.
- Adding and Editing requesters associated to the inactive site through API.
- Editing an inactive site through API.

**Inactive sites will not be auto activated for the following scenarios:**

- Creating requests through E-mail Command for an inactive site.
- Creating and Editing Requests, Asset, Technician for an inactive site through API.
Configuring Operational Hours

You can set the operational hours of your organization situated in various sites. The operational hours for a site depends on the time zone configured for that site. The operational hours that you configure is used while calculating the request due by date and time. To set the organization's operational hours,

1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Organizational Details block, click the Operational Hours icon. The Operational Hours form is displayed as shown below,

   ![Operational Hours form](image)

4. Select the site from the Operational hours for comb box. By default, the Operational hours for combo box will display Default Settings.

   **Note:** The Site Admin can set the operational hours for the sites to which he is associated. The sites can be selected from the Operational Hours for combo box. The Operational hours for combo box will appear if the site is configured in Admin-Sites.

5. If your organization works round the clock, then select Round the clock (24 hours) radio button. If you do not work round the clock then, select the radio button beside Select Operational Hours. Specify the working hours of your organization by selecting the Start Time and the End Time from the drop down boxes.

6. Now, select the days that your organization works by selecting the check boxes provided beside the days of the week.

7. Click Save.

You can also view the operational hours of a site by selecting the site from Operational Hours for combo box.

If you have already set the operational hours and wish to modify the same, you still need to follow the same procedure as specified above. But in this case, when you click Operational Hours from the Admin Home page, it will open the Operational Hours form with the details that have been set earlier. You can make the necessary modifications and then click on Save.
Configuring Holidays

You can set the holidays of your organization that is situated in various sites using the Holidays option available in the Admin page. This has the list of holidays during which the firm would remain closed and is exclusive of the weekly holiday when the firm does not function. You can also set repeated holidays such as, New Years Day, to an organization in a site. Thus by doing so you need not manually add the holiday every year in the Holidays option.

The holiday list along with the operational hours will be used for calculating the expected completion time of a service request, depending on the priority or SLA applicable to that request. To open the holiday configuration page,

1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Organizational Details block, click the Holidays icon . This displays the Default Settings of the available list of holidays. You can add, view, edit, or delete holidays for a particular site.

**Note:** The Site Admin can add and view the holidays to the site which he is associated. To view the holidays in a particular site, select the site from the Holidays for combo box.

If the sites are not configured then the Holidays for combo box will not appear. To configure the sites refer Sites under Organizational Details block.

Add Holidays

To add holidays in a site,

1. Select the site for which you want to add the holiday from the Holidays for combo box. If the sites is not selected then the holidays gets added under Default Settings.
2. Click Add New Holiday link available at the top right corner of the holiday list page. This opens the Add New holiday form.
3. Select the Date on which you want to add the holiday by invoking the calendar icon . This is mandatory field.
4. Enter a brief description of the significance of the holiday in the Description text field.
5. If the holiday occurs every year such as, 25th December (Christmas), then enable Check if this is recurring holiday check box. This will automatically add the holiday every year for the site.
6. Click Save. If you do not wish to add the holiday and would like to get back to the holiday list, click Cancel.
7. Clicking the View List link on the top right corner of the add holiday form will also take you to the holiday list view.

Edit Holidays

1. Select the site for which you want to edit the holiday from the Holidays for combo box. This lists out the holidays for the corresponding site.
2. Click the edit icon beside the holiday Date that you wish to edit.
3. Modify the date and the description of the holiday, and enable/disable the 'check if this is recurring holiday' check box in the Edit Holiday form.
4. Click Save to save the changes. At any point, if you wish to cancel the operation that you are performing, click Cancel.
Delete Holidays

1. Select the site for which you want to delete the holiday from the Holidays for combo box. This lists outs the holidays in that site.

2. Enable the check box beside the holiday Date which you want to delete from the holiday list page. Click the Delete button on the left hand side of the page. A confirmation dialog appears.

3. Click OK to proceed with the deletion. If you do not want to delete the holiday, then click Cancel.
Configuring Department

There can be various departments in an organization which can be situated in different sites, and each of these departments have a group of employees managed by a Department Head. In ServiceDesk Plus you can add, edit, or delete the various departments of your organization. These departments are essential while adding requesters and technicians since each requester or technician will be associated to a particular department of the organization.

To open the department configurations,

1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Organizational Details block, click the Departments icon. This displays the available list of departments. You can add, edit, or delete departments.

Note: The Site Admin can configure the department in the sites which he/she is associated. The list of departments associated to the site can be viewed by selecting the sites from the Departments for combo box. The Department for combo box will appear if the site is configured in Admin- Sites.

Add Department
To add a department for an organization in a site,

1. Select the site for which you want to add the department from the Departments for combo box. By default, the department gets added under Default Settings.
2. Click Add New Department link available at the top right corner of the Department list page. This opens the Add Department form.
3. Enter the Department Name in the text field. This is mandatory field.
4. Provide a brief Description about the department in the text field provided.
5. The Department Head manages the department and plays a vital role in approving the service request. To select the Department Head, click the icon. The Requester List window pops up. Click on the name of the requester to select the department head.
6. Click Save. At any point, if you do not wish to add the department and would like to get back to the department list from the add department form, click Cancel.

Edit Department
To edit an existing department,

1. Select the site for which you want to edit the department from the Departments for combo box. This lists out the available departments corresponding to the site.
2. Click the edit icon beside the Department Name that you wish to edit. This opens the Edit Department form.
3. Modify the department name and its description.
4. Click Save to save the changes. At any point, if you wish to cancel the operation that you are performing, click Cancel.

Delete Departments
1. Select the site for which you want to edit the department from the Departments for combo box.
2. Enable the check box beside the department name which you wish to delete from the department list page. Click Delete button. A confirmation dialog appears.
3. Click OK to proceed with the deletion. If you do not want to delete the department, then click Cancel.
Configuring Business Rules

You can define Business Rules for various sites of your organization. Business Rules enable you to organize the incoming requests (via web form and e-mail) and perform actions such as delivering them to groups, assigning status and other request parameters. Business Rule can be applied to a request when it is created (or received), edited or both. Notification can also be sent to the technicians once the Business Rule is executed.

To open the Business Rule configurations page,

1. Login to the ServiceDesk Plus application with admin username and password.
2. Click the Admin tab in the header pane.
3. On the Helpdesk block, click the Business Rule icon . The resulting page displays the available list of business rules under the Default Settings. You can add, edit, delete or organize business rules of a particular site.

Note: The Site Admin can add and view the business rules to the site which he is associated. To view the business rules of a site, select the site from the Business Rules for combo box. If the sites are not configured then the Business Rules for combo box will not appear. To configure the sites refer Sites under Organizational Details block.

Add New Business Rule

To add a Business Rule,

1. Select the site to which you want to add the business rule from the Business Rules for drop-down list. By default, the 'Default Settings' option is selected.
2. Click Add New Business Rule link available at the top right corner of the Business Rules List page.
3. The Add Business Rule form consists of three blocks to be configured namely, Business Rule Details, Criteria and Actions and Notification.

Business Rule Details

The details of the Business Rule are exclusively for the newly added business rule.

1. Specify a unique Rule Name in the given text field. It is a mandatory field.
2. The Site selected in Business Rules for drop down box is displayed in non editable text.
3. Provide the content to describe the business rule in the Description text field.
4. Business Rule can be executed on a request when it is created via web form (or received via email), edited or both on choosing the options from Execute when a request is dropdown list. By default, the 'Created' option is selected.
5. You can disable a Business Rule by selecting Disable Business Rule check box. On
disabling a Business Rule, the rule will not get executed on any new or edited request. The disabled business rule will be marked in grey in the list view.

6. By default, the execution of the business rule will stop once a rule is applied on a request. To continue execution of successive business rules even after a business rule is applied on a request, select **Turn on Cascade Execution** check box.

7. By default, when a business rule is applied, the request values will be changed with the values in the business rule only if the request value is empty. If the request value is not empty, the business rule value will not be applied. To override the request values with the values in the business rule enable **Override request values with Business Rule values**. Example: If the **Priority** in a request is set to 'High' and the **Actions Set in the business rule is 'Set Priority to Low', then the priority is automatically set to 'Low' when the business rule is applied.

**Note:** Bulk actions such as delete, disable/enable business rules, turn on/off cascade execution can be performed on a business rule by selecting the check box beside the business rule and click **Actions** drop down button.

To turn on/off cascade execution to a business rule from the list view, click the icon beside the business rule. A confirmation message appears. Click **Ok** to continue. The icon will be grayed if the cascade execution is discontinued.

**Criteria and Actions**

Under this block, define the rules and criteria that need to be satisfied by the incoming request.

1. **Select the Criteria and Condition** from the respective drop-down list, and then the individual values that needs to be matched by clicking the **Choose** button. The values from the database for that particular parent criteria that you chose from the drop-down list opens. Choose the values you want and click **Ok**. **Example:** If you want to match the requester name John, then select **Requester Name** in the Select Criteria drop-down box. Now select the condition is or is not from the drop-down list. The list varies for each criteria. Click **Choose** button to open the list of requesters in a pop-up window. Select the requester name from the list and click **Ok**. For multiple selection, press **Shift** or **Ctrl** key while selecting the names. The selected names appears in the text box just beside the choose button.

2. Click **Add to Rules** to add the defined rule to the rules table.

3. By default, the radio button **Match ALL of the following is selected**. If you do not want all of them to be checked but if it is enough if any one of the rules are matched, then select the radio button **Match ANY of the following**.
4. After defining the rules, you need to define the actions that need to be performed on the request matching the criteria. Choose the action from the **Choose Action** drop down list.

5. Click **Choose** button to select the values for the chosen action. **Example:** If the action you had chosen was to **Place in Group**, then click the Choose button to display the list of groups available in the corresponding site. Select the group to which the request has to be placed and click **Ok**.

6. Click **Add** to add the action in the actions table.

**Notification**

You can send Email and SMS notification to technicians once a business rule is applied.

**Caution:** Configure Mail Server Settings before enabling Notification.

To enable Email notification,

- Select the check box beside **Email**. Click **Add** to select the list of technicians from Select Assign to Technicians pop up window. Click **Ok** to add the technicians.

<table>
<thead>
<tr>
<th>Notifications</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Email</strong></td>
</tr>
<tr>
<td>Email the following technicians when the Business rule is executed</td>
</tr>
<tr>
<td><em>Howard Stern</em> and <em>Jennifer Doe</em></td>
</tr>
</tbody>
</table>

To enable SMS notification,

- Select the check box beside **SMS**. Click **Add** to select the list of technicians from Select Assign to Technicians pop up window. Click **Ok** to add the technicians.

To edit the Email Template,

- Click **Edit Email Template** link to open the email template form. Make the required changes in the Subject and Message text field. Click **Ok**.

Click **Save**. If you want to add more than one business rule, then click **Save and Add New**. At any point, if you do not wish to add the business rule and would like to get back to the business rules list from the add business rule form, click **Cancel**.

**Edit Business Rule**

To edit an existing business rule,

1. In the **Business Rules List** page, click the edit icon beside the **Business Rule Name** that you wish to edit.

2. In the **Edit Business Rule** form, you can modify all the fields mentioned in the add business rule form.

3. To edit the **Match the below criteria** set, click the edit icon beside the individual criteria. The respective selection window is opened in a separate pop-up. You can choose more values or remove a few values by de-selecting them.

4. You can also delete a criteria completely. To delete a criteria, click the delete icon beside the individual criteria.

5. In the actions to be performed, you can add new actions, edit or delete the existing actions.

6. Click **Save** to save the changes performed. At any point you wish to cancel the operation that you are performing, click **Cancel**. Even while editing a business rule, if you wish to add another new business rule, then click **Save and Add New** button.
Delete Business Rule

1. From the **Business Rule List** page, enable the check box beside the **Rule Name** you wish to delete.
2. Click **Actions** drop down button, and select the **Delete** option. A confirmation dialog opens.
3. Click **Ok** to proceed with the deletion. If you do not wish to delete the business rule, then click **Cancel**.

Organize Business Rules

Organizing the business rules decide the order in which the rule is applied on the incoming request. You can organize the business rule to appear in a particular order in the list view,

1. Select the site for which you wish to rearrange the order of the business rule from the **Business Rules for** combo box.
2. Click **Organize Business Rules** link at the top tight hand corner of the Business Rules List view page. A pop-up window opens displaying the list of available business rules in the order that is appearing in the list view.
3. Select a business rule, and click **Move up** or **Move Down** button beside the list.
4. Click **Save**.
Configuring Service Level Agreements

You can have Service Level Agreements (SLAs) defined for intra-organization service provided by the IT help desk team. These SLAs help evaluating the efficiency, effectiveness, and responsiveness of your help desk team. The SLAs can be defined for each individual, or departments, or workstations in a site. The priority for an incoming service request is automatically set if the request is governed by an SLA rule. Also, if the request is not attended and resolved within the time specifications of the SLA, then you can set the escalation rules.

To open the SLA configurations page,

1. Login to the ServiceDesk Plus application with admin username and password.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Service Level Agreement icon. The SLA list page opens. You can add, edit, or delete SLAs.
4. By default, all SLA based mail escalations will be enabled. If you wish to disable the escalation click Disable Escalation button.
5. By default, there are four SLAs set namely, High, Medium, Normal, Low SLAs. You can also add more SLAs to the list.

| Note: The Site Admin can configure the SLA for the sites to which he is associated by selecting the site from the Service Level Agreement for combo box. The list of all SLAs corresponding to the selected site gets displayed. If the sites are not configured then the Service Level Agreement combo box will not appear. To configure the sites refer Admin-Sites. |

Add New Service Level Agreement

To add an SLA,

1. Select the site to which you want to add the SLA from the Service Level Agreement for combo box. By default, the 'Default Settings' option is selected.
2. Click Add New SLA link at the top right corner of the SLA list page.
3. In the Add New SLA form, specify the SLA Name in the text field provided. It is a mandatory field.
4. The Site selected in Service Level Agreement for drop down box is displayed in non editable text.
5. If required, you can provide a corresponding Description for the SLA.
6. In the SLA rules block, set the rules and criteria for the SLA. By default, the radio button **Match ALL of the following** is selected. If you do not want all of them to be checked but if it is enough if any one of the rules are matched, then select the radio button **Match ANY of the following**.

7. **Select the Criteria** and **Condition** from the respective text box, and then choose the individual values that need to be matched by clicking on the **choose** button. The values from the database for that particular parent criteria that you chose from the drop down list opens. Choose the values you want and click **Ok**. **Example:** If you want to match the requester name John, then select **Requester Name** in the combo box. Now click **Choose** button, to open the list of requesters in a pop-up window. Select the requester name from the list and click **Select**. For multiple selection, press **Shift** or **Ctrl** key while selecting the names. The selected names will appear in the text field just before the choose button.

8. Click **Add to Rules** to add the defined rule to the **Rules Set**.

9. Set the **Response Time** and the **Resolution Time** in terms of days, hours and minutes. **Note:** The Response Time is the initial response sent out by the technician to the requester for a request. Automatic replies from Service Desk Plus will not be counted as a response. The specified response time should be less that the resolution time.

10. If you want this duration to override the operational hours, the select the check box beside **Should be resolved irrespective of operational hours**. By selecting this, you will be overriding the operational hours of your organization and the due by time will be calculated from the creation time without taking into consideration the holidays and operational hours.

11. The request can be escalated to other technicians when the request is not responded or resolved within the specified time. There are two blocks of escalations, one for the **Response Time** and the other for the **Resolution Time**.
Response Time:
There is only one level of escalation if the response time elapses.

i. To enable escalation, select the check box beside Enable Level 1 notification.

ii. Click Choose button to choose the technicians to whom the SLA violation should be escalated.

iii. You can choose to escalate before the violation or after the violation. If you wish to escalate the request before the SLA violation then click Escalate Before option. Specify the number of days before the SLA violation is about to happen in the text box. This is to escalate to the technician about the onset of the violation. You can also specify the time of escalation.

iv. Similarly, click Escalate After option to escalate after the violation. Specify the number of days after the SLA violation has occurred in the text box. You can also specify the time of escalation.

Resolution Time:
There are 4 levels of escalation if the specified resolution time elapses.

i. To enable escalation, select the check box beside Enable Level 1 notification.

ii. Click Choose button to choose the technicians to whom the SLA violation should be escalated.

iii. You can choose to escalate before the violation or after the violation. If you wish to escalate the request before the SLA violation then click Escalate Before option. Specify the number of days before the SLA violation is about to happen in the text box. This is to escalate to the technician about the onset of the violation. You can also specify the time of escalation.

iv. Similarly, click Escalate After option to escalate after the violation. Specify the number of days after the SLA violation has occurred in the text box. You can also specify the time of escalation.

9. Click the Save button to save the SLA and return to the list view. If you want to add more than one SLA, then click Save and Add New.

At any point, if you do not wish to add the SLA and would like to get back to the SLA list from the add SLA form, click Cancel. Clicking the View List link on the top right corner of the add SLA form will also take you to the SLA list view.

Edit Service Level Agreement
To edit an existing SLA,

1. Select the site of the SLA you wish to edit from the Service Level Agreement for combo box. The lists of all the SLA corresponding to that site is displayed.

2. Click the edit icon beside the SLA Name.
3. In the **Edit SLA** form, you can modify all the fields mentioned in the add SLA form.
4. Click **Save** to save the changes. At any point you wish to cancel the operation that you are performing, click **Cancel**. Even while editing an SLA, if you wish to add another new SLA, then click **Save and Add New** button.

**Delete Service Level Agreement**

1. Select the site of the SLA you wish to delete from the **Service Level Agreement for** combo box. The list of SLA corresponding to the site gets displayed.
2. Enable the check box beside the SLA. Click the **Delete** button. A confirmation dialog appears.
3. Click **Ok** to proceed with the deletion. If you do not want to delete the SLA, then click **Cancel**.

**Organize Service Level Agreements**

Organizing the SLAs decide the order in which the SLA is applied on the incoming request. You can organize the SLA to appear in a particular order in the list view,

1. Select the site for which you wish to rearrange the order of the SLA from the **Service Level Agreement for** combo box.
2. Click **Organize SLA** link available above the list of SLAs in the **SLA List** view. A pop-up window is opened with the list of available SLAs in the order that is appearing the list view.
3. Select an SLA, and click **Move up** or **Move Down** button beside the list.
4. Click **Save**.
Configuring Notification Rules

ManageEngine ServiceDesk Plus allows you to send notifications to requesters and technicians through notification rules. The notifications can be of two types: email and SMS. These notification modes can be set across various modules of the application, such as requests, problem, change and solution. Any default actions that you might want to perform when the state of any item changes can also be defined.

Note
For all modules, notification will not be sent to the logged in technician.
Say, for notification like, "Alert Technician by Email when a request is assigned.", if a technician picks up a request then a notification will not be sent to the technician.
Similarly, for notifications like "Alert the following technicians by email when a new request is created", notification will not be sent to the logged in technician if he is included in the notify list.

Further you can also customize the email template of the notification and prevent unwanted acknowledgements or notifications being sent to requesters/technicians through Junk Mail notification.

To set the notification rules and the message template,

1. Login to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Notification Rules icon under Helpdesk block.
4. By default, all notifications are sent in Rich text format. Clicking on Plain text formatting button will switch all the notifications in Plain text format.
5. Click on the appropriate tabs to configure for request, problem, change and solution modules.

<table>
<thead>
<tr>
<th>Request</th>
<th>Problem</th>
<th>Change</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Technician by Email when a problem is assigned.</td>
<td>Alert Technician by SMS when a problem is assigned.</td>
<td>Alert(Notify) Technician by Email when there is a new incident associated to problem.</td>
<td>Customize template</td>
</tr>
</tbody>
</table>

6. To enable or disable any of the notification rules, select or de-select the check box beside each of the rules.
7. For certain notifications you need to select the technicians who need to be notified when a new request is created.
   - Click Choose button.
   - Select the technicians from the list of technicians is displayed in a pop-up window.
   - For multiple selections, press Shift or Ctrl key and then select the technicians.
   - Click OK.
   - The selected technicians get listed in the text box beside the Choose technician(s) button.
8. Click Save.
Customizing Message Template
You can customize the message template for each of the notifications.

1. Click Customize Template link beside the notification for which you wish to modify the content that is being sent.

2. You can change the subject and the message content by typing the text of your choice and also adding other variables that you wish to display as a part of the subject or message content. To add more variables, just click the corresponding variable from the list box beside the respective field.

Junk Mail Notification
Junk Notification Filters prevents unwanted acknowledgements or notifications being sent to requesters / technicians when an information mail reaches the help desk. These mails are not requests and do not require any action to be taken.
Say, acknowledgement email like Out of Office replies, notifications that bounce back when the mail destination is not reachable (because of a wrong mail address) can be stopped from being acknowledged or notified.

To define a Junk Mail Notification,

1. Click on Edit Criteria link.
2. Define a rule by select the criteria and condition from the drop down combo list.
3. Click Choose.
4. Enter the value in the field provided. Click Save.
5. Click Add to Rule.
6. You can either match all of the following (AND) or match any of the following (OR) criteria. Select an appropriate radio button.
7. Click Save.
You can also edit or delete the criteria on clicking the appropriate icon.
Preventive Maintenance

You can create a Preventive Maintenance Task for regular maintenance such as changing the printer toner every month or perform a regular service shutdown.

To schedule a preventive maintenance task,

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Helpdesk block, click the Preventive Maintenance Tasks icon. This opens the Configuration Wizard page.
4. Click the Preventive Maintenance Tasks link at the left side of the page under the HelpDesk block. This opens Request Maintenance Tasks page.
5. Click Add New PM Task link. This opens Add Preventive Maintenance Task page. You can create a preventive maintenance task in two steps.

Creating a Task Template

Task template has four blocks, Request details, Owner details, Requester details, Category details.

1. Specify the Status of the request from the comb box. Ex. Open.
2. Specify the Level of the request from the combo box. The level should be selected based on the priority. Ex. If the priority of the request is high then select Tier 1.
3. Select the Mode from the combo box. This will be the mode of communication, to inform the technician.
4. Select the Priority from the combo box. For ex. High, Medium, Low etc.
5. Select the Group from the combo box. This option is given to group the task template. Ex. Network, Hardware etc.
6. Select the Technician from the combo box to assign the task and click the requester list icon to select the requester Name. This is a mandatory field. The other details such as Contact Number, Workstation ID and Department get filled automatically based on the requester details specified in the requester form.
7. Select the Category, Sub Category and Item from the combo box.
8. Specify the Subject line for the task in the given text field. Specify relevant information about the task in the given Description field.
9. To attach a file to the task template click Attach a File button to attach files.
10. You can add Resolution in the resolution text field.
11. Click Next>> button for Task Scheduling.

Task Scheduling

To schedule a task, select the time frame from the listed options:

Daily Schedule: To run a daily maintenance task, click Daily Schedule radio button.

1. Select the Time at which the maintenance task should be scheduled from the combo box.
2. Select the Date on when the maintenance task should be scheduled from the Calendar button.
3. Save the details.
**Weekly Schedule:** To run a weekly maintenance task, click **Weekly Schedule** radio button.

1. Select the day of the week by enabling the corresponding check box beside the day of the week.
2. Else if you wish to schedule on all days of the week, then click **Everyday** check box.
3. Select the **Time** frame to schedule the task from the combo box.
4. Save the details.

**Monthly Schedule:** To run a monthly maintenance task, click **Monthly Schedule** radio button.

1. Select the month to run the task by enabling the check box beside **Every Month**.
2. Select the **Date** on when the task should be scheduled from the combo box.
3. Select the **Time** at which the task should be scheduled from the combo box.
4. Save the details

**Periodic Schedule:** To run a periodic maintenance task, click **Periodic schedule** radio button.

1. Specify the day (s) in the given text field to schedule the maintenance task. i.e after every specified nth day the maintenance task will be executed.
2. Save the details.

**One Time Schedule:** To run a one time maintenance task, click **One Time Scheduling** radio button.

1. Select the **Date & Time** on when the maintenance task should be executed.
2. Save the details.

**For Example:**

If you wish to schedule a monthly task to change the printer cartridges,

1. Select **Monthly Schedule** radio button.
2. Select the check box **every month**.
3. Choose the **date** from the combo box. Ex: 3rd of every month.
4. Select the **time** from the combo box. Ex: 1500 hrs.
5. **Save** this schedule. A task to change cartridge will be sent to you every month on 3rd at 1500 hrs helping you to complete the regular maintenance task in advance without any request sent from the users.
Incident Template

In real world, there is a need to support different types of incident request which might require different fields in the form layout. Request Template supports to configure different set of fields for different type of requests. Thereby creating individual form for each request template for the most frequently raised requests such as, printer problem or mail fetching problem. The fields can be pre filled with values so that a request can be created instantly.

To open the request template form,
1. Click the Admin tab in the header pane. The configuration wizard page opens.

2. Click Incident Templates icon under the helpdesk block. This opens the Incident Template list view page.

Creating an Incident Template
1. Click Create New button. This opens the add incident template form view for the technician. The incident template form consists of three blocks namely, Header, Field list, Canvas and Show to Requester.
   - **Header**: The header consists of the Template Name, Comments and the Undo and Redo buttons.
   - **Field List**: The field list consists of the list of fields and the add new field option.
   - **Canvas**: The canvas decides the form look and has drag and drop area.
   - **Show to Requester**: The incident template can be made available to requesters by enabling "Show to Requester" check box. If you have configured User Groups, the template can be restricted to the requesters of a specific user group by selecting the user groups from the list. Click here to know more on configuring User Groups.

The following are the actions that can be performed in the form,
- Form Customization - Add New fields - Drag and Drop fields - Setting Field Property
- Request Preview - Technician View - Requester View - Add Tasks
- Edit incident Template
- Delete incident Template
Form Customization
The layout of the form can be customized by, add/remove fields, set field properties and re-arrange the fields in the Canvas for a incident template.

Add New Field
1. You can add new fields by dragging the Add New Field option under the Drag and Drop field on to the canvas.

2. This opens the Add New Field pop up window as shown below,

   ![Add New Field](image)

2. Select the type of field such as, text, numeric, by enabling the radio button beside it.
3. In the text field settings block, specify the Label Name in the field provided. This is mandatory field. If required, enter the significance of the field in the Description text field.
4. Select the type of the text field such as single-line, pick list.
5. Click Ok, the field gets added in the dragged place in the canvas with the above specifications.
The newly added fields are common for all the templates. The field name will also be same for all the templates. The newly added field can be edited or deleted only in Request - Additional Fields.

Drag and Drop
1. Drag the field from the Field List and drop it onto the canvas. The drop areas will be highlighted. The dragged field can be dropped only in the highlighted area.
2. The fields in the form can also be re-arranged by dragging the field and placing it over an empty cell. The field can be placed only in the highlighted area. The request details can be moved as a whole block.
3. If you want to Undo/Redo the changes then click the corresponding buttons.

Setting Field Properties
You can customize the fields such as, status, priority, mode by either changing the field properties, that is, making the fields mandatory or closing the fields. Thus you can customize the entire form by keeping the relevant fields in the canvas for a template. To customize the form,

1. Hover over the field, an Edit Field properties and Remove Field icons appears.
2. Click the Edit Field Properties icon 🖍️. A drop down appears containing the options,

- **Mandatory Field**: The field can be made mandatory by enabling the check box adjacent to this option. **Note**: If the Item field is marked as mandatory then the category and sub category will automatically be marked as mandatory. Similarly, if the Impact details is marked as mandatory then the Impact field will automatically be marked as mandatory.
- **Requester can Set:** Enabling this option, provides the requester with the privilege to set the field values in the new request form of the requester login. Selecting this option automatically enables requester can view’ option.

- **Requester can View:** The requesters can view the field in the request details page but cannot set nor edit the value.

**Note:** The fields such as request details, subject and description do not have field properties and hence can be only re-arranged in the canvas.

3. Click **Remove Field** icon to remove the field from the canvas. The detached fields are added under drag and drop field list. The fields like status, priority, description, subject and requester details does not have the Remove Field option.

On customizing the form layout, you can pre fill the fields with values. Click **Save**. The template is added to the available list in the Incident Template list view page. To save and add tasks for the template, click **Save and Add Task** instead of Save.

At any point, if you do not wish to add the Incident template and would like to get back to the list view page, click **Cancel**. Clicking the **View List** link on the top right corner of the Incident template form will also take you to the Incident template list view page.

The incident templates are populated under **New Request** drop down. To obtain the default request form, click New Request link. The default form can neither be deleted nor renamed. Requests created through mail is also based on the default template.

**Request Preview**

On customizing the request form for both the requesters as well as technicians, you can see the preview for both the logins using this option.

From the Incident Template list view page, click the Template name to preview.

**Technician View**

By default, the incident template form for a technicians is opened. You can drag and drop fields in the canvas, re-arrange, add/remove and set properties for the field.

**Requester View**

You can view the incident template form for a requester if the **Show to requester** option is enabled. To view the incident template form for a requester, click the **Requester** tab on the top left hand side of the page. The header section is grayed and hence is non editable. In the requester preview page, certain fields are hid from the requester while the rest of the fields can only be re-arranged.
Add Tasks
You can view and add tasks related to the incident template on clicking the Tasks tab. This displays the list of tasks for the template. You can add tasks by clicking Add Task button. To add task refer Add Task.

Edit Incident Template
You can edit the incident template and also have a preview of the incident templates for a technician and a requester.

1. Click on the incident template name from the incident template list view page. By default, the incident template form for a technicians is opened.
2. You can drag and drop fields in the canvas, re-arrange, add/remove and set properties for the field.
3. You can view the incident template form for a requester if the Show to requester option is enabled. To view the incident template form for a requester, click the Requester tab on the top left hand side of the page.
4. In the requester preview page, the fields can only be re-arranged. The header section will be grayed and hence will be non editable.
5. You can also view and add tasks related to the request by clicking on the Task tab. This displays the list of tasks for the template. You can also add tasks by clicking Add Task button.

Delete Incident Template
1. From the incident template list view page, enable the check box adjacent to the template which you want to delete.
2. Click Delete button, a pop up window appears confirming the delete operation.
3. Click **Ok** to continue. The template gets deleted from the list. If the template is been used by a request then the template will be marked in grey indicating no further usage of the template in the incident template list view page. To bring the form back to usage, disable **Template not for further usage** check box under the **Header** block of Edit Incident Template form.
Service Catalog

Enterprises today seek for an approach to enhance and streamline the communication between IT and end-users. While the IT department has services and the users have needs, the manner in which the services must be exposed to the users is a crucial task. This is where Service Catalog in ManageEngine ServiceDesk Plus plays a vital role in your organization.

Service Catalog is where you can portrait the wide range of services offered by your IT department to the end-users. Some of the most common day-to-day IT services required by the users are, installation, relocation, internet access, email access, virus protection, provision of hardware and software, mail server, account management and so on. With the simplicity and clarity through which the services are exposed in ServiceDesk Plus allows users to easily browse through the services, raise requests instantly and monitor their status thereon.

To access the service catalog configuration wizard page,

1. Click the Admin tab in the header pane to open the configuration wizard page.

2. Click Service Catalog icon under Helpdesk block. The Service Catalog page opens listing the service categories available in the application.

From this page, you can add new service category, manage the service items and also add services under each category. The number of services available is specified under each service category.

Getting Started

To start off with configuring your personalized Service Catalog, you need to first define Service Categories. Service Categories holds classified group of service items and can be configured from the Manage drop down. Apart from this, an instant means to get to the add service category form is by clicking the Add Service Category button. The configured Service Categories are displayed in the list view with an icon to depict its uniqueness.
From the Manage drop down, you can also configure the **Additional Fields** and **Service Level Agreement** for the service requests. If the default parameters in the template does not contain key information that is relevant to your organization, then the same can be configured from the **Additional Fields**. Using **Service Level Agreements**, your help desk team effectiveness and efficiency can be determined.

**Service Requests** for a service category is configured using the **Add Service** button beside the category. The list of services under a service category can be viewed using the drop down icon beside them, and on hovering over the services, the *delete, edit* and *disable* icons appear. Using these icons, the preferred operations can be performed. Representation of icons in Service Catalog list view screen,

- **X** - icon to delete a service item.
- **✓** - icon to edit a service item.
- **☒** - icon to disable a service item.
- **✔** - icon to enable a service item.

Service items configured are displayed under the **Service Catalog** tab in Home page. With Service Catalog, services are easily accessed, facilitating users to browse for services, submit requests for IT services and monitor their status.
Service Catalog - Service Categories

Service Category is a comprehensive list of IT services provided by the IT department to the end-users. Each service category has a classified group of service items which are exposed to user groups who are approved to access it.

To access the Service Category configuration page,

1. Click Admin module in the header pane. The configuration wizard page opens.
2. Click Service Catalog icon under Helpdesk block.
3. From the Service Catalog configuration wizard page, click Manage drop down and select Service Categories option. The Service Categories list view page opens where you can add edit and delete a service category.

Apart from this, an instant means to get to the add service category form is by clicking the Add Service Category button in the Service Catalog configuration wizard page

Adding New Service Category

1. Click Add New Service Category link. The Service Category page opens.
2. Specify the Name of the IT Service. This field is mandatory.
3. Enter a brief Description about the IT service details in the field provided.
4. Set an Icon for the service category. You can choose the icon from the icon set or upload an icon. The Icon set consists of the icons available in the application, by default. To upload an icon, click Upload an icon link and browse through the icons.
5. Click Save to save the details and return to the list view. Click Save and Add New, to add more than one service category. Click Cancel to return to the list view.

Editing a Service Category

1. From the Service Category list view page, click on the edit icon beside the service category to edit. The Service Category page opens.
2. All the fields in the form are editable. Modify the necessary fields.
3. Click Save to save the details and return to the list view. Even while editing a service category you can add a new service category by selecting Save and Add New button. Click Cancel to return to the list view.
Deleting a Service Category

1. From the Service Category list view page, enable the check box beside the service categories to delete.
2. Click **Delete** button. A confirmation dialog appears.
3. Click **Ok** to continue. The service category is deleted from the list.
Service Catalog - Additional Fields

If you require any further additional information apart from the defined pre-set fields in the service request form, you can configure the same under Service Management - Additional Fields. The additional fields can be made available in all the service request forms or in specific service request forms pertaining to a service category. You can add text fields, numeric fields and date type fields in the form.

To add additional fields,

1. Click Admin tab in the header pane. The configuration wizard page opens.
2. Click Service Catalog icon under Helpdesk block.
3. From the Service Catalog configuration wizard page, click Manage drop down and select Additional Fields option. The Additional Fields page opens where you can add upto 24 Text fields, 8 Numeric fields and 8 Date/Time fields.
4. Select the Service Category for which the additional field should appear. If the additional field should appear in all the service request forms, select “common fields”.

Configuring Additional Text fields

1. By default, the Text tab is selected. Specify the Label for the Additional field.
2. Specify any relevant information about the additional field in the Description text field.
3. Select the Type of the text field by enabling the radio button. It can be either Single - Line, Multi - Line or Pick List (drop down list).
4. You can also specify default values to be pre-filled in the add new service request form.
5. Save the settings.

Configuring Additional Numeric fields

1. Click on the Numeric tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text field.
4. Save the settings.

Configuring Additional Date/Time fields

1. Click on the Date/Time tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text fields.
4. Click Save to save the settings.

These additional fields will appear in the Service Fields section of the new service form. To delete the user-defined fields, instead of adding the label names, delete the existing label names you wish to remove from the fields of the form and click Save.
Service Catalog - SLA

Service Level Agreement evaluates the efficiency, effectiveness and responsiveness of the help desk team. The services created in the application can be exclusively assigned with specific SLAs thereby setting a due by date for the service requests. Escalation rules can also be set if the request is not attended and resolved within the specified time.

To access the SLA configuration wizard page,

1. Click Admin tab in the header pane. The configuration wizard page opens.

2. Click Service Catalog icon under Helpdesk block.

3. From the Service Catalog configuration wizard page, click Manage drop down and select Service Level Agreements option. The SLA List page appears from where you can add, edit and delete a SLA.

Adding SLA

1. Click Add New SLA link. The SLA form has three blocks of information, namely SLA Details, SLA Rules, and Escalations.

2. The SLA details consists of the SLA name and description.
   1. SLA Name uniquely identifies the SLA. It is a mandatory field.
   2. You can provide a brief explanation of the SLA in the Description field.

3. SLA Rules is where you need to set the Agreed Upon Time (due by time) for the service request. Enter the agreed upon time in terms of days, hours and minutes. If the service request should be fulfilled irrespective of the working hours and holidays, then enable Should be fulfilled irrespective of the operational hours check box.

4. Escalate the service requests to other technicians if the request is not resolved within the specified resolution time. Select the check box beside Enable Level 1 Escalation. Click Choose button to select the technicians to whom the SLA violation should be escalated.

5. You can choose to escalate before or after the SLA violation. If you wish to escalate the request before the SLA violation, click Escalate Before option. This informs the technician about the impending of the violation. Specify the number of days before the SLA violation in the text box. You can also specify the time of escalation.

6. Click Escalate After option to escalate after the violation. Specify the number of days after the SLA violation has occurred in the text box. You can also specify the time of escalation.

7. Similarly, there are four levels of escalation when the resolution time violates.

8. Click the Save button to save the SLA and return to the list view. Click the Save and Add
**New** button to save the SLA and add another SLA. Click **View List** to view the SLA list view page. To return to the Service Catalog configuration wizard page, click **Go Back**.

**Editing SLA**

1. From the Service Category list view page, click on **edit** icon beside the SLA name to edit. The edit SLA page opens.
2. The fields, SLA details, SLA rules and escalations are editable. **Modify** the necessary details.
3. Click **Save** button to save the SLA and return to the list view. Even while editing, you can add another SLA on clicking **Save and Add New** instead of the Save button. Clicking on **Cancel** takes you to the list view.

**Deleting SLA**

1. Enable the check box beside the SLA to delete.
2. Click the **Delete** button. A confirmation dialog appears.
3. Click **Ok** to proceed with the deletion. If you do not want to delete the SLA, then click **Cancel**.
Service Items

The day-to-day IT services such as installation, relocation, internet access, email access, virus protection, provision of hardware and software, mail server and so on are configured under this section. The service items are classified and grouped under Service Categories, which are displayed in the Home tab.

The Service Request form consists of a drag and drop template that should be configured in order to meet the end-user requirement. If the service involves the need of any resources, then the same can be configured under the Resource Info block. Furthermore, approvers, service level agreement and tasks can be assigned for individual service request.

To configure Service Items,

1. Click the **Admin** tab in the header pane to open the configuration wizard page.

2. Click **Service Catalog** icon under Helpdesk block. The Service Catalog page opens listing the service categories available in the application.

3. Click **Add Service** button beside a service category to add service under it. The Add Service Item form opens to display three tabs namely, Form Designer, Workflow and Requester View. By default, the form Designer is displayed.

This following are explained under this section.

- Configuring Form Designer
  - Configuring Resource Information
  - Show to Requester option

- Configuring Workflow
  - Approver Details
  - SLA
  - Adding Tasks to service requests
  - Template Action

- Requester View

- Enabling/Disabling Service Item

- Editing Service Item

- Deleting Service Item

**Configuring Form Designer**

To add services under a service category,

1. Click **Add Service** button beside the service category. The service request for Technician View appears consisting of the **Header**, **Service Fields** and **Service Preview**.

   - **Header** : The header consists of the **Service Name** and **Description**.
   - **Service Field** : The service fields consist of the list of available parameters and an option to add new fields for the service item.
   - **Service Preview** : The service preview decides the form look and consists of drag and drop area along with the **Undo** and **Redo** options. With the template, individual forms can be customized for each service by dragging the available service fields into the service preview form, remove fields from the form, set the field property and also rearrange fields in the form.
2. To add a new field in the form, drag **Add New Field** option in the service preview form. Place the field only in the yellow highlighted area of the form.

   ![Form Designer](image)

   i. An **Add New Field** pop up appears where you can select the type of field to be added in the canvas. The field can be text, numeric or Date/Time field.

   ![Add New Field](image)

   ii. Specify a unique **Label** in the field provided. This field is mandatory. Also, enter the significance of the field in the **Description** text field.

   iii. For Text field, select the field type from Single-line, Multi-line or Pick-list. Enable any one of the radio button.

   iv. Click **Ok** to add the field in the canvas with the above specifications.

4. The newly added fields are common for all the service items under a service category. Alternatively, you can also add new fields in Additional Field. From this section, you can also edit and delete the additional fields.

5. Similarly, you can drag the **Service fields** onto the service preview form. If required, the fields in the service preview form can be rearranged by dragging the field and placing it over the yellow highlighted area.

6. While rearranging the fields, if you want to **Undo/Redo** a change, click the corresponding button.

7. You can also add or select the default values to appear in the form.
8. To customize and remove undesirable fields in the form, hover over the field, the **Edit Field Properties** icon 🆕 and the **Remove Field** icon ✗ appears.

   ii. Click **Edit Field Properties** icon 🆕. A drop down containing the following options appears,
      i. **Mandatory Fields**: Enabling this option sets the field as mandatory.
      ii. **Requester can set**: Enabling this option allows the users to edit the field, i.e., they can enter or select values for the field while raising a new service request. Enabling this option automatically enables ‘requester can view’ check box.
      iii. **Requester can view**: Enabling this option alone allows users to view the field in the service request form but they cannot enter values for the field while raising a service request.

2. Click **Remove Field** icon ✗ to remove the fields from the service preview form. The fields detached from the form are listed in the Service Fields block.

   ![Service preview form with detached fields]

### NOTE
1. If the Item field is marked as mandatory then the corresponding Category and Sub category will be automatically marked as mandatory.

   Similarly, if the Impact details is marked as mandatory then the Impact field will also be marked as mandatory.

2. The fields such as Requester Details, Subject and Site do not have Edit Field Properties icon and hence these fields can only be re-arranged.

3. Fields such as Status, Description, Requester Details, Site and Subject do not have Remove Field icon.

8. **Save** the service before proceeding to the Resources block.

### Configuring Resource Information

If the service involves any resources then you can mention them under the **Resource Info** block. The process of adding resources involves a series of questions, and the resources can be displayed in either of the following formats - check box, drop down, plain text or with simple yes/no.

Take the case of a new employee joining your organization. The resources provided to the new employee would be, providing a desktop/laptop, installing the necessary softwares, provision of any additional hardware resource, communication device, entry into application logins like Active Directory, VPN, Email, Payroll, CRM and so on. These resources are entered under Resource Info block of the service request.
To add resources,

1. Click **Add Resource** button in the Resource Info block.

2. In the Add Resource pop up, specify the **Resource Title** and a brief **Description** on the purpose for adding this resource. The Resource Title is a mandatory field.

3. Next, you can either choose to select the question from the existing question list or create a new question. **Selecting from existing question list:** To select a question from the existing question list, use the **Select your question** drop down.

   ![Add Resource](image)

   Select a question from the list, say "Choose the additional hardware required". The question is displayed along with an edit and delete icon. If you wish to add another additional hardware to the list, click on the **edit** icon Edit. Enter your option and add it to the existing list as shown below. Click **Ok** to save the question.
Adding New Question:

If your desired question is not in the existing question list, then you can add a new question by clicking **New Question** button. **Enter your Question** and select the question format from the options provided. The question can be displayed either in a simple yes or no format, drop down, check box or as a plain text.

If you have selected the **Question Type** as check box or drop down, then the **Add Options** appears, listing all the product types configured in the application. Selecting a product type lists all the products (configured in the application) under that product type.

For instance, if the selected product type is "Software", then all the managed softwares available in the application are listed. If the selected product type is "Workstation", then the workstations configured and scanned in the application are listed.
Select the assets/software to be displayed in the question by clicking >> (move right) button as shown in the image. Click Ok to save the question.

Manual addition of Resources:
If the new employee is a designer and requires products that are not configured in the application, then you can manually add the resources by selecting the Add options as Add Manually as shown in the image below.

Enter the resource. In this case the resource is "HP Pavilion" and click Add >> to make the resource available in the question. Click Ok to save the question. To add another question, click New Question and follow the process as above.

4. Click Save to save the resource information. The questions are displayed in the Resource Info block of the service preview form from where you can also edit or delete the added resources.
Show to Requester

To make the service request accessible in the requester's login, select Show to Requesters check box. If User Groups are configured in the application, then you can select specific user groups to whom the service request should be made available too. Selecting the user groups makes a clear indication of the end users who can subscribe to the services.

Say for instance, if a service request should be shown to the requesters in the Sales department, then, configure the user group by selecting the "Department" as "Sales" under Admin -> User Management -> User Groups. Once the user group is configured, enable "Show to Requester" check box in the service item form and select the user group as "Sales User Group". To know more on configuring user groups, refer User Groups.

Click Save to save the details. Click Save and Configure Workflow button, to configure the service request workflow.

Workflow

The Workflow tab consists of options to select the approvers for the service request, map Service Level Agreement and an option to show the service request to requesters.
Approver Details

Certain service request raised in the application requires an approval from the concerned user to go ahead with the request. The approver can be a technician or a requester with the permission to Approve Service Requests and should possess an email address in the application.

Select the Approver using the icon 🗂. The head of the department to which the requester belongs can also approve the request provided the user has the permission to approve service requests.

On selecting the approver, the appropriate notifications have to be selected.

- **Send approval notification automatically when a service request is raised** - Enable this check box to send an approval notification to the concerned authority each time a service request is raised.
- **All configured approvers have to approve the Service Request** - Enabling this check box makes it mandatory for all the configured approvers to approve the service request. If anyone of the approver rejects the service request, the request does not proceed to the next stage.
- **Do not assign technician before Service Request is approved** - This option is enabled only on selecting "Send approval notification automatically when a service request is raised" check box. On selecting this option, a technician is assigned to a service request only when the service request is approved by the concern authority.

SLA

Each service request created in the application is assigned with a specific SLA to set the due by date. Select the SLA for the service request from the drop down. You can also add new SLAs using Add New SLA link.

Adding Tasks to Service Requests

You can add tasks to a service request if the request involves multiple technician work.

To add Tasks to service requests,

1. Click the Tasks tab -> click Add Task button from the tasks list view page.
2. In the Add Task form, specify the Title of the task. The Title is a mandatory field.
3. Specify relevant information about the tasks in the Description field.
4. Select the Group to which task has to be assigned. Select the Technician of the task from the combo box. Tasks can be assigned either:
   - to a Group alone,
   - to a Group and a specific Technician in the group,
   - to a Technician alone without selecting the group,
   - to no Group and no Technician.
5. If there are multiple tasks for a service request, the implementation of one task may be dependent on the completion of another. In this case, the dependencies on tasks can be captured by clicking on the relevant tasks under Task Dependency block.
6. Select the Status of the task from the drop down.
7. Specify any relevant comment about the task in the Comments field.
8. Click Save to save the details. Click Save and Add New, to save the details and open another Add Task form. Click Cancel to go back to the tasks list view.

You can also organize tasks from the list view to suit your desired priority. Click Organize Tasks button and change the order of the tasks using the up and down buttons.

The tasks for a service request are automatically created and assigned to the configured technician each time the service request is raised.
Template Action

If the service request involves software installation/uninstallation, then the same can be performed from the centralized server through Desktop Central Integration. The software installation/uninstallation is performed with the aid of a Desktop Central Agent that should be installed in the Windows workstation.

To avail this functionality, configure the Server Name and Port number of the Desktop Central server in SDP application. Since all service requests do not require Desktop Central operations, this activity is limited by providing a Template Action check box in each service item form. This functionality is attainable only when Desktop Central 7.0 and above is integrated with SDP. Refer Desktop Central Integration to know more.

Click Save to save the details. Click Save and Configure Requester button, to configure service request form for requesters.

Requester View

The "Requester View" tab is available in the service form only if the requesters have permission to view the service request. Click the Requester View tab to view the requester preview of the service request.

The service form is similar to the technician preview except,

- the header section is grayed indicating that its non editable,
- the service fields has limited parameters and the option to add new field is unavailable
- parameters such as Mode, Request Type, Level, Impact, Impact Details and Urgency are unavailable for the requester preview.
- the Edit Field Properties option is absent for the fields.

You can drag the available service fields onto the service preview form. Place the field only in the yellow highlighted area of the form. You can also rearrange the existing fields in a similar manner. In addition, you can also set default values for the fields to appear while raising the service request.

Click Save to save the configured details. Click Cancel to exit the form.

Disabling/Enabling Services

By default, a newly added service is enabled in the list view. To disable a service,

1. Click the icon beside the service category to list the services under them.
2. Hover over the service to disable. Click disable service icon. The service is grayed and will not be listed along with the existing services in the home page.

To enable a service,

1. Click the icon beside the service category to list the services under them.
2. Hover over the service to enable. Click enable service icon. The service is enabled and is listed along with the existing services in the home page.
Editing Services

To edit a service under a service category,

1. Click the icon beside the service category to list the services under them.
2. Hover over the service item to edit. Click the edit icon . The service form for a technician opens where you can add new fields, rearrange the existing fields and edit the default values.
3. Click Save to save the configurations. Similarly, you can edit all the remaining tabs from the service catalog page. Click Save and Configure Requester button, to configure service request form for requesters. To add tasks, click Save and Add Tasks.

Deleting Services

To delete services under a service category,

1. Click the icon beside the service category to list the services under them.
2. Hover over the service item to delete. Click the delete icon . A confirmation dialog appears.
3. Click Ok to proceed. The service item is deleted from the list.
User Management

For making the ServiceDesk Plus available and usable for all your customers, you need to add requesters and technicians, and define their roles. This enables the requesters to log in to the Self-Service Portal to check the status of the issues reported by them, submit requests, and search the knowledge base online. The added technicians can log in to the ServiceDesk Plus application and pick up requests, review and resolve requests assigned to them, add solution articles, and so on. The user management configurations allow you to add requesters, technicians, define roles, and login access permissions.

The various user management configurations that you can perform are

1. Configuring Roles
2. Configuring Requester Additional Fields
3. Configuring Requesters
4. Configuring Technician Additional Fields
5. Configuring Technicians
6. Configuring Technician Groups
7. Configuring User Groups
9. Configuring LDAP
10. Configuring Leave Type
11. Configuring Robo Technician

To access the user management related configurations:

1. Log in to the ServiceDesk Plus application using the user name and password of a ServiceDesk Plus administrator.

Click the Admin tab in the header pane. The Users block is below the Asset Management block.
Configuring Roles

Each technician accessing the help desk tool will have a set of permissions and tasks to execute in the application. These access permissions are termed as Roles in ServiceDesk Plus. Multiple roles can be created and assigned to each technician based on the requirement. The roles for requesters are pre-defined and hence cannot be configured.

To open the role configuration page:

1. Log in to the ServiceDesk Plus application using the **username** and **password** of a ServiceDesk Plus administrator.
2. Click the **Admin** tab in the header pane.
3. On the **Users** block, click the **Role** icon. The next page displays the available list of roles. You can add, edit, or delete roles.

**Add Role**

To add a role,

1. Click the **Add New Role** link to open the **Add Role** form.
2. Enter the **Role Name** in the given text field. The Role Name has to be unique and is a mandatory field.
3. Enter a brief description of the role in the **Description** field.
4. Set the **Access Permissions** for the role by selecting the check boxes beside the access levels defined for each module of the application. **Example:** If you wish to provide full control permissions to the requests, inventory, contract and solutions module, then enable the check box below **Full Control**. This will automatically enable all the operations of the corresponding modules. You can provide add permission to the remaining modules by selecting the **Add** check box. Enabling the **Add** check box automatically enables the view permission.
5. The access permissions for requests, purchase and assets module are further categorized and defined under **Advanced Permission**.

**Requests FGA (Fine Grained Authorization)**

Set the advanced permission for add, edit and delete operations by enabling the check box.

- **Adding/Editing Request Task**: Permission to Add/Edit the request tasks.
- **Adding Requesters**: Enabling this option will allow you to add new requesters on the fly while creating a new requests/problem/change. Adding requesters without this permissions pops up an error message stating "Requester Does not Exist".
- **Resolving Request**: Permission to change a request status to Resolved.
- **Disabling Stop Timer**: Permission to allow a requester to change the status of a request to OnHold.
- **Merging Requests**: Enable this option to provide permission to merge two or more requests.
- **Closing Request**: Permission to change a request status to Closed.
- **Modifying Due Time**: Permission to change the Due By Time and also the First Response Time of a request.
- **Modify Resolution**: Enable this option to provide permission to edit a resolution. On disabling this option, the technician can only add the resolutions for a request without a resolution entry.
- **Re-opening Request**: Permission to change the status of the request to Open from the previous state.
- **Assigning Technicians**: Permission to allow a technician to assign or reassign a request to a technician.
- **Editing Requester**: Permission to edit the requesters name while viewing the request.
- **Deleting Others Notes**: Permission to edit/delete notes added by other users/technicians. If the option is disabled, then the technician can delete the notes added by him.
- **Deleting Others Time Entry**: Permission to delete the Work order details entered by other users. If the option is disabled, then the Technician can only edit/delete his Work Order Entry.
- **Deleting Request Task**: Permission to delete the request tasks of a request.

**Assets FGA**

- **Install and Uninstall Software**: Permission to perform desktop management activities like Install and Uninstall softwares. This role is applicable only when Desktop Central is integrated with ServiceDesk Plus application. To know more refer Desktop Central Integration

**Purchase FGA**

- **Adding New Product**: Permission to add a new product while creating a purchase order.
- **Adding New Vendor**: Permission to add a new vendor while creating a new purchase order.

6. You can also choose to restrict the technician from viewing all the requests received by the application. To do this, select the corresponding radio button which will suit your need from the following,

- **All**: The technician with this role can view and add requests, problems, change and assets for all the sites available in the application.
- **All in associated Site**: The Technician can view and add requests, problems, change and assets that are part of his/her associated sites. To associate the site to the technician refer Technician.
• **All in Group & assigned to him:** The technician will be restricted to view all the requests of the Group to which he/she belongs and also those requests that are assigned to him/her.

• **Assigned to him:** The technician will be restricted to view the requests that are assigned to him/her. **Example:** A site has two groups, say Group1 and Group2. Adam is a technician associated to group1 with the privilege **All in group & assigned to him** enabled in the role assigned to him. With this restricted view enabled, Adam can view all the requests in Group1 and the requests assigned to him. He has the privilege to re-assign the requests to other technicians in his associated sites but once this is executed, the request will not be visible to Adam.

7. You can also provide permission to approve solutions in the role by enabling the check box beside **Technician allowed to Approve solution.** Thus the technician assigned with this role will be able to approve solutions.

8. Click **Save.** If you want to add more just one role, click **Save and add new** button.

At any point, if you decide not to add the new role, then click **Cancel** to get back to the role list. Clicking the **View List** link on the top right corner of the add role form will also take you to the role list view.

### Edit Role

To edit an existing role,

1. In the **Role List** page, click the **edit** icon beside the role name that you wish to edit. This opens the **Edit Role** form.

2. You can modify the name of the role, description, and the permissions associated with the role.

3. Click **Save** to save the changes. At any point, if you wish to cancel the operation that you are performing, click **Cancel**.

Even while editing a role, if you wish to add a new role, then click the **Save and add new** button. The Add Role form opens after displaying a message that the changes are saved.

### Delete Role

1. In the **Role List** page, click the delete icon beside the role name that you wish to delete. A confirmation dialog is opened.

2. Click **OK** to proceed with the deletion. If you do not want to delete the role, then click **Cancel**.

**Note:** You cannot edit or delete the SDAdmin and SDGuest roles that are already defined in the application. They are the default administrator and requester roles defined.
Configuring Requester - Additional Fields

By default, the New Requester form has the required fields, where you can enter important details about an organization. Sometimes, you may need some additional fields in the New Requester form. You can add your own fields using the Requester User Defined Fields configuration.

To add your own custom fields in the new requester form:

1. Login to the ServiceDesk Plus application using the user name and password of a ServiceDesk Plus administrator.

2. Click the Admin tab in the header pane.

3. In the Users block, click the Requester - Additional Fields icon. The next page is a form, where you can enter the field label and description of the field. You can add three types of fields in the form: text, numeric, and date/time. These three are available in three tabs as shown below:

   - **Text**: You can configure up to 12 text fields.
   - **Numeric**:
   - **Date/Time**:

4. To add the text fields, enter the label name in the form fields below the Label heading. If required, enter the description for the field.

ZOHO Corp.
5. You can choose the type of text field that you wish to add by selecting the radio buttons. A Single-line text field allows you to add just a text field. The Multi-line text field allows you to add a text box where a lengthy description can be added. A Pick List allows you to add a list menu from which you can select. In all the three cases, you can add default values for the text field in the space provided for the same.

6. To add items for the pick list, enter the value in the text field and click Add Item. The value will get added to the list below. To select the default selected value of the list, click on the value in the list.

7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields provided for the same.

8. To add date/time fields, click the Date/Time tab and enter the required details.

9. Click Save. A message for successful creation of the fields is displayed.

These fields appear under the grouping Additional Requester Details in the New Requester form.

To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label names that you wish to remove from the fields of the form and click Save. The respective fields that you deleted will be removed from the New Requester form.
Configuring Requesters

You can add, edit, or remove requesters from ServiceDesk Plus application and also provide them with login permissions to access the self-service portal.

To open the requester configuration page:

1. Log in to the ServiceDesk Plus application with the user name and password of a ServiceDesk Plus administrator.
2. Click the Admin tab in the header pane.
3. In the Users block, click the Requesters icon. The next page displays the available list of requesters. You can add, edit, or delete requesters.

Add Requester

There are three ways through which you can add requesters in the application

- Importing requesters from Active Directory
- Import from CSV
- Add New Requester from the application

Adding Requesters from the application

1. Click Add New Requester link from the Requester List page. This opens the Add Requester form
2. In the Personal Details block, enter the Full Name and Employee ID of the technician. The name is a mandatory field. Specify any relevant information about the requester in the Description text field.
3. In the contact information block, enter a valid e-mail ID. If the requester has a phone and a mobile number, you can enter the same in the space provided for entering these values.
4. Specify the department details such as, Site and the corresponding Department Name to which the requester belongs from the combo box. The requester has an option to view, only his requests, all his department requests or all the requests in the site to which he is associated. Select the options from the Requester allowed to view combo box. Specify the Job Title of the requester in the field provided.
5. If you have added any organization-specific fields for the new requester form, those will be available under the Additional Requester Details block. Enter the relevant information.
6. In the Self-Service Access Details block, enter the Login Name and Password, if you wish to provide self-service access to the requester. Enter the password again in the Re-type Password field.
7. If the requester is associated to a domain then select the Domain from the drop down list.
8. Certain requesters can also approve purchase order in an organization. Upon enabling the check box adjacent to Purchase Order Approvers, a link is sent to the requester to accept or reject the PO. Also, set the Approver Limit within which the requester can approve the PO.
9. You can also provide requester with the privilege to approve Service Requests raised in the application. Enable the check box beside Service Request Approver.
10. Click Save. If you want to add more than one requester then, click Save and add new button.

At any point if, you decide not to add the new requester, then click Cancel to get back to the requester list. Clicking the View List link on the top right corner of the add requester form will also take you to the requester list view.
Import Requesters from Active Directory

You can also import requesters from an active directory. To import requesters from active directory

1. Click Import from Active Directory link in the Requester List page. The Import From Active Directory window pops up.

2. From the list of domains that are listed in the Domain Name combo box, select the domain name in which the active directory from which you wish to import is installed. If the other details such as domain controller name, user name, and password have already been entered in the Domain scan page, then that will be populated automatically. Else enter the name of the domain controller in the Domain Controller Name field, login name and password in the corresponding fields.

3. Select the Fields for Import from the active directory by enabling the check box. The fields name configured in Active Directory can be specified beside the corresponding text fields. The unselected fields are not imported.

4. Click Import Now!. The import wizard displays the various Organizational Units (OUs) available in that domain. Choose the specific OU from which you wish to import users by selecting the check box beside it.

5. Click Start Importing. Once the import is complete, the data on how many records were added, how many overwritten, and how many failed to import will be displayed.

Import Requester from CSV (Comma Separated Value) Files

You can also add requesters by importing from CSV files. To import requesters from CSV file

Step 1: Locate the CSV file

1. Click Import from CSV link in the Requester List page. The Import Wizard opens in a pop-up window.

2. Click the Browse button in the wizard.

3. Select the CSV file in the file chooser window and click Open.

4. Click Next.

Step 2: Customize Mapping

1. The CSV column names are populated in the select boxes beside each label. Map the ServiceDesk Plus requester fields with the field names from the CSV file.

2. Click Next.

Step 3: Import

1. Click Import Now button. The values from the CSV file will be imported to the requester details. Once the import is complete, the data on how many records were added, how many overwritten, and how many failed to import.

If at any point you wish to stop importing from the CSV file, click the Exit button.

Note 1: Login name column will be the identifier for requesters. No two requesters can have the same login name. Hence the existence of a requester will be checked based on the login name value.

So, if by mistake there was any mismatch of fields during mapping, and a new import of CSV is performed, the records will be updated based on the login name value. If there were any records that did not have any login name at all or there was mismatch in the login name itself, then duplicate entries will be created. In these cases, delete such entries from the requester list and import again or manually edit the information available.
**Note 2:** While Importing users using CSV, the existing user information is overwritten based on two criteria - Username and Domain, and the Email id. If the Domain is not specified for a user and on performing a new import of CSV, the user information will be overwritten but the Domain will remain null even if the field is specified.

**Edit Requester**

To edit the requester details,

1. In the **Requester List** page, click the edit icon beside the requester's full name that you wish to edit. The **Edit Requester** form is displayed with the existing details of the requester.

   ![Edit Requester Form]

   **Personal Details**

   - Name: Sharon Harper
   - Employee ID: 887
   - Description: End User of the software product

   **Contact Information**

   - E-mail: sharon@zoho.com
   - Phone: 984-703-7432
   - Mobile: 984-703-7432

   **Department Details**

   - Site: New York
   - Department Name: Engineering
   - Requestor allowed to view: All other Department requests
   - Job title: Engineer

   **Self-Service Access Details**

   Application is currently configured NOT to email requesters on self-service login details. This can be enabled from 'Notification Rules' in Admin.

   **Login Name:** sharon
   **Password:** ********
   **Retype Password:** ********
   **Domain:** NDOMAIN

   **Select Permissions**

   - Service Request Approver
   - Purchase Order Approver

   **Approval Limit:** Unlimited

   ![Edit Requester Form]

   **Save | Save and Add Item | Cancel**

2. In the above form, you can modify all the fields displayed. You can also change the login name of the requester.

3. Click **Save**. If you do not wish to modify any of the details, click **Cancel**.

**Change Requester Password**

You can change the requester's password while editing the requester details.

1. To change the password of the requester, click the **Reset Password** link. The reset password window is opened.
**Change Requester to Technician**

You can change a requester to technician without having to delete the requester information and recreate the same as a technician. To change requester to technician,

1. Click on the requester's name -> click **Change as Technician** option. The page refreshes to display the edit technician form.
2. Change the roles assigned to the requester from **SDGuest** to any other role that you wish to provide the technician.
3. Enter any other details that you wish to enter including the **Cost per hour** and so on.
4. Click **Save**. If you do not wish to change the requester to technician, click **Cancel** instead of **Save**.

If you want to continue adding technician after converting a requester to technician, then instead of clicking **Save**, click **Save and add new** button. This saves the technician details and reopens the add technician form after displaying a success message for changing the requester to technician.

**Associate Workstation to Requester**

You can also associate a workstation with the requester. To associate a workstation with the requester

1. Click on the requester's name -> click **Associate Workstation** option. The associate workstation window is opened.
2. In the **Associate Workstation** pop-up, select the workstations that you wish to associate with the requester from the **Workstation List** and move them to the **Associated Workstations** list by clicking the >> button. To dissociate workstations, select the respective workstations in the **Associated Workstations** list and click the << button. If you wish to dissociate all the workstations, then click **Dissociate All**.

3. After associating the required workstations, click **Save Changes**.

4. A message is displayed. Click the **Close** button.

**Delete Requesters**

1. In the **Requester List** page, enable the check box beside the requesters to delete.
2. Click Actions drop down -> **Delete Requester(s)** option. A confirmation dialog is opened.
3. Click **Ok** to proceed with the deletion. If you do not want to delete the requester, then click **Cancel**.

**Search Requesters**

To search requesters

1. In **request list** view, click on the alphabet with which the name of the requester starts. This lists the requesters whose name starts with that alphabet.
2. If you are unsure of the starting letter, then you can type the name (first name or the last name, whichever you know) or email ID or any other parameter that will identify the requester in the field beside the **Search Requester List**. This lists the requesters whose details matches the search string that you entered.

You can also search requesters from the **Search** available on the left menu in the other pages of the application. From the **Search in** combo box, select **Requesters** and type your search string in the **Enter Keyword** text field. Click **Go** or press **Enter**. The requester names that match the search string are listed in a separate pop-up window.

Another option to search requesters will be using the column-wise search option. To perform a column-wise search

1. Click the search icon at the end of the requester list view headers. This opens the search field just below every column that is visible in the list view.
2. Enter the search key in field under the column of your choice.
3. Click **Go**. The search results matching the search string(s) are displayed.

**Requester List View Customization**

To customize the requester list view

1. Click the column edit icon available at the corner of the requester list headers. This opens the available columns that can be displayed in the list view. All those that are visible currently, will have the check box beside them selected.
2. To remove a column, disable the check box beside the column name.
3. To add a column to the list view, enable the check box beside the column name.

4. To change the column order, click the up and down arrow after selecting the column that you wish to move.

5. Click **Save**.

This will add only those columns which you have chosen in the list view. You can also sort the list view based on columns. To sort requester list by column, click the column header. Clicking it once will sort it in ascending order. Clicking twice will sort the column in descending order.
Configuring Technician - Additional Fields

By default, the New Technician form has the required fields, where you can enter important details about an organization. Sometimes, you may need some additional fields in the New Technician form. You can add your own fields using the Technician User Defined Fields configuration.

To add your own custom fields in the new technician form:

1. Log in to the ServiceDesk Plus application with the user name and password of a ServiceDesk Plus administrator.
2. Click the Admin tab in the header pane.
3. In the Users block, click the Technician - Additional Fields icon. The next page is a form, where you can enter the field label and description of the field. You can add three types of fields in the form: text, numeric, and date/time. These three are available in three tabs as shown below:

   - Text
   - Numeric
   - Date/Time

4. To add the text fields, enter the label name in the form fields below the Label heading. If required, enter the description for the field.

5. You can choose the type of text field that you wish to add by selecting the radio buttons. A Single-line text field allows you to add just a text field. The Multi-line text field allows you to...
add a text box where a lengthy description can be added. A Pick List allows you to add a list menu from which you can select. In all the three cases, you can add default values for the text field in the space provided for the same.

6. To add items for the pick list, enter the value in the text field and click **Add Item**. The value will get added to the list below. To select the default selected value of the list, click on the value in the list.

7. To add numeric fields, click the **Numeric** tab and then enter the label name in the form fields provided for the same.

8. To add date/time fields, click the **Date/Time** tab and enter the required details.

9. Click **Save**. A message for successful creation of the fields is displayed.

These fields appear under the grouping **Additional Technician Details** in the **New Technician** form. To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label names that you wish to remove from the fields of the form and click **Save**. The respective fields that you deleted will be removed from the New Technician form.
Configuring Technicians

The IT help desk team will have technicians who will be handling the requests posted/raised by various employees in the organization. You can add, edit, or remove the technicians from a site in the ServiceDesk Plus application and also provide them with various access privileges that suit their role and need.

To open the technician configuration page,

1. Log in to the ServiceDesk Plus application using the user name and password of a ServiceDesk Plus administrator.
2. Click the Admin tab in the header pane.
3. In the Users block, click the Technicians icon. This opens the technicians list view page. Here you can add, edit, or delete technicians.

**Note:** The Site Admin can add and view the technicians of the site to which he/she is associated by selecting the site from the Technicians for combo box. The Technicians for combo box will appear if the sites are configured. The sites can be configured in Admin-Sites.

Add Technician

To add a technician and associate a role with him/her,

1. Click the Add New Technician link available in the top right corner of the Technician List page. This opens the Add Technician form.
2. Enter the Full Name and Employee ID of the technician in the Personal Details block. The name is a mandatory field.
3. In the contact information block, enter a valid e-mail ID and SMS Mail ID of the technician. If the technician has a phone and a mobile number, you can enter the same in the space provided for entering these values.
4. Enter the cost details of the technician in the Cost per hour field.
5. Select the Department Name to which the technician belongs and enter his/her job title.
6. You can associate multiple sites to a technician. Select the sites to which you want to associate the technician from the list of Available Sites and move it to Associate Sites by clicking >> button. Similarly you can also dissociate the sites. You can also associate/dissociate sites from the technicians in the Technicians list page. **Note:** If sites are not associated to the technician, then the technician is associated to "Not in any Site" automatically.
7. You can also assign Groups to the technician. Select the groups from the list of Available Groups and move it Associated Group by clicking >> button.
8. If you have added any organization-specific fields for the new technician form, those will be available under the Additional Technician Details block. Enter the relevant information.
9. If you wish to assign the technician with the privilege to approve service requests, then enable Service Request Approver check box.
10. You can also assign the technician with the privilege to approve Purchase Orders on enabling the check box beside Purchase Order Approver. Set the Approver Limit within which the technician can approve the PO. A link is sent to the technician to accept or reject the PO.
11. To provide login access to the technician with specific access privileges or enable administrative privileges for the technician, enable the check box beside Enable Login for this technician. This displays the Login Details block.

12. Enter the Login Name and Password. Enter the password again in the Re-type Password field. All these fields are mandatory if login is enabled. Also note that the login name needs to be unique.

13. If the technician is associated to a domain then select the same from Domain drop down list.

14. Now you need to assign a role to the technician, which will define his access privileges to various modules in the application.
   - If you want the technician to have complete administrator access then select the radio button, Enable Administrator Privileges. This option will not be available when a Site Admin logs in to the application using his login credentials.
   - If you want the technician to have complete administrator access for the above selected sites then select the radio button, Enable Administrator Privileges for the sites selected above.
   - Else, Enable Custom Privileges radio button and choose the roles from the list of Available Roles and move it to Assigned Roles by clicking >> button. If you want to remove any of the roles assigned, then select the role from the Assigned Role list and click << button. The selected roles will be removed.

15. The API Key is essential while integrating ServiceDesk Plus with REST API or with Desktop Central application. To generate the API Key, click the Generate link. Select a time frame for the key to expire using the calendar icon or simply retain the same key perpetually. If a key is already generated for the technician, a Re-generate link appears.

16. Click Save. If you want to add more than one technician then, click Save and add new button.

If you decide to give the login access for the technician at a later time, you can save the technician details without the login details. For this, you need to stop with the step 5 and click Save. Later you can add the login details by editing the technician details.

At any point, if you decide not to add the new technician, then click Cancel to get back to the technician list. Clicking the View List link on the top right corner of the add technician form will also take you to the technician list view.

**Edit Technician**

If you have added a technician without giving the login details, then you can enable the same by editing the technician's details. To edit a technician information,

1. Select the site of the technician which you wish to delete from the Technicians for combo box. By default, the list of all the technicians is displayed. Click the edit icon beside the technician's full name that you wish to edit. If you have not enabled the login permissions, the edit technician form opens with a view similar to the add technician form. Enable the login permissions as mentioned in the add technician form (starting from step 6 onwards).

2. If the login permissions have been added while adding the technician itself, then the edit technician form will look as shown below,
3. In the above form, you can modify all the fields displayed and also change the roles assigned, by adding or removing roles. (To add new roles, refer to the Configuring Roles section.)

4. Click Save to save the changes performed. At any point, if you wish to cancel the operation that you are performing, click Cancel.

Even while editing a technician, if you wish to add a new technician, then click Save and add new button after making the changes. The Add Technician form opens after displaying a message that the changes have been updated successfully.
You can also change the password of the technician from the Edit Technician form.

1. Click the Reset Password link available beside the Password field in the Edit Technician form.
2. In the Reset Password pop-up, enter the New Password in the field provided below the login name.

3. To send the reset password information to the user, select the check box below the New Password field.
4. Click Reset Password. If you do not wish to change the password, click Close instead of Reset Password.
5. In the Edit Technician form, click Save.

While editing the technician details, you can also choose to remove his/her login permissions.

1. In the Edit Technician form, below the password field, click the Yes link beside the Remove Login field. A confirmation window appears.
2. Click Ok to proceed. A message is displayed informing the removal of the login permissions and the technician edit form is displayed without the login details. If you do not wish to remove the login permission, click Cancel.
3. Click Save.

Associate Technicians to Sites

You can associate bulk technicians to sites using this option. If you have added the technician without associating the sites then the same can be done from the technicians list view page.

1. From the technicians list view page, enable the check box adjacent to the technician for whom you want to associate site.
2. Click Actions button --> Associate to Site option. The Associate Technician(s) to site pop up window appears.
3. Select the Site to which you want to associate the technician from the combo box.
4. Click Associate button. The technician gets associated to the site.

Dissociate Technicians from Sites

You can dissociate bulk technicians from sites using this option. The added sites can also be dissociated from the technician from the technicians list view page.

1. From the technicians list view page, enable the check box adjacent to the technician for whom you want to dissociate/disassociate site.
2. Click Actions button --> Dissociate from Site option. The Dissociate Technician(s) from site pop up window appears.
3. Select the Site from which you want to dissociate the technician from the combo box.
4. Click Dissociate button. A pop up window confirming the operation appears. Click Ok to proceed. The technician gets dissociated from the site.
Note: Dissociating the technicians from a site will remove all their traces from SLA, Business Rules and Groups associated to that site.

Delete Technicians

1. Enable the check box beside the technician which you wish to delete from the Technician List page. Click the delete button. A confirmation dialog is opened.
2. Click OK to proceed with the deletion. If you do not want to delete the technician, then click Cancel.

Note: Delete icon will not be available beside the name of the technician who has currently logged in to the application. To delete that technician, you need to log out and log in as a different technician and then delete the details. Also, the administrator technician details can be deleted only by another technician with administrative privileges.
Configuring Technician Groups

Technician Groups denote the classification of your help desk team, so that the incoming requests are categorized and based on the technicians expertise, the requests are distributed.

By configuring technician groups, multiple support teams can be managed by classifying them into individual groups with e-mail settings for each group. So when an e-mail is sent to a group mail ID, the request is fetched and automatically sent to the group.

Say for instance, you are managing two support groups - hardware and network with the email IDs hardware@domain.com and network@domain.com respectively. The two mail IDs are linked to a single mail account that is fetched by ServiceDesk Plus. So on configuring the group mail IDs, e-mails sent to hardware@domain.com are automatically assigned to the hardware group and the conversation threads possesses the group mail ID in the address field.

Further, you can restrict technicians to view requests in their Group alone. This can be done by creating a Role "All in group & assigned to him" and assigning this role to the technician to restrict his view. Refer Roles to know more.

You can also enable notifications to be sent to the technicians on receiving a new request and if a request is left unpicked. The configured groups are listed in the groups drop-down menu in the New Request form.

To open the Group configuration page

1. Click the Admin tab in the header pane.

2. In the Users block, click the Technician Groups icon. The available technician groups are listed. From this page you can add, edit and delete groups.

Add Group

1. Click the Add New Support Group link available at the right top corner of the Group list page.

2. In the Add Group form, enter the group name in the Name field. This is mandatory field.

3. Select the technicians that you wish to group under this Group from the Available Technicians list box and click >> button to move them to Technicians interested in this Group.

4. You can choose the technicians of the Group to whom you wish to notify for a new request creation in the Group. To do this,
   1. Select the check box Send notification to Group technician(s) when a new request is added to this Group.
   2. Click Choose button. The technicians under the group is listed in a pop-up window.
   3. Select the technicians to notify and click Ok.
5. To choose the technicians to send notification for unpicked requests in the Group,
   1. Select the check box **Send notification to technician(s) when a request in this Group is left unpicked**.
   2. Click **Choose** button. The complete list of technicians available in your help desk appears in a pop-up window.
   3. Select the technicians from the list box and click **OK**. The technicians get listed in the field provided.
   4. Enter the time period, from the creation of the request in Group, after which the notification of unpicked requests will be sent to the selected technicians.

6. If you wish to describe the Group in detail enter the same in the **Description** text box.

7. If you wish to automatically assign the incoming tickets to the group, enter the **Support Group E-mail ID**. Each support group can possess multiple e-mail IDs which should be unique and separated by commas or semi colon.

   **Note:** Please note that the group e-mail IDs should be aliased to a mail account which is fetched by ServiceDesk Plus.

8. Specify the **Sender's Name** and the **Sender's E-mail** in the given text field. The senders name will be specified while sending e-mails.

9. Click **Save**. The new Group is added to the technician group list.

At any point, if you decide not to add the new Group, then click **Cancel** to get back to the Group list. Clicking the View List link on the top right corner of the add Group form will also take you to the Group list view.

```
Note: Enabling the check boxes while adding Group does not ensure that the notification will be sent. This setting is just to choose the technicians to whom the notification needs to be sent and the time frame after which the unpicked request notification is to be sent. To actually send the notification, you need to enable the corresponding setting under the Notification Rules under the Admin tasks, which are:

1. Notify Group technician by mail when request is added to Group.
2. Notify technician by mail when request is unpicked in Group.
```

**Edit Group**

To edit an existing Group

1. In the **Group List** page, click the **edit** icon beside the group name to edit.
2. In the **Edit Group** form, you can modify the name of the Group, the technicians belonging to the Groups, the notification settings, and description.
3. Click **Save** to save the changes. At any point, if you wish to cancel the operation that you are performing, click **Cancel**.

Even while editing a Group, if you wish to add a new Group, then click **Save and add new button** instead of clicking **Save button after making the changes.**
Delete Group

1. In the Group List page, enable the check box beside the group name to delete.

2. Click Delete button. A confirmation dialog appears.

3. Click Ok to proceed with the deletion. If you do not want to delete the Group, then click Cancel.
Configuring User Groups

You can classify all the ServiceDesk Plus end-users (requesters) within your organization into various User Groups. In Site based implementation, categorizing users into groups is especially necessary to prevent users from accessing certain items. The users can be restricted to view certain service items, solutions, announcements and request template.

For instance, the announcement - Nortel network is down for a day due to maintenance in the site New York. This announcement is vital for users in site New York alone. A user group is created such that the announcement is available only to the users associated to site New York. The user group can also be filtered based on Department, Email ID, Job Title and Name.

To access the user group configuration page,
1. Click Admin tab in the header pane to open the configuration page.
2. Click User Groups icon under Users block. The User Group list view page is displayed where you can add, edit and delete a user group.

Adding New User Group
1. Click Add User Group link from the User Group list view page.
2. Specify a unique Name for the user group. Say, Sales Team in New York. This field is mandatory.
3. Enter a short Description about this user group.
4. Set the Filter by selecting the Criteria and Condition from the drop down. Enter the value in the text field.
   You can also perform a search operation for the values using the search icon . A pop up listing the values for the selected criteria appears. Select a value click ok.
5. To view the requesters under the specified criteria, click **Preview** button. The requesters list appears in a pop up window.

6. To add another criteria, click the addition button and repeat the similar process. Choose to match **All the conditions** (And) or **Any one of the condition** (Or) from the drop down.

7. Click **Save** to save the user group and return to the list view. Click **Save and Add New**, to save the user group and add another.

   The configured User Groups appear while creating a new Service Item, solution, announcement and request template.

**Editing User Groups**

1. From the User Groups list view page, click the **edit** icon beside the user group name to edit. The Edit User Group form appears.

2. Modify the Name and Description field.

3. You can also alter the existing filters set or add new filters using the criteria and condition drop down.

4. Click **Save**, to save the user group and return to the list view. Even while editing, you can add another user group by clicking **Save and Add New** button.

**Deleting User Groups**

1. From the User Groups list view page, enable the check box beside the user group to delete.

2. Click **Delete** button. A confirmation dialog appears.

3. Click **Ok** to proceed. The User group is deleted from the list.
Configuring Active Directory Authentication

You can configure to authenticate the requester login with the active directory (AD). On configuring AD authentication, if there are any changes made in the password made in AD, the same is reflected in ServiceDesk Plus. So the requesters can login using the login name and password of the system.

**Note:** Please ensure that before you start configuring the AD Authentication, you have already imported the requesters. Only if a user account is available in ServiceDesk Plus application, it will authenticate the password for that user account from the active directory. Hence, when none of the users have been imported from the active directory, the authentication cannot be done for the user account.

To configure the Active Directory Authentication

1. Log in to the ServiceDesk Plus application using the **user name** and **password** of a ServiceDesk Plus administrator.
2. Click the **Admin** tab in the header pane.
3. In the **Users** block, click the **Active Directory Authentication** icon. Here you can enable or disable active directory authentication. By default the AD authentication will be disabled.
4. If you have already imported requesters from any of the domains in your network, then click **Enable** button.

Even after enabling Active Directory (AD) Authentication, if you would like to bypass the AD Authentication, then in the application login screen, you need to select **Local Authentication** from the Domain list box after entering the login name and password, and then click **Login** button to enter ServiceDesk Plus.

**Configure Pass-through Authentication**

On enabling single sign-on, ServiceDesk plus directly authenticates your windows system user name and password. Hence you need not login over again to enter into ServiceDesk plus or remember too many passwords.

ServiceDesk Plus Pass through Authentication uses NTMLV2 which provides better security and validates the credentials using NETLOGON service.

1. Enabling Active Directory, activates the Pass-through authentication (Single Sign-on) option.
2. If you like to activate single sign-on, select the **Enable Pass-through Authentication (Single Sign-On)** option.
3. You can enable Pass-through authentication for users from a particular domain. To do so, select the **Domain Name** from the drop down list. Enabled domain should be two way trusted.
4. Specify the **DNS Server IP** of the domain in the provided field.
5. To use the NTLM security provider as an authentication service a computer account needs to be created in the Active Directory with a specific password. Specify a unique name for the **Computer Account** and **Password** for this account.
6. The **Bind String** parameter must be a fully qualified DNS domain name or the fully qualified DNS hostname of a particular AD server.
7. **Save** the authentication. You will get a confirmation message on the authentication.

Upon saving the details, a new computer account will be created on the Active Directory (with the help of VB Script). If the user specifies existing computer account name, the password specified here will be reset on the Active Directory for the computer account. User can choose to reset the password of computer account by clicking on the **Reset Password** link as well.
Even if there is a problem creating Computer Account or Resetting Password of already created Computer Account using VB script from SDP server (upon save, the script will be called automatically), the details specified here will be saved and user can execute the script locally on the AD server specifying the same details to create computer account / reset password.

If there is an issue with computer account creation, user can specify an already created computer account name and reset password of that computer account with the help of reset password script.

**Importing Requesters from Active Directory**

If you have not yet imported requesters from any of the domains, you can import them by clicking **Import Requesters from Active Directory** link. The **Import From Active Directory** window pops up.

1. From the list of domains that are listed in the **Domain Name** combo box, select the domain name in which the active directory from which you wish to import is installed. If the other details such as domain controller name, user name, and password have already been entered in the Domain scan page, then that will be populated automatically. Else enter the name of the domain controller in the **Domain Controller Name** field, login name and password in the corresponding fields.

2. You also have an option to select the fields such as Department, Email, Job Title, Site name and so on, to import from the active directory. The field name configured in Active Directory for the selected fields is specified in the corresponding text fields provided. Say, if Phone is configured as Telephone Number in active directory, then enter Telephone Number in the text field provided. The unselected fields will not be imported. This is to avoid over ridding of the new values by the old values from the directory.

3. Click **Import Now !**. The import wizard displays the various **Organizational Units** (OUs) available in that domain. Choose the specific OU from which you wish to import users by selecting the check box beside it.

4. Click **Start Importing**. Once the import is complete, the data on how many records were added, how many overwritten, and how many failed to import will be displayed.

**Schedule AD import**

1. You have an option to schedule Active Directory import in specified number of days.

2. Select the **Schedule AD import** check box. Specify the number of days in the text box. The requester details gets imported automatically once in specified number of days.

Click saveADSync button to be in sync with the active directory.
Configuring LDAP authentication

You can also import users from the LDAP server through the domain controller. On enabling the LDAP authentication, the users can login using their LDAP credentials. By default, the LDAP authentication will be disabled.

**Note:** Ensure that before you start configuring LDAP authentication the users are already imported from the domain. The LDAP authentication supports both Linux and Windows users. On enabling LDAP authentication for Windows users, the AD authentication gets disabled automatically.

To import users from a New Domain,

1. Login to ServiceDesk Plus application using your username and password.
2. Click the **Admin** tab in the header pane.
3. In the **Users** block, click the **LDAP Authentication** icon. By default, the LDAP authentication will be disabled.
4. Click **Add New Domain** button under Domain Controllers block. This opens the Add New Domain Controller form as shown below,

   ![Add New Domain Controller](image)

5. Specify the Domain Controller from where the users have to be imported in the **Domain Controller** text field. For ex: ldap://<server name>:<port number>. The default port is 389.
6. Enter the **User Name** along with the Organizational unit (OU) in the given field. For ex, CN:john, CN=Users, DC=domain name, DC=com.
7. Specify the **Password** in the respective field.
8. Specify the **Base DN** which represents the distinguished base name such as, CN = Users, DC = domain name, DC = com.
9. Specify the criteria which you want to apply on that particular domain controller in the search filter text field. For ex: mail=* will import users from the parameter mail in the specified domain controller.
10. Select the **LDAP Server Type** from the combo box. For ex. OpenLDAP.

   **Note:** If you have chosen the Server type as default LDAP such as, Microsoft Active Directory, Novell eDirectory and OpenLDAP then the Login Attributes Label, Mail Attribute Label and Distinguished Name Attribute Label will appear in a non editable text.

11. If the LDAP Server Type is **Others** then, specify the **Login Attribute Label** and **Mail Attribute Label** in the respective fields.
12. The **Distinguished Name Attribute Label** is similar to the Base DN.
13. Click Save to save the domain controller. If you want to save and import the users, click Save and Import.

You can also import users from the existing domain by clicking Import Now of the corresponding Domain Controllers. The existing data will be over written on importing the users from the same domain. Once the users are imported, Enable LDAP Authentication by selecting the check box. Click Save. The user can login to the application using his LDAP credentials.

**Edit Domain Controller**

1. Click domain controller name which you wish to edit. This opens the Add new domain controller form.
2. Modify the changes and click Save. To save and import the users from the domain controller, click Save and Import.

**Delete Domain Controller**

1. From the domain controller list view page, enable the check box adjacent to the domain controller which you wish to delete.
2. Click Delete button. A pop up window confirming the delete operation appears. Click Ok to continue. The domain controller gets deleted from the list.

On deleting a domain controller, the users imported from that domain controller will not be able to login to the application using LDAP credentials.
Configuring Leave Types

Leave types is the type of leave taken by the technician such as sick leave, casual leave and so on. This is essential while marking leave for the technicians in Scheduler. You can configure the type of leave using Leave Types option. To open the leave type configuring page,

1. Login to ServiceDesk Plus application using your username and password.
2. Click the Admin tab in the header pane.
3. In the Users block, click Leave Types icon. This opens the Leave Types page

Add Leave Type

1. Click New Leave Type link on the right hand side of the leave type list view page. This opens the Add-Leave Type form.
2. Enter the Name of the leave type in the given text field. For ex. Sick Leave, On Duty. The specified name has to be unique. This is mandatory field.
3. Specify brief description about the leave type in the Description text field.
4. Click Save. The leave type gets listed in the list view page. Click Save and Add New to save and add another leave type.

Edit Leave Type

1. From the Leave Types list view page, click the edit icon beside the leave type which you wish to edit. This opens the Update page.
2. Modify the Name and the description field.
3. Click Save. You can also save and add another leave type from Update page by clicking Save and Add New.

Delete Leave Type

1. From the Leave Type List view page, enable the check box adjacent to the leave type which you wish to delete.
2. Click Delete button. A confirmation dialog appears.
Click Ok to continue. The leave type gets deleted from the list.
Robo Technician

Using Robo Technician you can reset the user password quickly & easily. This involves two steps process to reset the user password such as, 1) configure robo task 2) creating a request template.

To open the robo technician page,
1. Log in to the ServiceDesk Plus application using the user name and password of a ServiceDesk Plus administrator.
2. Click the Admin tab in the header pane.
3. In the Users block, click the Robo Technician icon. On purchasing the license for the robo technician the Robo Task Configuration page is displayed.

Configuring Robo Task
1. Click Enable robo task option to perform the robo task operations by clicking the enable icon. By default the status of the robo task would be disabled.
2. There are three blocks available in the configuring robo task page such as, Task Options, Action On Success & Action On Failure. In the Task Options block select Password Reset Type from the combo box. You have four passwords reset types such as,
   - Random Password: In this case the robo technician assigns a random password to the user.
   - Typed Password: In this type the logged in technician will enter the password in the given text field.
   - Same as the User Name: The robo technician will assign the same user name as password.
   - Blank Password: In this type the password assigned will be a blank password.
3. If you wish, you can select User must change password on next login check box. Generally this option should be enabled for security purpose.
4. On resetting the password successfully you can configure the corresponding actions to be performed in the Action On Success block. Select the Request Status you wish from the combo box.
5. Specify the Resolution Details in the text field.
6. If the password-reset action is failed then you can configure the corresponding actions to be performed in the Action On Failure block. To assign the event to the currently logged in user select Assign to Invoker check box.
7. Or you can assign it to the Group under which the problem is associated.
8. And also you can assign the problem to the corresponding Technician.
9. Specify the notes about the issue in the Notes text field.
10. Click Save button to save the details.
11. Click Save and go to Template button to go to the Request Template page.

Creating a Request Template
On installing Robo Technician it automatically creates a default Request Template for a particular Robo Task. You can also edit this request template based on your needs.

Example: Say if a user requests technician for password reset, and if the technician has already configured robo task, then he can create a request to reset password using this default template.
Configuring Technician Auto Assign

Apart from assigning technicians to requests using Business Rule, selection of category or from the UI, technicians can be automatically assigned to requests on configuring the Technician Auto Assign option. The Technician Auto assign follows the Round Robin or Load Balancing methods, and based on the availability of the technicians, the requests are assigned. So if a technician is unavailable on a specific day, and the due by time of certain requests falls on that day, the technician on leave will not be assigned to those requests.

**Note**

For site specific requests, the technicians associated to the sites are auto assigned to the requests. Similar for requests associated to groups, the technicians associated to the groups are assigned to the requests.

To access Technician Auto Assign Configuration,

1. Click on the **Admin** tab in the header pane to open the configurations wizard page.

2. Click **Technician Auto Assign** icon under **Users** block. The Technician Auto Assign page opens.

Enabling Technician Auto Assign

1. Select **Enable Technician Auto Assign** check box.

2. Requests are assigned to the technicians either through **Round Robin** or **Load Balancing** model.

   **Load Balancing:** The number of requests that are In progress and assigned to a technician is taken as the load of the technician. So on selecting this model, technicians with the least load are assigned to requests.

   **Round Robin:** In this model, technicians are assigned to the request irrespective of the load.

3. The tech auto assign is executed for newly created requests, edited requests or, to both created and edited requests. Select your option by enabling the radio button.

4. On creating a new request, the technician auto assign can be applied to either the **Unassigned Requests** or to the assigned/unassigned **Requests**.

   **Unassigned Requests:** On selecting this option, the technician auto assign is applied to requests that are unassigned even after passing through all the Business Rules and Category selections.

   **All Requests:** When this option is selected, the technicians assigned to the requests through business rules or category selection, will be overridden.

**Note**

While editing a request, technician auto assign is applied to requests that remain unassigned even after the application of Business Rules and Category selection. The auto assign is not applied to requests that are assigned to technicians.
Excluding Technicians from auto assign
You can exclude certain technicians from being auto assigned say, the administrator, site admin, change manager.

1. Click **Exclude the following Technician** check box.
2. Click **Add Technicians to exclude** link. The list of technicians available in the application appear.
3. Select the technicians to be excluded by clicking on their Name link. These technicians get listed under **Selected Technicians**. Click **Ok** button. You can delete individual technicians from the Selected Technicians list using the delete icon. Click **Delete All** link to delete all the technicians from the Selected Technician list.

Excluding Requests from auto assign
You can also exclude certain requests from being auto assigned to technicians. Say for example, requests with the priority as "High" should not be auto assigned to technicians.

1. Select **Enable Exceptions** check box.
2. Choose the **Column** from the drop down and its corresponding **Value** using the icon ☐.
3. Choose to match all the exceptions (AND) or any of the exceptions (OR) from the drop down.

**Save** the details.
Problem/Change Management

The goal of Problem Management is to find the root cause of incidents and reduce the impact on business. The goal of Change Management is to control and manage approved changes with accepted risk. ServiceDesk Plus allows you to implement a comprehensive problem management and change management system. Problem/Change related configurations are:

1. Problem Additional Fields
2. Problem Closure Rules
3. Change Type
4. Change Status
5. Change Advisory Board
6. Change Additional Fields
7. Change Closure Rules

To access Problem/Change related configurations:

1. Log in to the ServiceDesk Plus application using the **user name** and **password**.

Click the **Admin** tab in the header pane. The problem/change management block is below the Help Desk block.
Problem Additional Fields

You have pre-defined fields by default in the New Problem form to enter the details about the problem. If you need any additional fields in the New Problem form then, you can add your own additional fields using this option. You can add text, numeric and date/time fields in the form.

To add your own custom fields in the New Problem form:

1. Login to the ServiceDesk Plus application using the user name and password of a ServiceDesk Plus administrator.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Problem - Additional Fields icon. This opens the Problem - Additional Fields page. You can add three types of fields in the form: text, numeric and date/time.
4. To add the text fields, enter the label name in the form fields below the Label heading. If required, enter the description for the field.
5. You can choose the type of text field that you wish to add by selecting the radio buttons.
   - A Single-line text field allows you to add just a text field.
   - The Multi-line text field allows you to add a text box where a lengthy description can be added.
   - A Pick List allows you to add a list menu from which you can select. In all the three cases, you can add default values for the text field in the space provided for the same.
6. To add items for the pick list, enter the value in the text field and click Add Item. To select the default selected value of the list, click on the value in the list.
7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields provided for the same.
8. To add date/time fields, click the Date/Time tab and enter the required details.
9. Click Save. A message for successful creation of the fields is displayed.

These fields appear under the grouping Additional Problem Details in the New Problem form. To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label names that you wish to remove from the fields of the form and click Save. The respective fields that you deleted will be removed from the New Problem form.
Problem Closure Rules

Problem closing rules can be used to select the mandatory fields to be filled in by the technicians while closing the problems and also includes optional rules that can be enabled by the technician on closing the problem.

**Example:** If you have selected ‘Associated Tasks should be closed’ as a mandatory field in this page, then the technician whoever resolving the problem, should close all the related tasks to a problem and enter the details in the corresponding field before closing it. Else an error message pops up, asking you to fill the details in the field. If you have selected the optional rules as, **E-mail all requesters affected by this problem** and **Close all associated incidents**, on closing the problem a pop up window listing the selected optional rules appears. Based on the incident the technician can enable the check box corresponding to the optional rules.

To configure the problem closing rules,

1. Login to the ServiceDesk Plus application using the **user name** and **password**.
2. Click the **Admin** tab in the header pane.
3. In the **Problem/Change Management** block, click the **Problem Closure Rules** icon. This opens the Problem Closure Rules page.
4. Select the **Mandatory Fields** from the list to be filled in before closing the problem by enabling the check box.
5. Select the **Optional Rules** by enabling the check box. The selected rules will get listed to the technician on closing the problem. Based on the incident the technician can,
   - **E-mail technician working on incidents associated with this problem:** An e-mail notification is sent to the concerned technicians working on the incident associated with the problem.
   - **E-mail all requesters affected by this problem:** An e-mail notification is sent to all requesters who have raised requests concerning the problem.
   - **Copy problem solution and workaround to all associated incidents:** The solution to the problem and workaround is copied to all associated incidents.
   - **Close all associated incidents:** All the associated incidents is closed on resolving the problem.

Save the details.
Change Type

The change types show the significant changes in the organization which involves cost and time. By default, you have four change types and Standard is a pre-defined change type hence cannot be edited. And the Standard Change type is a pre-approved change type which will not require approval from the change manager.

To access the Change Type configuration wizard,

1. Login to the ServiceDesk Plus application using the **user name** and **password**.
2. Click the **Admin** tab in the header pane.
3. In the **Problem/Change Management** block, click the **Change Types** icon. This opens the **Change Type list** page.

Adding Change Type

1. Click on the **New Change Type** link. This opens the **Add New** page.
2. Specify the **Name** for the change Type in the given text field, say **Significant**. This is a mandatory field.
3. Select the **Colour** by clicking the colour icon to indicate the severity of the change. This is a mandatory field.
4. Specify the **Description** about the change type in the description field.
5. **Save** the changes. You can see the change type getting listed in the change type list view.
6. **Click the Save and add new** button to save the Change Type and add another Change Type.

Editing Change Type

To edit an change type,

1. In the Change Type list page, click the edit icon beside the change type name that you wish to edit.
2. In the **Edit Change Type** form, edit the fields you want to change.
3. Click **Save** to save the changes. At any point, if you wish to cancel the operation that you are performing, click **Cancel**.

Even while editing a change type, if you wish to add a new change type, then click **Save and add new** button instead of clicking Save button after making the changes.

Delete Change Type

1. From the Change Type list page, enable the check box beside the change type name that you wish to delete.
2. **Click Delete** button. A confirmation dialog appears.

Click **OK** to proceed with the deletion. The change type gets deleted from the available list. If you do not wish to delete the change type, then click **Cancel**.
Change Status

Change Status shows the current state of the change in the organization. You have a list of default change status. Rejected is a pre-defined change status hence cannot be deleted.

To access the Change Status configuration wizard,

1. Login to the ServiceDesk Plus application using the user name and password.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Change Status icon. This opens the Status List page.

Adding New Change Status

1. Click on the New Status link on the right hand side of the page. This opens the Add Status page.
2. Specify the Name of the status in the given text field.
3. Specify the Description about the status in the given text field.
4. Save the changes. You can see the new status getting listed in the status list page.
5. Click the Save and add new button to save the Change Status and add another Change Status.

Editing Change Status

To edit an change status,

1. In the Change Status list page, click the edit icon beside the change status name that you wish to edit.
2. In the Edit Change Status form, edit the fields you want to change.
3. Click Save to save the changes. At any point, if you wish to cancel the operation that you are performing, click Cancel.

Even while editing a change status, if you wish to add a new change status, then click Save and add new button instead of clicking Save button after making the changes.

Delete Change Status

1. From the Change Status list page, enable the check box beside the change status name that you wish to delete.
2. Click Delete button. A confirmation dialog appears.

Click OK to proceed with the deletion. The change status gets deleted from the available list. If you do not wish to delete the change status, then click Cancel.
Change Advisory Board

The Change Advisory Board (CAB) is a body that exists to approve changes and to assist Change Management in the assessment and prioritise of changes. The members of the CAB are selected based on their expertise and capability to assess change adequately from business and technical point of view.

To add new a CAB,

1. Login to the ServiceDesk Plus application using the user name and password.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Change Advisory Board icon. The Change Advisory Board (CAB) page opens.
4. Click New CAB button to open the Add CAB page.
5. Specify the Name of the CAB in the given text field. It is a mandatory field.
6. Specify the Description of the CAB in the description field.
7. Click Add CAB Member icon to select the members for the CAB. The list of users appears in a pop up window. If the list is vast, select the number of users to be listed in a page from Show page drop down box. You can navigate to the next and previous pages using the navigation options.
8. Select the members of the CAB from the users list by enabling the check box beside their name and clicking Add CAB Member button. Click Add CAB Member and close, to add a CAB Member and close the pop up window.
9. The selected Members in this CAB are listed in the Add CAB page. You can delete a CAB Member on selecting the delete icon beside their name.

Click Save to save the CAB details and return to the list view. Click Save and Add New button to save the CAB and add another CAB.
Change Additional Fields

You have pre-defined fields by default in the New Change form to enter the change details in the form. If you need any additional fields in the New Change form then, you can add your own additional fields using this option. You can add text, numeric and date/time fields in the form.

To add change additional fields,

1. Login to the ServiceDesk Plus application using the user name and password.
2. Click the Admin tab in the header pane.
3. In the Problem/Change Management block, click the Change Additional Fields icon. This opens the Change Additional Fields page. You can add three types of fields in the form: text, numeric and date/time.
4. To add the text fields, enter the label name in the form fields below the Label heading. If required, enter the description for the field.
5. You can choose the type of text field to add by selecting the radio buttons.
   - A Single-line text field allows you to add just a text field.
   - The Multi-line text field allows you to add a text box where a lengthy description can be added.
   - A Pick List allows you to add a list menu from which you can select. In all the three cases, you can add default values for the text field in the space provided for the same.
6. To add items for the pick list, enter the value in the text filed and click Add Item. To select the default selected value of the list, click on the value in the list.
7. To add numeric fields, click the Numeric tab and then enter the label name in the form fields provided for the same.
8. To add date/time fields, click the Date/Time tab and enter the required details.
9. Click Save. A message for successful creation of the fields is displayed.

These fields appear under the grouping Additional Change Details in the New Change form. To delete the user-defined fields, in step 4 through 7, instead of adding the label names, delete the label names that you wish to remove from the fields of the form and click Save. The respective fields that you deleted will be removed from the New Change form.
Change Closure Rules

Change closing rules can be used to select the mandatory fields to be filled in by the technicians before closing the changes.

**Example:** If you have selected **Impact** as a mandatory field, then the technician whoever doing the change, should enter all the impact details of the change before closing it. Else an error message pops up, asking you to enter the details of the impact in the corresponding field.

To select the mandatory fields,

1. Login to the ServiceDesk Plus application using the **user name** and **password**.
2. Click the **Admin** tab in the header pane.
3. In the **Problem/Change Management** block, click the **Change Closure Rules** icon. This opens the Change Closure Rules page.
4. Select the mandatory fields for closing the change from the list by enabling the check box.

Save the details.
Discovery - Scanning Workstations and Other Network Devices

With ServiceDesk Plus you can scan all your windows domain, networks part of your enterprise, Linux, MAC, Solaris, AIX machines and IP based IT assets. Also, you can set up audits for scheduling periodic scanning and regular cleanup, scan assets in remote locations and perform individual scan for newly added workstations.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Please note that, only <strong>technicians with administrator privilege</strong> can perform and configure a Scan.</td>
</tr>
<tr>
<td>2. ServiceDesk Plus currently supports scanning for the following OS - <strong>Linux, Solaris, MAC, IBM-AIX</strong> and IP devices - <strong>Printers, Routers, Switches and Access Points</strong>.</td>
</tr>
</tbody>
</table>

Scanning Mechanisms

- **Windows Domain Scan**  
  Scans all the **Windows Workstations and Servers** that are,  
  a. part of **Windows domain**  
  b. scanned using **Active Directory**, and  
  c. part of **Windows workgroup**  
  You can also scan workstations using an Agent or Agentless mode (scans machines using WMI).

- **Network Scan**  
  Scan workstations and devices that are part of your network range. Network Scan supports,  
  a. OS workstations like, **Linux, MAC, Solaris, IBM-AIX** machines  
  b. **Windows workgroup** (workstations that are not part of any domain controller).  
  c. IP devices like **Printer, Router, Switches and Access Points**.

- **Schedule Scan**  
  Schedule scan at periodic intervals to scan domains and networks that are part of your enterprise. Also, you can set re-scanning intervals to discover newly added workstations.

- **Stand Alone Workstation Audit**  
  Scan remotely located **Windows Workstations and Servers** using scripts.

- **Workstations/Device Scan**  
  Use this option to scan an individual or newly added machines in your network. Machines like **Windows, Linux, Solaris, IBM-AIX, MAC** and IP devices like **Printers, Routers, Switches and Access Points** are currently supported.

Distributed Asset Scan  
For all your remotely located workstations that cannot be accessed by the Central AE server, a Remote AE server is installed in each location which scans the workstation information, and pushes the data to the Central AE Server either manually or automatically.
Scanning Windows Machine

ServiceDesk Plus provides you various options to scan your Windows machines. You can scan machines that are part of a domain, network, workgroup and even schedule to scan the windows machines. Apart from this, you can scan remotely located Windows machines and workstations that are manually entered in the application.

Scanning Mechanisms
- Types of Scan
- Modes of Scan

Types of Scan
The list below shows the different methods through which a Windows machine can be scanned:-
- Windows Domain Scan
  Scans all the Windows Workstations and Servers that are,
  a. part of Windows domain
  b. scanned using Active Directory, and
  c. part of Windows workgroup
  By default, when you start the application for the first time, the Windows domain in the network are automatically discovered.
- Network Scan Windows workstation that are part of a network can be scanned using the Network Scan. The communication protocol and login credentials for windows workstations are given below,
  a. Communication Protocol: WMI or Agent
  b. Login Credentials: Credentials of the domain controller
- Standalone Workstation Audit The Windows workstations/servers that are not part of a domain or network are scanned using Standalone Workstation Audit. The remote workstations are scanned using a script and the inventory details are pushed to the AE Server.
- Workstation/Device Scan Scan your newly added windows machines by specifying the workstation/device credentials.

Modes of Scan
- Agent Mode Agent based scanning involves an agent to be deployed in Windows workstations through Active Directory or Windows Domain Scan, deployed manually or from the ServiceDesk Plus Application. The Agent mode is easy to deploy, more secure and provides easy access for remote control.
- Agentless Mode Agentless mode uses a built-in agent such as Windows Management Instrumentation (WMI) installed in each Windows machines. The ServiceDesk Plus server should be installed in a Windows machine to scan Windows workstations and servers.
Modes of Scan: Agent and Agentless

With the evolution of network discovery solutions in recent times, two technologies have emerged into existence - Agent and Agent-less mode of scan. While Agent-less scans inventories using WMI (Windows Management Instrumentation) and does not involve any client side software installed in the host, the Agent is an instance of a software, installed in the host to scan inventories and access them remotely.

ManageEngine ServiceDesk Plus supports both, Agentless and Agent modes to scan all your Windows workstation and servers.

This section will cover the following topics:-

- Agent Mode
  - Methods of Deployment
  - Uninstalling Agent
- Agentless Mode
Agent Mode

For a wide spread organization with a complex network infrastructure, the Agent based scanning is most effective and provides easy deployment, more security and low bandwidth.

The application provides an agent, which can be deployed in the network workstations through various methods. [Refer Methods to deploy agent]. Once the agent is deployed in the network workstations, it scans all the workstations and provides easy access for remote assistance.

The following topics are discussed in this section:-
- Delta Scan
- Agent Settings
- Agent Configuration in ServiceDesk Plus application
- Pros and Cons of Agent mode

Delta Scan

While performing a scan (Domain scan or Scheduling a scan) through Agent or Agentless mode, some amount of data is obtained in the ServiceDesk Plus Server. The data obtained in the AE Server through an Agent scan is comparatively minimal to that of Agentless. The agent transfers only the changes ("delta") that occur between two subsequent scans to the server, and automatically strips out any unchanged data, thus reducing the data transfer to 1 - 2kb instead of the usual 20 - 30kb.

Note
1. Windows is the only Supported Platform for Agent.
2. The Ports used in Agent based Scanning are TCP 9000.

Agent Settings

Choose to scan all your Windows workstations in both, Agent and Agentless mode by selecting the corresponding option from Agent Settings under the Admin tab. If you have enabled Agentless mode, the Windows workstation and servers are scanned using WMI. If you have enabled both the modes, the agent based scanning is performed and if that fails, the agentless scanning is performed.
Agent Configurations

For a successful scan, the agent should communicate with the ServiceDesk Plus server. The server details are configured under Agent Configurations. By default, the server in which the application is installed is populated as the server details.

You can modify these configurations to create your own Agent Configurations.

- **Server Name**: The server name or IP address of the computer where ServiceDesk Plus is installed. The agent residing in the client computers communicates with the ServiceDesk Plus server using this Server Name/IP address.
- **Server Port**: The port configured for the application.
- **Protocol**: The protocol used to communicate with the server.
- **Agent Port**: The port number of the agent.
- **Scan at System Startup**: On enabling this option, the agent scans the workstation on every startup.

Click Create New Agent button. Clicking on Cancel takes you to the agent settings page.

Installing Agent in Windows Workgroup

The Agent is installed in Windows Workgroup using psexec utility. The example to execute the command is given below,

```
psexec.exe \<machine name> -u <username> \<domain> -p <password> msiexec /i \"\sdp-winxp\shared\New Folder\ManageEngineServiceDesk PlusAgent_sdp-win2k3.msi\"
```

**Note:**

1. You can download the PsExec software from here.
2. You can also modify the configurations to create your own Agent Configurations.
3. If the agent is installed in all the Windows machines and if any of the below circumstances occurs, the agent details can be updated using a script.
   a. ServiceDesk Plus application is moved from one server to another or if the AE port or protocol (http or https) has been changed.
   b. If agent port needs to be changed in all the machines or enable/disable scanning on system startup.

This script can be run as a logon script in the Active Directory or manually in each machine to update the configurations in the agent. While executing the script, the parameters should be in the format "-servername <AE server name> -port <AE port> -protocol <http or https >".

Please contact our support team for the script.

Pros and Cons of Agent Mode

Agent based scan Pros:
1. Only one port is required during scan, which can be configured under Admin -> Agent settings -> Agent Configuration -> Agent Port.
2. Performs scan on system boot up and pushes the data to AE application.
3. The data transfer in agent scan is very minimal compared to agentless scan and even more less when compared to delta scan (difference in data between two subsequent scans is fetched).
4. Quick access to the remote machine on performing Remote Control.
5. Easy to deploy agent through active directory.
6. Dependencies over DCOM and RPC settings are eliminated.
7. Once the agent is installed in all the machines, you can scan those machine from linux server.

Agent based scan Cons:
Agent should be upgraded if the version is changed. This can be performed from the Active Directory.
Methods of Agent Deployment

If you have enabled Agent Mode, you can deploy the agent in the Windows machine through any of the methods given below,

- Active Directory
- AssetExplorer Application
- Manual Installation

Import from Active Directory logon script

An instant method to push the agent in all the Windows machine within a domain is through Active Directory logon script. Instead of providing permission to all the scanned workstations for file transfer, the agent is installed once the user logs into the machine. In addition, the agent can be deployed to all the newly added workstations automatically on scheduling an AD Import.

To install the agent from Active Directory,

1. Create a network share like, MyServer\MyShare
2. Click Download Agent and run the agent.msi file.
3. Save the agent and the script in the network share.
5. In the console tree, right click on your domain, and select Properties.

7. Right click on the name of domain or the Organizational unit for which you would like to configure the script. Click Create and Link a GPO Here... option.
8. Type a name for the new GPO say, AGENT DOWNLOAD and click Ok. The GPO is added to the existing list.

9. Right click on the newly created GPO and click on Edit option.

10. In the new window go to the User Configuration -> Windows settings -> scripts -> double click Logon.

11. In the new Logon Properties window click on Add. Now Browse and select the script "\MyServer\MyShare\InstallAgent.vbs". The script should be accessible by the target workstations.

12. Specify the Script parameters as msi file name with path (eg. \MyServer\MyShare\ManageEngineAssetExplorerAgent.msi) and click Ok.

13. Close the Group Policy Window and click Ok.
15. When the client computer starts the agent is automatically installed.

**Note**

1. The agent can be deployed to all the Windows Workstations and Servers within the domain.
2. The agent is deployed when the user logs into the machine.

**Deploying the Agent from AssetExplorer Application**

Apart from Active Directory which involves deployment of agent in workstations of a particular domain, you can deploy agents in workstations that are part of a network group or workgroup from the AssetExplorer application. You can choose to deploy the agent as a bulk or in individual machines.

**Configurations essential to deploy the agent from the AE application**

1. Scan the workstations using the Scanning Prerequisites.
2. After a successful scan, enable "File and Printer share" on executing the command (given below) in the command prompt of the workstation to install the agent.

```plaintext
netsh firewall set service FILEANDPRINT
```

**a. Bulk Deployment of Agent**

1. From the Workstation Configuration page, click on Agent Details link. The workstations for which the agent is not installed is listed.
2. Select the check box beside the workstations for which the agent should be installed.
3. Click Install Now. The agent is installed in the selected workstations.

**b. Upgrading the Agent**

In certain cases, the agent installed in the workstation may be of an older version. You can upgrade to the latest agent version from the AE application,

1. Select Agent with older version from the Filter drop down.
2. Select the check box beside the workstations for which the agent should be upgraded.
3. Click Upgrade.

**c. Installing Agent in Individual machine**

In credentials for Agent Installation page,

- **Name/IP**: Enter the workstation name or the IP address of the workstation for which the agent should be installed.
• **Login Credentials**: Select the login credentials as either Global or Local. Global credentials are common login permissions for all the assets. Local credentials are private login permissions for an asset.

• If you have enabled **Local Credentials**, specify the login credentials to your machine.

If you have enabled **Global Credentials**

• **Scan Type**: Specify the scan type as Domain mode/Network mode under which the workstation is configured.

• **Domain Name**: Select the Domain name/network under which the workstation is configured.

• **Login Name & Password**: Specify the domain credentials.

**Manually Installing the Agent**

Once the Agent configurations is accomplished, you can download and Install the agent as a service.

1. Click on **Download Agent** button.


3. Click **Next >**.

4. Choose the **Installation folder** name under which the Agent needs to be installed. By default, the folder name is specified as **C:\ManageEngine\AssetExplorer** directory.

![Select Installation Folder](image)

If you want to change the installation directory, then, click the **Browse** button beside the directory path. From the file chooser window, choose the directory of your choice and click **Ok**.

**ZOHO Corp.**

435
5. You can choose to install the agent for yourself or for everyone who uses the computer with the application. Select the corresponding radio button. Click **Next >**.

6. The next step is **Agent Configurations**, if you have not yet configured the agent, you can specify the server details and agent settings. Click **Next >**.

You also have an option to enable scan whenever the **system starts up**. Click **Next** to install the agent.
**Un-installing the Agent**

You can manually un-install the agent from Add/Remove Programs or from the ServiceDesk Plus application. If you are unable to un-install the agent from the Control Panel then follow the steps below,

1. Click on **Workstations** link from the Resources block.
2. From the Workstation list view page, click on **Agent Details** link. By default, the workstations for which the agent is not installed is listed.
3. Select the options either **Agent with older version** or **Agent installed Workstations** from the **Filter** drop down.
4. Select the check box beside the workstations to un-install the agent.

Click **Un-install** button. The agent is removed from the selected workstations.
Agent-less Mode

As the name suggests, the Agent-less mode does not involve any client side software installed in the host. Instead, the agent-less mode uses a built-in agent such as WMI (Windows Management Instrumentation) installed in each Windows machines to scan the inventory details and to access the workstation remotely.

The accessibility of the data using WMI is controlled by the RPC and DCOM settings which should be configured in the workstations. Click here to configure the settings.

The agent-less mode is most appropriate for small organization where the network is less complex and does not involve installing, upgrading and maintaining an additional software program on each machine.

Credentials for Scans

Note: Please note that the agent-less supports only 'Windows' platform.

<table>
<thead>
<tr>
<th>Communication Protocol</th>
<th>Login Credentials</th>
</tr>
</thead>
<tbody>
<tr>
<td>WMI  (Supports only Windows platform)</td>
<td>Credentials of Domain Controller</td>
</tr>
</tbody>
</table>

Pros and Cons of Agent-less mode

Agent-less scan pros:
1. Does not involve an agent to be installed, upgraded and maintained in each workstation.

Agent-less scan cons:
1. The DCOM and RPC settings should be configured.
2. More number of ports used when compared with agent mode.

ServiceDesk Plus server should be installed in a Windows machine to scan windows workstations/servers.
Scanning Linux, Solaris, MAC and AIX machines

Apart from scanning Windows machines, ServiceDesk Plus scans workstations/servers of other Operating Systems such as Linux, Solaris, MAC and IBM-AIX.

There are two methods through which these machines can be scanned in ServiceDesk Plus application,

- Network Scan - Scan workstations/servers that are part of your network.
- Workstation/Device Scan - Scan your newly added machines by specifying the workstation credentials.

Ports and Credentials to perform scan for these machines are,

<table>
<thead>
<tr>
<th>Communication Protocol</th>
<th>Login Credentials</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telnet</td>
<td>Telnet Credentials</td>
</tr>
<tr>
<td>SSH (Secure Shell)</td>
<td>SSH Credentials</td>
</tr>
</tbody>
</table>

Click here to know more on ports used for scan.
Scanning Printers, Routers, Switches and Access Points

ServiceDesk Plus currently supports the scanning of IP devices namely, Printers, Routers, Switches and Access Points.

There are two methods through which these devices can be scanned in the application,

- **Network Scan** - Scans devices that are part of your network.
- **Workstation/Device Scan** - Scan your newly added devices by specifying the their credentials.

**Note**: Please note that ServiceDesk Plus does not scan other IP devices like Firewall, Hubs, IP Telephones and so on.

Ports and Credentials to perform device scan

<table>
<thead>
<tr>
<th>Communication Protocol</th>
<th>Login Credentials</th>
<th>Port</th>
<th>Service Performed</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNMP (Simple Network Management Protocol)</td>
<td>SNMP Credentials</td>
<td>161</td>
<td>Fetches and Identifies the IP devices.</td>
</tr>
<tr>
<td>SSH (Secure Shell)</td>
<td>SSH Credentials</td>
<td>22</td>
<td>Fetches additional information on Routers and Switches.</td>
</tr>
</tbody>
</table>

Click here to know more on ports used for scan.
Windows Domain Scan

You can configure and scan all the available Windows Workstations and Servers in your domain network using ManageEngine ServiceDesk Plus. When you set up the ServiceDesk Plus application and start it for the first time, the application automatically discovers all the available Windows domain in your network.

To discover workstations in a domain,
- Select a Domain and enter the domain controller and login credentials for the domain controller.
- Select the Organizational Units (OUs) from the list.
- The workstations in the OUs are retrieved, enumerated and scanned (ten workstations are scanned simultaneously)
- The machines in the specified domain then is Pinged.
- If the machine responds to the ping, scan the inventories (hardware/software information) in the machine using Agent or Agentless mode.

The Windows Domain Scan page can be access in two ways,
- Quick Actions drop down
- Admin Tab

Quick Actions drop down
The Quick Actions drop down is a quick navigator to instantly access the Domain List page.

Admin Tab
1. Click Admin tab in the header pane to open the configuration wizard page.
2. Click Windows Domain Scan icon under Discovery. The Domain list view page opens where you can add, edit, delete and scan a domain.

Add a New Domain
If you find that there are some domains that are missing in the list, then you can add those domains manually.
1. Click on Add New Domain link.
2. Enter the Domain Name. The name should be unique to identify the domain and is a mandatory field. Say, Acme.
3. If you want the domains to be displayed in the login screen when Active directory Authentication is enabled, select the check box beside Public Domain. Else un-check the Public Domain check box to list the domain as Private Domain.
4. Enter the Domain Controller name for the Active Directory Server. The organizational units are listed only if the domain controller name is provided.
5. Specify the Login Credentials for the domain controller in Username and Password fields.
6. If you wish to add any description for the domain, enter it in the Description text box.
7. Click Save. The domain is listed in the domain list view page.
Click **Save and Scan now** button to save and scan the domain immediately. Clicking on **Cancel** button takes you back to the list view.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>For the workstation scan to execute successfully the following things need to be true:</td>
</tr>
<tr>
<td>a. WMI should be enabled in the workstation where the Asset Explorer server is running.</td>
</tr>
<tr>
<td>b. COM/DCOM service should be switched on in all the workstations belonging to the</td>
</tr>
<tr>
<td>windows domain.</td>
</tr>
</tbody>
</table>

**Scanning a Domain**

1. Click **Scan Domain** icon of the domain to be scanned from the Domain list view page.
2. Choose the **Organizational Units** for which you want to import the workstations by enabling the check box.
3. Select the **Site** to associate the scanned workstations from the **Choose Site** option. This option is available only if the sites is specified
4. Click **Start Scanning** button to start the scanning process.

You will get the complete report of the scan listing the total number of scanned workstations, successful scanned workstations and the number of failed workstation list.

**Editing a Domain**

1. Click on the **Edit** icon beside the **Domain Name** you wish to edit.
2. In the **Edit Domain** form, you can modify the name of the domain, login name, password, and description of the domain.
3. Click **Save** to save the changes performed. Click **Save and Scan now** button to save and scan the domain immediately. At any point, if you wish to cancel the operation that you are performing, click **Cancel**.

**Deleting a Domain**

1. Click the **Delete** icon beside the **Domain Name** you wish to delete. A confirmation dialog is opened. Click **OK** to proceed with the deletion. The domain gets deleted from the list. If you do not wish to delete the domain, then click **Cancel**.
Network Scan

With Network Scan you can discover all the Linux, Solaris, MAC, IBM-AIX machines and devices such as Printers, Routers, Switches and Access Points that are part of your network. In addition, you can also scan Windows machines and Workgroup (Windows machines that are not part of a domain).

To discover workstations in a network,

- Enter the **Network Range** to scan.
- The workstations and devices in the network are retrieved, enumerated and scanned (ten workstations are scanned simultaneously)
- The machines in the specified range is **Pinged**.
- If the machine responds to the ping, **scan the inventories** (hardware/software information) in the machine. Use **SSH or Telnet** for Linux, Solaris, MAC, IBM-AIX machines, **SNMP** for Printers, Routers, Switches and Access Points, **WMI** for windows machines.

The Network Scan page can be accessed by two ways in ServiceDesk Plus application,

a. Quick Actions drop down
b. Admin Tab

**Quick Actions drop down**

The Quick Actions drop down is a quick navigator to instantly access the Network Scan page. From the Quick Actions drop down select **Network Scan** option.

**Admin Tab**

1. Click the **Admin** tab in the header pane to open the configuration wizard page.

2. Click **Network Scan** icon under Discovery block. The Network list view page opens where you can add, edit, delete and scan a network.

**Ports and Credentials to scan machines using Network Scan**

- Linux, MAC, Solaris, IBM-AIX
  - **Communication Protocol**: Telnet or SSH
  - **Login Credentials**: Telnet Credentials
  - **Port for Telnet**: 23
  - **Port for SSH**: 22
- Printers, Routers, Switches, Access Points
  - **Communication Protocol**: SNMP + SSH (devices are identified and fetched using SNMP. If SSH credentials is provided, additional information on routers and switches can be fetched)
  - **Port for SNMP**: 161
  - **Port for SSH**: 22
- Windows Machines
  - **Communication Protocol**: WMI or Agent
  - **Login Credentials**: Credentials of the domain controller
Add New Network
Linux, MAC, Solaris, IBM-AIX

1. Click Add New Network link.
2. Enter the Network Address. You can either scan the Entire Network say, all workstations under 192.168.27.0 or particular Range of Network say 192.168.27.0 to 192.168.27.30 by clicking the corresponding options.
3. Select the Protocol say, SSH or Telnet.
4. If license softwares are installed in Linux and Solaris machines, enable Scan Softwares in Linux and Solaris workstations check box.
5. If you have enabled SSH, enter the SSH login credentials. If you have enabled Telnet, enter Telnet Credentials in the Login Name and Password fields.
6. Provide any relevant information pertaining to the network details in the Description field.
7. Click Save. Click Save and Scan now, to save and scan the workstations in the specified range.

Printers, Routers, Switches and Access Points

1. Click Add New Network link.
2. Enter the Network Address. You can either scan the Entire Network say, all workstations under 192.168.27.0 or particular Range of Network say 192.168.27.0 to 192.168.27.30 by clicking the corresponding options.
3. If the Protocol is SSH, enable the corresponding radio button.
4. If SSH is enabled, enter the SSH Login Credentials which provides additional information on routers and switches.
5. For SNMP discovery of network devices enter the Community String. SNMP is used for identification of printers, routers, switches and access points. In case of printers the complete inventory is being fetched using SNMP. In case of routers and switches basic inventory is being fetched using SNMP and a more detailed inventory is done using SSH or telnet (if credentials are provided).
6. Provide any relevant information pertaining to the network details in the Description field.
7. Click Save. Click Save and Scan now, to save and scan the devices in the specified range.
Windows Machine

1. Click **Add New Network** link.
2. Enter the **Network Address**. You can either scan the **Entire Network** say, all workstations under 192.168.27.0 or particular **Range of Network** say 192.168.27.0 to 192.168.27.30 by clicking the corresponding options.
3. Enter the **Login Credentials** of the domain controller in the **Login Name** and **Password** fields. The login Name should be provided as <DOMAIN_NAME>/<USER_NAME>. For instance, ACME/administrator
4. Provide any relevant information pertaining to the network details in the **Description** field.
5. Click **Save**. Click **Save and Scan now**, to save and scan the workstations in the specified range.

Scan Domain

1. From the Network List View page, click **Scan Network** icon.
2. If your organization is distributed across various sites, select the **Site** to which the workstations/devices are associated.
3. Click **Start Scanning**. Once scanned, you will get the complete report on the success and failed workstations of the scan.

Edit Network

1. From the Network List View page, click the **Edit** icon of the network to be edited.
2. Edit the network details and **Save** the changes. Click **Save and Scan now**, to save and scan the workstations in the specified range

Delete Network

1. From the Network List View page, click the **Delete** icon beside the network to delete.
A confirmation message on the delete operation appears. Click **Ok** to continue. The network is deleted from the list.
Workstation/Device Scan

If a new workstation/device is added in your network, and you wish to scan only the newly added workstation instead of the entire network, you can specify the workstation/device credentials and scan.

You can scan workstations/devices using Global Credentials or Local Credentials. Global Credentials are common login permission for all assets which can be scanned with Domain mode or Network Mode. Local credentials are private login permissions i.e., login permission to the workstation/device to be scanned.

Note

Local Credentials are generally selected for scanning devices such as servers and routers which needs private or local user name and password.

The Workstation/Device Scan can be accessed by two ways in ServiceDesk Plus application,

a. Quick Actions drop down

b. Asset Tab

Quick Actions drop down

Click Quick Actions drop down -> Workstation/Device Scan option. The Quick Actions drop down is a quick navigator to instantly the Scan configuration page.

Asset Tab

1. From the Resource block, click any one of the IT Assets.
2. Click New Scan button to open the Scan Configuration page.
3. Specify the Name or IP address of the workstation to be scanned. This field is mandatory as the workstation in the network is identified with the Name or IP address.
4. Select any one of the credentials by enabling the radio button.

Global Credentials

1. Select the Scan Type from the drop down. The scan type can be either Domain Mode (if the workstation is Windows) or Network Mode.
2. Choose the Domain Name/Network from the drop down. If the domain/network is unavailable in the list, you can add a new domain/network using the Add New link. [Refer Network Scan to add a new network].
3. Specify the Login Credentials for the Domain/Network in the Login name and Password field.
4. If you have selected Network Mode to scan a device, enter the Community String of the device in the field provided.
5. Click Scan. The workstation/device is scanned and the information is obtained.

Local Credentials

1. Specify the Login Credentials for the workstation/device in the Login Name and Password field.
2. Select the communication **Protocol** as SSH or Telnet for workstations like Linux, Solaris, MAC, AIX and devices such as router, switches, access points and printers.

3. If license softwares are installed in Linux and Solaris machines enable **Scan softwares in Linux and Solaris workstations** check box.

Click **Scan**.
Standalone Workstation Audit

All Windows workstations/servers that are not part of a domain/network are scanned using Standalone Workstation Audit. The remote workstations are scanned using a script and the inventory details are pushed to the AE Server. The script can also be configured as Logon/Startup script in the Domain Controller.

<table>
<thead>
<tr>
<th>Scanning remote workstations involves two simple steps,</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Download the <strong>ae_scan.vbs</strong> script from ServiceDesk Plus application and execute the script in the workstation to be scanned.</td>
</tr>
<tr>
<td>2. On executing the script a XML file is generated. Import the XML file into the ServiceDesk Plus application. You can see the standalone workstation details in the list view.</td>
</tr>
</tbody>
</table>

The standalone Workstation Audit can be accessed by two ways in the application,

a. Quick Actions drop down

b. Admin tab

**Quick Actions drop down**

Click Quick Actions drop down -> **Standalone Workstation Audit** option. The Quick Actions drop down is a quick navigator to instantly the Scanning Windows Workstation through WMI Script page.

**Admin Tab**

1. Click **Admin** tab in the header pane to open the configuration wizard page.

2. Click **Stand Alone Workstation Audit** icon under **Discovery** block.

3. Click the **Click to Download** option to download the **ae_scan.vbs** script. Save the file.

4. Open the command prompt. Change the directory to folder where the script is saved and execute the following script. **CSCRIPT ae_scan.vbs**

5. On executing the script, a XML file is generated in the same folder.

6. Import the XML file to the application and **Submit** it.
Scanning Windows Workstations through WMI Script:

 Executing the below script in remote workstation will scan the workstation and push the inventory details to AssetExplorer server. The script can also be configured as Logon/Startup script in Domain Controller.

 Standalone workstation audit:

 Upon executing the script, an xml file (C:<workstationname>_umiddata.xml) with scanned data will be generated in the same folder. In case the server cannot be reached from the remote workstation, the generated xml file has to be copied to the server using a USB drive, floppy disk etc for importing the data. Click here to import.

 Locate XML File: C:\heather\india\advnet.com\xml

 Steps for executing the script:

 1. Click on the Download link below and save the target link as "ae_scan.vbs".

 2. Open a command prompt. Move to the folder where the script file is saved and execute the command as shown below:

    CSCRIPT ae_scan.vbs

 3. Executing the script will push the data to AssetExplorer Server. If server is not reachable from the remote workstation, the generated xml file can be imported from here.

On importing the XML file, the standalone workstation is scanned and gets listed in the Workstation list view page.
Ports used during Scan

The various ports used during the scan and remote control is illustrated with the help of a diagram below.

**Ports used during Scan & Remote Control**

- **Port(s) used to fetch the computers list during domain scan and users list from Active Directory**: TCP / 389
- **Ports used to scan windows machine in agent less mode using WMI**: TCP/135,445,5000,5001,5002
- **Ports used for agent installation**: TCP/135,445,5000,5001,5002
- **Ports used to scan windows machine in agent mode**: Agent port (default:TCP/9999)
- **Ports used for Remote Control**: Agent port (default:TCP/9999) | TCP/10443
- **Ports used for scanning unix machines**: TCP/23(telnet) | TCP/22(ssh)
  - TCP/11000 (if Asset explorer is installed in Unix machine)
- **Ports used to scan other network devices**: UDP/161 (snmp) | TCP/22 (ssh)

*Note: ICMP echo and ICMP echo reply should be allowed in the firewall, as this is used to ping the target machines. If the target machine has non-english OS, port TCP/22 needs to be added in the exception list of the firewall.*
Scanning WAN environment

For a Wide Area Network (WAN) such as an organization distributed across various geographical locations, two methods of scanning mechanism can be put to practice

- Distributed Asset Scan

  This method involves a Remote AE server to be installed in each geographical location to scan and maintains all the workstations, and user information of the respective sites. The data from the Remote AE Server is pushed to the Central AE Server either manually or by scheduling the data periodically.

- Open the Firewall ports between the sites.

  To know more on this section refer Ports used for scan.
Schedule Scan

With Schedule Scan, you can schedule periodic scanning of your domain/network, enable regular cleanup of scanned information and set re-scanning interval for scanning workstation.

To access the schedule scan configuration page,

1. Click on the Admin tab in the header pane to open the configuration wizard page.

2. Click Schedule Scan icon under Discovery block. The Schedule Scan form opens.

Enabling Schedule Scan

Select Enable Scheduled Scan check box to configure regular scanning of the workstations. Select any of the 5 radio buttons below:

- **Scan Once** Select the date on which you want to scan your network using the calendar icon. And set the time to scan on the chosen date.

- **Daily Scan** Select the time (hours and minutes) from the combo box to scan workstations on a daily basis. Then select the date from the calendar button to schedule scans.

- **Weekly Scan** In the weekly scan option, you can also choose to schedule a daily scan. Select Everyday checkbox to enable scan on all the days of the week. Or, select the check box beside a particular day of the week. Then set the time (hours and minutes) of the scan to start the scanning process on the selected day of the week.

- **Monthly Scan** In the monthly scan option select the check box Every Month to scan every month throughout the year. Or, you can also choose the months you want to scan by selecting the check box beside the name of the months. Also, you can choose to schedule a weekly scan by enabling the radio button Day and select the scanning day of the week from the drop down. Or, select Date radio button and select the date from the drop down. Finally select the time (hours and minutes) of the scan.

- **Periodic Scan** You can enter a random period of time to repeat the scan. Enter the number in the field provided. The scan will be performed on every specified nth day. Where n is the number you enter in the field. The default value is 7th day.

Scan History Clean up

You can enable regular cleanup of the scanned information, by selecting the Enable Scan History Clean up check box and specifying the number of days after which the scanned history information should be deleted.

**Note:** We suggest you to clean up the scanned history periodically to enhance ServiceDesk Plus performance.
Checking for Newly Added workstations

You can also check for newly added workstations by performing a re-scan of your domain/network. For this you need to select **Check for newly added workstations** check box and enter the number of days when the periodic re-scanning of your domain/network should be performed.

Click **Save**, to save the details. Click **Reset** button to reorganize the settings.
Distributed Asset Scan

In a widely distributed organization across various sites, the ServiceDesk Plus server may not be able to access all the assets in sites. Hence, a Remote AE server is installed in each site which scans and maintains all the workstations, and user information of the respective sites. The data from the Remote AE Server is pushed to the ServiceDesk Plus Server either manually or by scheduling the data periodically.

Since there is a constant need to update the users and workstation information in the ServiceDesk Plus Server, you can automate the process by specifying the central server details in the remote server thereby synchronizing the two servers.

Methods to perform Distributed Asset Scan

Manual
1. Extract the data in a **zip format** from the Remote AE server and **export** it to the SDP server.
2. **Import** this zip file into the SDP Server.

Auto Synchronization
1. Configure the SDP Server details in **Central Server Settings**.
2. Select **Export and Push data to Central Server now** button. The data is automatically pushed to the SDP server provided the server is reachable.

Asset Scan in Remote AE Server
The scanned information in the Remote AE Server can be updated periodically either manually or automatically to the SDP Server.

ZOHO Corp.
Installing the Remote AE Server

You can install AssetExplorer as a Remote Server by choosing the server type as Remote AE Server on starting the application for the first time. The application gets started as the Remote AE Server.

Accessing the Configuration

1. Click the Admin tab in the header pane.

2. Click Distributed Asset Scan icon under Discovery block.

Methods to export the data

The data can be exported manually or pushed automatically in the SDP Server.

**Manual**

1. Click on Export Data to export the asset data into a zip file.
2. A confirmation message appears. Click Ok to proceed.
3. If the data has been generated successfully, an Export Data box pops up.
4. Click on the link to download the zip.
5. Send the zip file to the central server location through E-mail or through some storage device.

**Auto Synchronization**

If the central server is reachable, configure the details of the SDP Server by clicking on Central Server Settings.

- **Server Name:** Enter the Server Name or IP Address of the SDP Server.
- **Server Port:** The port where the SDP Server is installed.
- **Server Protocol:** The protocol to connect the SDP server and the remote server. Say, Http, Https
- **Site:** Site where the Remote AE Server is installed. The site specified must be configured in the SDP server so that the assets and users are associated to the appropriate site.
- **Username & Password:** Credentials of the SDP Server.
- **Domain Name:** Specify Domain Name if Active Directory authentication is enabled in SDP Server.
The Central Server may be connected through a proxy server. In this case,

- **Enable Is connected through Proxy Server** check box.
- **Proxy Server Name**: The Server Name or IP Address of the Proxy server.
- **Proxy Server Port**: The port of the proxy server.
- **Proxy Username & Password**: Credentials of the Proxy Server.

On configuring the Central Server Settings, you can export and push the data to central server automatically by clicking on **Export and Push Data to Central Server Now** button. The executed date, status of the operation and related comments is displayed in the List View.

**Schedule Pushing of data to SDP Server**

You can schedule to push the data from the remote AE server to the SDP Server at periodic intervals.

1. Click on **Schedule to synchronize data with Central Server** link.
2. Select **Enable** radio button.
3. Select the number of days after which the data should be pushed to the central server.
4. Select the date from the calendar icon to start the process. Also select the **Time** in hours and minutes from the drop down.
5. If there is a failure in pushing the data to the central server, you can send a **Notify** to the technician. Specify the email address in the text provided.

**Importing data into SDP Server**

**Accessing the Configuration**

1. Click the **Admin** tab in the header pane.
2. Click on **Distributed Asset Scan** icon under Discovery block.
3. Click **Browse** and locate the zip file of the scanned assets.
4. Select the **Site** of the remote server from the drop down.

Click **Import** button to import the data. On importing the data successfully you get a success message.
General Settings

In General Settings, you can configure Invalid Service Tags, provide option for MAC address identification during scan, and for OIDs with unknown type; option to specify the product type and product name.

Configure Invalid Service Tags

While performing a scan, the Workstations and Servers are uniquely identified based on its Service Tags, Name and MAC address. So when the service tags are not incorrectly configured by the OEM, many machines would result in similar service tags. In such cases, if a scan is performed, one workstation details would be overwritten by the other. To avoid this, you can add the service tag under Invalid Service Tag list such that, the workstations with the service tag is ignored during a scan.

Enable/Disable MAC address identification during scan

Machines connected through VPN or VMware have similar MAC address. So while performing a scan in similar network environment, one machine is overwritten by the other. Hence you can uniquely identify the MAC address by enabling/disabling the radio button.

OIDs with Unknown Type

While performing a scan, the routers, switches, printers and access point in the network generate an OID which uniquely denotes the assets. If the OID of the asset is not available in the database, a new entry is populated from where you can choose the product type and specify the product name.
Asset Management

The inventory module of the ServiceDesk Plus application enables you to keep track of the various assets available in your organization and their corresponding usage and availability. It also helps you monitor your assets online in any of the networks in your firm. This helps you in proactively planning your resource allocation and purchases. Before you start using the inventory module, you have to configure the inventory-related information. The inventory-related configurations are:

1. Product Type
2. Product
3. Vendor information
4. Workstation - Additional Field
5. Asset Additional Field for new asset form
6. Resource State

To access the inventory-related configurations:

1. Log in to the ServiceDesk Plus application using the user name and password of a ServiceDesk Plus administrator.

Click the Admin tab in the header pane. The Asset Management block is just below the helpdesk block.
Configuring Product Types

Each product purchased by a firm can be categorized into a specific product type. This is the high-level categorization for the assets that are bought. For example, Adobe Photoshop or Macromedia Flash can be categorized under the product type Software, while HP Inkjet Printer can be categorized under the product type Printer. In general, product type is a parent category under which you can group each of the specific assets owned by your firm. Proper categorization helps in estimating how much has been spent for purchasing each of the product type assets (Printer, Scanners, etc.), how much assets in each of the product types are available in the organization and so on.

- **Product Type**: Product Type is the high level categorization in grouping products. Say, Workstations in an organization are grouped under the product type "Workstations".

- **Type**: Type is a subdivision of product types that is classified into Asset, Components and Consumable. Say, Workstation is an Asset, Keyboard is a Component and the Printer Toner is Consumable.

- **Category**: Category is a common attribute of Product Types and Types. They are classified into IT and Non-IT. Say, Workstation is an IT asset, and Projector and Scanners are Non - IT assets.

**Example** : Adobe Photoshop & HP Inkjet Printer can be categorized as,

<table>
<thead>
<tr>
<th>Assets</th>
<th>Product Type</th>
<th>Type</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe Photoshop/Macromedia Licenses</td>
<td>Software Licenses</td>
<td>Components</td>
<td>IT</td>
</tr>
<tr>
<td>HP Inkjet Printer</td>
<td>Printer</td>
<td>Asset</td>
<td>IT</td>
</tr>
</tbody>
</table>

To open the product type configuration page:

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Asset Management block, click the Product Types icon. The next page displays the available list of product types. You can add, edit, or delete product types.

**Add Product Types**

To add product types:

1. Click Add New Product Type link.
2. In the Add Product Type form, specify the Product Type Name which will uniquely identify the individual product types. Say, Printer.
3. Select the Type from the drop down. Say, Asset, Component, Consumable.
4. Select the Category from the drop down. Say, IT, Non-IT.
5. Specify any relevant information about the product type in the Description field.
6. Click Save button.

If you want to add more than one product type, then instead of clicking Save, click Save and add new button. This adds the new product type and reopens the add product type form after displaying a message that the a new product type is added.

At any point, if you decide not to add the new product type, then click Cancel to get back to the product type list. Clicking the View List link on the top right corner of the add product type form will also take you to the product type list view.
Edit Product Type

To edit an existing product type:

1. In the Product Types List page, click the edit icon beside the Product Type Name that you wish to edit.
2. In the Edit Product Type form, you can edit the product type name, type, category and the description.
3. Click Save. At any point, if you wish to cancel the operation that you are performing, click Cancel.

Even while editing a product type, if you wish to add new product type, then click Save and add new button instead of clicking Save button after making the changes.

Delete Product Types

To delete a product type:

1. In the Product Types List page, click the delete icon beside the Product Type Name that you wish to delete. A confirmation dialog is opened.
2. Click OK to proceed with the deletion. If you do not want to delete the product type, then click Cancel.
Configuring Products

The specific asset types are termed as products. For example, Dell Latitude D600 is a product representing Dell Laptops. These products need to be added in the application so that they can be used while referencing from the various modules of the application, such as Inventory and Purchase. As and when you purchase any specific product belonging to a new asset type, you need to add the new product. Also, if a product needs to be discarded you can also remove it from the list by deleting the details of the same.

To open the product configuration page:
1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Asset Management block, click the Products icon. The next page displays the available list of products. You can add, edit, or delete product.

Add Product

To add products:
1. In the Product List page, click Add New Product link available at the top right corner.
2. In the Add Product form, enter the Product Name. This field cannot be blank.
3. If you know the manufacturer of the product, enter the same in the Manufacturer field.
4. From the Product Type combo box choose the product type under which you wish to classify the product that you are adding.
5. Enter the Part No. of the product.
6. If required, add relevant Comments for the product.
7. Click Save. A message is displayed and the product is added. Simultaneously, a Vendors tab is also added. This tab is to give a vendor association to the product.
8. Click the Vendor tab.
9. Click the Associate Vendor button to associate vendor with the product. This opens the Associate Vendor page.
10. In the Associate Vendor form, choose the vendor name from the combo box provided and enter the price of the product. These are the two fields that are mandatory.
11. If you know the warranty period of the product, enter it in the Warranty Period by choosing the number of years and months from the combo box.
12. Choose the maintenance vendor.
13. If you wish to add any comments, add it in the Comments text box.
14. Click Save to save the details. The page is refreshed to display the vendor association information. Repeat the steps 9 - 14, till you have added all the vendors who supply this product.

If you do not wish to associate the vendor now, then click Cancel. It goes back to the Product Details tab.

If you wish to add more than one product, then in step 7, instead of clicking Save, click Save and add new button. This would add the product and open the add product form for you to add more products. In this case, the product vendor association needs to be done later. To get back to the product list page without adding the product or after completing the vendor product association, click View List link at the top right corner of the Add Product form.
Edit Product
If you have added the product without associating the vendor with the product, then you will have to associate the vendor by editing the product information.

To edit the product information:
1. Click the edit icon beside Product Name in the Product List page.
2. In the Edit Product form, you can edit all the form fields mentioned in the add product procedure.
3. Click the Vendor tab and click the Associate Vendor button.
4. Edit the required fields and click the Add button.

Even while editing the product information, if you wish to see the product list page, click the View List link at the top right corner of the Edit Product form. Also if you want to add a new product, then in the product details tab, click Save and add new button.

Delete Product
To delete a product, it is necessary that the product vendor association is first removed and then the product is deleted. Also ensure that the particular product is not used elsewhere. Follow the steps below to delete a product:
1. In the Product List page, click the edit icon beside Product Name.
2. Click the Vendors tab.
3. Click the delete icon beside the Vendors. A confirmation dialog is opened.
4. Click OK to proceed with the deletion. Delete all the vendor associations of the product.
5. Click view list link on the top right corner of the center pane.
6. Now, click the delete icon beside the Product Name for which you removed the vendor association. A confirmation dialog is opened.

Click OK to proceed with the deletion. If you do not wish to delete the product, click Cancel.
**Configuring Vendors**

An organization can have business contacts with more than one vendor for buying the various resources of the organization. It is very essential for the firm to keep track of its vendors and the products supplied by these vendors. To configure these details, you can use the configuring vendors option available in the admin page.

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. In the Asset Management block, click the Vendors icon. You can add, edit, or delete vendors.

### Add Vendors

To add vendors:

1. In the Vendor List page, click the Add New Vendor link available at the top right corner.
2. In the Add Vendor form, enter the Vendor Name. This name needs to be unique and this field cannot be blank. All the other fields are optional.
3. Enter relevant Description for the vendor.
4. Enter the Contact Name at the vendor location.
5. Enter the address details of the vendor in the respective fields.
6. Enter the vendor e-mail ID, phone, fax, and web URL.
7. Click Save. A message is displayed and the vendor is added. Simultaneously, a Products tab is also added. This tab is for adding the list of products that are supplied by the vendor.
8. Click the Products tab.
9. Click Associate Product button.
10. In the associate product form, choose the product name from the combo box and enter the price of the product. These are the two fields that are mandatory.
11. If you know the warranty period of the product, enter it in the Warranty Period by choosing the number of years and months from the combo box.
12. Choose the maintenance vendor from the combo box.
13. If you wish to add any comments, add it in the Comments text box.
14. Click Add. The page is refreshed to display the product association information. Repeat the steps 9 - 14, till you have added all the products supplied by this vendor.

If you do not wish to add the product list after opening the associate product form, then click Cancel. It goes back to the Vendor Details tab.

If you wish to add more than one vendor, then in step 7, instead of clicking Save, click the Save and add new button. This would add the vendor and open the add vendor form for you to add more vendors. In this case, the product list needs to be added later. To get back to the vendor list page without adding the vendor or after adding the list of product supplied by the vendor, click View List link at the top right corner of the Add Vendor form.

### Edit Vendor

If you have added the vendor without adding the product list, then you have to add the list of product supplied by the vendor only by editing the vendor information.
To edit the vendor information:

1. Click the edit icon beside Vendor Name in the Vendor List page.
2. In the Edit Vendor form, you can edit all the form fields mentioned in the add vendor procedure.
3. Click the Products tab to add the list of products supplied by the vendor and follow the steps 9 through 14 in add vendors.

Even while editing the vendor information, if you wish to see the vendor list page, click the View List link at the top right corner of the Edit Vendor form. Also if you want to add a new vendor, then in the vendor details tab, click the Save and add new button.

Delete Vendors

To delete a vendor, it is necessary that the product vendor association is first removed and then the vendor is deleted. Also ensure that the particular vendor is not used elsewhere. Follow the steps below to delete a vendor:

1. In the Vendor List page, click the edit icon beside Vendor Name.
2. Click the Products tab.
3. Click the delete icon beside the Products. A confirmation dialog is opened.
4. Click OK to proceed with the deletion. Delete all the products listed.
5. Click view list link on the top right corner of the center pane.
6. Now, click the delete icon beside the Vendor Name for which you removed the product list. A confirmation dialog is opened.

Click OK to proceed with the deletion. If you do not wish to delete the vendor, click Cancel.
Workstation Additional Fields

You can define your own organization specific fields that need to appear in the new workstation form apart from the default fields. You can add text fields, numeric fields, and date/time type fields in the form.

Adding Workstation Additional Fields

1. Click the Admin tab in the header pane.
2. Click Workstation Additional Fields icon in the Configuration Wizard page. This opens Workstation – Additional Fields page.

Configuring Additional Text fields

1. By default the list of all additional text fields are displayed. Specify the Label for the Workstation Additional Fields.
2. Specify any relevant information about the additional fields in the Description text field.
3. Specify the Type of the text field by enabling the radio button. It can be either Single-Line, Multi-Line or drop down menu list.
4. Specify the Default Values in the given text field.
5. Click Save to save the settings.

Configuring Additional Numeric fields

1. Click on the Numeric tab.
2. Specify the Label for the additional field. This is a mandatory field.
3. Specify any relevant information about the additional fields in the Description text field.
4. Click Save to save the settings.

Configuring Additional Date/Time fields

1. Click on the Date/Time tab.
2. Specify the Label for the additional field. This is a mandatory field.
3. Specify any relevant information about the additional fields in the Description text fields.

Click Save to save the settings.
Asset Additional Fields

You can define your own organization specific fields that need to appear in the new asset form apart from the default fields. You can add text fields, numeric fields, and date/time type fields in the form.

Adding Asset Additional Fields
1. Click on Admin tab in the header pane.
2. Click Assets Additional Fields icon in the Configuration Wizard page. This opens Assets – Additional Fields page.

Configuring Additional Text fields
1. By default the list of all additional text fields are displayed. Specify the Label for the asset additional fields.
2. Specify any relevant information about the additional fields in the Description field.
3. Specify the Type of the text field by enabling the radio button. It can be either Single-Line, Multi-Line or drop down menu list.
4. Specify the Default Values in the given text field.
5. Click Save to save the settings.

Configuring Additional Numeric fields
1. Click on the Numeric tab.
2. Specify the Label for the additional field. This is a mandatory field.
3. Specify any relevant information for the additional fields in the Description field.
4. Click Save to save the settings.

Configuring Additional Date/Time fields
1. Click on Date/Time tab.
2. Specify the Label for the additional field. This is mandatory field.
3. Specify any relevant information for the additional fields in the Description field.
4. Click Save to save the settings.
Resource State

Resource can be categorized based on its current status in the organization. Ex: Resource In Use, In Store, Expired and so on.

To access the resource state configuration wizard page,

1. Click the **Admin** tab in the header pane. This opens the Configuration Wizard page.

2. Under the Asset Management block click the **Resource State** icon. This opens the Resource State list page where you can add, edit and delete a resource state. By default you have five resource state available in ServiceDesk Plus. You cannot edit or delete the resource state.

**Adding Resource State**

1. Click **New Resource State** link.
2. Specify the **Resource State** name in the given text field. This is a mandatory field.
3. Specify any relevant information about the resource state in the **Description** field.
4. Click **Add Resource State** button to add the resource to the application.

**Editing Resource State**

1. From the Resource State list view page, click the **edit** icon beside the resource state to edit. The edit form appears pre-filled with the values entered while adding the resource state.
2. **Modify** the Resource State and Description.
3. Click **Update Resource State** button to update the changes.

**Deleting Resource State**

1. From the Resource State list view page, click the **delete** icon beside the resource state to delete. A confirmation dialog appears.

Click **Ok** to proceed. The resource state is deleted from the list.
Softwares

Softwares helps you to configure all the software related tasks such as Software Type, Software Category, Software License Types and Additional fields for software license and license agreement.

- Software Type
- Software Category
- License Additional Fields
- Software License Types
- Agreement Additional Fields
- Import License (s) from CSV
Configuring Software Type

All different forms of software such as, licensed, prohibited, freeware, shareware, excluded and unidentified software comes under this category.

To access the Software Type configuration page,
1. Click the Admin tab in the header pane. This opens the Configuration Wizard page.
2. Click the Software Type icon under the Software block. This opens the Software Type list view page. By default there are six software types that cannot be edited nor deleted.
   - Shareware: Software that is available free of charge, may be distributed for evaluation with a fee requested for additional features or a manual etc.
   - Freeware: Software that is provided without charge.
   - Prohibited: Software that is prevented from use.
   - Excluded: Software that is omitted from use.
   - Managed: All licensed software comes under this software type.
   - Un-Identified: Unknown softwares can be categorized under this software type.

Adding New Software Type
1. Click the New Software Type link. This opens the Software Type Details page.
2. Specify the Software Type name in the given text field. This is a mandatory field which will uniquely identify individual software type.
3. Specify any relevant information about the Software Type in the description field.
4. Click Add Software Type button. This adds the software type to ServiceDesk Plus and gets displayed below the add software form.

Editing Software Type
1. From the Software Type list view page, click the Edit icon beside the software type to edit.
2. Modify the necessary changes.
3. Click Update Software Type button.

Deleting Software Type
1. From the Software Type list view page, click the Delete icon beside the software type to delete.
2. A confirmation dialog appears.
   Click Ok to proceed. The software type is deleted from the list.
Software Category

The softwares available in the application are organized by grouping them into specific Software Categories. Some of the default software categories available in the application are Accounting, Internet, Graphics, Multimedia, Operating System, Game and much more.

To access the software category configuration wizard,

1. Click the Admin tab in the header pane to open the configuration wizard page.

2. Click Software Category icon under Software block. The Software Category list view page opens. From this page, you can add, edit and delete a software category.

By default, there are nine software categories listed in the application. These software categories can neither be edited nor deleted.

Adding Software Category

1. Click New Software Category link.

2. Specify a unique name for the Software Category in the provided field. The Software Category is a mandatory field.

3. Specify any relevant information about the category in the Description field.

4. Click Add Software Category button to add the software category to the list. Click Cancel to go back to the list view. The added software categories are displayed while adding a new software.

Editing Software Category

1. Click the Edit icon beside the software category to edit.

2. Modify the Software Category name and Description fields.

3. Click Update Software Category to update the changes.

Deleting Software Category

1. Click the Delete icon beside the software category to delete.

2. A confirmation dialog to delete the software category appears. Click Ok to proceed. The software category is deleted from the list.
License - Additional Fields

If you require any further additional information while adding the software license details, apart from the pre-set fields in the Add software licences form you can configure them under License - Additional Fields. You can add text fields, numeric fields, date type fields and Cost fields as the additional fields in the form.

To add license - additional fields,

1. Click on the Admin tab in the header pane to open the configuration wizard page.

2. Click on License - Additional Fields icon under Softwares block. The License Additional page opens to view the following tabs namely, Text, Numeric, Date/Time and Cost. You can add up to twelve text and cost fields, and four numeric and date/time fields.

Configuring Additional Text fields

1. By default, the Text tab is selected. Specify the Label for the Additional field.

2. Specify any relevant information about the additional field in the Description text field.

3. Select the Type of the text field by enabling the radio button. It can be either Single-Line, Multi-Line or Pick List (drop down list).

4. You can also specify default values to be pre-filled in the software license form.

5. Save the settings.

Configuring Additional Numeric fields

1. Click on the Numeric tab.

2. Specify the Label for the additional field.

3. Specify any relevant information about the additional fields in the Description text field.

4. Save the settings.

Configuring Additional Date/Time fields

1. Click on the Date/Time tab.

2. Specify the Label for the additional field.

3. Specify any relevant information about the additional fields in the Description text fields.

4. Click Save to save the settings.

Configuring Cost fields

1. Click on the Cost tab.

2. Specify the Label for the Additional field.

3. Specify any relevant information about the additional field in the Description text field.

4. You have two cost type fields, Add cost (for cost addition) and Subtract cost (for cost subtraction). Click the corresponding radio button to select the cost fields and also specify the Default values to be pre-filled in the software license form.

These additional fields will appear while adding a software license under the Additional Informations block. To delete a user-defined fields, instead of adding the label names, delete the existing label names you wish to remove from the fields of the form and click Save. The fields are automatically removed from the Software License form.
Software License Types

Every software manufacturing company has their unique software license type apart from the several common license types. Since it is not feasible to support all these license types, ServiceDesk Plus helps you customize the license types for all software manufacturers based on the workstations and users.

To access the Software License Types configuration page,

1. Click the **Admin** tab in the header pane to open the configuration wizard page.

2. Click **Software License Types** icon under **Softwares** block. The list of default license types filtered by the manufacturer are displayed.
   - **Individual**: License type for single installation
   - **OEM (Original Equipment Manufacturers)**: License type for softwares that are already installed in the hardware.
   - **Named User License**: License Type for a specific user.
   - **Volume**: License Type supporting multiple users.
   - **Client Access License (CAL)**: License type that gives a user the rights to access the services of the server.
   - **Trial License**: License Type for trial versions of a software.
   - **Enterprise (Perpetual)**: License Type that does not require renewal and is for life long.
   - **Concurrent License**: License Type for a software that can be accessed by a specific number of users at a time.
   - **Free License**: License Type for freeware softwares.
   - **Enterprise Subscription**: License Type that requires renewal for every specific period.
   - **Node Locked**: License Type for workstations with specific configurations.

Apart from the default license types available in the application, you can add, edit and delete Software License Types.

**Adding New License Type**

1. Click **Add New License Type** link.

2. Enter the **License Type** say Volume, Enterprise, Standard and so on. In general, each manufacturer depicts their license types uniquely and so the license type needs to be specified accordingly to the manufacturer. This field is mandatory.

3. Select the software **Manufacturer** from the drop down. If required, you can also add a new manufacturer using the **Add New Manufacturer** icon.

4. The software license can be tracked by workstations or users.
   - **Workstations**: The license is allocated to the workstation.
   - **User**: The license is allocated to the workstation as well as the user.
   Select the corresponding option from **Track By** drop down.

5. Choose any one option from **Installation allowed** drop down.
   - **Single**: Similar to Individual license, only one installation is allowed for this license type.
   - **Volume**: Multiple installation(s) is allowed for this license type.
   - **Unlimited**: Unlimited installation(s) is allowed for this license type.
   - **OEM (Original Equipment Manufacturers)**: The software license is attached to the hardware i.e. hardwares say, laptops for which the software is installed. The software
cannot be transferred to another workstation and the license expires once the workstation is moved to Disposed state.

6. If you have selected Workstation as the Track By option, the Is Node Locked option appears. This option can be enabled for workstation with specific configurations. Enabling this option automatically changes the Installation Allowed field to Single.

7. If you have selected Users, the Users Allowed field appears. From this field you can select the number of users who can access the software, say, Single, Volume (multiple) or Unlimited.

8. If the software is one time installation and does not require a renewal, enabled Is Perpetual check box.

9. If the software is freeware with unlimited installations and no expiry date, enable Is Free License check box.

10. Few software license type can be divided into sub license types say for instance, with Client Access License (CAL) you can purchase license for every user who access the server (Per User) or license for every device that accesses the server (Per Device). Enter the License Option and click Add to add it in the pick list field. You also have an option to delete the License Option from the pick list field. Select the license option and click the delete icon 🗑.

**Editing License Type**

1. From the Software - License Types page, click on the Edit icon  ⬅️ beside the License Type you wish to edit.

2. The Software - License Types page opens with the values populated while adding the License Type.

3. Modify the required details and Save the changes.

**Deleting License Type**

1. From the Software - License Types page, select the Manufacturer from the Filter drop down.

2. Select the check box beside the license type to be deleted.

3. Click Delete button. A confirmation dialog appears. Click Ok to continue. The Software - License Type is deleted from the selected manufacturer list.
License Agreement- Additional Fields

If you require any further additional information while adding the software license agreement details, apart from the pre-set fields in the licence agreement form you can configure them under License Agreement - Additional Fields. You can add text fields, numeric fields, date type fields and Cost fields as the additional fields in the form.

To add license - additional fields,

1. Click on the Admin tab in the header pane to open the configuration wizard page.

2. Click on Agreement - Additional Fields icon under Softwares block. The License Agreement Additional page opens to view the following tabs namely, Text, Numeric, Date/Time and Cost. You can add up to twelve text and cost fields, and four numeric and date/time fields.

Configuring Additional Text fields

1. By default, the Text tab is selected. Specify the Label for the Additional field.
2. Specify any relevant information about the additional field in the Description text field.
3. Select the Type of the text field by enabling the radio button. It can be either Single-Line, Multi-Line or Pick List (drop down list).
4. You can also specify default values to be pre-filled in the license agreement form.
5. Save the settings.

Configuring Additional Numeric fields

1. Click on the Numeric tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text field.
4. Save the settings.

Configuring Additional Date/Time fields

1. Click on the Date/Time tab.
2. Specify the Label for the additional field.
3. Specify any relevant information about the additional fields in the Description text fields.
4. Click Save to save the settings.

Configuring Cost fields

1. Click on the Cost tab.
2. Specify the Label for the Additional field.
3. Specify any relevant information about the additional field in the Description text field.
4. You have two cost type fields, Add cost (for cost addition) and Subtract cost (for cost subtraction). Click the corresponding radio button to select the cost fields and also specify the Default values to be pre-filled in the license agreement form.

These additional fields will appear while adding the license agreement details. To delete a user-defined fields, instead of adding the label names, delete the existing label names you wish to remove from the fields of the form and click Save. The fields are automatically removed from the License Agreement form.
Importing License From CSV

Adding license information for each and every software scanned in ServiceDesk Plus application is tedious and endless. Hence with the easy-to-use CSV import option, you can import software license information from your existing database or even from other applications. The License Key is a pivotal identifier to add or update the software license(s). So the license key should be unique to avoid overwriting with the existing ones.

To import contacts from CSV file,

1. Click on the Admin tab in the header pane to open the configurations wizard page.
2. Click Import License from CSV icon under the Software block.

Step 1: Locate CSV file

1. Click on Browse button to select the CSV file.
2. On locating the CSV file from the file chooser window, click Open. The path to the file appears automatically in Locate CSV file field.
3. Click on Submit.

Step 2: Customize Mapping

1. Map the application software license fields with the field names from the CSV file. If there are any additional fields configured under License - Additional Fields, the same appears in the customized mapping form.

![Image of the Import License Wizard interface with steps 1 and 2 explained]
2. Click **Import** button. The software license details from the CSV file is imported.

3. Once the import is complete, the data on the total number of license, the number of license imported and the number of failed to import license is displayed.

<table>
<thead>
<tr>
<th>Imported Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Licenses</td>
</tr>
<tr>
<td>Imported Licenses</td>
</tr>
<tr>
<td>Failed Licenses</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error file</th>
<th>Error List (This file will have a failed software licenses records and corresponding error messages)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed CSV file</td>
<td>FailedLicensesList.csv (This file will have a failed software licenses records along with any failure while importing software license(s)) please don’t re-import the whole software licenses once again instead correct the errors in FailedLicensesList.csv file then try to import otherwise you will get the duplicate software license(s).</td>
</tr>
</tbody>
</table>

**Warning**

If there are any failure records while importing software license(s), don't re-import the same CSV file. Instead download the FailedLicensesList.csv from the Imported Result page and correct the errors on comparing with ErrorList.txt file. The Error List file shows the failed software license records along with the corresponding error message. This is to avoid duplication of the software license(s).
User Survey

You can easily configure the customer satisfaction survey to collect information on various key parameters that you would like to measure about the support team and the response quality. You can define your own survey and the reports will be generated based on the survey that you have defined. You can also set the frequency of conducting the survey.

The various survey related configurations that you can perform are

1. Configuring Survey Settings
2. Defining a Survey

Apart from the above the you can also do the following survey related actions:

1. Sending Survey for a Request
2. Viewing the Survey Results

Once you have completed configuring and defining the survey, you can have a look at the preview of the survey by clicking the Survey Preview link on the left menu or the Survey Preview icon in the Admin tab.

To access the user survey related configurations

1. Log in to the ServiceDesk Plus application using the user name and password of a ServiceDesk Plus administrator.

Click the Admin tab in the header pane. The User Survey block is below the Users block.
Configuring Survey Settings

Survey settings enables you to configure the default values for welcome message, survey success or failure message, and thank you message. You can also choose to enable or disable a survey. If you enable a survey you can also schedule the periodicity of conducting the survey.

To configure the survey settings

1. Log in to the ServiceDesk Plus application with the **user name** and **password** of a ServiceDesk Plus administrator.
2. Click the **Admin** tab in the header pane.
3. In the **User Survey** block, click the **Survey Settings** icon. The Survey Settings page is displayed.
4. To enable the survey, select the check box **Enable User Survey**.
5. Under the **Survey Details** block, enter the **Welcome Message**, which you wish to display as soon as the user reaches the survey page. or when the user is taking the survey.
6. **Email Content**: Specify the purpose of the email in the Email Content text field. This content will be displayed in the mail sent to the requesters. $RequesterName & $SurveyLink are variables which changes based on the requester & application URL.
7. **Success Message**: Enter the message that will be displayed once the survey has been successfully answered and submitted by the user.
8. **Failure Message**: When the survey is taken by a person who has already submitted the answers for the survey, then you will have to display a failure message. You can enter the same in the Failure Message text area.
9. **Thanks Message**: Enter the thanks message. This message will be displayed just before the submit button in the survey form.
10. To schedule the survey, in the **Schedule Survey** block, choose the radio button that you wish to set as a criteria for sending the survey. The options are,
   - **A request is closed**: For closing every one request a survey mail will be sent
   - **Requests are closed**: Specify the number of requests to be closed of all the available requests in the text box. Once the specified number of requests is closed a survey mail will be sent.
   - **Requests from a requester are closed**: Specify the number of requests to be closed for a requester in the text box. Once the specified number is reached a survey mail is sent to the requester. This text box can take only integer values as input.
11. Click **Save** to save the survey settings.
### Survey Settings

<table>
<thead>
<tr>
<th>Enable Survey</th>
<th>Enable User Survey</th>
</tr>
</thead>
</table>

#### Survey Details

**Welcome Message**

Please help us to improve our service by participating in this brief survey.

**Email Content**

Dear [Requester Name],

Please help us improve our service by completing this short survey. Your feedback and comments will help us to improve our service. We appreciate your time here.

Thanks and regards,

IT Admin

**Success Message**

Your feedback has been sent and comments will be considered.

**Failure Message**

Your survey information for this request has already been received for consideration.

**Thank You Message**

Thank you for taking part in this survey.

#### Schedule Survey

Send Survey every time

- [x] a request is closed.
- [ ] 0 requests are closed.
- [ ] 0 requests from a requester are closed.
Defining a Survey

You can define your own survey by adding your own questions and satisfaction levels that will suit the needs of your organization and users.

To define your survey,

1. Log in to the ServiceDesk Plus application using the **user name** and **password** of a ServiceDesk Plus administrator.
2. Click the **Admin** tab in the header pane.
3. In the **User Survey** block, click the **Define a Survey** icon. Here you can add, edit, or delete your survey questions and satisfaction levels.

Add Survey Questions

To add a survey question

1. Click the **+ Add Question** button available in the **Questions** tab in the **Define Survey** page.
2. In the Question pop-up window, type your question in the text area provided.
3. Click **Save**. The question will get added in the Define Survey Questions tab.

You can add any number of questions to the survey by following the above steps. As you keep adding questions, it will get appended at the end of the list of questions. You can change the order of the questions by clicking the **Move Up** and **Move Down** link that is available beside each question.

Edit a Survey Question

To edit the survey question

1. In the **Questions** tab, click the **Edit** link beside the question that you wish to edit.
2. In the Question pop-up window, edit the question displayed in the text area.
3. Click **Save**. The **Define Survey** page is refreshed to display the modifications made.

Delete a Survey Question

1. In the **Questions** tab, click **Delete** link beside the question that you wish to delete. A confirmation dialog pops up.
2. Click **OK** to delete the question.

**Note:** If you delete a question from a survey, then it will have an impact on the survey results that have been collected previously.

Add Satisfaction Levels

To add satisfaction levels that will be displayed as choices for each of the survey questions

1. Click the **Satisfaction Levels** tab in the **Define Survey** page.
2. Click **+ Add Level** button.
3. In the satisfaction level pop-up window, enter the satisfaction level in the text area provided.
4. Click **Save**. The satisfaction level is added and the **Define Survey** page is refreshed to display the added satisfaction level.
You can add any number of satisfaction level to the survey by following the above steps. As you keep adding the levels it will get appended at the end of the list of already added levels. You can change the order of the same by clicking the Move Up and Move Down link that is available beside each question. Satisfaction levels scales from good to bad, good at the top bad at the bottom. Moving up or down changes the satisfaction levels.

**Edit a Satisfaction Level**

To edit a Satisfaction level

1. In the **Satisfaction Levels** tab, click the **Edit** link beside the satisfaction level that you wish to edit.
2. In the satisfaction level pop-up window, edit the satisfaction level displayed in the text area.
3. Click **Save**. The Define Survey page is refreshed to display the modifications made.

**Delete a Satisfaction Level**

1. In the **Satisfaction Levels** tab, click the **Delete** link beside the satisfaction level that you wish to delete. A confirmation dialog pops up.
2. Click **OK** to delete the satisfaction level.

**Note:** If you delete a satisfaction level from a survey or change its order, then it will have an impact on the survey results that have been collected previously.

**Survey Translate**

If you have purchased the license along with multi language, then the **Survey Translate** tab appears. The survey can be displayed in various languages supported by ServiceDesk Plus to users located in various locations.

**Add New Translation**

To add new translation,

1. In the Define Survey page, click on **Survey Translate** tab.
3. Select the **Survey Language** from the drop down list. The languages supported by ServiceDesk Plus is displayed. The languages for which a translation is added does not appear again in the Survey Language drop down list.
4. Enter the **Survey Questions** in the language selected in Survey language drop down list.
5. Similarly, specify the **Satisfactory Levels** and **Messages** in the respective fields.
6. Click **Save** to save the new translation in the list view. By default, while adding a new translation the language is enabled. To disable the language, select the check box beside the language to be disabled and click **Disable** button.

The survey form for the requester consists of Display Language drop down listing all the enabled languages configured under Survey Translate tab. Select the language to view the survey.

**Edit a Translation**

While editing a translation, the Survey Language cannot be modified.

1. In the Translate Language page, click the **Edit** icon beside the language you wish to edit. The New Translation form appears
2. The Survey Language is in non editable text. Modify the details in **Survey Question**, **Satisfactory Levels** and **Messages**.
3. Click **Update** to save the changes.
Delete a translation

1. In the Translation Language page, select the check box beside the language you wish to delete.

Click Delete button. A confirmation box appears. Click Ok to continue. The translated language is deleted from the list.
Viewing Survey Results

Once the requester completes the survey, the administrator and the requester who took the survey can view the survey results.

To view the survey results

1. Log in to the ServiceDesk Plus application using the **user name** and **password** of a ServiceDesk Plus administrator.
2. Click the **Requests** tab.
3. In the Requests list view select the **Closed Requests** or **My Closed Requests** filter.
4. Click the request **Title** for which you wish to see the survey results.
5. Click **View Survey Results** link available under the **Tasks** block. The survey results opens in a pop-up window.
6. Once you have viewed the results, click the **Close** button.

You can view the survey results filled in by the requester from this page. A survey is defined and a survey mail is sent to the requester. By sending the survey mail you ask the requester to answer the survey questions to improve the service provided by the technicians. The survey results answered by the requesters will be listed under this section.

**Note:**
The View Survey Results link appears only if the requester has completed taking the survey. Else this link will not be present.

Once the survey is submitted, the responses cannot be changed.
General Settings

General Settings configurations are,

- **Self Service Portal** Select fields to be displayed in the self service portal of the end-user login.

- **Backup Scheduling** Schedule a backup of all your files and attachments at regular intervals.

- **Data Archiving** Boost the performance of your help desk by archiving closed/resolved requests.

**Desktop Central Integration** Automate desktop management activities like installing softwares, patches and service packs in your Windows environment from a single point.
Configuring Self Service Portal Settings

Self-Service Portal settings has fifteen different settings to be configured in ServiceDesk Plus such as, Default Currency, Display Language, My Reminders, Requester List, Dynamic User Addition, Alias URL, Customize ServiceDesk and so on.

To open the self service portal settings page,

1. Login to ServiceDesk Plus using the user name and password of an admin user.
2. Click the Admin tab in the header pane.
3. Click Self Service Portal Settings icon under the General block.

Default Currency

Specify the default currency in the given text field. This unit will be used in all the places where cost calculation is done. The default currency specified is $.

Display Language

ServiceDesk Plus supports different languages as part of the application. You can choose default language of your choice to be displayed in the application. To select the language of your choice, Click Browser default combo box. Select the language of your choice from the list.

My Reminder(s)

If you wish to show all your tasks as reminders to the requesters then select 'Yes' radio button else select 'No' option. The reminders will be shown in the home page.

Requester List

While entering the requester name in the new request form, the list of all available requesters will be automatically listed. If you wish to list the technicians name along with the requesters name then select 'Yes' else select 'No' button.

Request Feature List

Includes options to change the status of a request to Open, when a requester replies to an Onhold request. And, actions to perform when a requester replies to a closed requests.

While replying to an Onhold requests, if you wish to change the status to Open upon the requesters reply, click 'Yes' radio button. When a requester replies to a closed request, select anyone of the radio button, Reopen the request always, append the request as conversation to the request and notify technician, create a new request or reopen the request within the specified number of days from closed time. Else, create a new request.

Dynamic User Addition

By default, when a user is not imported into the application but imported through Active Directory, then the user can login to the application using the AD credentials. This will automatically provide login access to the application. If you do not wish to provide dynamic user addition when the user is not imported into the application then enable the 'No' radio button.

User Login Addition

By default, if a mail fetched by the ServiceDesk Plus application has a requester name and email ID that is not available in the requester or technician list already, then the name is automatically added in
the requester list and the login name and password is created. The first part of the e-mail ID is set as the name and the entire e-mail ID is set as login name and password. The requester can log in to the self-service portal and change his/her password. If you do not wish to provide login access to users created through email requests then enable the 'No' radio button.

**Override User based on Email ID**
While importing users using Active Directory, CSV and LDAP, the existing user information is overwritten based on two criteria - The first criteria is based on the username and Domain, and the second criteria is based on email id. If you do not wish to override user information based on email id then enable 'No' radio button else enable 'Yes'.

**Enable Local Authentication Login**
On enabling Active Directory, if you wish to allow users to login to the application using the password configured in ServiceDesk Plus then enable 'Yes'. The user should select Local Authentication from the Log on to drop down list in the Login screen. If you wish to allow users to login to the application using the system password then enable 'No' option.

**Quick Create Settings**
If you wish to show the quick create section to the technicians in the home page, then enable the 'Yes' radio button else select the 'No' button.

**Auto Assign Asset**
In ServiceDesk Plus, you can assign multiple workstations to a requester. So while creating a request through email, by default, the first workstation is displayed. If you do not wish to display the workstation information in the request details page, then enable 'No' radio button else enable 'Yes'.

**Requester Details**
If you wish to allow requesters to edit their profile select 'Allow to edit their profile' else select 'Not allowed to edit their profile'. By default, all the workstations configured by the administrator will be listed in add new request form of the self service portal. If you want the requester to view the workstations associated to them then enable the check box 'Show workstation associated to requester in Self-Service Portal'.

**Solutions Settings**
By default, the solutions approver can approve their own solutions rather than submitting it for approval. If you wish the solution approver should not approve his own solution enable 'No' radio button.

**Remote Desktop Access**
If you wish to enable Remote Desktop Access to all the workstations then select 'Yes' radio button else select 'No' button.

**Alias URL**
To provide an alternate URL
1. In the text field provided beside the http:// text, enter the URL (along with the port number if needed).
2. Click the Open alias URL in a new window link just below the text field, to test if the alias URL works.
Customize ServiceDesk

You can customize the application by choosing to display your custom logo. You need to add the logo in two dimensions, one for the login page and the other for the header image that you see on the top left corner of the pages once you login. The login page image should be of the dimensions 252 px x 61 px (W x H), while the header image needs to be 166 px x 46 px.

To import the login page image,
1. Click Import image ... button.
2. Click Browse button.
3. In the file chooser window, select the file that you wish to import and click Open.
4. Click Import.

The image that you just imported will be replaced instead of the login page image. Follow the same process for header image also.

Click Save, to save the changes made in the settings.
Backup Scheduling

You can configure backup scheduling to take back up of all the files at regular intervals.

1. Click Admin tab in the header pane. The configuration wizard page opens.
2. In the General block, select Backup Scheduling icon.

Scheduling a Backup

1. Click Edit Scheduling link on the right hand side of the page. The Edit settings page opens.
2. Enable backup scheduling by selecting Enable radio button.
3. Select the number of days from the combo box to schedule the backup process. For every n number of days selected the backup will be taken for the available data.
4. Select the date to start the backup on invoking the calendar icon from Start Backup on field. Also select the Time in hours and minutes from the combo box.
5. In case of any failure in the backup, you can notify it to a particular technician by specifying their email address.
6. You can take a Backup of either the entire Database or only the File Attachments or both. Select the check box accordingly.
7. Specify the location to store the backup data in Backup Location field.
8. Save the changes. If you do not wish to configure backup scheduling, click Cancel.

Deleting Backup Files

1. From the list of backup files, enable the check box beside the files you wish to delete.
2. Click Delete button. A confirmation dialog opens.

Click Ok to continue. The backup file is deleted from the list.
Data Archiving

Data archiving enables the user to archive closed and/or resolved requests and move them to a separate storage state. It is most useful since thousands of accumulating active requests could hinder the performance of the help desk on a longer run.

Archived requests:

- Requests that have been moved to the archived state (archived requests) will be removed from the current active requests list. These archived requests are considered as a separate set with separate search options and reports. The current active requests list, current active requests search option and the current active requests report will not include the archived requests.
- The archived requests cannot be modified, deleted or moved back to the active state.
- Any reply to an already archived request will be added as a new request and not as a thread to the existing archived request.

To view Archived Requests,

- To view the archived requests list, click on the Requests tab in the top header panel. Then click on Archived Requests link at the top right side, below date and time.
- You can also view the archived requests by clicking on Quick Actions at the top left side and choosing Archived Requests from the drop down menu.

To configure Data Archiving,

1. Log in to ServiceDesk Plus using the Username and Password of the admin user.
2. Click the Admin tab in the header pane.
3. Click Data Archiving icon under the General block.
4. Click on the check box Enable Schedule Data Archiving.
5. Set the parameters of the requests that need to be archived
   - The Status of the requests,
   - Time of creation/closure of the requests,
   - Column Name, Criteria and Values for the specific requests that need to be retained, and
   - The Schedule Time for archiving process.
6. Click on Save to save the set parameters. The archiving process takes place as per the configured schedule.
Request status:

Request status reflects the current status of the requests that have to be archived.

- **Completed** – Completed requests are those that have been resolved by the technicians and closed by the end user.
- **Resolved** – Resolved status reflects the requests that have been attended and answered by the technicians but have not been closed by the end user.
- **Any status** – All requests in any state (open, closed, resolved, on hold, feedback, follow up and so on) will be considered for archiving.

Choose the status of the requests that have to be archived are in.

Time period:

Requests can be archived based on two factors of time:

- Requests can be archived based either on the Created or Closed Time.
- They can also be archived based on the Time Period during which they were created or closed.

Requests can be archived by selecting a combination of the above two factors. The requests Created/Closed before the configured time period will be moved to the Archived State during the next scheduled archiving process.

* For example, if the archiving is to take place on 2006-11-20 (November) and you choose “Closed requests”, “Closed Date” and “6 months” from the combo boxes, then the requests closed by the technicians as well as the end users before 2002-06-20 (June) would be archived.

* Similarly, if the archiving is to take place on 2006-11-20 and you choose “Any request”, “Created Date” and “1 year” form the combo boxes, then all requests created before 2005-11-20 would be archived irrespective of the state they are currently in.

Exceptions:

A small check box **Allow Exception** is available in the Data Archiving. This option allows certain requests that fall under the archiving configurations to be retained in the current active request list without being moved into archived folder. It follows the OR condition where requests matching the any of the selected conditions are not archived.

Exceptions are rules that are defined by certain parameters. These rules can be configured by selecting parameters (**Column Name**, **Criteria** and **Value**) from the 3 combo boxes present in the feature. The first 2 parameters are chosen from the drop down list box while the third parameter, an attribute of the first parameter, is chosen from the pop up window by clicking on the choose/pick value icon.
Multiple exceptions can be added to retain more specific requests by clicking on Add more exception or by clicking the add icon and providing the necessary parameters.

For example, if you choose the first parameter as “Priority”, the second parameter as “is”, and the third parameter as “High” from the pop up box, then requests that have high priority will not be moved to the archived state.

An exception can be deleted by clicking on the cross/delete icon.

**Process Schedule:**

Schedule the archiving process by entering valid data in the “date”, “hours”, and “minutes” combo boxes. This can be done by selecting the required date from the calendar pop up box, and the hours and minutes from the drop down boxes. This process can be executed on a daily basis at the scheduled time.

If you choose ‘2006-11-20’ from the calendar pop up box, ‘21’ from the hours drop down box, and ‘00’ from the minutes drop down box, then the Data Archiving process takes place at 9 o’clock in the night of the scheduled date and repeats everyday at the same time.
Desktop Central Integration

Desktop Central is a web-based Windows Server and Desktop Management Software from ManageEngine. And, with Desktop Central Integration in ServiceDesk Plus, you can configure and manage your Windows environment from a single point. Desktop Central automates regular desktop management activities like installing softwares, patches and service packs in the Windows workstations and servers available in your network.

Note

1. The Desktop Central Integration is available in the ServiceDesk Plus Enterprise Edition.
2. The Desktop Central operation works on Service requests and not Incident requests.
3. This integration is attainable with Desktop Central version 7.0 and above.

Desktop Central activities are performed,

- On Workstations and Servers that are part of a windows domain.
- The domain should be managed by Desktop Central, and
- A Desktop Central Agent should be installed in the workstations.

- Getting Started with DC Integration - Step by step configuration to accomplish the integration and perform desktop management activities.
- Authentication Mechanism between the two applications - Authentication between SDP and DC application is through an application level key. This section explains about generating this authentication key.
- Handling Desktop Management activities from ServiceDesk Plus - Procedure on handling DC operations like install/uninstall from ServiceDesk Plus
- Enabling Notification to Technician - Enable notification to the concern technician when the software installation/uninstallation task is updated.
- Integration when DC is running in Https mode - Steps to establish connection when Desktop Central is running in Https mode.

Getting Started with DC Integration

To get started with Desktop Central Integration, the following should be configured to accomplish the Integration and perform desktop management activities:-

1. Desktop Central Server Settings
2. Configuring Role to perform DC operations
3. Assigning DC Role to Technician
4. Enabling Template Actions in the Service Request form

Step 1: Desktop Central Server Settings

If you have installed both ServiceDesk Plus and Desktop Central servers, you just have to provide the details of the computer where Desktop Central is installed along with its Port Number. On entering these details and save, ServiceDesk Plus will try to establish a connection with the Desktop Central server. Once the connection is established, the configured software details from Desktop Central server are fetched.

1. Click Admin tab in the header pane to open the configuration wizard page.

2. Click Desktop Central Server Settings icon under General block.
3. In the Desktop Central Server Settings page, enter the **Server where DesktopCentral application** is installed.

4. Enter the **Port Number** of the DesktopCentral server.

5. Select the **Protocol Settings**. Say, http or https. If the Desktop Central Server is running in https mode, refer SDP-DC integration with DC in Https mode, to know more on establishing connection.

6. Click **Save**. Clicking on Save, saves the settings, sets up a connection between ServiceDesk Plus and Desktop Central servers and fetches the software details from DC.

ServiceDesk Plus automatically sync with Desktop Central server for configured software packages day-to-day. So, if you need to fetch the configured software packages instantly, select **click here** link.

**Step 2: Configuring a Role to perform the DC operation**

The Desktop Central Integration operations is restricted to technicians with specific permissions. This privilege can be obtained by enabling Install/Uninstall Software under Asset Fine Grained Authorization under Roles.

1. Click **Admin -> Roles** icon under Users block.
2. Click **Add New Roles** link.
3. Select **Install and Uninstall Software** under Advanced Permission block.
4. Save the details.
Step 3: Assigning the Role to a Technician

Once the specific role for Desktop Central operation is created, enable login permission to the technician and assign this role. This technician now has the privilege to perform Desktop Central operation on service requests.

Step 4: Enabling Template Actions for a Service Request

Apart from providing technicians with the privilege to perform Desktop Central operations, an option to "Display Install/Uninstall software in the service request details page" should be enabled. Since all service requests do not require Desktop Central operations, this activity is limited by providing a Template Action check box in each service item form.

The Template Action option is available under the Rules tab of a service item.

This functionality is available only when Desktop Central 7.0 and above is integrated with ServiceDesk Plus. If the integration is not established, this option is grayed.
Authentication mechanism between the two applications

The authentication between ServiceDesk Plus and Desktop Central is through an application level key that functions as a handshake mechanism between the two applications. A unique key is generated for a technician in ServiceDesk Plus application.

1. Click Admin -> Technicians icon under User block.
2. Click the edit icon beside the technician to generate the API key. Please note that the technician should be enabled with login permission.
3. Click Generate. If a key is already generated for the technician, a Re-generate link appears.

The generated key is specified as the Authentication Key under ServiceDesk Settings in Desktop Central application. So whenever Desktop Central contacts ServiceDesk Plus, the authentication key is passed. This key is validated against ServiceDesk Plus database and if found valid, the process continues, else an error is thrown.
Handling desktop management activities from ServiceDesk Plus

Since the whole idea of this Integration is to perform regular desktop management activities from ServiceDesk Plus application, the softwares list available for install/uninstall is fetched from Desktop Central periodically and populated in ServiceDesk Plus database.

So when an end-user raises a service request for "installing a software", the technician with Desktop Central role can log into ServiceDesk Plus application and perform the installation operation.

Performing desktop management activities

From the request details page of the service request, click Actions drop down -> Install/Uninstall software option. The Install/Uninstall Software page pops up.

Package Settings

1. Select the Installer Type, whether the software to be installed is of the format MSI or EXE.
2. The list of softwares under the selected Installer Type is listed under Package Name. Choose the software from the drop down.
3. Specify the name of the user for which the installation should run in Run As field.
4. Enter the Password of the specified user.
5. The type of operation, say Install or Uninstall is listed in Operation Type drop down. If the Installer Type is MSI, the operation type consists of Install, Advertise and Uninstall. For EXE, the operation type consists of Install and Uninstall.
6. If the execution file is in a network share, then the file or folder can be copied to the client machine by selecting the option from Copy Option drop down.

Deployment Settings

1. The domains available in ServiceDesk Plus is listed under the Domain drop down. Select the domain of the user/workstation.
2. The installation can be for a user or a workstation. Select the option from Install for drop down.
3. You can set and schedule the installation operation. If the Install for is selected as User, the installation can occur During or after Login into the machine, during login or after login. Similarly for a workstation, the installation can occur During Startup, After Startup, During or After Startup.
4. You can also schedule a time for the deployment operation by enabling the check box beside Schedule Operation check box. Select the Schedule Date and Time using the calendar icon.
5. Set the **Reboot Policy** from the drop down. You can either force a reboot when the user logs into the machine, force a shutdown when the user has logged in or allow the users to skip the reboot/shutdown.

**Selecting Users/Workstations**

1. You can select the Users/Workstations for the installation from the icon ![Select User/Workstation](image). The Users/Workstations under the selected domain is listed in a pop up window. **NOTE:** Selecting Users/Workstations depends on the Install for option under Deployment Settings. If you have selected Users, Select Users appears and vice versa.

2. Enable the check box beside the user/workstation.

3. Click **Select User/Workstation** button. The users/workstations are listed under Selected Users/Workstation. Click **Select Users/Workstation and Close** button to add the users/workstations to the list and close the pop up window.

4. **Save** the details.

On saving, a task is generated for the request in ServiceDesk Plus application. Simultaneously, a request is generated in Desktop Central with the form values, along with a call back url. Desktop Central validates the request and if valid, proceeds with the specified task.

Once the operation is executed, Desktop Central sends the updated information using the call back url for that specific task. The authentication key is sent along with the task. This key is validated against ServiceDesk Plus database and if found valid, the status of the task is updated in SDP application. If the authentication key is invalid, an error is thrown and the status is not updated.

**Note**
The other possibilities for which the status is not updated in SDP application,
- The request is deleted from the list.
- The request is moved to archive state.

**Enabling Notification to Technician**

Once the software installation/uninstallation task is performed and the status is updated by Desktop Central, you can enable notification to the concerned technician regarding the update under Notification Rules.

1. Click **Admin -> Notification Rules** icon under Helpdesk block.

2. In the Request section, Enable **"Notify Technician when a software Installation/Uninstallation task is updated"** check box.

3. **Save** the details.
Integration when Desktop Central is running in Https mode

If Desktop Central Server is running in Https mode, then the following steps should be followed to establish connection between ServiceDesk Plus and Desktop Central servers.

1. Download the .zip file from the link given below and extract it to ManageEngine\ServiceDesk
2. Connect to the command prompt. Goto ManageEngine\ServiceDesk and run the batch file with following format:
   C:>ManageEngine\ServiceDesk\gencert.bat  dcservername:portnumber
3. On running the command, you will receive an exception PKIX and then it will ask you to enter a value. Provide value 1 which will generate a file named jssecacerts under ManageEngine\ServiceDesk.

Copy the jssecacerts file under ManageEngine\ServiceDesk\jre\lib\security folder and then restart the ServiceDesk Plus application.
ServiceDesk Plus API

- Purpose of API in ServiceDesk Plus
- API Types and supported Operations
- Procedure
  - Servlet API
  - REST API
- Difference between Servlet and REST API
- Future Enhancements

Purpose of API in ServiceDesk Plus

Application Programming Interface (API) is used to integrate various applications and facilitate sharing of data between them. The integration can be achieved with any third party (external) applications or web services that is capable of sending the data via http protocol.

With API, ServiceDesk Plus operations can be accessed from other applications or web services. In case of request operations, it provides a convenient method to raise requests (other than the default e-mail or web form) directly into ServiceDesk Plus without logging into the application. If required, you can also have an option to create your own web form for using API.

API Types and supported Operations

ManageEngine ServiceDesk Plus supports both Servlet and REST API. While the functionality are similar for both, Servlet consists of http form based submission whereas, REST conforms to the REST specifications. Both the api methods can be implemented simultaneously in the application provided, the operation is performed with the corresponding syntax definitions.

The servlet Http form submission based API supports operations such as,

- Adding new request, editing, closing, deleting, viewing existing requests and adding notes for existing requests.
- Adding new site, editing and deleting the existing site.
- Adding new technician, editing and deleting the existing technician.
- Adding new requester, editing and deleting the existing requester.
- Adding a workstation/server, updating a workstation/server, adding an asset, updating an asset and deleting assets.

While the REST API supports only request related operations such as,

- Adding new request, editing, closing, deleting and viewing existing requests.
- Adding new notes to a request, editing, deleting and viewing existing notes.
- Adding worklog to a request, editing, deleting and viewing existing worklogs.
Difference between Servlet and REST API

<table>
<thead>
<tr>
<th>Servlet API</th>
<th>REST API</th>
</tr>
</thead>
<tbody>
<tr>
<td>The servlet is a form based input submission by the external applications. While the output is exposed in XML format.</td>
<td>The input data is sent as an XML string and the output is exposed as an XML string.</td>
</tr>
<tr>
<td>Authentication is through User Name and Password for every API operation.</td>
<td>Authentication is through Technician Key for every API operation.</td>
</tr>
<tr>
<td>Supports operations on features such as Request, Site, Technician, Requester and Assets.</td>
<td>Supports operations on Requests alone.</td>
</tr>
</tbody>
</table>

Future Enhancements
- Support the remaining modules namely problem, change, purchase, contracts, cmdb and admin.
Servlet API

- About Servlet API
- Servlet API Supported Operations
- Troubleshooting Tips

About Servlet API
Servlet http form based submission is one of the methods of API in SDP. In this case, a html form is created directly from the web browser or by plugging in small piece of code in the integrating applications. This form helps users to access ServiceDesk Plus from other applications.

Scenario:
Say for instance, the html form for creating requests is exposed in your organization's intranet. Users can use this form to raise requests instantly in ServiceDesk Plus without accessing the application. The result of the operation contains the status of the operation and key information such as the request ID.

Similar operations can be performed on requests, sites, technician, requesters and assets from the external application, for which the sample forms are shown in the following documents.

The field values to be set in Request, Site, Technician, Requester and Assets are added as parameters in HttpRequest details. The fields unavailable in the form are set as empty (or default). The Operation performed is decided based on the http parameter 'operation'. The html form is submitted to /servlets/RequestServlet as,

http://machine_name:Port_Number/servlets/RequestServlet

URL or submitting the request programmatically to the above link. Authorization to the ServiceDesk Plus server is based on the username and password provided.
Servlet API supported operations

The servlet Http form submission based API supports operations such as,

- Adding new request, editing, closing, adding notes, deleting and viewing a request.
- Adding new site, editing a site and deleting a site.
- Adding new technician, editing and deleting technician.
- Adding a new requester, editing and deleting requester.
- Adding a workstation/server, updating a workstation/server, adding an asset, updating an asset and deleting assets.

Troubleshooting Tips

If login failed for a correct userName and password,

1. Check if the user is imported from Active Directory.
2. If user is not imported from Active Directory, then submit only the username and password to the below link for authentication. http://machinename:portname/servlets/RequestServlet
3. If user is imported from Active Directory, then submit the username and password along with DOMAIN_NAME and logonDomainName to the below link for authentication. http://machinename:portname/servlets/RequestServlet

| Note | DOMAIN_NAME represents the Domain to which the User belongs, logonDomainName represents Authentication Mode, Local Authentication or empty value refers to Local Authentication mode, and AD_AUTH refers to Active Directory Authentication Mode. |

ZOHO Corp.
Request Attributes and xml Response

The request attributes for all request operations should be defined as mentioned. The operations on requests are based on the "Roles" assigned to the users.

**Note**
1. Attributes are case sensitive and should be used as defined.
2. Operations on request can be performed based on the Roles assigned to the user.
3. While renaming the button in the sample html form, specify 'operation' as hidden element.

- Add Request
- Updating Request
- Assign Request
- Close Request
- Delete Request
- Add Notes
- Add WorkLog
- Delete WorkLog
- Get Request

### Add Request

The details necessary for Adding a Request should be set in http request parameters and the 'operation' command should be 'AddRequest'.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/RequestServlet&quot;</td>
<td>Operation target url for Adding Request</td>
</tr>
<tr>
<td>operation='AddRequest'</td>
<td>Operation command for Adding Request</td>
</tr>
<tr>
<td>reqTemplate</td>
<td>name of the Request Template</td>
</tr>
<tr>
<td>title</td>
<td>Subject of the request</td>
</tr>
<tr>
<td>description</td>
<td>Description of the request</td>
</tr>
<tr>
<td>resolution</td>
<td>Resolution</td>
</tr>
<tr>
<td>requester</td>
<td>Requester</td>
</tr>
<tr>
<td>requesterEmail</td>
<td>Email Id of Requester</td>
</tr>
<tr>
<td>priority</td>
<td>Priority</td>
</tr>
<tr>
<td>level</td>
<td>Level</td>
</tr>
<tr>
<td>status</td>
<td>Status</td>
</tr>
<tr>
<td>mode</td>
<td>Mode</td>
</tr>
<tr>
<td>urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Attribute</td>
<td>Comment</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>impactDetails</td>
<td>Impact Details</td>
</tr>
<tr>
<td>requesttype</td>
<td>RequestType</td>
</tr>
<tr>
<td>site</td>
<td>Site</td>
</tr>
<tr>
<td>category</td>
<td>Category</td>
</tr>
<tr>
<td>subcategory</td>
<td>SubCategory</td>
</tr>
<tr>
<td>item</td>
<td>Item</td>
</tr>
<tr>
<td>group</td>
<td>Group</td>
</tr>
<tr>
<td>technician</td>
<td>Technician Name</td>
</tr>
<tr>
<td>technicianEmail</td>
<td>Technician EmailID</td>
</tr>
<tr>
<td>UDF Alias Name</td>
<td>name of the UDF field specified while creating the field.</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs. Domain Name needs to be specified on selecting AD authentication.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. AD_AUTH refers to Active Directory Authentication. Local Authentication or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

**Note:**

1. Requester and Technician is identified based on their **UserName** and **EmailID**.
2. While creating a request in Requester Login, the **Site** field is set with the site of the requester.
3. For a Technician login, **Not in Any Site** is specified by empty value or ‘NULL’ for site.
4. While creating request through Requester Login, the Requester is restricted to create request for the asset associated to him/her only if **Show workstations associated to requester in Self-Service Portal** is selected under Admin -> Self Service Portal Settings.
5. If a Technician (with restricted access permissions) creates request for a site unassociated to him, then the Request Site field is set as ‘Not In Any Site’.
6. If a Technician (with restricted access permissions) creates a request for the site specified in the template, the Request Site field is set as ‘Not in Any Site’.
7. While creating a request, if **Subject** field is left empty, then '(no subject)' is set as subject for the Request.
8. If a field is not available for a request template but given through API, then the field is discarded.
9. If the **Requester** information is not provided, then the logged in user is set as the Requester for the request.
10. While creating a request, if the mandatory fields specified in Request Template are not provided, then the request is created with the information provided by RequestServlet and a System Log is populated with an error message.

The sample form to create request can be accessed here.

The html form is submitted to http://machine_name:Port Number/servlets/RequestServlet and a response in xml format displays "Success" message along with the WorkOrder ID.

If the technician creating the request does not have permission to create new requests or has limited
access permissions then a "Failure" message appears in the xml form.

**Update Request**

The details to be updated should be set in the http request parameters along with 'workOrderID' parameter. The 'workOrderID' parameter is mandatory for request update. The 'operation' command should be 'UpdateRequest'. Requesters do not have permission to update requests.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/RequestServlet&quot;</td>
<td>Operation target url for updating Request</td>
</tr>
<tr>
<td>operation='UpdateRequest'</td>
<td>Operation command for Updating Request</td>
</tr>
<tr>
<td>workOrderID</td>
<td>Request ID of the request to update.</td>
</tr>
<tr>
<td>reqTemplate</td>
<td>name of the Request Template</td>
</tr>
<tr>
<td>title</td>
<td>Subject of the request</td>
</tr>
<tr>
<td>description</td>
<td>Description of the request</td>
</tr>
<tr>
<td>resolution</td>
<td>Resolution</td>
</tr>
<tr>
<td>requester</td>
<td>Requester</td>
</tr>
<tr>
<td>requesterEmail</td>
<td>Email Id of Requester</td>
</tr>
<tr>
<td>priority</td>
<td>Priority</td>
</tr>
<tr>
<td>level</td>
<td>Level</td>
</tr>
<tr>
<td>duebytime</td>
<td>Due By time to be applied for the request</td>
</tr>
<tr>
<td>status</td>
<td>Status</td>
</tr>
<tr>
<td>mode</td>
<td>Mode</td>
</tr>
<tr>
<td>urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>impact</td>
<td>Impact</td>
</tr>
<tr>
<td>impactDetails</td>
<td>Impact Details</td>
</tr>
<tr>
<td>requesttype</td>
<td>RequestType</td>
</tr>
<tr>
<td>site</td>
<td>Site</td>
</tr>
<tr>
<td>category</td>
<td>Category</td>
</tr>
<tr>
<td>subcategory</td>
<td>SubCategory</td>
</tr>
<tr>
<td>item</td>
<td>Item</td>
</tr>
<tr>
<td>group</td>
<td>Group</td>
</tr>
<tr>
<td>technician</td>
<td>Technician Name</td>
</tr>
<tr>
<td>technicianEmail</td>
<td>Technician EmailID</td>
</tr>
<tr>
<td>UDF Alias Name</td>
<td>name of the UDF field specified while creating the field.</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs. Domain Name needs to be specified on selecting AD authentication.</td>
</tr>
</tbody>
</table>
Man in a Engine ServiceDesk Plus 8.0  :: Admin Guide

logonDomainName | Authentication Mode [AD or Local Authentication].
 "AD_AUTH" refers to Active Directory Authentication.
 "Local Authentication" or empty value refers to Local Authentication.

**Note:**
1. Requester and Technician is identified based on their **UserName** and **EmailID**.
2. Empty Values can be updated to request by passing the value as **NULL**.
3. Requester cannot update a request.

A sample form for updating requests can be viewed here.

A Success message appears in a xml format if the request is updated successfully.

If the technician does not have permission to update the request ( Edit Request permission under Roles), a Failure message appears in the xml form.

In some cases, the technicians view permission is restricted say, a technician with the permission to view only
"Requests assigned to him" cannot update requests assigned to other technicians.

Similarly, technicians who are associated to "not associated in any site" option have permission to update requests assigned to him and requests not associated to any sites. Click here to view the xml response.

**Assign Request**

Assign Request is similar to Update Request except the Technician Name should be set in the request parameters along with workOrderID’ parameter. The 'workOrderID' parameter is mandatory for assigning a request to other technicians. The 'operation' command should be 'UpdateRequest'. Requester does not have permission for updating a request.

The sample form for assigning/picking up request is similar to that of Updating requests. Requests are assigned to technicians associated to the specified site. If Group is mentioned then the technician should be assigned to the group. If the request is assigned to a technician unassociated to the site, the response in xml format does not display an error message and the request is not assigned to the technician.

**Close Request**

A request can be closed in two ways,
- Set the 'status' parameter as 'Closed' along with the 'workOrderID' parameter (mandatory parameter) and operation command as 'UpdateRequest'.
- Set 'workOrderID' parameter (mandatory for request update) and 'operation' command as 'CloseRequest'. Set the 'Close comments' parameter as 'closeComment'. The Close Comment can be added, if 'Confirm User Acknowledgment' is selected as 'YES' in 'Request Closing Rules'. Requester does not have permission for closing a request.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/RequestServlet&quot;</td>
<td>Operation target url for closing Request</td>
</tr>
<tr>
<td>operation='CloseRequest'</td>
<td>Operation command for closing Request</td>
</tr>
<tr>
<td>workOrderID</td>
<td>Request ID of the request to close.</td>
</tr>
<tr>
<td>closeComment</td>
<td>Close Comments</td>
</tr>
<tr>
<td><strong>Attribute</strong></td>
<td><strong>Comment</strong></td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs. Domain Name needs to be specified on selecting AD authentication.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. &quot;AD_AUTH&quot; refers to Active Directory Authentication. &quot;Local Authentication&quot; or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

The sample form to close request can be accessed here.

A success message appears in xml format on submitting the form to http://macine_name:Port_Number/servlets/RequestServlet.

At time if the request ID mentioned does not exist then "WorkOrder not found for ID : 20" appears in the xml form.

If the technician has restricted access permission or does not have permission to close the request then a Warning message appears in the xml form.

**Delete Request**

The 'workOrderID' parameter should be set in the http request parameters along with the 'operation' command as 'DeleteRequest'. Requester does not have permission for deleting a request.

<table>
<thead>
<tr>
<th><strong>Attribute</strong></th>
<th><strong>Comment</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/RequestServlet&quot;</td>
<td>Operation target url for deleting Request</td>
</tr>
<tr>
<td>operation='DeleteRequest'</td>
<td>Operation command for Deleting Request</td>
</tr>
<tr>
<td>workOrderID</td>
<td>Request ID of the request to delete.</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs. Domain Name needs to be specified on selecting AD authentication.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. &quot;AD_AUTH&quot; refers to Active Directory Authentication. &quot;Local Authentication&quot; or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

The sample form to delete requests can be viewed here.

A Success message appears if the technician has permission to delete the request.

If a technician without delete permission or with restricted viewing permission, is trying to delete a request then a Failure message appears as the xml response.
Add Notes
The parameters namely, 'Notes', 'isPublic', 'workOrderID' should be set in the http request parameters along with the 'operation' command as 'AddNotes'.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/RequestServlet&quot;</td>
<td>Operation target url for adding notes to request</td>
</tr>
<tr>
<td>operation='AddNotes'</td>
<td>Operation command for closing Request</td>
</tr>
<tr>
<td>workOrderID</td>
<td>Request ID of the request to add notes</td>
</tr>
<tr>
<td>notesText</td>
<td>Notes to be added to the given Request Id</td>
</tr>
<tr>
<td>isPublic</td>
<td>isPublic=true denotes Public Notes</td>
</tr>
<tr>
<td></td>
<td>isPublic=false denotes Private Notes</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs. Domain Name needs to be specified on selecting AD authentication.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. AD_AUTH refers to Active Directory Authentication. Local Authentication or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

The sample form to add notes can be accessed here.
Technicians with permission over request module can add notes. A Success message appears if the note is added successfully.
At times, technicians may not have permission (Edit permission under Roles) or their access is restricted for which a Failure message appears.

Add WorkLog
The 'workOrderID' parameter along with the 'operation' command as 'AddWorkLog' should be sent to the http request parameters. Only technicians have permission to add worklog.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/RequestServlet&quot;</td>
<td>Operation target url for adding notes to request</td>
</tr>
<tr>
<td>operation='AddWorkLog'</td>
<td>Operation command for adding worklog to request</td>
</tr>
<tr>
<td>workOrderID</td>
<td>Request ID</td>
</tr>
<tr>
<td>technician</td>
<td>Technician Resolving the Request</td>
</tr>
<tr>
<td>technicianEmail</td>
<td>Email-ID of technician Resolving the Request</td>
</tr>
<tr>
<td>description</td>
<td>description</td>
</tr>
<tr>
<td>workHours</td>
<td>Time Taken To Resolve in hours</td>
</tr>
<tr>
<td>workMinutes</td>
<td>Time Taken To Resolve in minutes</td>
</tr>
<tr>
<td>cost</td>
<td>Incident Cost</td>
</tr>
<tr>
<td>executedTime</td>
<td>Executed Time</td>
</tr>
<tr>
<td>Attribute</td>
<td>Comment</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs. Domain Name needs to be specified on selecting AD authentication.</td>
</tr>
</tbody>
</table>
| logonDomainName    | Authentication Mode [AD or Local Authentication].  
|                    | AD_AUTH refers to Active Directory Authentication.                      |
|                    | Local Authentication or empty value refers to Local Authentication.      |

**Note:**

1. If the fields, 'technician' and 'technicianEmail' is left unfilled, the logged in technician is considered as the technician resolving the request.
2. If the 'cost' field remains empty, then 'cost per hour' will be taken as the Incident Cost.
3. If the execution time is left unfilled, the current time is taken as the 'execution time'.
4. The Execution Time should be in the format 'dd MMM yyyy, HH:mm:ss[08 Nov 2009, 21:15:26]'.

The sample form to add WorkLog can be accessed here.

A Success message appears along with the 'requestChargeID' in xml format on submitting the form to http://machine_name:Port_Number/servlets/RequestServlet.

If the technician is not provided with the role to add worklog a Failure message appears in the xml response.

At times, the access to view requests is restricted for which a Failure message appears in xml form. Click here to view the response.

**Delete WorkLog**

The 'requestChargeID' parameter along with the 'operation' command as 'DeleteWorkLog' should be set in the http request parameters. Only technicians have the permission to delete worklogs. The requestChargeID is provided while adding the worklog.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/RequestServlet&quot;</td>
<td>Operation target url for deleting worklog</td>
</tr>
<tr>
<td>operation='DeleteWorkLog'</td>
<td>Operation command for Deleting worklog</td>
</tr>
<tr>
<td>requestChargeID</td>
<td>WorkLog ID to delete</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs. Domain Name needs to be specified on selecting AD authentication.</td>
</tr>
</tbody>
</table>
| logonDomainName        | Authentication Mode [AD or Local Authentication].  
|                       | "AD_AUTH" refers to Active Directory Authentication.                      |
|                       | "Local Authentication" or empty value refers to Local Authentication.      |

The Delete WorkLog sample form can be accessed here.
The worklog is deleted successfully if the technician has permission to delete the WorkLog. Click here to view the xml response.

**Get Request**

The 'workOrderID' parameter should be set in the http request parameters along with the 'operation' command as 'GetRequestDetails'. Requester does not have permission for deleting a request.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetRequestDetails</td>
<td>Operation command for Getting Request Details</td>
</tr>
<tr>
<td>workOrderID</td>
<td>Request ID</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs. Domain Name needs to be specified on selecting AD authentication.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication].</td>
</tr>
<tr>
<td></td>
<td>AD_AUTH refers to Active Directory Authentication.</td>
</tr>
<tr>
<td></td>
<td>Local Authentication or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

The sample form to view the request details can be accessed here.

The request details is displayed as the response in xml if the technician has permission to view requests. The fields unspecified in the form are set as 'null' as shown.

A failure message appears as shown if the technician does not have permission to view requests or has restricted access permission.
Site Attributes and xml Response

The site attributes along with their actions should be used as defined below.

<table>
<thead>
<tr>
<th><strong>Note</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The site operations that can be performed through API are adding, updating and deleting sites.</td>
</tr>
<tr>
<td>2. Site operations can be performed by technicians only with administrator privilege. The Site Administrator can neither add, edit nor delete a site.</td>
</tr>
<tr>
<td>3. The attributes are case sensitive and should be used as defined.</td>
</tr>
<tr>
<td>4. While renaming the button in the sample html form, specify 'operation' as hidden element.</td>
</tr>
</tbody>
</table>

- Add Site
- Update Site
- Delete Site

Add Site

The details necessary for adding a site should be set in HttpRequest parameters and HttpRequest parameter value for operation attribute should be 'AddSite'.

<table>
<thead>
<tr>
<th><strong>Attributes</strong></th>
<th><strong>Comments</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL==&quot;/servlets/SiteServlet&quot;</td>
<td>target url for adding site</td>
</tr>
<tr>
<td>operation='AddSite'</td>
<td>operation command for Adding site.</td>
</tr>
<tr>
<td>siteName</td>
<td>Organization Name</td>
</tr>
<tr>
<td>description</td>
<td>Description for the site</td>
</tr>
<tr>
<td>region</td>
<td>The Region to which the site belongs</td>
</tr>
<tr>
<td>timeZone</td>
<td>Time Zone of the site</td>
</tr>
<tr>
<td>doorNo</td>
<td>Address of the organization.</td>
</tr>
<tr>
<td>street</td>
<td>Address where the company is located in the specified site.</td>
</tr>
<tr>
<td>landmark</td>
<td>Provide a landmark if required.</td>
</tr>
<tr>
<td>city</td>
<td>City where the company is located.</td>
</tr>
<tr>
<td>postalCode</td>
<td>Address where the company is located in the specified site.</td>
</tr>
<tr>
<td>state</td>
<td>Address where the company is located in the specified site.</td>
</tr>
<tr>
<td>country</td>
<td>Address where the company is located in the specified site.</td>
</tr>
<tr>
<td>email</td>
<td>Email address of the organization.</td>
</tr>
<tr>
<td>phone</td>
<td>contact information of the organization.</td>
</tr>
<tr>
<td>fax</td>
<td>Fax number of the organization.</td>
</tr>
<tr>
<td>webUrl</td>
<td>website of the organization.</td>
</tr>
</tbody>
</table>
| OperationalHoursSettings | Related Settings for Operational hours of the site. Allowed values:
<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>HolidaysSettings</td>
<td>Related Settings for Holidays setting of the site. Allowed values:</td>
</tr>
<tr>
<td></td>
<td><strong>copy</strong> (Copy Default Settings), <strong>refer</strong> (Refer Default Settings),</td>
</tr>
<tr>
<td></td>
<td><strong>custom</strong> (Custom Settings)</td>
</tr>
<tr>
<td>DepartmentsSettings</td>
<td>Related Settings for Departments setting of the site. Allowed values:</td>
</tr>
<tr>
<td></td>
<td><strong>copy</strong> (Copy Default Settings), <strong>custom</strong> (Custom Settings)</td>
</tr>
<tr>
<td>TechSiteAssociationSettings</td>
<td>Related Settings for Technicians/Site Association setting of the site.</td>
</tr>
<tr>
<td></td>
<td>Allowed values: <strong>copy</strong> (Copy Default Settings), <strong>refer</strong> (Refer Default Settings), <strong>custom</strong> (Custom Settings)</td>
</tr>
<tr>
<td>GroupsSettings</td>
<td>Related Settings for Groups setting of the site. Allowed values:</td>
</tr>
<tr>
<td></td>
<td><strong>copy</strong> (Copy Default Settings), <strong>refer</strong> (Refer Default Settings),</td>
</tr>
<tr>
<td></td>
<td><strong>custom</strong> (Custom Settings)</td>
</tr>
<tr>
<td>BusinessRulesSettings</td>
<td>Related Settings for Business Rules setting of the site. Allowed values:</td>
</tr>
<tr>
<td></td>
<td><strong>copy</strong> (Copy Default Settings), <strong>refer</strong> (Refer Default Settings),</td>
</tr>
<tr>
<td></td>
<td><strong>custom</strong> (Custom Settings)</td>
</tr>
<tr>
<td>SLASettings</td>
<td>Related Settings for Service Level Agreements setting of the site. Allowed values:</td>
</tr>
<tr>
<td></td>
<td><strong>copy</strong> (Copy Default Settings), <strong>refer</strong> (Refer Default Settings),</td>
</tr>
<tr>
<td></td>
<td><strong>custom</strong> (Custom Settings)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Login Name for SDP Authentication</th>
<th>SDP Authentication</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Domain Name to which the user belongs. Domain Name should be specified on enabling AD authentication.</th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Authentication Mode [AD or Local Authentication]. &quot;AD_AUTH&quot; refers to Active Directory Authentication. &quot;Local Authentication&quot; or empty value refers to Local Authentication.</th>
<th></th>
</tr>
</thead>
</table>

**Note:**

1. If the Region specified for the site is not configured in the ServiceDesk Plus, then the region field does not get populated in the application.

2. If any of the Related Settings other than DepartmentSettings is left unselected, 'Refer Default Settings' option is selected is selected as default. In the case of DepartmentSettings, Custom Default Settings is selected by default.
3. If any of the following namely, TechSiteAssociationSettings, GroupsSettings, BusinessRulesSettings or SLASettings is selected as Refer Default Settings, the other three is set to refer in the application.

4. Technicians with SDSiteAdmin role have the privilege to edit the site information. However, they cannot edit 'Related Settings.'

The sample form to add a new site can be viewed here.

The html form is submitted to http://machinename:Portnumber/servlets/SiteServlet and a response in xml format displays Success message along with the Site ID.

A failure message appears if,
- A technician without admin permission is trying to add a new site. [xml response]
- The specified site name already exist. [xml response]

**Update Site**

The details to be updated should be set in the http request parameters with the 'operation' command as 'Update'. It is a mandatory field while updating a site.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=<code>/servlets/SiteServlet</code></td>
<td>target url for adding site</td>
</tr>
<tr>
<td>operation='UpdateSite'</td>
<td>operation command for Adding site.</td>
</tr>
<tr>
<td>oldSiteName</td>
<td>Site Name for update</td>
</tr>
<tr>
<td>siteName</td>
<td>New Organization Name</td>
</tr>
<tr>
<td>description</td>
<td>Description for the site</td>
</tr>
<tr>
<td>region</td>
<td>The Region to which the site belongs</td>
</tr>
<tr>
<td>timeZone</td>
<td>Time Zone of the site</td>
</tr>
<tr>
<td>doorNo</td>
<td>Address of the organization.</td>
</tr>
<tr>
<td>street</td>
<td>Address where the company is located in the specified site.</td>
</tr>
<tr>
<td>landmark</td>
<td>Provide a landmark if required.</td>
</tr>
<tr>
<td>city</td>
<td>City where the company is located.</td>
</tr>
<tr>
<td>postalCode</td>
<td>Address where the company is located in the specified site.</td>
</tr>
<tr>
<td>state</td>
<td>Address where the company is located in the specified site.</td>
</tr>
<tr>
<td>country</td>
<td>Address where the company is located in the specified site.</td>
</tr>
<tr>
<td>email</td>
<td>Email address of the organization.</td>
</tr>
<tr>
<td>phone</td>
<td>contact information of the organization.</td>
</tr>
<tr>
<td>fax</td>
<td>Fax number of the organization.</td>
</tr>
<tr>
<td>webUrl</td>
<td>website of the organization.</td>
</tr>
<tr>
<td>OperationalHoursSettings</td>
<td>Related Settings for Operational hours of the site. Allowed values:</td>
</tr>
<tr>
<td>Attributes</td>
<td>Comments</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HolidaysSettings</td>
<td>Related Settings for Holidays setting of the site. Allowed values:</td>
</tr>
<tr>
<td></td>
<td>copy (Copy Default Settings),</td>
</tr>
<tr>
<td></td>
<td>refer (Refer Default Settings),</td>
</tr>
<tr>
<td></td>
<td>custom (Custom Settings)</td>
</tr>
<tr>
<td>DepartmentsSettings</td>
<td>Related Settings for Departments setting of the site.</td>
</tr>
<tr>
<td></td>
<td>Allowed values:</td>
</tr>
<tr>
<td></td>
<td>copy (Copy Default Settings),</td>
</tr>
<tr>
<td></td>
<td>custom (Custom Settings)</td>
</tr>
<tr>
<td>TechSiteAssociationSettings</td>
<td>Related Settings for Technicians/Site Association setting of the site.</td>
</tr>
<tr>
<td></td>
<td>Allowed values:</td>
</tr>
<tr>
<td></td>
<td>copy (Copy Default Settings),</td>
</tr>
<tr>
<td></td>
<td>refer (Refer Default Settings),</td>
</tr>
<tr>
<td></td>
<td>custom (Custom Settings)</td>
</tr>
<tr>
<td>GroupsSettings</td>
<td>Related Settings for Groups setting of the site.</td>
</tr>
<tr>
<td></td>
<td>Allowed values:</td>
</tr>
<tr>
<td></td>
<td>copy (Copy Default Settings),</td>
</tr>
<tr>
<td></td>
<td>refer (Refer Default Settings),</td>
</tr>
<tr>
<td></td>
<td>custom (Custom Settings)</td>
</tr>
<tr>
<td>BusinessRulesSettings</td>
<td>Related Settings for Business Rules setting of the site.</td>
</tr>
<tr>
<td></td>
<td>Allowed values:</td>
</tr>
<tr>
<td></td>
<td>copy (Copy Default Settings),</td>
</tr>
<tr>
<td></td>
<td>refer (Refer Default Settings),</td>
</tr>
<tr>
<td></td>
<td>custom (Custom Settings)</td>
</tr>
<tr>
<td>SLASettings</td>
<td>Related Settings for Service Level Agreements setting of the site.</td>
</tr>
<tr>
<td></td>
<td>Allowed values:</td>
</tr>
<tr>
<td></td>
<td>copy (Copy Default Settings),</td>
</tr>
<tr>
<td></td>
<td>refer (Refer Default Settings),</td>
</tr>
<tr>
<td></td>
<td>custom (Custom Settings)</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs. The Domain Name should be specified</td>
</tr>
<tr>
<td></td>
<td>on enabling AD authentication.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. &quot;AD_AUTH&quot; refers to</td>
</tr>
<tr>
<td></td>
<td>Active Directory Authentication.</td>
</tr>
<tr>
<td></td>
<td>&quot;Local Authentication&quot; or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>
The sample form to update sites can be viewed here.
A Success message appears in the xml form when the site details are updated successfully.

**Delete Site**

The 'siteName' parameter along with the operation command as 'DeleteSite' should be set in HttpRequest parameters.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/SiteServlet&quot;</td>
<td>target url for Adding site</td>
</tr>
<tr>
<td>operation='DeleteSite'</td>
<td>operation command for deleting site</td>
</tr>
<tr>
<td>siteName</td>
<td>Organization Name</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication].</td>
</tr>
<tr>
<td></td>
<td>AD_AUTH refers to Active Directory Authentication.</td>
</tr>
<tr>
<td></td>
<td>Local Authentication or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

The sample form to delete site can be accessed here.
A Success message appears in xml format once the site is deleted successfully.
A Failure message appears if,
- A SiteAdmin is trying to delete the sites. [xml response]
- If the site is used by a module. [xml response]
Technician Attributes and xml Response

The technician attributes along with their actions should be used as defined below.

Note

1. The technician operations that can be performed through API are adding, updating and deleting.
2. Only technicians with roles of SDAdmin and SDSiteAdmin can perform add, update and delete operations.
3. The attributes are case sensitive and should be used as defined.
4. While renaming the button in the sample html form, specify 'operation' as hidden element.

- Add Technician
- Update Technician
- Delete Technician

Add Technician

The details necessary for adding a technician should be set in HttpRequest parameters and Httprequest parameter value for operation attribute should be 'AddTechnician'.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL= */servlets/TechnicianServlet&quot;</td>
<td>target url for Adding technician</td>
</tr>
<tr>
<td>operation=AddTechnician'</td>
<td>operation command for Adding technician.</td>
</tr>
<tr>
<td>name</td>
<td>Technician name</td>
</tr>
<tr>
<td>employeeId</td>
<td>Employee ID of the technician</td>
</tr>
<tr>
<td>email</td>
<td>Email Address of the technician</td>
</tr>
<tr>
<td>phone</td>
<td>Phone Number of the technician</td>
</tr>
<tr>
<td>mobile</td>
<td>Mobile number of technician</td>
</tr>
<tr>
<td>smsMailId</td>
<td>SMS mail id of technician</td>
</tr>
<tr>
<td>costPerHr</td>
<td>technician's costperhour</td>
</tr>
<tr>
<td>departmentName</td>
<td>department name to which the technician is associated to.</td>
</tr>
<tr>
<td>techSiteName</td>
<td>site name to which the technician is associated to.</td>
</tr>
<tr>
<td>jobTitle</td>
<td>Job title of the technician</td>
</tr>
<tr>
<td>associateSites</td>
<td>Associated sites of the technician</td>
</tr>
<tr>
<td>associateGroups</td>
<td>Associated groups of the technician</td>
</tr>
<tr>
<td>approvePurchaseOrder</td>
<td>Purchase Order Approver Allowed Values: true,false.</td>
</tr>
<tr>
<td>UDF aliases name</td>
<td>additional fields should be specified based on their column names</td>
</tr>
</tbody>
</table>

ZOHO Corp.
<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>enableLogin</td>
<td>parameter for Enable Login for Technician Allowed Values: true, false.</td>
</tr>
<tr>
<td>loginName</td>
<td>Technician's login name</td>
</tr>
<tr>
<td>pwd</td>
<td>Technician's password</td>
</tr>
<tr>
<td>userDomainName</td>
<td>Domain to which the technician belongs to</td>
</tr>
<tr>
<td>associateRoles</td>
<td>roles associated with the technician</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication].</td>
</tr>
<tr>
<td></td>
<td>&quot;AD_AUTH&quot; refers to Active Directory Authentication.</td>
</tr>
<tr>
<td></td>
<td>&quot;Local Authentication&quot; or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

**Note:**

i. If the technician is associated to many sites, the sites should be specified in comma separated format in 'associateSites' say, India, US, London.

ii. If the technician is assigned to more than one group, the groups should be specified in comma separated format in 'associateGroups' as sitename-groupname'.

iii. If the technician is 'Not associated to any site', specify the value as 'default' in 'associateSites'.

iv. To assign a technician to a department of 'Not associated to any site ', 'techSiteName' should be specified as 'default'.

v. If invalid values are provided for 'departmentName' and 'techSiteName', then technician is associated to 'Not associated to any site'.

vi. 'approvePurchaseOrder' is enabled only when the email ID of the technician is specified. The values permitted for 'approvePurchaseOrder' are 'true' and 'false'. By default, the value is 'false'.

vii. The values permitted for 'enableLogin' are 'true' and 'false'. By default, the value is 'false'.

viii. If 'pwd' is not specified, the pwd for the technician is the same as the specified 'loginName'.

ix. Login is not provided to the technician if 'loginName' is not specified.

x. Technicians with SDSiteAdmin privileges but restricted access permissions can add technicians only for their associated sites.

The sample form to add a new technician can be viewed here.
The html form is submitted to http://machinename:Portnumber/servlets/RequestServlet and a response in xml format displays Success message along with the User ID.

A failure message appears if,

1. a technician without admin privilege is trying to add a technician. [xml response]
2. A technician with restricted access is trying to create a technician not associated to his site. [xml response]
3. the specified technician login name already exists [xml response]
Update Technician

The details necessary for adding a technician should be set in HttpRequest parameters and HttpRequest parameter value for operation attribute should be 'UpdateTechnician'.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL= */servlets/TechnicianServlet&quot;</td>
<td>target url for Updating technician.</td>
</tr>
<tr>
<td>operation='UpdateTechnician'</td>
<td>operation command for Updating technician.</td>
</tr>
<tr>
<td>techUserName</td>
<td>Technician Name to update</td>
</tr>
<tr>
<td>techLoginName</td>
<td>Login Name of the technician</td>
</tr>
<tr>
<td>techDomainName</td>
<td>Domain Name to which technician the technician belongs</td>
</tr>
<tr>
<td>techEmailId</td>
<td>Email ID of the technician</td>
</tr>
<tr>
<td>userid</td>
<td>Technician ID</td>
</tr>
<tr>
<td>name</td>
<td>Technician name</td>
</tr>
<tr>
<td>employeeId</td>
<td>Employee ID of the technician</td>
</tr>
<tr>
<td>email</td>
<td>Email Address of the technician</td>
</tr>
<tr>
<td>phone</td>
<td>Phone Number of the technician</td>
</tr>
<tr>
<td>mobile</td>
<td>Mobile number of technician</td>
</tr>
<tr>
<td>smsMailId</td>
<td>SMS mail id of technician</td>
</tr>
<tr>
<td>costPerHr</td>
<td>technician's costperhour</td>
</tr>
<tr>
<td>departmentName</td>
<td>department name to which the technician is associated to.</td>
</tr>
<tr>
<td>techSiteName</td>
<td>site name to which the technician is associated to.</td>
</tr>
<tr>
<td>jobTitle</td>
<td>Job title of the technician</td>
</tr>
<tr>
<td>associateSites</td>
<td>Associated sites of the technician</td>
</tr>
<tr>
<td>associateGroups</td>
<td>Associated groups of the technician</td>
</tr>
<tr>
<td>UDF aliases name</td>
<td>additional fields should be specified based on their column names.</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. &quot;AD_AUTH&quot; refers to Active Directory Authentication. &quot;Local Authentication&quot; or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

Note:
1. While performing the edit operation, technicians are identified based on the order below,
   i. The users are first identified based on the 'techLoginName' and 'techDomainName'.
   ii. If the 'techDomainName' is not specified, the user is identified based on the 'techLoginName' with 'techDomainName' as an empty value.
   iii. If the technician does not fall under the above criteria, the user is identified based on the 'techEmailid'.
   iv. If the technician is unavailable in the above specified criteria, the technician is identified based on the 'techUserName'.
v. If the technician cannot be identified from the above criteria, then the technician is identified based on ‘userid’.

vi. Based on the reqUserName or reqEmailId, if more than one technicians are identified then the technician details is not updated nor deleted.

2. Login details and ‘approvePurchaseOrder’ value cannot be updated through API.

3. Technicians with SDSiteAdmin privileges but restricted access permissions can add technicians only for their associated sites.

The sample form to update technicians can be accessed here.

A success message appears if the technician is updated successfully.

A failure message appears if,

1. A technician without admin privilege is trying to update a technician. [xml response]

2. A technician with restricted access is trying to update a technician not associated to his site. [xml response]

Delete Technician

The details necessary for adding a technician should be set in HttpRequest parameters and HttpRequest parameter value for operation attribute should be 'UpdateTechnician'.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=</td>
<td>target url for deleting technician</td>
</tr>
<tr>
<td>&quot;/servlets/TechnicianOperationServlet&quot;</td>
<td></td>
</tr>
<tr>
<td>operation='DeleteTechnician'</td>
<td>operation command for deleting technician</td>
</tr>
<tr>
<td>name</td>
<td>technician Name</td>
</tr>
<tr>
<td>loginName</td>
<td>technician's loginName</td>
</tr>
<tr>
<td>domainName</td>
<td>technician's login domain name</td>
</tr>
<tr>
<td>emailId</td>
<td>technician's emailId</td>
</tr>
<tr>
<td>userid</td>
<td>technician id</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. “AD_AUTH” refers to Active Directory Authentication. “Local Authentication” or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

Note:

1. Technician with 'SDAdmin' can be deleted only by other 'SDAdmin'.

The sample form to delete a technician can be viewed here.

The response in xml displays a Success message if the technician has permission to delete technicians.
Requester Attributes and XML Response

The requester attributes along with their actions are given below,

| Note | 1. The requester operations that can be performed through API are adding, updating and deleting requester.  
2. Technicians with restricted access permission can perform add, edit and delete operations on requesters associated to their sites.  
3. The attributes are case sensitive and should be used as defined.  
4. While renaming the button in the sample HTML form, specify 'operation' as hidden element. |

- Add Requester
- Update Requester
- Delete Requester

Add Requester

The details necessary for adding a requester should be set in HttpRequest parameters and Httprequest parameter value for operation attribute should be 'AddRequester'.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/RequesterServlet&quot;</td>
<td>target url for Adding requester</td>
</tr>
<tr>
<td>operation=&quot;Addrequester&quot;</td>
<td>operation command for Adding requester</td>
</tr>
<tr>
<td>name</td>
<td>Requester name</td>
</tr>
<tr>
<td>employeeId</td>
<td>Employee ID of the requester</td>
</tr>
<tr>
<td>description</td>
<td>Description about employee</td>
</tr>
<tr>
<td>email</td>
<td>Email Address of the requester</td>
</tr>
<tr>
<td>phone</td>
<td>Phone Number of the requester</td>
</tr>
<tr>
<td>mobile</td>
<td>Mobile number of requester</td>
</tr>
<tr>
<td>site</td>
<td>site to which requester is associated to</td>
</tr>
<tr>
<td>departmentName</td>
<td>department name to which the requester is associated to</td>
</tr>
<tr>
<td>jobTitle</td>
<td>Job title of the requester.</td>
</tr>
<tr>
<td>requestViewPermission</td>
<td>permission for 'Requester allowed to view'. Allowed Values: OWN REQUEST: for Requester allowed to view-Show only their own requests, DEPARTMENT REQUEST: for Requester allowed to view-Show all their Department requests, SITE REQUEST: for Requester allowed to view-Show all their Site requests</td>
</tr>
<tr>
<td>approvePurchaseOrder</td>
<td>Purchase Order Approver Allowed Values: true, false.</td>
</tr>
</tbody>
</table>
### Attributes

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>UDF aliases name</td>
<td>additional fields should be specified based on their column names</td>
</tr>
<tr>
<td>loginName</td>
<td>login name</td>
</tr>
<tr>
<td>pwd</td>
<td>password</td>
</tr>
<tr>
<td>userDomainName</td>
<td>Domain with which the requester is associated to</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. “AD_AUTH” refers to Active Directory Authentication. “Local Authentication” or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

### Note:

1. If the requester is not associated to any department in a site, the site value is automatically set to 'not associated to any site'.
2. By default, the value for approvePurchase Order is false.
3. ‘approvePurchaseOrder’ is enabled only when the email ID of the requester is available.
4. If 'requestViewPermission' value is vacant, then the value is set as 'Show only their request'.
5. If a technician with 'SDAdmin' role provides values for 'techSiteName' and 'departmentName' which is unavailable in the database, then the requester is associated to the site and department specified in 'techSiteName' and 'departmentName'.
6. If a technician with restricted access permission provides values for 'techSiteName' and 'departmentName' which is unavailable in the database, then the requester is associated to 'Not associated to any site'.

The sample form for adding a new requester can be viewed here.

The html form is submitted to http://machinename:Portnumber/servlets/RequesterServlet and a response in xml format displays Success message along with the userID or Requester ID.

A failure message appears

- If the technician adding the requester is not associated to the site and has restricted access permissions.
- A technician without administrator privilege is trying to add a requester. [Click here to view the xml response]

### Update Requester

The details necessary for updating a requester should be set in HttpRequest parameters and HttpRequest parameter value for operation attribute should be 'Updaterequester'.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=</td>
<td>target url for Updating requester.</td>
</tr>
<tr>
<td>&quot;/servlets/requesterServlet&quot;</td>
<td></td>
</tr>
<tr>
<td>operation=&quot;Updaterequester&quot;</td>
<td>operation command for Updating requester.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Comments</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>reqUserName</td>
<td>Requester Name to update</td>
</tr>
<tr>
<td>reqLoginName</td>
<td>Requester Login Name to update</td>
</tr>
<tr>
<td>reqdomainName</td>
<td>Domain Name to which the requester belongs to</td>
</tr>
<tr>
<td>reqEmailId</td>
<td>Requester Email-Id to update</td>
</tr>
<tr>
<td>userid</td>
<td>Requester Id</td>
</tr>
<tr>
<td>name</td>
<td>Requester name</td>
</tr>
<tr>
<td>employeeId</td>
<td>Employee ID of the requester</td>
</tr>
<tr>
<td>description</td>
<td>Description about employee</td>
</tr>
<tr>
<td>email</td>
<td>Email Address of the requester</td>
</tr>
<tr>
<td>phone</td>
<td>Phone Number of the requester</td>
</tr>
<tr>
<td>mobile</td>
<td>Mobile number of requester</td>
</tr>
<tr>
<td>site</td>
<td>site to which requester is associated to</td>
</tr>
<tr>
<td>departmentName</td>
<td>department name to which the requester is associated to</td>
</tr>
<tr>
<td>jobTitle</td>
<td>Job title of the requester</td>
</tr>
</tbody>
</table>
| requestViewPermission | permission for 'Requester allowed to view'.  
|                   | Allowed Values:  
|                   | OWN REQUEST:for Requester allowed to view- Show only their own requests,  
|                   | DEPARTMENT REQUEST:for Requester allowed to view- Show all their Department requests,  
|                   | SITE REQUEST:for Requester allowed to view- Show all their Site requests  |
| approvePurchaseOrder | Purchase Order Approver  
|                   | Allowed Values: true,false.                                 |
| UDF aliases name  | additional fields should be specified based on their column names |
| loginName        | login name                                                    |
| pwd              | password                                                      |
| userDomainName   | Domain with which the requester is associated to              |
| username         | Login Name for SDP Authentication                             |
| password         | Password for SDP Authentication                               |
| DOMAIN_NAME      | Domain Name to which the user belongs                         |
| logonDomainName  | Authentication Mode [AD or Local Authentication].  
|                   | “AD_AUTH” refers to Active Directory Authentication.  
|                   | “Local Authentication” or empty value refers to Local Authentication. |

**Note:**

1. While performing the edit operation, requesters are identified based on the order below,
   - The users are first identified based on the 'reqLoginName' and 'reqDomainName'.

ZOHO Corp.  522
If the 'reqDomainName' is empty, the user is identified based on the 'reqLoginName' with 'reqDomainName' as an empty value.

If the requester does not fall under the above criteria, the user is identified based on the 'reqEmailId'.

If the requester is unavailable in the above specified criteria, the user is identified based on the 'reqUserName'.

If the user cannot be identified from the above criteria, then the user is identified based on 'userid'.

Based on the reqUserName or reqEmailId, if more than one users are identified then the user is not updated nor deleted.

2. Login information of requesters cannot be edited through API.

3. To enable 'Purchase Order Approver' role while editing a requester, 'email' should be specified along with 'approvePurchaseOrder' even if 'email' has been configured for the requester.

4. Technician associated only to 'Not associated to any site' will not be allowed to create/edit requesters.

5. If a technician with 'SDAdmin' role provides values for 'techSiteName' and 'departmentName' which is unavailable in the database, then the requester is associated to the site and department specified in 'techSiteName' and 'departmentName'.

6. If a technician with restricted access permission provides values for 'techSiteName' and 'departmentName' which is unavailable in the database, then the requester is associated to 'Not associated to any site'.

The sample form to update requester can be accessed here.

The requester details are updated successfully indicated with a Success message in the xml form.

**Delete Requester**

The details necessary for deleting a requester should be set in HttpRequest parameters and Httprequest parameter value for operation attribute should be 'Updaterequester'.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=</td>
<td>target url for deleting requester</td>
</tr>
<tr>
<td>&quot;/servlets/requesterOperationServlet&quot;</td>
<td></td>
</tr>
<tr>
<td>operation='Deleterequesters'</td>
<td>operation command for deleting requester</td>
</tr>
<tr>
<td>name</td>
<td>requester Name</td>
</tr>
<tr>
<td>loginName</td>
<td>Requester's loginName</td>
</tr>
<tr>
<td>domainName</td>
<td>Requester's login domain name</td>
</tr>
<tr>
<td>emailId</td>
<td>Requester's emailId</td>
</tr>
<tr>
<td>userid</td>
<td>Requester id</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. &quot;AD_AUTH&quot; refers to Active Directory Authentication. “Local Authentication” or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>
The sample form to delete requesters can be viewed here.

A Success message appears as the xml response if the technician has permission to delete requesters.
Asset Attributes and xml Response

The asset attributes along with their actions should be used as defined below.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The asset operations that can be performed through API are adding, updating and deleting assets.</td>
</tr>
<tr>
<td>2. Asset operations can be performed by technicians only with Inventory privilege.</td>
</tr>
<tr>
<td>3. The attributes are case sensitive and should be used as defined.</td>
</tr>
<tr>
<td>4. While renaming the button in the sample html form, specify 'operation' as hidden element.</td>
</tr>
</tbody>
</table>

- Add/Update Workstation and Server
- Add/Update Asset
- Delete Asset

Add/Update Workstation and Server
The Details necessary for adding workstation should be set in HttpRequest parameters and HttpRequest parameter value for 'operation' attribute can be 'AddAsset','UpdateAsset' or 'SaveAsset'.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
</table>
| targetURL= 
"/servlets/AssetServlet" | target url for adding/updating workstation/server |
<p>| assetName | Name of the asset (workstation/server) |
| assetType | asset type |
| model | model no of the asset (workstation/server) |
| productName | Product Name of the asset (workstation/server) |
| siteName | site to which workstation/server is associated |
| ipAddress | ipAddress of workstation/server. |
| serviceTag | Service Tag of workstation/server |
| wsManufacturer | Workstation Manufacturer |
| proCount | proCount of workstation/server |
| proType | proType of workstation/server |
| proSpeed | proSpeed of workstation/server |
| proManufacturer | proManufacturer of workstation/server |
| ramSize | ramSize of workstation/server |
| virtualCapacity | virtualCapacity of workstation/server |
| osName | osName of workstation/server |
| osServicePack | osServicePack of workstation/server |
| resTag | resTag of workstation/server |</p>
<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>resSlNo</td>
<td>resSlNo of workstation/server</td>
</tr>
<tr>
<td>barCode</td>
<td>barCode of workstation/server</td>
</tr>
<tr>
<td>location</td>
<td>location of workstation/server</td>
</tr>
<tr>
<td>vendor</td>
<td>vendor of workstation/server</td>
</tr>
<tr>
<td>acqDate</td>
<td>Acquisition Date of workstation/server</td>
</tr>
<tr>
<td>expiryDate</td>
<td>expiryDate of workstation/server</td>
</tr>
<tr>
<td>warrantyExpDate</td>
<td>warrantyExpiryDate of workstation/server</td>
</tr>
<tr>
<td>assetState</td>
<td>state of the of workstation/server</td>
</tr>
<tr>
<td>assetToAssociate</td>
<td>Associate the asset to other assets. (Valid only for Asset State 'In Use').</td>
</tr>
<tr>
<td>associateToUser</td>
<td>Associate the asset to user. (Valid only for Asset State 'In Use').</td>
</tr>
<tr>
<td>associateToDepartment</td>
<td>Associate the asset to department. (Valid only for Asset State 'In Use').</td>
</tr>
<tr>
<td>UDF Column Aliases</td>
<td>UDF aliases name should be specified</td>
</tr>
<tr>
<td>macAddress</td>
<td>macAddress of workstation/server</td>
</tr>
<tr>
<td>nicInfo</td>
<td>NicInfo of workstation/server</td>
</tr>
<tr>
<td>netAddress</td>
<td>netAddress of workstation/server</td>
</tr>
<tr>
<td>domain</td>
<td>domain of workstation/server</td>
</tr>
<tr>
<td>dnsServer</td>
<td>dnsServer of workstation/server</td>
</tr>
<tr>
<td>gateway</td>
<td>gateway of workstation/server</td>
</tr>
<tr>
<td>dhcpEnabled</td>
<td>dhcpEnabled of workstation/server</td>
</tr>
<tr>
<td>monitorType</td>
<td>monitorType of workstation/server</td>
</tr>
<tr>
<td>monitorSerialNumber</td>
<td>monitorSerialNumber of workstation/server</td>
</tr>
<tr>
<td>monitorManufacturer</td>
<td>monitorManufacturer of workstation/server</td>
</tr>
<tr>
<td>mouseType</td>
<td>mouseType of workstation/server</td>
</tr>
<tr>
<td>mouseSerialNumber</td>
<td>mouseSerialNumber of workstation/server</td>
</tr>
<tr>
<td>mouseManufacturer</td>
<td>mouseManufacturer of workstation/server</td>
</tr>
<tr>
<td>keyboardType</td>
<td>keyboardType of workstation/server</td>
</tr>
<tr>
<td>keyboardSerialNumber</td>
<td>keyboardSerialNumber of workstation/server</td>
</tr>
<tr>
<td>keyboardManufacturer</td>
<td>keyboardManufacturer of workstation/server</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. AD_AUTH refers to Active Directory Authentication. Local Authentication or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>
Note:

1. The 'assetName' is unique and hence cannot be duplicated and edited.
2. If 'ServiceTag' is specified, then the information provided for the workstation/server is considered only for that Service Tag and not for the specified asset name.
3. Product Type should be specified as the 'assetType'. This field is mandatory.
4. Product of the asset should be specified as the 'productName'.
5. If the specified 'model' or 'productName' is invalid or empty, then the model is created as 'Unknown ProductType' say, Unknown Workstation.
6. If the specified 'site' is invalid, the workstation/server is associated to 'Not associated to any site.'
7. If the specified 'vendor' is invalid and if the technician has permission to add a vendor, then the Vendor is created as specified by the user.
8. The Resource State should be specified in 'assetState'.
9. Workstations/Servers with the 'assetstate' as 'In Use', can be associated to departments, users or assets.
10. If the 'assetstate' is specified as 'In Use' then the values should be specified in the following fields, 'assetToAssociate','associateToUser' or 'associateToDepartment'.
11. If the assetState is 'In Use' and if the invalid values are provided for the following fields 'assetToAssociate','associateToUser' or 'associateToDepartment', the state is set to 'In Store'
12. Workstations/Servers in disposed state cannot be assigned users or departments.
13. Workstations/Servers in disposed state cannot be assigned with other assets.
14. Technician with restricted access can create/update workstations/servers only for their associated site.
15. Technician with restricted access can assign/associate asset based on his access for that site alone.
16. To configure the asset additional fields for a workstation, specify the attribute as 'asset_MeasureName'

Add Workstation/Server
The sample form to Add Workstations/Servers can be accessed here. The 'AddAsset' operation performs only the add operation.

The operation status is Success when the workstation/server is added successfully. The xml response also displays the 'resourceid' and the 'resourcename' along with the message. Click here to view the xml response.

The operation status is failure if

- The mandatory fields are not specified
- The technician with restricted access is trying to create a new workstation/server.

Update Workstation/Server
The sample form to Update Workstations/Servers can be accessed here. The 'UpdateAsset' operation performs only the update of existing assets with the information provided.

The operation status is Success when the workstation/server is updated successfully. Click here to view the xml response.

Save Workstation/Server
The sample form to Save Workstation/Server can be accessed here.

While performing SaveAsset operation, if the asset is already available with the specified criteria, the asset is updated. Else, a new asset is created with the information provided.
**Add/Update Asset**

The details to add/update assets should be set in the Http Request parameters and the Http Request parameter value for 'operation' command can be 'AddAsset', 'UpdateAsset' or 'SaveAsset'.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL= */servlets/AssetServlet&quot;</td>
<td>target url for adding/updating asset</td>
</tr>
<tr>
<td>assetName</td>
<td>Name of the asset</td>
</tr>
<tr>
<td>assetType</td>
<td>type of asset</td>
</tr>
<tr>
<td>productName</td>
<td>Product Name of the asset</td>
</tr>
<tr>
<td>siteName</td>
<td>site to which asset is associated</td>
</tr>
<tr>
<td>assetTag</td>
<td>asset Tag</td>
</tr>
<tr>
<td>assetSlNo</td>
<td>Serial No of the asset</td>
</tr>
<tr>
<td>barCode</td>
<td>barCode of asset</td>
</tr>
<tr>
<td>location</td>
<td>location of asset</td>
</tr>
<tr>
<td>purchaseCost</td>
<td>PurchaseCost of the asset</td>
</tr>
<tr>
<td>vendor</td>
<td>vendor of asset</td>
</tr>
<tr>
<td>acqDate</td>
<td>Acquisition Date of asset</td>
</tr>
<tr>
<td>expiryDate</td>
<td>expiryDate of asset</td>
</tr>
<tr>
<td>warrantyExpDate</td>
<td>warrantyExpiryDate of asset</td>
</tr>
<tr>
<td>assetState</td>
<td>state of the of asset</td>
</tr>
<tr>
<td>assetToAssociate</td>
<td>Associate the asset to other assets.(Valid only for Asset State 'In Use').</td>
</tr>
<tr>
<td>associateToUser</td>
<td>Associate the asset to user.(Valid only for Asset State 'In Use').</td>
</tr>
<tr>
<td>associateToDepartment</td>
<td>Associate the asset to department.(Valid only for Asset State 'In Use').</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. AD_AUTH refers to Active Directory Authentication. Local Authentication or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

**Note:**

1. The 'assetName' is unique and hence cannot be duplicated or edited.
2. Product Type should be specified as the 'assetType'. This field is mandatory.
3. Product of the asset should be specified as the 'productName'.
4. If the specified 'model' or 'productName' is invalid or empty, then the model is created as 'Unknown ProductType' say, Unknown Workstation.
5. If the specified 'site' is invalid, the workstation/server is associated to 'Not associated to any site.'
6. If the specified 'vendor' is invalid and if the technician has permission to add a vendor, then the Vendor is created as specified by the user.
7. The Resource State should be specified in 'assetState'.
8. Assets with the 'assetstate' as 'In Use', can be associated to departments, users or assets.
9. If the 'assetstate' is specified as 'In Use' then the values should be specified in the following fields, 'assetToAssociate','associateToUser' or 'associateToDepartment'.
10. If the assetState is 'In Use' and if the invalid values are provided for the following fields 'assetToAssociate','associateToUser' or 'associateToDepartment', the state is set to 'In Store'
11. Assets in disposed state cannot be assigned users or departments.
12. Assets in disposed state cannot be assigned with other assets.
13. Technician with restricted access can create/update Assets only for their associated site.
14. Technician with restricted access can assign/associate asset based on his access for that site alone.

**Add Asset**
Click here to access the sample form.
The operation status is Success when the asset details are added successfully. The xml response also displays the 'asseteid' and the 'resourcename' along with the message. Click here to view the xml response.

The operation status is failure if,
- The mandatory fields are not specified
- The technician with restricted access is trying to create a new asset.

**Update Asset**
The sample form to Update Asset can be accessed here. The 'UpdateAsset' operation performs only the update of existing assets with the information provided.
The operation status is Success when the asset is updated successfully. Click here to view the xml response.

**Save Asset**
The sample form to Save Workstation/Server can be accessed here.
While performing SaveAsset operation, if the asset is already available with the specified criteria, the asset is updated. Else, a new asset is created with the information provided.

**Delete Asset**
The details necessary for deleting assets should be set in HttpRequest parameters and Httprequest parameter value for operation attribute should be 'DeleteAsset'.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetURL=&quot;/servlets/AssetServlet&quot;</td>
<td>target url for deleting asset</td>
</tr>
<tr>
<td>assetName</td>
<td>Name of the asset</td>
</tr>
<tr>
<td>assetType</td>
<td>type of asset</td>
</tr>
<tr>
<td><strong>Attributes</strong></td>
<td><strong>Comments</strong></td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>username</td>
<td>Login Name for SDP Authentication</td>
</tr>
<tr>
<td>password</td>
<td>Password for SDP Authentication</td>
</tr>
<tr>
<td>DOMAIN_NAME</td>
<td>Domain Name to which the user belongs.</td>
</tr>
<tr>
<td>logonDomainName</td>
<td>Authentication Mode [AD or Local Authentication]. AD_AUTH refers to Active Directory Authentication. Local Authentication or empty value refers to Local Authentication.</td>
</tr>
</tbody>
</table>

The sample form to delete asset can be accessed here.

The operation status is a Success if the asset is deleted successfully. Click here to view the xml response.
**REST API**

- About REST API
- Generating API Key
- REST API Supported Operations

**About REST API**

**Representational State Transfer (REST)** has similar functionality as that of Servlet API except for a few distinctness [Refer Different between Servlet and REST API to know more]. The REST API is completely automated, and users need not log into ServiceDesk Plus to perform operations. The purpose of REST API can be explained with the help of a scenario.

**Scenario:**

Lets take the case of a network monitoring tool (external application) that is installed in your network. In general, when an alarm is raised by the network monitoring tool, an e-mail notification is sent as a ticket to ServiceDesk Plus application. The field values (priority, level, impact, category and so on) should be filled by the technician manually in ServiceDesk Plus. This mechanism is time consuming and eventually results as a dip in your helpdesk productivity chart.

With REST API, you can automate this ticketing process. So, when an alarm is triggered, the network monitoring tool provides the field details and raises a ticket automatically in ServiceDesk Plus via http protocol. The ticket ID is sent back to the network monitoring tool in order to perform any further operations over the request.

When the cause for the alarm is resolved, ServiceDesk Plus will invoke an URL (callback URL) that was provided by the monitoring tool. The URL functions as a notification to the external application intimating that the ticket is resolved. If this URL (callback URL) is not provided, ServiceDesk Plus will not perform any additional operation on the ticket. When ServiceDesk Plus invokes the callback URL, the network monitoring tool can perform "any" internal operations based on the URL invocation. However, the expectation is that the application will clear the alarm (which was raised as a ticket) at their end.

**Note:** Please note that the callback URL is applicable only while creating and editing requests.

The operations performed with REST API is based on the 'operation' parameter and is sent to the url via HTTP POST method. The url format is as shown below,

```
http://<servername>:<port number>/sdpapi/<module>
```

Authentication to the ServiceDesk Plus application is key based i.e., an API key is sent along with the url for every operation. This key is technician based and can be generate for technicians with login privilege. The role given to the technician is also taken into consideration, so the key is valid only for the role given to the technician. Once the key is generated, the key is manually transferred to the integrated application so that the application can use the key for further API operations. If the key is invalid (key is expired or the technician login is disabled), the operation fails and an error is propagated to the integrated application.
Note

1. Please note that the administrator alone has the privilege to generate the authentication key for technicians with login permission.
2. If a login for the technician is disabled, then the technician key is deleted.
3. The operations can be performed based on the Role provided to the technician.

Currently, XML is the supported input and output format. The input data is sent as an XML string along with the technician key and operation name, while the output is exposed as an XML string.

Generating API Key

The authentication between ServiceDesk Plus and integrated application is through an API key. A unique key is generated for a technician with login permission in ServiceDesk Plus application.

1. Click Admin -> Technicians icon under User block.
2. If you want to generate the API key to the existing technician, click the edit icon beside the technician. If you want to generate the API key to a new technician, click Add New Technician link, enter the technician details and provide login permission.
3. Click Generate link under the API key details block. You can select a time frame for the key to expire using the calendar icon or simply retain the same key perpetually. If a key is already generated for the technician, a Re-generate link appears.

The key in the above image is generated for an existing technician. A time frame for the key is selected which shows the date, month, year and the time (in hours and minutes) when the key will expire.
REST API supported operations

The REST API supports only request related operations which can be separated into:-

- **Operations on request:** adding new request
- **Operations on a specific request:**
  - editing, closing, deleting and viewing existing requests.
  - adding new notes to a request, editing, deleting and viewing existing notes.
  - adding worklog to a request, editing, deleting and viewing existing worklogs.
Request Operations

The operations on request such as adding new request, updating, closing, deleting and viewing the existing request are discussed under this section.

To perform operations on the request, the following URL patterns should be used.

For adding request:

http://<servername>:<port number>/sdpapi/request/

For operations on a specific request:

http://<servername>:<port number>/sdpapi/request/<request id>

Contents

- Adding Request
- Editing Request
- Viewing Request
- Deleting Request
- Closing Request

Adding Request

Say, you are running ServiceDesk Plus with the server name "localhost" in the port "8080". You are creating a new request for the requester Shawn Adams, who is unable to browse the internet. The input and output XML format for the above scenario is given below.

To add a new request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/

So for the scenario above, the URL is: http://localhost:8080/sdpapi/request/

Key Points:

1. The operation name "ADD_REQUEST" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is XML string as "post attribute" with key "INPUT_DATA"

Input:

<Operation>
<Details>
<requester>Shawn Adams</requester>
<subject>Specify Subject</subject>
<description>Specify Description</description>
</Details>
</Operation>
<requesttemplate>Unable to browse</requesttemplate>
<priority>High</priority>
<site>New York</site>
<group>Network</group>
<technician>Howard Stern</technician>
<level>Tier 3</level>
<status>open</status>
<service>Email</service>

Output:

<?xml version="1.0" encoding="UTF-8"?>
<operation name="ADD_REQUEST">
  <result>
    <status>Success</status>
    <message>Request added successfully</message>
  </result>
  <Details>
    <workorderid>25</工作orderid>
  </Details>
</operation>

Editing Request

To edit a request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>

Assume the Request ID to edit is 25, then the URL is: http://localhost:8080/sdpapi/request/25

Key Points:

1. The operation name "EDIT_REQUEST" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is XML string as "post attribute" with key "INPUT_DATA"

Input:

<Operation>
  <Details>
    <level>Tier 3</level>
  </Details>
</operation>
Output:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<operation name="EDIT_REQUEST">
  <result>
    <status>Success</status>
    <message>Request 25 successfully edited</message>
  </result>
</operation>
```

Viewing Request

To view a request, the URL is given as:

```
http://<servername>:<port number>/sdpapi/request/<request id>
```

Assume the Request ID to view is 24, then the URL is: http://localhost:8080/sdpapi/request/24/

Key points:

1. The operation name "GET_REQUEST" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is not required for viewing requests.

Output:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_REQUEST">
  <result>
    <status>Success</status>
    <message>Request details fetched successfully</message>
  </result>
  <Details>
    <workorderid>24</workorderid>
    <requester>Howard Stern</requester>
    <createdby>Howard Stern</createdby>
    <createdtime>31 May 2010, 20:52:26</createdtime>
    <duebytime>01 Jun 2010, 10:00:00</duebytime>
    <respondedtime/>
    <completedtime/>
    <timespentonreq>0hrs 0min</timespentonreq>
    <subject>this is sub second</subject>
    <requesttemplate>Default Request</requesttemplate>
  </Details>
</operation>
```
Deleting Request
To delete a request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>

Assume the Request ID to delete is 21, then the URL is: http://localhost:8080/sdpapi/request/21/

Key points:
1. The operation name "DELETE_REQUEST" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is not required for deleting requests.

Output:

<?xml version="1.0" encoding="UTF-8"?>
<operation name="DELETE_REQUEST"/>
<result>
  <status>Success</status>
  <message>Request deleted successfully</message>
</result>

Close Request
To close a request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>

Assume the Request ID to close is 25, then the URL is given as:
http://localhost:8080/sdpapi/request/25

Key points:
1. The operation name "CLOSE_REQUEST" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. The input XML is optional. If specified, then the input is an XML string as "post attribute" with key "INPUT_DATA"

Input:

<Operation>
  <Details>
    <closeAccepted>Accepted</closeAccepted>
    <closeComment>this is close comment</closeComment>
  </Details>
</operation>

Output:

<?xml version="1.0" encoding="UTF-8"?>
<operation name="CLOSE_REQUEST">
  <result>
    <status>Success</status>
    <message>Request closed successfully</message>
  </result>
</operation>
Notes Related Operations

The notes related operations on specific request such as adding new notes, updating, deleting and viewing the existing notes are discussed under this section.

To perform the notes related operations on an existing request, the following URL patterns should be used.

For adding notes to a request:

http://<servername>:<port number>/sdpapi/request/<request id>/notes

For operations on a specific note for a request:

http://<servername>:<port number>/sdpapi/request/<request id>/notes/<notes id>

Contents
- Adding Note
- Editing Note
- Viewing Note
- Viewing all the Notes
- Deleting Note

Adding Note

Say, you are running ServiceDesk Plus with the server name as "localhost" in the port "8080". You are adding a note for an existing request for which the input and output in XML format is given below.

For adding a note to an existing request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>/notes

So for the above scenario, the URL is: http://localhost:8080/sdpapi/request/24/notes/

Key Points:
1. The operation name "ADD_NOTE" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is XML string as "post attribute" with key "INPUT_DATA"

Input:
<Operation>
<Details>
<Notes>
<Note>
<isPublic>false</isPublic>
<notesText>req notes api second</notesText>
</Note>
</Notes>
</Details>
</Operation>
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="ADD_NOTE">
  <result>
    <status>Success</status>
    <message>Note added successfully for request 24</message>
  </result>
</operation>

Editing Note
To edit a note of an existing request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>/notes/<note id>

Assume the Note ID to edit the note is 301, then the URL is:
http://localhost:8080/sdpapi/request/24/notes/301

Key Points:
1. The operation name "EDIT_NOTE" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is XML string as "post attribute" with key "INPUT_DATA"

Input:
<Operation>
  <Details>
    <Notes>
      <Note>
        <notesText>edited sub</notesText>
      </Note>
    </Notes>
  </Details>
</Operation>

Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="EDIT_NOTE">
  <result>
    <status>Success</status>
    <message>Note 301 successfully edited for request 24</message>
  </result>
</operation>
Viewing Note
To view one of the notes of an existing request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>/notes/<note id>

Assume the Note ID to view the note is 301, then the URL is:
http://localhost:8080/sdpapi/request/24/notes/301

Key Points:
1. The operation name "GET_NOTE" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is not required in this case.

Output:

<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_NOTE">
  <result>
    <status>Success</status>
    <message>Note details fetched successfully</message>
  </result>
  <Details>
    <Notes>
      <Note>
        <userid>301</userid>
        <ispublic>false</ispublic>
        <notestext>req notes api second</notestext>
        <username>Shawn Adams</username>
        <notesid>301</notesid>
        <notesdate>1275373443722</notesdate>
        <workorderid>24</workorderid>
      </Note>
    </Notes>
  </Details>
</operation>

Viewing all the Notes
To view all the notes of a request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>/notes/

Assume the Request ID to view all the notes is 24, then the URL is:
http://localhost:8080/sdpapi/request/24/notes
Key Points:

1. The operation name "GET_NOTES" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is not required in this case.

Output:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_NOTES">
  <result>
    <status>Success</status>
    <message>Notes details fetched successfully</message>
  </result>
  <Details>
    <Notes>
      <Note URI="http://localhost:8080/sdpapi/request/24/notes/302/">
        <ispublic>false</ispublic>
        <notestext>another note</notestext>
        <username>Shawn Adams</username>
        <notesdate>1275373948835</notesdate>
      </Note>
      <Note URI="http://localhost:8080/sdpapi/request/24/notes/301/">
        <ispublic>false</ispublic>
        <notestext>req notes api second</notestext>
        <username>Shawn Adams</username>
        <notesdate>1275373443722</notesdate>
      </Note>
    </Notes>
  </Details>
</operation>
```

Deleting Note

To delete a note of an existing request, the URL is given as:

```
http://<servername>:<port number>/sdpapi/request/<request id>/notes/<note id>
```

Assume the Note ID to delete the note is 301, then the URL is:
http://localhost:8080/sdpapi/request/24/notes/301
Key Points:

1. The operation name "DELETE_NOTE" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is not required in this case.

Output:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<operation name="DELETE_NOTE">
  <result>
    <status>Success</status>
    <message>Note deleted successfully</message>
  </result>
</operation>
```
Worklog Related Operations

The worklog related operations on specific request such as adding worklog, updating, deleting and viewing the existing worklogs are discussed under this section.

To perform worklog related operations the following URL patterns should be used.

**For adding worklog to an existing request:**

http://<servername>:<port number>/sdpapi/request/<request id>/worklogs

**For operations on a specific worklog:**

http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/<work log id>

Contents

- Adding Worklog
- Editing Worklog
- Viewing Worklog
- Viewing all the Worklogs
- Deleting Worklog

Adding Worklog

To add a worklog for an existing request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>/worklogs

So for the scenario above, the URL is: http://localhost:8080/sdpapi/request/24/worklogs/

Key Points:

1. The operation name "ADD_WORKLOG" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is XML string as "post attribute" with key "INPUT_DATA"

**Input:**

```
<Operation>
  <Details>
    <Worklogs>
      <Worklog>
        <description>Adding a New Worklog</description>
        <technician>Howard Stern</technician>
        <cost>25</cost>
        <workMinutes>20</workMinutes>
        <workHours>6</workHours>
      </Worklog>
    </Worklogs>
  </Details>
</Operation>
```
Output:
<?xml version="1.0" encoding="UTF-8"?>
<operation name="ADD_WORKLOG">
  <result>
    <status>Success</status>
    <message>Work Log added successfully for request 24</message>
  </result>
</operation>

Editing Worklog
To edit a worklog of an existing request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/<work log id>

Assume the Worklog ID to edit is 302, then the URL is:
http://localhost:8080/sdpapi/request/24/worklogs/302

Key Points:
1. The operation name "EDIT_WORKLOG" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is XML string as "post attribute" with key "INPUT_DATA"

Input:

<Operation>
  <Details>
    <Worklogs>
      <Worklog>
        <description>Worklog</description>
      </Worklog>
    </Worklogs>
  </Details>
</operation>

Output:

<?xml version="1.0" encoding="UTF-8"?>
<operation name="EDIT_WORKLOG">
  <result>
    <status>Success</status>
    <message>Work Log 302 successfully edited for request 24</message>
  </result>
</operation>
Viewing Worklog

To view one of the worklog of an existing request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/<work log id>

Assume the Worklog ID to view worklog is 302, then the URL is:
http://localhost:8080/sdpapi/request/24/worklogs/302

Key Points:
1. The operation name "GET_WORKLOG" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is not required in this case.

Output:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_WORKLOG">
  <result>
    <status>Success</status>
    <message>Work log details fetched successfully</message>
  </result>
  <Details>
    <Worklogs>
      <Worklog>
        <dateTime>1275375445281</dateTime>
        <executedTime>1275375433484</executedTime>
        <cost>21.6666666666667</cost>
        <WORKORDERID>24</WORKORDERID>
        <workHours>0</workHours>
        <workMinutes>7800000</workMinutes>
        <technician>Howard Stern</technician>
        <description>Worklog</description>
        <requestCostID>301</requestCostID>
      </Worklog>
    </Worklogs>
  </Details>
</operation>
```

Viewing Worklogs

To view all the worklogs of a request, the URL is given as:

http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/

Assume the Request ID to view all the worklogs is 302, then the URL is:
http://localhost:8080/sdpapi/request/24/worklogs/
Key Points:
1. The operation name "GET_WORKLOGS" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is not required in this case.

Output:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<operation name="GET_WORKLOGS">
  <result>
    <status>Success</status>
    <message>Work log deleted successfully</message>
  </result>
  <Details>
    <Worklogs>
      <Worklog URI="http://localhost:8080/sdpapi/request/24/worklogs/301/">
        <dateTime>1275375445281</dateTime>
        <executedTime>1275375433484</executedTime>
        <cost>21.6666666666667</cost>
        <WORKORDERID>24</WORKORDERID>
        <workHours>0</workHours>
        <workMinutes>7800000</workMinutes>
        <technician>Howard Stern</technician>
        <description>Worklog</description>
        <requestCostID>301</requestCostID>
      </Worklog>
      <Worklog URI="http://localhost:8080/sdpapi/request/24/worklogs/302/">
        <dateTime>1275375861188</dateTime>
        <executedTime>1275375861188</executedTime>
        <cost>25.0</cost>
        <WORKORDERID>24</WORKORDERID>
        <workHours>0</workHours>
        <workMinutes>22800000</workMinutes>
        <technician>Howard Stern</technician>
        <description>Worklog 2</description>
        <requestCostID>302</requestCostID>
      </Worklog>
    </Worklogs>
  </Details>
</operation>
```
Delete Worklog

To delete a worklog from a request, the URL is given as:

   http://<servername>:<port number>/sdpapi/request/<request id>/worklogs/<work log id>

Assume the Worklog ID to delete is 301, then the URL is:
http://localhost:8080/sdpapi/request/24/worklogs/301

Key Points:

1. The operation name "DELETE_WORKLOG" should be sent as a "post attribute" with key "OPERATION_NAME"
2. The technician key should be sent as a "post attribute" with key "TECHNICIAN_KEY"
3. Input is not required in this case.

Output:

   <?xml version="1.0" encoding="UTF-8"?>
   <operation name="DELETE_WORKLOG">
     <result>
       <status>Success</status>
       <message>Work Log deleted successfully</message>
     </result>
   </operation>
Reports

ManageEngine ServiceDesk Plus gives you a set of preset help desk, problem/change and asset reports and so on generated from the data available in the application.

To view the various reports available in application

1. Log in to the ServiceDesk Plus application using the user name and password of an admin user.

2. Click the Reports tab in the header pane. The next page lists the various reports grouped under different heads. Along with the default reports you also create New Custom Reports, New Query Reports, New Scheduled Report.

The following sections explain the various reports and the kind of data that each of these reports represents.

- About ServiceDesk Plus
- New Custom Report
- New Query Report
- Flash Report
- New Scheduled Report
- Custom Settings
About ServiceDesk Plus Reports

Reports in ServiceDesk Plus can be classified as Helpdesk, Problem/Change, Request Timespent, Survey, Asset, Audit, Resources, Purchase, Contracts reports.

Helpdesk Reports

Reports by all requests

These reports provide you with graphical view of all open and closed requests by category, group, created date, department, due date, level, priority, status, technician, status by category, status by level, status by priority, status by technician.

Also they can be exported as HTML file, PDF file, XLS file and CSV file.

To save the report in a particular folder click **Save report as** button. This opens the Save Report page. Specify the Report Name and if you wish the report to be viewed by all select Every One (Public) report. If you wish to view the report by just yourself (Private), select **Just me** button.

Select the Folder name from the Save-in-Folder combo box. If you wish to add new folder click **Add New Folder link**.

Specify the Description about the report in the given text field and Save the details.

You can also Schedule reports, View query, mail this reports for these reports. These options are available for all the report types under each report title.

Reports by completed requests

These reports show the distribution of completed and closed requests. Similar to Report by all request, these reports are also generated based on various parameters such as category, group, department, due date, level, mode, priority and request date.

Reports by SLA Violated requests

These reports display the distribution of the requests that have violated the SLA that was applicable on them. You can view these violations based on the request category, group, the department from which the request was generated, and the technician who handled the request and so on.

Reports by pending requests

This shows the distribution of all pending requests for a specific period of time, based on different parameters, such as priority, department, technician, category, due date, request date and so on.

Request Summary requests

These reports provide you with a high level view of the requests received and closed during a particular period, date-wise. The summary reports available are the received request summary reports by date and closed request summary reports by date. These reports are generated on the parameters of request received or closed by technicians, request received or closed in a specific category, priority, and mode.

Problem/Change Reports

Reports by All Problems

You get a graphical view as well as tabular view of all open, closed, on-hold and resolved problems based on different parameters such as category, status, priority, impact, technician and urgency.
Reports on Pending Problems
You get a graphical view as well as tabular view of all open and on-hold problems based on different parameters such as, category, priority, urgency and incidents counts.

Reports on Completed Problems
You get a graphical view as well as tabular view of all closed problems based on different parameters such as, category, priority, urgency, cost and incident counts.

Reports by All Changes
You get a graphical view as well as tabular view of all approval, approved, completed, implementation, planning, rejected, release, requested, review and testing changes based on different parameters such as, category, impact, status, change type, technician, time spent on change and priority.

Reports on Pending Changes
You get a graphical view as well as tabular view of all pending changes such as approval, approved, implementation, planning, release, requested, review and testing changes based on different parameters such as, category, priority, change type, urgency, incident counts and problem counts.

Reports on Completed Changes
You get a graphical view as well as tabular view of all completed changes based on different parameters such as, category, change type, priority, urgency, cost, incident counts and problem counts.

Request Timespent Reports

These reports provide information on the technician's time spent on requests and the cost per technician based on the time spent. You can group the report information based on category, department, requester and technician attending to the request. The time spent report by requester, gives you an idea on the cost per requester and the number of request.

By default, the help desk reports will be created for the current week. You can choose any custom period of your choice or choose to create reports for last week, or this month, or for just this day. All these reports can be used for analysis purposes. For example, the reports mapped against the parameter technician can be used to measure the technician responsiveness and load handling capability.

Survey Reports

These reports provide you with the summary details on the survey results based on various parameters. All these reports help in measuring the efficiency and effectiveness of the support team and take respective corrective actions.
Under Survey reports you have,

- Survey Overview Report which gives you the overall ratings of each of the questions in the survey based on the feedback of the users who took the survey. The ratings give you an idea about the value that is associated with the corresponding question. This report provides both tabular and a graphic representation of the results.

- Survey Results by Category report has the survey information grouped based on the category. Against each category, the points gained by each of the survey questions will be tabulated. Depending on the kind of survey questions, this report will provide valuable information based on individual request categories.

- Survey Results by Department has the survey information grouped based on the department from which the requests originated. The points for each question of the survey is mapped against the department name from where the request originated.
• **Survey Results by Level** has the survey information grouped based on the level of the requests. The points for each question of the survey is mapped against the level of the request for which the survey was sent.

• **Survey Results by Mode** has the survey information grouped based on the mode of the requests. The points for each question of the survey is mapped against the mode of the request for which the survey was sent. This also gives you an idea on the mode of request that is most frequently used to create a new request.

• **Survey Results by Priority** has the survey information grouped based on the priority of the requests. The points for each question of the survey is mapped against the priority of the request for which the survey was sent.

• **Survey Results by Requester** has the survey information grouped based on individual requester. This helps you in finding out which requester has sent the maximum number of requests and any other information based on your survey questions. This will give you an idea of the users perspective and help you in deciding about the corrective actions that need to be taken to make the support team more efficient and effective.

• **Survey Results by Technicians** has the survey information grouped based on individual technicians. Each of the survey questions will carry some value and based on this value, the average value for the questions will be marked against the technicians. These points will enable you to objectively measure the technicians efficiency and effectiveness from the users perspective and take any corrective measures, if required.

**Asset Reports**

**All Computers ( Workstation and Servers )**

The workstation reports give you information about the various workstation-related metrics.

• **Computers by Domain** report tells you the computers grouping based on domains. Thus you get to know the number of computers in each of the domains in your organization network.

• **Computers by Manufacturer** report gives you a high-level distribution view of the computers used from different manufacturers.

• **Computers by OS** report gives you an overview on the percentage of computers belonging to each type of operating system. Thus you will also know the different types of Operating Systems in use in your organization.

• **Computers by Processor Manufacturer** report gives you the graphical view as well as the tabular view of the computers by processor manufacturer. Thus it gives a count of all computers with processor vendor name used in your organization.

• **Computers by Processor Type** report will give a tabular view of all processor type in each computers used in your organization.

• **Computers by Vendor** report gives a graphical as well as the tabular view of all vendors for each the computers in your organization.

• **Computers with less than 256MB RAM and more than 256MB RAM** gives the report of all computers in your organization with more than 256MB RAM and less than 256MB RAM.

• **Operating System by Region** gives you the list of workstations that are grouped under a particular region but are not yet assigned to any user or department. The list of computers is also displayed in the tabular form just below the graph.

• **Unassigned workstations by Domain** gives you the number of computers that are connected to the domains but are not assigned to any user or department or computer. The list of computers is also displayed in the tabular form just below the graph.

**Server**

• **Server with less than 10% Free Disk space** gives the report of all the servers in your organization with less than 10% free Disk space.
• Servers with less than 512MB RAM gives the report of all the servers in your organization with less than 512MB RAM.

Software
Under software reports you have, Software Reports - Purchased Vs Installed software, Software by Category and Software by Manufacturer. Under software reports - purchased Vs Installed software you can view the list of all software purchased vs installed in each of the workstation in your organization. Under software by category you can view the list of all software classified under default software category. Under Software by Manufacturer you can have the tabular view of all software used in your organization listed based on the manufacturer of the software.

Workstation Summary Reports
Under workstation summary reports you have, Software Summary Report and Hardware Summary Report. Software summary report provides you with the tabular view of all the software installed in each workstation. This includes all managed, unmanaged software. Hardware summary report provides you with all the hardware details of an workstation such as, memory details, drive information, hard disk information, physical drive information, network adapters and so on. Thus it gives a complete overview of all the software installed and hardware details of an workstation.

Audit Reports
Under audit reports you have audit history by workstation, audit history by time line, audit history by changes. The updated audit reports are available only by scanning the workstation. Audit history by workstation gives a complete report on the account of all actions taken place in a workstation. This provides detail report on both hardware and software details. Audit history by time line gives a detail overview of all actions taken place in a workstation for a specific time period. By default you can get only the current week report. Audit history by changes gives a complete report on all changes taken place in a workstation for the current week.

To get the audit report for previous weeks,
1. Click the Edit button. This opens the Custom Reports.
2. From the Date Filter block-> select the Scan Date option from the combo box -> select the duration by clicking During combo box which provides you with the last week, last month, this month, this quarter, last quarter or yesterday options to generate reports. (OR) if you wish to generate reports for a specific time period then select the From and To radio button and select the dates from the calendar button.
3. Click Run Report button. You can get report for the specified time period.

Resources Reports
Under resources reports you have, resources by product type, resources by vendor, resources types by site. Resources by product types gives the graphical view as well as the tabular view of all the resources (assets) available for all default and newly added product types. Resources by Vendor gives the graphical and tabular view of all the resources in the organization based on the vendor name. The name of the vendor will be in X-axis and the resource count will be in Y-axis. Resource Types by Site lists all the available resources in your organization distributed across each sites of your company.

Contract Reports
Under contracts reports you have reports based on Active contracts, Contracts by Max value, Contracts by status, Contracts by vendor and Expired contracts. Active Contracts shows all the open contracts in your organization in a graphical and tabular view. Contracts by Max Value shows all the contracts which costs above 1000$ will be displayed in both graphical and tabular view. Contracts by
**Status** shows the list of all contracts with its status level such as, open contracts, expired, expired in the last 30 days, expiring in next 7 days and expiring in next 30 days in a graphical and tabular view. **Contracts by Vendor** shows all the contracts with all status level but classified based on the vendor. **Expired Contracts** shows the list of all the expired contracts in your organization.

**Purchase Reports**

Under purchases you have reports based on PO Vendors, PO by Ordered Date, PO by Required Date, PO by Status. **Purchase orders by vendors** gives the graphical view and tabular view of all the approved, pending for approval, partially approved, closed, overdue, po's due in next 7 days, po's due in next 30 days purchase orders classified based on the vendor name. **Purchase orders by ordered date** gives the graphical view and tabular view of all the approved, pending for approval, partially approved, closed, overdue, po's due in next 7 days, po's due in next 30 days purchase orders classified based on the ordered date. **Purchase orders by required date** gives the graphical view and tabular view of all the approved, pending for approval, partially approved, closed, overdue, po's due in next 7 days, po's due in next 30 days purchase orders classified based on the required date.
Custom Reports

ServiceDesk Plus enables you to create reports that meet your need if you are unable to find them from the list of out-of-the-box reports already available. To create your custom reports,

1. Login to ServiceDesk Plus application with your user name and password.
2. Click Reports tab in the header pane.
3. Click New Custom Report button in the reports home page. This opens the Custom Report page that will help you navigate through the various steps involved in the creation of a custom report.
4. Specify the relevant Report Title in the given text field. This is a mandatory field.
5. Choose the Report Type by selecting the radio buttons. You can create Tabular Reports, Matrix Reports, Summary Reports, Audit Reports.
6. Choose the module (Request, TimeSpent, Problem, Change and so on) for which you wish to create the report. The audit History module will be enabled only for audit reports. This is applicable only for the tabular and matrix reports. For summary reports, audit reports default modules will be selected.
7. Click Proceed to Report Wizard >> button. This opens the Display Columns page. This page differs for each report type. Each report type has to go through various steps before generating it as a customized report.

To generate Tabular Reports

Tabular reports are simple reports that allow you to list your data based on certain criteria. If you had selected the Tabular Reports option then you have five steps to create a complete customized tabular report. If you wish to skip a particular option then click the next tab and move to the next step.

Display Columns

The first step to create tabular reports is to select the display columns which need to be displayed in the tabular report. Select the columns from the Available Columns list box and click >> button to move them to Display Columns list box. Click the << button if you want to remove any column from the Display Columns list box.

Click Next button. This leads you to the grouping of columns, where you can choose two levels of grouping.

Filter Options

1. If you are using the date/time filter criteria, select the date column name from the Select Column combo box.
2. Select the period for which you want to generate the report. If you would like to generate report during this week, last week, this month, last month, this quarter, last quarter or today, yesterday then select the During radio button and select the time period from the combo box. (OR) If you wish to provide a custom period, then select the From and To date using the calendar button.
3. To use Advanced Filtering, select the column name such as, Requester name, region site and so on from the combo box. Select the criteria (is, is not, contains and so on) from the combo box. You can pick a value by invoking the icon . Select AND or OR option from the combo box to add more than one criteria. You can delete a criteria by clicking the delete icon .
4. Click the Choose button and select the value for the column to add as a filter condition.
5. Click as Add to Filter button to add the filter condition to the filter set which gets listed under the Filter Set title.
6. Click Next button to go to the grouping of data.
Grouping Data
From the Group by combo box, select the column based on which you wish to group the data.
Select the Order by from the combo box.
Click the Next button to go to the next stage.

Column Summary
You can get the column summary for all the columns in the report. If you wish to have the column summary displayed in the report, select the column summary options available for each column. The summary options differs for each column you have selected.
Click the Next button to go to the next option.

Charts
In addition to the tabular chart, if you wish to have a chart displayed for a particular column then, or you can skip this option and directly run the report.
1. Select the chart type to be displayed from the combo box.
2. Select the Axis column from the combo box to be displayed in the chart. This is a mandatory field. The data will be grouped in the chart based on the column selected.
3. Select the Display Format from the combo box. For ex: in numbers or in percentage.
4. Click Run Report button.
On running the report you get a tabular report as well as the graphical view for the selected column data.

To generate Matrix Reports
Matrix reports provides the data in a grid manner (m x n format). It allows you to study different scenarios based on the chosen criteria. If you have selected matrix reports you have two steps to generate a complete matrix report. Click the Proceed to Report Wizard button to go to next page.

Grouping Data
You have simple grouping and advanced grouping option for matrix reports.

Simple Grouping
1. Click the Simple grouping tab. You have two options Top column information and left column information. Select the top column information from the combo box. This is a mandatory field.
2. Select the left column information from the combo box. This is a mandatory field.
3. Select the summarize column count from the combo box to get the column summary.

Normal Grouping
1. Click the Advanced grouping tab. You have two options Column grouping and Group by.
2. Select the Columns and Date format to be displayed from the combo box. Select the group by from the combo box. You have three options for group by to be displayed in the report. This is a mandatory field.
3. Select the summarize column from the combo box.
4. Select the period for which you want to generate the report. If needed you can also provide a custom period by choosing the from and to date manually.

5. Click Next.

6. To use Advanced Filtering, you first need to select the radio button for matching all the selected criteria or any one of them. Then from the column listing, select the various columns and set the match operator and mention the values for matching.

Filter Options
1. If you are using the date/time filter criteria, select the date column name from the Select Column combo box.

2. Select the period for which you want to generate the report. If you would like to generate report during this week, last week, this month, last month, this quarter, last quarter or today, yesterday then select the During radio button and select the time period from the combo box. (OR) If you wish to provide a custom period, then select the From and To date using the calendar button.

3. To use Advanced Filtering, you first need to select the radio button for matching all the selected criteria or any one of them. Then from the column listing, select the various columns from the list and set the match operator and mention the values for matching the column as (is, is not, contains and so on) from the combo box.

4. Click the Choose button and select the value for the column to add as a filter condition.

5. Click as Add to Filter button to add the filter condition to the filter set which gets listed under the Filter Set title.

6. Click Run Report button. You get a matrix report

Request Summary Reports

Summary reports are detailed reports that allow you to list your data based on certain criteria. To create a request summary report, select the corresponding radio button from the custom reports page and click the Proceed to Report Wizard button to go to next page. You have two steps to generate a complete request summary reports.

Display Columns
The first step to create request summary reports is to select the display columns which need to be displayed in the request summary report. Select the columns from the Available Columns list box and click >> button to move them to Display Columns list box. Click the << button if you want to remove any column from the Display Columns list box.

Click Next button. This leads you to the grouping of columns, where you can choose two levels of grouping.

Filter Options
1. If you are using the date/time filter criteria, select the date column name from the Select Column combo box.

2. Select the period for which you want to generate the report. If you would like to generate report during this week, last week, this month, last month, this quarter, last quarter or today, yesterday then select the During radio button and select the time period from the combo box. (OR) If you wish to provide a custom period, then select the From and To date using the calendar button.

3. To use Advanced Filtering, you first need to select the radio button for matching all the selected criteria or any one of them. Then from the column listing, select the various columns from the list and set the match operator and mention the values for matching the column as (is, is not, contains and so on) from the combo box.

4. Click the Choose button and select the value for the column to add as a filter condition.
5. Click as **Add to Filter** button to add the filter condition to the filter set which gets listed under the **Filter Set** title.

6. Click **Next** button to go to the grouping of data.

**Audit Reports**

Audit reports are detailed history report that allow you to list your inventory history data based on scan time criteria. Click **Proceed to Report Wizard** button to go to the next page. This opens the **Audit History Report** page.

You have three audit history reports options, on scanning the workstation you get the updated version of all the audit reports.

- **Audit history by workstation.**
  Audit history by workstation gives a complete audit reports of the hardware and software details of the workstation.

- **Audit history by time line.**
  Audit history by time line gives a detail overview of all the actions taken place in a workstation for a specific time period.

- **Audit history by changes.**
  Audit history gives a complete report on all changes taken place in a workstation.

Select any of the three audit history report options. Specify the scan date from the combo box.

Click **Run Report** button. You get the audit history report.
Creating New Query Reports

1. Click on the Reports tab. This opens the All Reports page.
2. Click New Query Report button. This opens the Query Editor page.
3. Select the Table Schema from the combo box say, requests, timespent and so on. Click Get to view the table schema for the selected option.
4. Specify the title of the report in the Report Title field. This is a mandatory field.
5. Specify the query to be executed for getting reports in the Query field. This is a mandatory field.
6. The logs will display all error messages on providing any wrong query.
7. Click Run Report to run query report.

Tips
1. Date Formulae: DATE_FORMAT (FROM_UNIXTIME (COLUMN_NAME/1000),'%d-%m-%Y %k: %i') 'Column Alias'.
2. Minutes Formulae: ROUND (((COLUMN_NAME/1000)/60)) % 60 'Minutes'.
3. Hours Formulae: ROUND (((COLUMN_NAME/1000)/3600)) 'Hours'.
4. Compare Date: COLUMN_NAME >= (UNIX_TIMESTAMP (DATE ('2006-07-24 00:00:00')) * 1000).
5. Convert Memory in GB: ((((MEMORY_COLUMN)/1024)/1024)/1024)
6. Default Value For Null Data: COALESCE (COLUMN_NAME, 'Unassigned')
7. Group by: Query statement will be ends with order by <column_index>

Additional Field tables
1. Request Additional Fields - WorkOrder_Fields
2. Requester Additional Fields - Requester_Fields
3. Technician Additional Fields - Technician_Fields
4. Asset Additional Fields - Asset_Fields
5. Workstation Additional Fields - Workstation_Fields
6. Problem Additional Fields - Problem_Fields
7. Change Additional Fields - Change_Fields
Flash Report

Flash Reports help to get a quick and customizable overview of reports. Using Flash Reports we can generate a high level picture on the status of the requests based on the selected criteria. It tells us the number of requests that are present for a given condition.

To configure and view flash reports,

1. Login to ServiceDesk Plus application with your user name and password.
2. Click on Reports tab in the header pane
3. Click on Flash Reports button in the reports home page. This opens the Flash Reports page.
4. Select the filter parameters:
   - Select Created/Responded/Due-by/Completed time from the drop down box.
   - Select pre-defined time period from the drop down box by choosing During option or customize the time period by selecting the From and To dates from the calendar.
5. Click on OK.
6. The report is loaded in the same page.

The report shows information pertaining to requests in the mentioned time period under conditions such as Total requests, Pending Requests, Completed Requests and SLA Violated Requests. Based on parameters such as SLA, Technicians, Priority, Category, Site, Level, Type, Urgency, Impact, Mode and Status, the reports can be further scrutinized. These parameters can be viewed by clicking on the button.

For example,

If you need to know the number of requests that have violated the SLA, then click on "SLA" option. This shows number of violated/non-violated requests. For further information on the requests, click on the downward arrow and choose from one of the given parameters. Say, you need to know technicians handling the SLA violated requests, and then click on downward arrow and choose "Technician" from the drop down list. The technicians along with the number of requests handled by them are displayed in the next branch. Further if you want to know the priority of requests handled by a particular technician, then click on downward arrow next to the technician name and select "Priority". This displays the number of requests that have normal, high and low priorities.
If you click on the number that is displayed along with the report, the list of requests will be displayed in a new window. By clicking on the title of the request, you can view the request details in the space below. The request details cannot be edited/modified in this screen.
Scheduling Report Settings

1. Click Reports tab. This opens the All Reports page.
2. Click New Scheduled Report button. This opens Schedule Report Settings page.
3. To generate report once click Generate Once radio button. Specify the date using the calendar button and Time from the combo box on which the report has to be generated.
4. Select the report to schedule from the combo box. The list will display all the available reports such as, Reports by All requests, Reports by Completed requests, Reports by SLA Violated reports and so on. This is a mandatory field.
5. Specify the E-mail ID of the person to whom the generated report has to be sent.
6. Save the details. Scheduled reports gets displayed in the Schedule Reports page.
7. To generate reports on a daily basis click Daily Report radio button and specify the From Date, Time, report to be scheduled and the e-mail address of the person to whom the report has to be sent. Save the details.
8. To generate weekly report click Weekly Report radio button. Specify the days of the week on which you want to generate reports by selecting the check box. Or select Everyday check box to generate reports on daily basis. Also specify the time, report to schedule, and E-mail ID of the person to whom the generated report has to be sent. Save the details.
9. To generate reports on a monthly basis click Monthly Report radio button. Specify the month on which the report has to be generated by enabling the check box. Or select Every Month check box to generate reports on monthly basis. Also specify the time, report to schedule, and E-mail ID of the person to whom the generated report has to be sent. Save the details.
Custom Settings

The custom settings wizard helps you to customize the report column size. This helps to increase or decrease the tabular column size, matrix column size and modify the date and time format of your custom reports.

1. Click Reports tab. This opens the All Reports page.
2. Click the Custom Settings button. The Report Settings page pops up.
3. If you wish to customize the Tabular column size, specify the size of the small text, large text, number size and date and time text. And update the changes.
4. If you wish to customize the Matrix column size, specify the size of the cell width and cell height and update the changes.
5. You can also change the date and time format to be displayed in the report. If you specify the format in the given text field as MM-dd-yyyy HH:mm then the result would be Date: 09-20-2007 Time:03:20.
6. To disable the links in reports enable the check box beside Disable links in report under General Settings block. To view one Group per page, enable the check box beside the same.
7. Click the Update button to update the changes. While generating reports the customized report format will be
Appendix

This topic explains the various features that are not grouped under any of the modules but can be used from the application.

- System Log Viewer
- Feedback
- Personalize
- Backup and Restore
- Changing web server port
- ServiceDesk Plus Editions
- Troubleshooting
System Log Viewer

You can view the error logs generated by the ServiceDesk Plus application online.

To view the error logs,
1. Log in to the ServiceDesk Plus application using your user name and password. If you have the permissions to view the support information, you will see a Support tab in the header.
2. Click the Support tab in the header pane.
3. Click the System Log Viewer link available in the Support page.

To view the individual error details,
1. In the Error Log list view page, click the hyperlinked Error Message. An error log window with the details of the error is opened.
2. The Error Message field contains the complete error message.
3. The Module field indicates the module in which the error occurred.
4. The Occurred At field indicates the date and time when the error occurred.
5. If the probable cause of the error is known, then the cause is displayed in the Probable Cause field.
6. The Performed By field indicates the origin of the error. For example, if it is a system-generated error, then the Performed By field contains System as its value.
7. Click Close after viewing the details of the error message.

None of these fields are editable. You can also search for a specific error log details with the help of the Search in feature.

To search for error logs,
1. In the left menu, the search block is found at the bottom. If you are in the Error Log list view page, then by default, the System Log option is chosen in the Search in combo box. If not, then choose System Log.
2. In the Enter Keyword text field, enter the search string.
3. Press Enter on your keyboard or click Go. The search results will display all the error logs that match the search string.
4. Click the error log of your choice to view the same.

You can delete these error logs.

To delete individual error logs
1. In the Error Log list view, select check boxes beside the Error Messages that you wish to delete.
2. Click Delete.

If you want to delete all the existing error messages, then click the Delete All button.
Feedback

If you are connected to the network you can send your feedback about ServiceDesk Plus immediately to our support team.

To send your feedback,

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click Feedback link available at the top left corner of the page. This opens the Feedback pop up window.
3. The To address will be in non-editable format to our support team. Specify Your Name, Your email ID, Subject of the mail and Message mail content in their corresponding fields.
4. Click Submit button to send the mail.
Personalize

You can localize your personalization such as display language, time zone and so on, as well as change your login password using this option. Apart from the option of changing password from the user management configurations, you can also change your individual password.

1. Log in to the ServiceDesk Plus application using your user name and password.
2. Click the **Personalize** link available at the top right corner of the page. This opens Personalize page which has two tabs which are, **Personalize** and **Change Password** as shown below,

![Personalize](image)

**Personalize**

The personalize tab consists of display language, time zone, data format, time format and e-mail signature.

- **Display Language** Select the language of your choice from the **Choose Language** combo box. The selected language will be your default display language in the application. All the data will be displayed in the language selected by you.

- **Time Zone** Since the organizations can be situated in various sites, every site has its particular time zone. Select the time zone of the site of your organization from the **Select Time Zone** combo box. The date and time will be set according to the selected time zone.

- **Date/Time Format** Select the format of the date such as, Tue 16 Sep 2008, from the **Set Date Format** combo box. Similarly, you can also set the time format from **Set Time Format** combo box. The selected date and time format will be displayed where ever date/time is considered. For example: While creating a request, the request created on and due by time will be displayed in the selected date and time format corresponding to the selected time zone. The same can be viewed under Problem, Change, Solution and Purchase modules.
• **E-mail Signature** You can have your own personalized signature while replying to the mails using this option. Enter your signature in the text provided. Click **Save**.

**Change Password**

1. Click the Change Password tab in the personalize page. This displays the Change Password form.
2. Enter your old password in the **Current Password** field.
3. Enter your new password in the **New Password** field.
4. In the **Confirm New Password**, enter the new password again.
5. Click **Save** button.
Back up and Restore

- In Windows
- In Linux

**In Windows**

Follow the steps given below to take a back up of the ManageEngine ServiceDesk Plus data:

1. Click **Start -> Programs -> ManageEngine ServiceDesk Plus -> Backup Data**. A back up of the data and the file attachments that have been added to the application will be created.

The back up file will be created in the `<ServiceDesk>\backup` directory. The file name for the back up file will be of the pattern `BackUp_monthdate_year_hr_min.data`. An example of the back up file name: `BackUp_May20_2005_23_15.data`

To restore the back up data,

1. Go to `<ServiceDesk>\bin` directory.
2. Execute the file `restoreData.bat` at command prompt as shown below: `restoreData.bat <backup file name>`

The back up file name has to be the `.data` file from which you wish to restore the data. This will restore the data from the back up file.

**Note:** The ServiceDesk Plus server needs to be shut down before you restore the data.

**In Linux**

Follow the steps given below to take a back up of the ManageEngine ServiceDesk Plus data:

1. Go to `<ServiceDesk>/bin` directory.
2. Execute the `backUpData.sh` file as given below: `sh backUpData.sh`

The back up file will be created in the `<ServiceDesk>/backup` directory. The file name for the back up file will be of the pattern `BackUp_monthdate_year_hr_min.data`. An example of the back up file name: `BackUp_May20_2005_23_15.data`

To restore the back up data

1. Go to `<ServiceDesk>/bin` directory.
2. Execute the file `restoreData.sh` at command prompt as shown below: `sh restoreData.sh <backup file name>`

The back up file name has to be the `.data` file from which you wish to restore the data. This will restore the data from the back up file.

**Note:** The ServiceDesk Plus server needs to be shut down before you restore the data.
Changing Web Server Port

- In Windows
- In Linux

**In Windows**
Follow the steps given below to change the web server port where the ServiceDesk Plus server will be running:

1. Go to `<ServiceDesk>\bin` directory.
2. Execute the file `changeWebServerPort.bat` at command prompt as shown below:
   
   ```
   changeWebServerPort.bat <new port number> <http or https>
   ```
   The web server port will be reset to the new port number that you have specified.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>https</td>
<td>To start the ServiceDesk Plus server in https mode.</td>
</tr>
<tr>
<td>http</td>
<td>To start the ServiceDesk Plus server in http mode. By default, executing the file as <code>changeWebServerPort.bat &lt;new port number&gt;</code> will start the server in http mode.</td>
</tr>
</tbody>
</table>

If the port number is occupied, you will be prompted to enter a different port number. If you do not wish to enter a different port number then press N on your keyboard to exit the application. Else press Y and enter a different port number that is unoccupied.

This change will be effected only when you restart the server. To connect to the ServiceDesk Plus server after restarting, the new port number must be used.

**In Linux**
Follow the steps given below to change the web server port where the ServiceDesk Plus server will be running:

1. Go to `<ServiceDesk>/bin` directory.
2. Execute the file `changeWebServerPort.sh` at command prompt as shown below:

   ```
   $ sh changeWebServerPort.sh <new port number> <http or https>
   ```
   The web server port will be reset to the new port number that you have specified.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>https</td>
<td>To start the ServiceDesk Plus server in https mode.</td>
</tr>
<tr>
<td>http</td>
<td>To start the ServiceDesk Plus server in http mode. By default, executing the file as <code>changeWebServerPort.bat &lt;new port number&gt;</code> will start the server in http mode.</td>
</tr>
</tbody>
</table>

If the port number is occupied, you will be prompted to enter a different port number. If you do not wish to enter a different port number then press N on your keyboard to exit the application. Else press Y and enter a different port number that is unoccupied.

This change will be effected only when you restart the server. To connect to the ServiceDesk Plus server after restarting, the new port number must be used.
ServiceDesk Plus Editions

ServiceDesk plus is available in 3 editions namely,

- **Standard Edition** - which comprises of Incident Management alone.
- **Professional Edition** - includes Asset Management, Purchase and Contract Management

The tabular below gives a quick view of the features available in the 3 editions,

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Management</td>
<td>YES</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>Priority Matrix</td>
<td>-</td>
<td>-</td>
<td>YES</td>
</tr>
<tr>
<td>Problem Management</td>
<td>-</td>
<td>-</td>
<td>YES</td>
</tr>
<tr>
<td>Change Management</td>
<td>-</td>
<td>-</td>
<td>YES</td>
</tr>
<tr>
<td>Asset Management</td>
<td>-</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>Software License</td>
<td>-</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>Management</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Purchase Management</td>
<td>-</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>Contracts</td>
<td>-</td>
<td>YES</td>
<td>YES</td>
</tr>
<tr>
<td>Desktop Central Integration</td>
<td>-</td>
<td>-</td>
<td>YES</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>-</td>
<td>-</td>
<td>YES</td>
</tr>
</tbody>
</table>
Troubleshooting

This section gives you solutions for the problems faced while scanning for workstations in ServiceDesk Plus Inventory module.

1. Either access denied for the user or the remote DCOM option might be disabled in the workstation.
2. User does not have the access privileges to perform this operation.
3. Remote DCOM option is disabled in the Server machine.
4. Connection to RPC server in the workstation failed.
5. One of the WMI components is not registered properly.
6. Execution failure in the WMI Service of workstation.
7. WMI Service is disabled in the workstation.
8. Request for scan operation rejected by the workstation.
9. Connection to Telnet Service in the workstation failed.
10. Either Username or Password is incorrect in the workstation.
11. Scan operation Timed out.
12. The operation invoked is not supported in the current platform.
13. General failure while performing the operation.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>Either access denied for the user or the remote DCOM option might be disabled in the workstation.</td>
<td>This error message is shown when scanning of a Windows workstation fails due to any of the following reasons: 1. The login name and password provided for scanning might be invalid in the workstation. 2. Remote DCOM option might be disabled in the remote workstation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Check if the login name and password are entered correctly.</td>
</tr>
<tr>
<td>2. Check if Remote DCOM is enabled in the remote workstation. If not enabled, then enable the same. To enable DCOM in Windows 2000 Computers:</td>
</tr>
<tr>
<td>1. Select Start &gt; Run</td>
</tr>
<tr>
<td>2. Type DCOMCNFG in the text field</td>
</tr>
<tr>
<td>3. Click OK</td>
</tr>
<tr>
<td>4. Select Default Properties tab</td>
</tr>
<tr>
<td>5. Check the box &quot;Enable Distributed COM in this machine&quot;</td>
</tr>
<tr>
<td>6. Press OK</td>
</tr>
<tr>
<td>To enable DCOM in Windows XP Computers:</td>
</tr>
<tr>
<td>7. Select Start &gt; Run</td>
</tr>
<tr>
<td>8. Type DCOMCNFG in the text field</td>
</tr>
<tr>
<td>9. Click OK</td>
</tr>
<tr>
<td>10. Right Click on Component Services &gt; Computers &gt; My Computer</td>
</tr>
<tr>
<td>11. Click Properties</td>
</tr>
<tr>
<td>12. Select Default Properties tab in the frame that pops</td>
</tr>
<tr>
<td>13. Check the box &quot;Enable Distributed COM in this machine&quot;</td>
</tr>
<tr>
<td>14. Press OK</td>
</tr>
<tr>
<td>ZOHO Corp. 572</td>
</tr>
</tbody>
</table>
3. Check if the user account is valid in the target workstation. For this execute the following commands in the command prompt (of the server machine). net use \<RemoteComputerName>C$ /u:<DomainName\UserName> "<password>" net use \<RemoteComputerName>ADMIN$ /u:<DomainName\UserName> "<password>" Replace the relevant value within <> . Supply password within the quotes.

If these commands show any error message, then the provided user account is not valid in that remote computer.

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>User does not have the access privileges to perform this operation</td>
<td>Such error messages are shown, if the User ID provided for scanning does not have sufficient access privileges to perform the scanning operation. Probably, this user does not belong to the Administrator group of the workstation.</td>
<td>Move the user to the Administrator Group of the workstation (or) Scan with an administrator (preferably a Domain Administrator) account.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remote DCOM option is disabled in the Server machine</td>
<td>Remote DCOM option might be disabled in the machine running ServiceDesk Plus Server.</td>
<td>ServiceDesk uses Windows Management Instrumentation (WMI) to scan the remote workstations. WMI works over Remote DCOM and hence this option must be enabled for scanning the remote machines. To know how to enable DCOM in Windows system refer to resolution of the error message Either access denied for the user or the remote DCOM option might be disabled in the workstation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection to RPC server in the workstation failed</td>
<td>This message is shown when a firewall is configured on the remote computer. Such exceptions mostly occur in Windows XP (SP-2), when the default Windows Firewall is enabled.</td>
<td>Disable the default Firewall in the workstation. To disable the Firewall in Windows XP (SP2) 1. Select Start-&gt;Run 2. Type Firewall.cpl 3. Click OK. 4. In the General tab, click Off. 5. Click OK. If Firewall cannot be disabled then, we can launch Remote Administration feature for administrators in the remote computer. The following command when executed in the target computer, can enable the feature: netsh friewall set service RemoteAdmin After scanning the computer, if required, the Remote Administration feature can also be disabled. The following command disables the feature: netsh friewall set service RemoteAdmin disable</td>
</tr>
<tr>
<td>Error Message</td>
<td>One of the WMI components is not registered properly</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Cause</td>
<td>This message is shown if WMI is not available in the remote windows workstation. This happens in the Windows 9x, Windows NT and Windows ME. Such error codes might also occur in higher versions of Windows if the WMI Components are not registered properly.</td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td>Install WMI core in the remote workstation. This can be downloaded from the Microsoft web site. If the problem is due to WMI Components registration, then register the WMI dlls by executing the following command at command prompt: winmgmt /RegServer</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Execution failure in the WMI Service of workstation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Such error messages are shown, when there are some internal execution failures in the WMI Service (winmgmt.exe) running in the remote workstation. Probably the last update of the WMI Repository in that workstation could have failed.</td>
</tr>
</tbody>
</table>
| Resolution    | Restart the WMI Service in the remote workstation. To restart the WMI service in the workstation  
1. Click Start -> Run.  
2. Type Services.msc  
3. Click OK.  
4. In the Services window that pops-up, select "Windows Management Instrumentation" service and right-click on that.  
5. Click Restart. |

<table>
<thead>
<tr>
<th>Error Message</th>
<th>WMI Service is disabled in the workstation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>This error message is shown when the WMI Service (winmgmt.exe) is not enabled in the remote workstation.</td>
</tr>
</tbody>
</table>
| Resolution    | Modify the property of WMI Service to Manual or Automatic from Disabled.  
1. Click Start -> Run.  
2. Type Services.msc  
3. Click OK.  
4. In the Services window that pops-up, select "Windows Management Instrumentation" service and right-click on that.  
5. Click Properties.  
6. If the Startup type is "Disabled", change it to "Automatic/Manual" and start the service.  
7. Restart the service. |
<table>
<thead>
<tr>
<th>Error Message</th>
<th>Request for scan operation rejected by the workstation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>DCOM settings in Registry of the target workstation reject the scan request.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Edit the Registry key value, as described below:</td>
</tr>
<tr>
<td></td>
<td>1. Use Regedit to navigate to: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\OLE.</td>
</tr>
<tr>
<td></td>
<td>2. Double-click the EnableDCOM value Name, a string (REG_SZ) data type. Set its data value to Y, even if it is already SET to Y.</td>
</tr>
<tr>
<td></td>
<td>3. Click OK</td>
</tr>
<tr>
<td></td>
<td>4. Shutdown and restart the computer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Connection to Telnet Service in the workstation failed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Telnet Service might not be running in the target computer (or) Telnet Service is not running in default port 23.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Discovering remote Linux Machines by ServiceDesk is done using Telnet. Ensure that Telnet is running in the remote workstations in the default port 23.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Either Username or Password is incorrect in the workstation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>The username and password provided to scan the remote workstation is incorrect.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Discovering Linux Workstations, in ServiceDesk Plus is done using the Telnet. Provide a valid username and password that can successfully establish a telnet session with the target workstation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Scan operation Timed out</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Target workstation did not respond within the default time limit. This might be due to some delay in the network.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Try scanning the workstation, sometime later. If the same error message repeats, contact ServiceDesk Plus Support Team at <a href="mailto:servicedeskplus-support@manageengine.com">servicedeskplus-support@manageengine.com</a>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Message</th>
<th>The operation invoked is not supported in the current platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Such error codes are shown if the workstation has an Operating System other than Windows or Linux.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Currently, Network Discovery in ServiceDesk Plus supports Windows or Linux machines, only.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Error Message</th>
<th>General failure while performing the operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cause</td>
<td>Some unexpected exception occurred while, scanning the workstation.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Contact the ServiceDesk support team at <a href="mailto:servicedeskplus-support@manageengine.com">servicedeskplus-support@manageengine.com</a> with the Error log files. You can obtain the error log files from Support tab by clicking on the Support File link in the ServiceDesk Plus application.</td>
</tr>
</tbody>
</table>